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After purchasing the PXW-X320 Solid-State 
Memory Camcorder, before operating, it is 
necessary to set the area of use.
(Unless this setting is made, the camcorder will 
not operate.)

For details of these settings, see “Setting the Area of 
Use” (page 36).

Note

Before attaching/removing optional components or 
accessories to/from the PXW-X320 (referred to as “the 
camcorder”), be sure to turn the power of the camcorder 
off.

Foreword

Before Using This Unit
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a LIGHT switch
AUTO: When the POWER switch of the video 

light is in the on position, the video light is 
turned on automatically while the camcorder 
is recording.

MANUAL: You can turn the video light on or off 
manually, using its own switch.

Note

When the camcorder is set for recording in Picture Cache 
mode, it is not possible to turn on the light before 
operation to start recording is carried out (or while data 
is being stored in memory).

b POWER switch

c DC IN (DC power input) connector 
(XLR type, 4-pin, male)

d DC OUT 12V (DC power output) 
connector (4-pin, female)

Supplies power for an optional WRR-860C/861/
862 UHF Synthesized Diversity Tuner 
(maximum 0.5 A).

Note

Do not connect any equipment other than the UHF 
synthesized diversity tuner.

e Battery attachment shoe
Attach a BP-L80S Battery Pack. Alternatively, 
you can attach an AC-DN2B/DN10 AC Adaptor 
to operate the camcorder on AC power supply.

For details, see“Preparing a Power Supply” 
(page 30).

Note

For your safety, and to ensure proper operation of the 
camcorder, Sony recommends the use of the BP-L80S 
Battery Pack.

Adaptor connector
Enables connection of a CA-FB70/TX70 HD 
Camera Adaptor or an HDCA-702 MPEG TS 
Adaptor. To connect an adaptor, remove the 
cover from the connector and install the optional 
CBK-CE01 50 Pin Interface and Digital 
Extender.

Chapter1 Overview

Locations and Functions 
of Parts and Controls

Power Supply
Adaptor connector 
(see page 10)
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a Shoulder strap fitting (see page 43)

b Accessory shoe (see page 43)

c Viewfinder front-to-back positioning 
lever

d Viewfinder left-to-right positioning ring 
(see page 31)

e Viewfinder attachment shoe

f VF (viewfinder) connector (26-pin, 
rectangular)

g VF (viewfinder) connector (20-pin, 
round)

Connect the cable of the optional DXF-C50WA 
or DXF-20W viewfinder.

For connecting the DXF-C50WA, optional parts are 
required (see page 35).

h Lens mount securing rubber
After locking the lens in position using the lens 
locking lever, fit this rubber over the lower of the 
two projections. This fixes the lens mount, 
preventing it from coming loose.

i Viewfinder front-to-back positioning 
knob (LOCK knob) (see page 31)

j Fitting for optional microphone holder 
(see page 40)

k Shoulder pad
Raise the shoulder pad fixing lever to adjust the 
position in the front-to-rear direction (see 
page 44).

l LIGHT (video light) connector (2-pin, 
female)

A video light with a maximum power 
consumption of 50 W, such as the Anton Bauer 
Ultralight 2 or equivalent can be connected (see 
page 43).

m Lens cable clamp

n MIC IN (microphone input) (+48 V) 
connector (XLR type, 5-pin, female)

The power (+48 V) is supplied via this connector.

o LENS connector (12-pin)

Note

When connecting or disconnecting the lens cable to this 
connector, power off the camcorder first.

p Tripod mount

q Lens mount (special bayonet mount)

Consult a Sony service representative for 
information about available lenses.

Note

The auto iris function does not operate when a 
lens with 7-pin camera connector is attached.

r Lens locking lever
After inserting the lens in the lens mount, rotate 
the lens mount ring with this lever to lock the lens 
in position.
After locking the lens, be sure to use the lens 
mount securing rubber to prevent the lens from 
becoming detached.

s Lens mount cap
Remove by pushing up the lens locking lever. 
When no lens is mounted, keep this cap fitted for 
protection from dust.

Accessory Attachments
11



Front

a REC START (recording start) button
The effect is the same as that of the REC button 
on the lens.

b SHUTTER switch
Set to ON to use the electronic shutter. Push to 
SELECT to switch the shutter speed or shutter 
mode setting. When this switch is operated, the 
new setting appears on the viewfinder screen for 
about three seconds.

For details, see “Setting the Electronic Shutter” 
(page 53).

Note

When shutter is set to on while the flashband reduce 
function is set to on, the flashband reduce function is set 
to off and the FBR indication on the display disappears. 
When shutter is set to off, the flashband reduce function 
is set to on and the FBR indication appears on the 
display.

c FILTER selector
When this selector is used, the new setting 
appears on the viewfinder screen for about three 
seconds.

You can change the “MAINTENANCE” menu 
setting so that different white balance settings can 
be stored for different FILTER selector positions. 
This allows you to automatically obtain optimum 
white balance for the current shooting conditions 
in linkage with the filter selection.

For details, see “Adjusting the White Balance” 
(page 50).

d MENU knob
Changes the item selection or a setting within the 
menu (see page 115).

e AUTO W/B BAL (automatic white/
black balance adjustment) switch

WHITE: Adjust the white balance automatically. 
If the WHITE BAL switch (see page 14) is 
set to A or B, the white balance setting is 
stored in the corresponding memory. If the 
WHITE BAL switch is set to PRST, the 
automatic white balance adjustment function 
does not operate.

BLACK: Adjust the black set and black balance 
automatically.

You can use the AUTO W/B BAL switch even 
when the ATW (Auto Tracing White Balance) 
function is operating.
If you push the switch to the WHITE side once 
more during the automatic white balance 
adjustment, the adjustment is cancelled and the 
white balance setting returns to the original 
setting.
If you push the switch to the BLACK side once 
more during the automatic black balance 
adjustment, the adjustment is cancelled and the 
black balance setting returns to the original 
setting.

f MIC (microphone) LEVEL control (see 
page 58)

Operating and Connectors Section FILTER 
selector setting

ND filter

1 CLEAR

2 1/4 ND (attenuates light to 
approximately 1/4)

3 1/16 ND (attenuates light to 
approximately 1/16)

4 1/64 ND (attenuates light to 
approximately 1/64)
12



Right side (near the front)

a ASSIGN. (assignable) 1/2/3 switches
You can assign the desired functions to these 
switches on “OPERATION” > “Assignable SW” 
in the setup menu (see page 164).
The ASSIGN.1/3 switches are provided with an 
indicator to show whether a function is assigned 
to the switch (ON) or not (OFF).

b COLOR TEMP. (color temperature) 
button

You can also use this button as an assignable 
switch (see page 165).

c ALARM (alarm tone volume 
adjustment) knob

Controls the volume of the warning tone that is 
output via the built-in speaker or optional 
earphones. When the knob is turned to the 
minimum position, no sound can be heard.
However, if “MAINTENANCE” > “Audio” > 
“Min Alarm Volume” in the setup menu is set to 

“Set,” the alarm tone is audible even when this 
volume control is at the minimum position.

d MONITOR (monitor volume 
adjustment) knob

Controls the volume of the sound other than the 
warning tone that is output via the built-in speaker 
or earphones. When the knob is turned to the 
minimum position, no sound can be heard.

e MONITOR (audio monitor selection) 
switches

By means of combinations of the two switches, 
you can select audio that you want to hear through 
the built-in speaker or earphones.
Position of lower switch: CH-1/2

Position of lower switch: CH-3/4

a) By connecting stereo headphones to the EARPHONE 
jack, you can hear the audio in stereo. 
(“MAINTENANCE” > “Audio” > “Headphone Out” 
in the setup menu must be set to “Stereo.”)

f ASSIGN. (assignable) 0 switch
You can assign the desired function to this switch 
on “OPERATION” > “Assignable SW” in the 
setup menu (see page 164).
This is a momentary type switch. Each press of 
the switch turns the function assigned to this 
switch on or off.

g GAIN selector
Switches the gain of the video amplifier to match 
the lighting conditions during shooting. The gains 

Position of upper 
switch

Audio output

CH-1/CH-3 Channel 1 audio

MIX Channels 1 and 2 mixed 
audio (stereo) a)

CH-2/CH-4 Channel 2 audio

Position of upper 
switch

Audio output

CH-1/CH-3 Channel 3 audio

MIX Channels 3 and 4 mixed 
audio (stereo) a)

CH-2/CH-4 Channel 4 audio

ALARM

Minimum Maximum
13



corresponding to the L, M, and H settings can be 
selected on “OPERATION” > “Gain Switch” in 
the setup menu (see page 129).
When this switch is adjusted, the new setting 
appears on the viewfinder screen for about three 
seconds.

h OUTPUT/DCC (output signal/dynamic 
contrast control) switch

BARS: Output the color bar signal.
CAM: Output the video signal being shot. When 

this is selected, you can switch DCC1) on and 
off.

1) DCC (Dynamic Contrast Control):
Against a very bright background with the iris opening 
adjusted to the subject, objects in the background will 
be lost in the glare. The DCC function will suppress 
the high intensity and restore much of the lost detail. It 
is particularly effective in the following cases.
• Shooting people in the shade on a sunny day
• Shooting a subject indoors, against a background 

through a window
• Any high contrast scene

i WHITE BAL (white balance memory) 
switch

PRST: Adjust the color temperature to the preset 
value (the factory default setting: 3200K). 
Use this setting when you have no time to 
adjust the white balance.

A or B: Recall the white balance adjustment 
settings already stored in A or B. Push the 
AUTO W/B BAL switch (see page 12) on 
the WHITE side, to automatically adjust the 
white balance, and save the adjustment 
settings in memory A or memory B.

B (ATW 1)): When this switch is set to B and 
“OPERATION” > “White Setting” > “White 
Switch<B>” is set to “ATW” in the setup 
menu, ATW is activated.
You can use the AUTO W/B BAL switch 
even when ATW is in use.

When this switch is adjusted, the new setting 
appears on the viewfinder screen for about three 
seconds.
1) ATW (Auto Tracing White Balance): The white 

balance of the picture being shot is adjusted 
automatically for varying lighting conditions.

j MENU ON/OFF switch
This switch is used to display the menu on the 
viewfinder screen or the test signal screen. Each 
time the switch is pushed down, the menu screen 
is turned on and off. The function of this switch is 

the same as that of the MENU button in the 
thumbnail screen operations section.

k STATUS ON/SEL/OFF (menu display 
on/page selection/display off) switch
MENU CANCEL/PRST (preset)/
ESCAPE switch

When the menu is not displayed, this switch 
functions as the STATUS ON/SEL/OFF switch. 
When the menu is displayed, the switch functions 
as the MENU CANCEL/PRST/ESCAPE switch. 
(To use the switch, open the cover.)

Use the STATUS ON/SEL/OFF switch in the 
following way.
ON/SEL: Each time this switch is pushed 

upward, a window to confirm the menu 
settings and status of the camcorder appears 
on the viewfinder screen (see page 62). Each 
page is displayed for about 10 seconds.

OFF: To clear the page immediately after 
display, push this switch down to the OFF 
position.

Use the MENU CANCEL/PRST/ESCAPE 
switch in the following way.
CANCEL/PRST: Pushing this switch up to this 

position after a setting is changed in the setup 
menu displays the message to confirm 
whether the previous settings are cancelled. 
Pushing this switch up to this position again 
cancels the previous settings.
Pushing this switch up to this position before 
a setting is changed in the setup menu or after 
a setting change is cancelled in the setup 
menu displays the message to confirm 
whether the setting is reset to the initial 
value. Pushing this switch up to this position 
again resets the settings to the initial value.

ESCAPE: Use this switch when the menu page, 
which has a hierarchical structure, is opened. 
Each time the switch is pushed to this 
position, the page returns to one stage higher 
in the hierarchy.

l Switch cover
14



Right side (near the rear)
 

a Built-in speaker
The speaker can be used to monitor E-E1) sound 
during recording, and playback sound during 
playback. The speaker also sounds alarms to 
reinforce visual warnings (see page 187).
If you connect earphones to the EARPHONE 
jack, the speaker output is suppressed 
automatically.
1) E-E: Abbreviation of “Electric-to-Electric”. In E-E 

mode, video and audio signals input to the camcorder 
are output after passing through internal electric 
circuits only. This can be used to check input signals.

b Monochrome LCD panel
Displays remaining battery capacity, remaining 
media capacity, audio levels, time data, and so on 
(see page 20).

c WARNING indicator (see page 187)

d ACCESS lamp
Lights up in blue when data is written to or read 
from the recording media.

e Protective cover of the audio control 
section (see page 16)

f Protective cover of the thumbnail 
screen operations section (see page 16)

g F REV (fast reverse) button and 
indicator

The playback speed changes in the order ×4 t 
×15 t ×24 with each press of the button. The 
indicator lights during high-speed playback in the 
reverse direction.

h PLAY/PAUSE button and indicator
Press this button during playback to pause, 
outputting a still image. At this time the indicator 
flashes at a rate of once per second.
Pressing the F REV or F FWD button during 
playback or pause starts high speed playback in 
the forward or reverse direction.

i F FWD (fast forward) button and 
indicator

The playback speed changes in the order ×4 t 
×15 t ×24 with each press of the button. The 
indicator lights during high-speed playback in the 
forward direction.

j PREV (previous) button
This jumps to the first frame of the current clip.
If you press this together with the F REV button, 
the jump is to the first frame of the first recorded 
clip on the recording media.
If you press this button twice in rapid succession, 
the jump is to the first frame of the last preceding 
clip (or the first frame of the current clip when no 
preceding clips exist).

k STOP button

l NEXT button
This jumps to the first frame of the next clip.
If you press this together with the F FWD button, 
the jump is to the first frame of the last recorded 
clip on the recording media.
15



m EXPAND (expand function) button
If you press this button when the thumbnail 
screen is displayed, the duration of the selected 
clip is divided into fractions, and the first frame of 
each of the divisions is shown in a further 
thumbnail display (expand function). For an HD 
recorded MP4 clip, its duration is divided into 12. 
If an SD recorded AVI clip comprises multiple 
files, the divisions are displayed for the individual 
files.
For MP4 clips, each time you press this button the 
division is repeated. Hold down the SHIFT button 
and press this button to step back through the 
division process.

n HOLD (display hold) button
Pressing this button instantly freezes the time data 
displayed in the monochrome LCD panel (the 
timecode generator continues running). Pressing 
this button again releases the hold.

For details about the counter display, see page 20.

o RESET/RETURN button
Resets the value shown in the time counter 
display in the monochrome LCD panel. 
According to the settings of the PRESET/
REGEN/CLOCK switch (see page 17) and the 
F-RUN/SET/R-RUN switch (see page 17), this 
button resets the display as follows.

a) Of the timecode bits for every frame recorded on the 
media, those bits which can be used to record useful 
information for the user such as scene number, 
shooting place, etc.

For details, see “Setting Time Data” (page 59).

This button returns to the previous screen when 
pressed during thumbnail screen display, expand 
thumbnail screen display, or shot mark thumbnail 
screen display.

p DISPLAY switch
This cycles the data displayed in the time counter 
display in the monochrome LCD panel through 
the sequence COUNTER, TC, and U-BIT (see 
page 20).
COUNTER: Display the elapsed recording/

playback time (hours, minutes, seconds, 
frames).

TC: Display timecode.
U-BIT: Display user bits data.

q BACKLIGHT button

Thumbnail screen operations section and audio 
control section
 

a THUMBNAIL indicator
This lights when thumbnail screen is displayed.

b THUMBNAIL button
Press this button to display the thumbnail screen 
(see page 101) and to carry out a thumbnail 
operation.
Press once more to return to the original display.

c SET button and arrow buttons
Use these buttons to make timecode and user bit 
settings, and for thumbnail screen operations (see 
page 106).
When the menu is displayed, press this button to 
select an item or to confirm the setting change.

d MENU button
Each press of this button turns the setup menu 
display on and off.

Settings of switches RESET/RETURN 
button operation

DISPLAY switch: 
COUNTER

Reset the counter to 
0:00:00:00.

DISPLAY switch: TC
PRESET/REGEN/
CLOCK switch: 
PRESET
F-RUN/SET/R-RUN 
switch: SET

Reset the timecode to 
0:00:00:00.

DISPLAY switch:
U-BIT
PRESET/REGEN/
CLOCK switch: 
PRESET
F-RUN/SET/R-RUN 
switch: SET

Reset the user bit data a) 
to 00 00 00 00.
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The function of this button is the same as that of 
the MENU ON/OFF switch.

e F-RUN/SET/R-RUN (free run/set/
recording run) switch

Selects the operating mode of the internal 
timecode generator. The operating mode is set as 
explained below, depending on the position of the 
switch.
F-RUN: Timecode keeps advancing, regardless 

of whether the camcorder is recording. Use 
this setting when synchronizing the timecode 
with external timecode.

SET: Sets the timecode or user bits.
R-RUN: Timecode advances only during 

recording. Use this setting to have a 
consecutive timecode on the recording 
media.

For details, see “Setting the Timecode” (page 59).

For details, see “Setting the User Bits” (page 60).

f AUDIO LEVEL CH1/CH2/CH3/CH4 
(audio channel 1/2/3/4 recording level) 
knobs

Adjust the audio levels to be recorded on channels 
1, 2, 3, and 4 when the AUDIO SELECT CH1/
CH2 and AUDIO SELECT CH 3-4 switches are 
set to MANUAL.

g AUDIO SELECT CH 3-4 (audio 
channel 3/4 adjustment method 
selection) switch

Select the audio level adjustment method for each 
of audio channels 3 and 4.
AUTO: Automatic adjustment
MANUAL: Manual adjustment

h ESSENCE MARK button
By pressing this button when the thumbnail 
display of a clip is on the screen, you can view the 
following thumbnail display of the shot-marked 
frames of that clip, depending on the item 
selected in a list displayed on the screen.
All: Thumbnail display of all frames marked with 

essence marks.
Shot Mark1: Thumbnail display of the frames 

marked with Shot Mark 1
Shot Mark2: Thumbnail display of the frames 

marked with Shot Mark 2
You can also select Shot Mark 0 and Shot Mark 3 
to Shot Mark 9.

If you have recorded clips by using planning 
metadata that defined names for Shot Mark 0 to 
Shot Mark 9, the defined names are displayed 
instead of the above item names in the list.

i SHIFT button
Use this in combination with other buttons.

j PRESET/REGEN (regeneration)/
CLOCK switch

Selects the type of timecode to record.
PRESET: Record new timecode on the media.
REGEN: Record timecode continuous with the 

existing timecode recorded on the media. 
Regardless of the setting of the F-RUN/SET/
R-RUN switch, the camcorder operates in 
R-RUN mode.

CLOCK: Record timecode synchronized to the 
internal clock. Regardless of the setting of 
the F-RUN/SET/R-RUN switch, the 
camcorder operates in F-RUN mode.

k AUDIO SELECT CH1/CH2 (audio 
channel 1/2 adjustment method 
selection) switches

Select the audio level adjustment method for each 
of audio channels 1 and 2.
AUTO: Automatic adjustment
MANUAL: Manual adjustment

l AUDIO IN CH1/CH2/CH3/CH4 (audio 
channel 1/2/3/4 input selection) switches

Select the audio input signals to be recorded on 
audio channels 1, 2, 3 and 4.
FRONT: Audio input signals from the 

microphone connected to the MIC IN 
connector

REAR: Audio input signals from an audio device 
connected to the AUDIO IN CH-1/CH-2 
connectors

WIRELESS: Audio input signals from the UHF 
portable tuner if it is installed
17



Left side and upper section

a ASSIGNABLE 4/5 switches
You can assign the desired function to this switch 
on “OPERATION” > “Assignable SW” in the 
setup menu (see page 165).
Off is assigned to these switches when the 
camcorder is shipped from the factory.

b Dedicated wireless adapter connector
Remove the cover to attach a CBK-WA101 
Wireless Adapter (not supplied). For details about 
attaching the CBK-WA101, refer to the 
Operating Instructions or Installation Manual of 
the CBK-WA101.

c PC connector
Used to put this camcorder into USB connection 
mode and use it as an external storage device for 
a computer. When a computer without 
ExpressCard slot is connected to this connector, 
every memory card inserted in the camcorder is 
recognized as a drive for that computer.

d External device connector
Connect an optional CBK-WA101 Wireless 
Adapter, IFU-WLM3 USB Wireless LAN 
Module, or USB flash drive.
When connecting the CBK-WA101 or IFU-

WLM3: You can connect the camcorder and 
device via wireless LAN connection.

When connecting a USB flash drive: You can 
record, store, or load the following data.
• Planning metadata (see page 97)
• Setting data file (see page 170)

Note

Use this connector only for connecting the 
CBK-WA101, IFU-WLM3, USB flash drive, or USB 
media. Do not connect and use a USB hub or similar 
products.

For details about wireless LAN connection, see 
“Connecting the Camcorder to Devices using the 
IFU-WLM3 USB Wireless LAN Module” (page 81) 
or “Connecting the Camcorder to Devices using the 
CBK-WA101 Wireless Adapter” (page 85).

e SxS memory card slots
These two slots (A and B) can receive SxS 
memory cards or other recording media (see 
page 63).

f ACCESS lamps
Indicate the state of slots A and B (see page 63). 
You can check whether the lamps are lit even 
when the slot cover is closed.

g EJECT (SxS memory card eject) 
buttons (see page 63)

h Slot cover
Slide to the left and right to open and close.

HDMI GENLOCK
IN

TC IN

VIDEO
OUT TC

OUT
18



i SLOT SELECT (SxS memory card 
select) button (see page 63).

j HDMI output connector
When a video monitor provided with an HDMI 
signal input connector is connected to this 
connector, you can monitor picture being shot 
(camera picture) or playback picture.

k GENLOCK IN (genlock signal input) 
connector (BNC type)

This connector inputs a reference signal when the 
camcorder is to be genlocked or when timecode is 
to be synchronized with external equipment. 
Available reference signals vary depending on the 
current system frequency as shown in the 
following table.

(Genlock for the camera module supports 
horizontal sync signals only.) Adjust the genlock 
H-phase (phase of horizontal sync signal) on 
“MAINTENANCE” > “Genlock” in the setup 
menu.

l TC IN (timecode input) connector 
(BNC type)

To apply an external lock to the timecode of the 
camcorder, input the reference timecode.

For details, see “Setting the Timecode” (page 59).

m VIDEO OUT connector (BNC type)
The output signals can be selected either 
composite video or HD-Y depending on the 
setting of “OPERATION” > “Input/Output” > 
“Output&i.LINK” in the setup menu.

n TC OUT (timecode output) connector 
(BNC type)

To lock the timecode of an external VTR to the 
timecode of this camcorder, connect this 
connector to the external VTR’s timecode input 
connector.

Rear

a TALLY (back tally) indicators (red)
Light up during recording. They will not light if 
the TALLY switch is set to OFF. These indicators 
also flash to indicate warnings (see page 15). The 
tally indicator on the front of the viewfinder and 
the REC indication on the viewfinder screen light 
or flash in the same manner.

For details, see “Error/Warning System” 
(page 187).

System frequency Available reference 
signals

1080/59.94i 1080/59.94i, 480/59.94i

1080/29.97P 1080/59.94i, 480/59.94i

1080/23.98P (PsF 
output)

1080/23.98PsF, 480/59.94i

1080/23.98P 
(Pulldown output)

1080/59.94i, 480/59.94i

720/59.94P 1080/59.94i, 720/59.94P, 
480/59.94i

720/29.97P 1080/59.94i, 720/59.94P, 
480/59.94i

720/23.98P 1080/59.94i, 720/59.94P, 
480/59.94i

480/59.94i 1080/59.94i, 480/59.94i

480/29.97P 1080/59.94i, 480/59.94i

1080/50i 1080/50i, 576/50i

1080/25P 1080/50i, 576/50i

720/50P 1080/50i, 720/50P, 576/50i

720/25P 1080/50i, 720/50P, 576/50i

576/50i 1080/50i, 576/50i

576/25P 1080/50i, 576/50i
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b TALLY switch
Set to ON to activate the TALLY indicator 
function.

c EARPHONE jack (stereo, minijack)
You can monitor the E-E sound during recording 
and playback sound during playback. When an 
alarm is indicated, you can hear the alarm sound 
through the earphone. Plugging an earphone into 
the jack automatically cuts off the built-in 
speaker.
You can select monaural or stereo on 
“MAINTENANCE” > “Audio” in the setup 
menu.

d AUDIO IN selector switches
Select the audio source you connect to the 
AUDIO IN CH-1/CH-2 connectors.
LINE: When connecting a stereo amplifier or 

other external audio signal source
MIC: When connecting a microphone that does 

not require 48 V power supply
+48V: When connecting a microphone that 

requires 48 V power supply

e HD/SD SDI OUT connectors (BNC 
type)

The camcorder has two HD/SD SDI OUT 
connectors.
These connectors output an HDSDI or SDSDI 
signal (with embedded audio). The output from 
these connectors can be turned on or off, on 
“OPERATION” > “Input/Output” > “SDI 
Output” in the setup menu.

f AUDIO IN CH-1/CH-2 (audio channel 
1 and channel 2 input) connectors (XLR 
type, 3-pin, female)

You can connect audio equipment or a 
microphone.

g Bottom cover
This is provided for protecting the cables 
connected to the connectors on the rear panel.
By loosening the screws which retain the cover to 
the bottom of the camcorder, you can adjust the 
position of the cover depending on the size and 
shape of the microphone or audio cable plugs. 
After adjusting the position, tighten the screws to 
secure the cover.

h AUDIO OUT connector (XLR type, 
5-pin, male)

Outputs the audio signals recorded on audio 
channels 1 and 2 or audio channels 3 and 4.
The audio signals are selected by the MONITOR 
switch.

i REMOTE connector (8-pin)

Note

Before connecting/disconnecting the Remote Control 
Unit to/from the camcorder, be sure to turn off the 
camcorder POWER switch.

j i.LINK (HDV/DV) connector (6-pin, 
IEEE1394 compliant, S400)

To input and output HDV/DV streams, connect to 
an HDV/DV device.

a Timecode status indicator
NDF: Appears when non-drop-frame timecode is 

selected.
EXT-LK: Appears when the internal timecode 

generator is locked to an external signal input 
to the TC IN (timecode input) connector.

b Counter display mode
Shows the type of information selected by the 
DISPLAY switch to be displayed in the time 
counter display.
COUNTER: Counter values
TC: Timecode
U-BIT: User bits data

c Time counter display
Switches displays of time counter values, 
timecode, and user bits data, depending on the 
position of the DISPLAY switch.

Monochrome LCD Panel
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When the HOLD button is pressed to hold the 
timecode value, the timecode is displayed in the 
format shown below. When the HOLD button is 
pressed again to release the hold, the timecode is 
displayed in the normal format.

d HOLD indicator
Appears when the timecode generator output is 
displayed in the hold mode.

e Audio level indicators
Indicate the audio recording or playback levels of 
channels 1 to 4.

f Lock icon
Appears when the recording media is write-
protected.

g Remaining media capacity indicator
Shows bar segments indicating the remaining 
capacity of recording media in the slots.

h Remaining battery capacity indicator
Shows bar segments indicating the remaining 
battery capacity.

a PUSH AF (auto focus) button
When the focus adjustment is in the manual 
mode, by pressing this button you can use the auto 
focus for an instantaneous adjustment to the 
subject.
When the button is pressed, the auto focus 
operates until the image is in focus, then 
disengages.
Even when the FOCUS switch is set to A (auto), 
by pressing this button, you can restart the auto 
focus.

b FOCUS switch
A (auto): The auto focus function is constantly 

active. Even with the switch in the A 

The three dots indicates that timecode is 
displayed in the hold mode.

Auto Focus Lens
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position, you can manually adjust the focus 
by operating the focus ring.

M (manual): The manual mode allows focusing 
adjustment with the focus ring.
In manual mode, auto focus adjustment is 
also possible, by pressing the PUSH AF 
button.

c MACRO switch
When this switch is in the ON position, the macro 
mode is enabled, allowing focusing over the 
whole range (5 cm 1) to ∞) including the macro 
range (from 5 cm 1) to 90 cm from the front of the 
lens).
This operation is independent of whether the 
focus adjustment mode is auto or manual.
In the macro range, the auto focusing speed is 
lower.
1) At the wide-angle setting

d Iris ring
For manual iris adjustment, set the IRIS switch to 
the M (manual) position, then turn this ring.

e Zoom ring
For manual zoom adjustment, set the ZOOM 
switch to the MANUAL position, then turn this 
ring.

f Focus ring
Turn this ring to adjust the focus.
This ring can be turned endlessly in both 
directions. The faster you turn, the faster the 
focusing mechanism operates, to minimize the 
amount of turning required for focusing.
When you slide the focus ring back (toward the 
camcorder), the focus mode becomes Full MF 
mode, in which all focus adjustments are manual 
(see page 57).

g Flange focal length adjustment button
Press this to adjust the flange focal length (the 
distance from the lens mounting flange plane to 
the focusing plane) (see page 37).

h ZOOM switch
SERVO: Motorized zoom. Operate the zoom 

with the power zoom lever.
MANUAL (manual): Manual zoom. Operate the 

zoom with the zoom ring.

i Zoom control connector (8-pin)
Connecting an optional zoom servo controller 
allows remote control of zooming.

j PUSH AUTO button
When the IRIS switch is in the M position for 
manual adjustment, press this button for an 
instantaneous auto adjustment. The iris is 
automatically adjusted while the button is held 
down.

k IRIS switch
A (auto): The iris is adjusted automatically.
M (manual): Adjust the iris with the iris ring.

l Power zoom lever
This is enabled when the ZOOM switch is in the 
SERVO position. Push to the W (wide) side when 
you want wide-angle, and push to the T 
(telephoto) side when you want telephoto.
Press the lever harder for a faster zoom action, or 
softer for slower zoom action.

Notes on auto focus
• In the following cases, it may be difficult to 

focus on the subject. If this does happen, use 
manual focusing.
- If the subject has no contrast
- If the subject is moving rapidly
- When shooting point light sources, under 

street lighting or at night
- When there are very bright objects close to the 

subject
- When shooting through a glass window

• If there are a number of objects within the 
screen at close and far range, the focus may not 
be on the intended subject. In this case, with the 
subject on which you want to focus in the center 
of the screen, press the PUSH AF button.

• After focusing with the PUSH AF button, if you 
operate the zoom or adjust the iris, the depth of 
field may become shallower, losing crisp focus. 
In such cases, press the PUSH AF button once 
more.

• If you focus at wide-angle then zoom to 
telephoto, the subject may no longer be in focus.

• It may take time until the image is in focus 
while using the slow shutter mode.

Note on zoom speed
Depending on the shooting distance, the zoom 
speed may fall as the lens approaches the 
telephoto end.
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m RET (return video) button
You can use this as an assignable switch (see 
page 167).
Use this to check the video when Lens RET is 
assigned to this button (factory default setting). If 
you press this after recording stops, the last few 
seconds recorded appear on the viewfinder screen 
(recording review) (see page 88).
Pressing this button (single click) during 
recording or playback records a Shot Mark 1 
mark, and double-clicking records a Shot Mark 2 
mark (see page 90).

n VTR button
Use this to start and stop recording. Press once to 
start recording, then press once more to stop.

a  Connector
Connect to the VF connector (26-pin) on the 
camcorder.

b Slide stopper
Prevents the viewfinder from coming off the 
camcorder when it is slid from side to side.

c Eyecup

d Diopter adjustment ring
Allows for optimal focus adjustment.

e Eyepiece
You can raise this up when required by the 
situation.

f Viewfinder barrel
You can raise this up or rotate when required by 
the situation.

g Tally indicator
Lights up when recording is started by a press of 
the REC START button on this camcorder, the 
VTR button on the lens, or the VTR button on the 
remote control unit.
When an abnormality occurs, the tally indicator 
flashes to indicate a warning.

h PEAKING control
Turning this knob clockwise adjusts the picture 
sharpness, and makes focusing easier. This 
control has no effect on the output signals of the 
camcorder.

i CONTRAST control
Adjusts the contrast of the screen. This control 
has no effect on the output signals of the 
camcorder.

j BRIGHT control
Adjusts the brightness of the screen. This control 
has no effect on the output signals of the 
camcorder.

k TALLY switch
Controls the tally indicator located on the front of 
the viewfinder.
HIGH: The tally indicator brightness is set to 

high.
OFF: The tally indicator is disabled.
LOW: The tally indicator brightness is set to low.

l ZEBRA (zebra pattern) switch
Controls the zebra pattern display on the 
viewfinder screen as follows.
ON: Display a zebra pattern.
OFF: Do not display a zebra pattern.

m DISPLAY switch
ON: Display text information.

Viewfinder
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OFF: Do not display text information.

n MIRROR switch
The image display on the monitor screen becomes 
reversed horizontally or vertically when the 
viewfinder barrel is raised up or rotated.
L/R: Reverse the image horizontally.
OFF: Do not reverse the image.
B/T: Reverse the image vertically.

o Viewfinder cable

p Microphone holder

The viewfinder screen displays not only the video 
picture but also characters and messages 
indicating the camcorder settings and operating 
status, a center marker, a safety zone marker, etc.
When the menu screen is not displayed and the 
DISPLAY switch is set to ON, the items for 
which an ON setting was made with 
“OPERATION” > “Super Impose” in the setup 
menu or with related switches are displayed at the 
top and bottom of the screen.
Not only these indications are displayed on the 
viewfinder screen, but a menu setting enables 
them to be output as video signals.

Screen display item name suffixes
The symbols [M], [A], and [D] beside screen item 
names have the following meaning.
[M]: You can select to show/hide this item 

individually using “OPERATION” 
>“Display On/Off” in the setup menu 
(page 130).

[A]: You can select to show/hide this item 
individually using an assignable button 
assigned with the corresponding function 
(page 164).

[D]: You can change the setting using the Direct 
menu displayed on the screen (page 29).

Viewfinder Screen 
Display
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Top of viewfinder screen

a Extender indicator [M] 
Indicates the setting of the digital extender 
function (when optional CBK-CE01 is installed) 
of this camcorder and the setting of the lens 
extender.
EX: The lens extender is on.
08: The lens shrinker is on.
x2D: The digital extender function of this 

camcorder is on.
Ex2D: The lens extender and the digital extender 

function of this camcorder are both on.
Digital extender function can be turned on or off 
by an assignable switch to which Digital Extender 
is assigned.

b Zoom position (when the lens is 
mounted) [M] 

Indicates the zoom position of the zoom lens in 
the range from 0 to 99.

c Focus position (when the serial lens is 
mounted) [M] 

Indicates the focus position as distance to the 
subject (in units of m).

d Green tally indicator
Lights when the camcorder is the following 
states.
• “MAINTENANCE” > “Camera Config” > “HD 

SDI Remote I/F” is set to “G-Tally” in the setup 
menu and a recording control signal is output 
from the HD/SD SDI OUT connector.

• Green tally signal received (when a camera 
adaptor is mounted on the camcorder and a 
camera control unit is connected)

e Media status
Displays the name of the currently active media 
slot (A or B).

f Recording mode/operation status 
indicator

g Wireless receiver reception level
When a wireless receiver is installed in the 
camcorder, “W” appears together with the 
following four segment reception level indicators 
for each of the channels (1 to 4) that can be used 
by the receiver.
In normal situation: The number of white 

segments indicates the strength of the signal 
level.

Muting (for an analog receiver) or error rate 
aggravation (for a digital receiver): The 
number of gray segments indicates the 
strength of the signal level.

Reception level over peak: “P” is displayed 
instead of the indicators.1)

Tuner battery is low: The channel number and 
indicator of the corresponding channel 
flash.1)

1) When an optional DWR-S02D is used

Ext.

Indicator Meaning
zREC Recording in progress

STBY Standby for recording

zCACHE Standby in Picture Cache mode

zINT REC Recording in progress in 
Interval Rec mode

zINT STBY Standby for next recording in 
Interval Rec mode

INT STBY Standby in Interval Rec mode

zFRM REC Recording in progress in Frame 
Rec mode

zFRM STBY Standby for next recording in 
Frame Rec mode

FRM STBY Standby in Frame Rec mode

zS&Q REC Recording in progress in Slow 
& Quick Motion mode

S&Q STBY Standby in Slow & Quick 
Motion mode

zSML REC 2-slot recording in Simul Rec 
mode

SML STBY Standby for 2-slot recording in 
Simul Rec mode

zCALL Being called from a connected 
device

BREVIEW During recording review
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h Battery remaining/voltage display [M] 

i External power input
Appears when power is supplied from an external 
power source connected to the DC IN connector.

j Network client mode status indicator/
Streaming status indicator [M] 

Indicates the network client mode connection 
status indicator and streaming status when an 
optional CBK-WA101 Wireless Adapter is 
connected.

k ALAC (automatic lens aberration 
correction) status [M] 

Appears when “ALAC” (see page 151) of the 
MAINTENANCE menu is set to “AUTO,” and 
an ALAC compatible lens is attached to the 
camcorder.

l Color temperature [M] [D] 
Displays a color temperature calculated from the 
gain of R and B, in the range 1.5 K to 50.0 K (in 
steps of 0.1 K). The +/– signs may be displayed 
depending on the “Offset White” setting (see 
page 133).
No display: “Offset White” is “Off.”
+: The value of “Offset White” is greater than 

3200K.

–: The value of “Offset White” is less than 
3200K.

m Number of system lines [M] 
Indicates the number of system lines (1080/720/
576/480) of video currently being recorded or 
played back.

n Video format [M] 
Indicates the video format (see page 45).
The video aspect ratio (16:9 or 4:3) can also be 
displayed when the recording format is set to 
DVCAM.

o Depth of field indicator (when the serial 
lens is mounted) [M] [A] 
Error/warning indicator

A bar indicates the depth of field. The display unit 
is meters or feet, as selected on “OPERATION” 
> “Display On/Off” > “Lens Info” in the setup 
menu.
An error or warning message is displayed here 
depending on the situation.

Under this area, you can also display the name of 
the next clip to be recorded (see page 136).

p Special recording mode indicator [M] 
The following is displayed when the camcorder is 
in a special recording mode.
• Frame Rec (frame recording mode)
• Interval Rec (interval recording mode)
• S&Q Motion (Slow & Quick Motion mode)

q Special recording mode settings 
indicator [M] (in Slow & Quick Motion 
mode standby only [D])

Appears when the camcorder is in a special 
recording mode.

Type of power 
source

Indicator

InfoLithium 
battery

Remaining battery capacity 
icon and remaining recording 
time

Anton Bauer 
battery

Remaining battery capacity (% 
indication)

Other type than 
above

Input voltage

Indicator Meaning
Network client mode connected 
status

Network client mode connection 
status (flashing)

Network client mode connection 
error status

Streaming distribution idle state

Streaming distribution state

Streaming distribution error state
26



Bottom of viewfinder screen

a TLCS iris control mode [M] [D] 
Indicates the currently selected TLCS control 
mode.
You can set the TLCS control mode using the 
Direct menu, when the Direct menu function is 
enabled.

For details about basic operation and settings of 
Direct menu, see “Changing settings using the 
Direct menu” (page 29).

b Focus adjustment mode (when the auto 
focus lens is mounted) [M] 

Indicates the current focus adjustment mode of 
the camcorder.
• AF (Auto Focus mode)
• MF (Manual Focus mode)
• MF* (Manual Focus mode when the MF Assist 

function is on)
• Full MF (Full Manual Focus mode)

c External device control
“Rec2” is displayed when “MAINTENANCE” > 
“Camera Config” > “HD SDI Remote I/F” is set 
to “Chara” in the setup menu and a recording 
control signal is output from the HD/SD SDI 
OUT connector.
“Rec2-P” is displayed when “MAINTENANCE” 
> “Camera Config” > “HD SDI Remote I/F” is set 

to “Para Rec” in the setup menu and synchronized 
recording is performed with a compatible device.

d Operation status of connected i.LINK 
device

e Video level indicator [M] 
Suitable ND filter indicator 
Clip uploading status indicator [M] 

An indication is displayed together with an 
appropriate ND filter position number when the 
light level of the subject is too high or too low. 
Indicates the status for clip uploading when an 
optional CBK-WA101 Wireless Adapter is 
connected.

f Timecode [M] 
Caution message [M] 

Indicates the elapsed recording/playback time, 
timecode, user bits data or other information 
selected by the DISPLAY switch (see page 16).
Also indicates a caution message when caution is 
required such as when you try to change settings.

g Brightness level [M] [A] 
Indicates the average brightness level (%) of the 
detection area.

h External input source
Indicates the type of external input signal (HDV) 
to be recorded.

i External input setting indicator
Indicates “EXT” when an external input is 
recorded.

j Media remaining space indicator for 
the CBK-WA101 Wireless Adapter (not 
supplied) [M] 

Icon TLCS control mode
Backlight mode

Standard mode

Spotlight mode

Ext.

STDSTD

Indicator Meaning
zREC HDV recording in progress

STBY Standby for HDV recording

zREC DV recording in progress

STBY Standby for DV recording
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k USB media icon indicator (see page 183) 
or status indicator of the CBK-WA101 
Wireless Adapter (not supplied) [M] 

l Electric color temperature filter
Appears when the CC 5600K function is set to on.

m Filter indicator [M] 
Indicates the currently selected ND filter position 
number (see page 12).
When Electrical CC is assigned to an assignable 
switch, the electrical filter position (A/B/C/D) 
appears to the right of the ND filter position (1 to 
4).

n White balance memory [M] 
Indicates the currently selected white balance 
automatic adjustment memory.
ATW: ATW (Auto Tracing White Balance) mode
W:A: Memory A mode
W:B: Memory B mode
W:P: Preset mode
3200: When the assignable switch to which Color 

Temp SW 3200K has been assigned is on
4300: When the assignable switch to which Color 

Temp SW 4300K has been assigned is on
5600: When the assignable switch to which Color 

Temp SW 5600K has been assigned is on
6300: When the assignable switch to which Color 

Temp SW 6300K has been assigned is on

o Gain value [M] 
Indicates the gain value (in dB) of the video 
amplifier, as set by the GAIN selector.

p Recording status indicator
When “OPERATION” > “Super Impose” > 
“Super (Rec Status Indicator)” is set to “On” in 
the setup menu, B marks are displayed as the 
recording proceeds.

q Shutter [M] [D] 
Indicates the shutter speed or the shutter mode.

For details, see “Setting the Electronic Shutter” 
(page 53).

r Audio level meters [M] 
Indicate the audio levels of channel 1 and channel 
2.

s Remaining media capacity [M] 
Indicates the recording time remaining for each of 
the media loaded in the slots. The available time 
for recording with the current video format 
(recording bit rate) is calculated according to the 
remaining space of each media and indicated in 
time units of minutes. A lock icon appears if the 
media is write-protected.

For details, see “Checking the Remaining Recording 
Time” (page 64).

t Histogram [M] [A] 
Shows a pixel distribution of video luminance 
(HD mode only).

u Flashband reduce status indicator [M] 
Appears when “Flashband Reduce” (see 
page 131) of the OPERATION menu is set to 
“On” and the flashband reduce function is 
activated.

v Iris position indicator (when the lens is 
mounted) [M] 

Indicates the iris position and the setting for iris 
override (reference value for the lens iris) (see 
page 55).
The iris override setting is indicated by four 
segments indicator as follows.

Indicator Meaning
Wi-Fi signal strength when 
operating in station mode (1 to 4)

3G/4G/LTE USB modem RF 
connection

Wired LAN connection

Reference 
value

Indicator

+0.25
x

Lower left segment is lit 
gray.

+0.5 x

x

Left two segments are lit 
gray.

+0.75 x

xx

Left two segments and lower 
right segment are lit gray.

+1 xx

xx

All segments are lit gray.

–0.25
s

Lower left segment is lit 
white.

–0.5 s

s

Left two segments are lit 
white.

–0.75 s

ss

Left two segments and lower 
right segment are lit white.
28



Changing settings using the Direct menu
The settings of items with a [D] suffix can be 
changed using the Direct menu displayed on the 
screen. The Direct menu is enabled by setting 
“MAINTENANCE” >“Direct Menu” to “On” in 
the setup menu (page 157).
The following items can be set using the Direct 
menu.

Notes

• If a target item that is configurable using the Direct 
menu but whose display in the viewfinder is turned off 
(by setting “OPERATION” >“Display On/Off” to 
“Off” in the setup menu), then the item cannot be 
controlled using the Direct menu.

• Depending on the item, the Direct menu is enabled 
under the following conditions.

Basic operation

1 Set “MAINTENANCE” > “Direct 
Menu” to “On” in the setup menu.

2 When the camcorder’s status or settings 
are displayed on the viewfinder screen, 
turn the MENU knob.

Note

Direct menu operations cannot be performed while 
the setup menu is displayed.

3 Turn the MENU knob left/right to move 
the cursor to the item that you want to 
set.

4 Press the MENU knob.
The selected item is displayed in the Direct 
menu.

5 Turn the MENU knob to select the 
setting.

6 Press the MENU knob again to apply 
the setting.

Note

Operation may vary depending on the target item 
selection.

–1 ss

ss

All segments are lit white.

Target item See
White balance COLOR TEMP 
setting

page 51

TLCS mode setting page 27

Shutter speed or number of 
accumulated frames setting for the 
electronic shutter

page 54

Slow & Quick Motion frame rate 
setting

page 94

Item Conditions
White balance 
COLOR TEMP 
setting

WHITE BAL (white balance 
memory) switch is set to 
position A or B. If the 
WHITE BAL switch is set to 
position B, “OPERATION” > 
“White Setting” > “White 
Switch<B>” must be set to 
“Memory” in the setup menu.

Reference 
value

Indicator
Shutter speed 
setting of the 
electronic shutter

• Common to all modes
SHUTTER switch is in the 
ON position.

• In Speed mode
“OPERATION” > “Shutter” 
> “Shutter Select” is set to 
“Second” in the setup menu.

• In Angle mode
“OPERATION” > “Shutter” 
> “Shutter Select” is set to 
“Degree” in the setup menu.

• In ECS mode
Shutter is set to ECS mode.

Accumulated 
frames setting of 
the electronic 
shutter

In Slow Shutter mode, 
“OPERATION” > “Shutter” 
> “Slow Shutter” must be set 
to “On” in the setup menu.

Slow & Quick 
Motion frame 
rate setting

“OPERATION” > “Rec 
Function” > “Slow & Quick” 
must be set to “On” in the 
setup menu.

Item Conditions
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For safety, use only the Sony battery packs and 
AC adaptors listed below.
• BP-L80S Lithium-ion Battery Pack
• AC power using the AC-DN2B/DN10 AC 

Adaptor

The life expectancy of the AC adaptor and the 
electrolytic capacitor is about 5 years under 
normal operating temperatures and normal usage 
(8 hours per day; 25 days per month). If usage 
exceeds the above normal usage frequency, the 
life expectancy may be reduced correspondingly.

Note

Turn off the camcorder and check that the monochrome 
display is not lit before removing the battery pack or AC 
Adaptor.

Press the battery pack against the back of the 
camcorder, aligning the line on the side of the 
battery pack with the line on the camcorder. Then 
slide the battery pack down until its “LOCK” 
arrow aligns with the line on the camcorder.
To detach the battery pack, pull the battery pack 
up by holding the release button in.

Note

The battery pack operating time depends on the 
frequency of use of the battery pack, and the ambient 
temperature when used.

Before use, charge the battery pack with a charger 
suitable for each battery.

For details on the battery charging procedure, refer 
to the battery charger operation manual.

Note on using the battery pack
A warm battery pack may not be able to be fully 
recharged.

Notes

• If the battery pack is not attached correctly, the 
terminal may be damaged.

• During recording and playback (while the ACCESS 
lamp on the right-side panel is lit in blue and the 
ACCESS lamp in the card slot section is lit in orange), 
be careful never to remove the battery pack.

Mount an AC-DN2B/DN10 on the camcorder in 
the same way as a battery pack, then connect to 
the AC power supply.
The AC-DN2B/DN10 can supply up to 100 W of 
power.

Chapter2 Preparations

Preparing a Power 
Supply

Using a Battery Pack

Using AC Power
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CAUTION

When the viewfinder is attached, do not leave the 
camcorder with the eyepiece facing the sun.
Direct sunlight can enter through the eyepiece, be 
focused in the viewfinder and cause fire.

Note

When attaching the viewfinder, take note of the 
following points.
• Be sure to power off the camcorder before coupling the 

viewfinder connector to the camcorder’s VF connector 
(26-pin). If you make this connection when the 
camcorder power is on, the viewfinder may not 
function properly.

• Couple the viewfinder connector firmly to the 
camcorder’s VF connector (26-pin). If the coupling is 
loose, noise may appear on the video or the tally 
indicator may not operate properly.

1 1 Loosen the viewfinder left-to-right 
positioning ring, 2 attach the 
viewfinder to the viewfinder fitting 
shoe, and 3 tighten the viewfinder left-
to-right positioning ring.

2 Couple the viewfinder connector to the 
VF connector (26-pin).

Detaching the viewfinder
You can detach the viewfinder by following the 
attaching procedure in reverse order. But there is 
an additional action to take: when detaching the 
viewfinder from the fitting shoe, pull up the 
stopper (see page 31).

To adjust the viewfinder left-to-right position, 
loosen the left-to-right positioning ring, and to 
adjust the front-to-back position, loosen the front-
to-back positioning knob.

Attaching the Viewfinder

Attaching the Supplied Viewfinder

Slide stopper

Left-to-right 
positioning 
ring

Adjusting the Viewfinder Position

VF connector (26-pin)

Upward

Viewfinder left-to-right positioning ring

Viewfinder front-to-back positioning knob
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You can adjust the angle of the viewfinder.

To reverse the display (image/text indication) 
vertically
The viewfinder can be rotated as much as 180 
degrees toward the direction facing the subject.
When you do this, the picture and other 
information displayed in the viewfinder appear 
upside down.
To restore the normal display, set the MIRROR 
switch on the rear panel of the viewfinder to B/T.

You can view the LCD screen inside the 
viewfinder or its mirrored image by lifting up the 
viewfinder barrel or the eyepiece.
This section describes how to lift up the 
viewfinder barrel and detach it. The eyepiece can 
also be lifted up and detached in the same way.

To raise up the viewfinder barrel
Push the clip on the bottom to release and flip up 
the viewfinder barrel.
It locks at the 120-degree position.

Normally use it in the locked position.
Although you can open it farther from the lock 
position, you must return it to the closed position 
to lock it at the 120-degree position again.

Adjusting the Viewfinder Angle

Lifting Up the Viewfinder Barrel 
and Eyepiece

LCD screen
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To detach the viewfinder barrel

1 Push the clip on the bottom to release.

2 Flip up the viewfinder barrel.

3 Slide the knob on the top to the opposite 
side of the viewfinder barrel.

4 Detach the viewfinder barrel by 
horizontally sliding it.

To reverse the display (image/text indication) 
horizontally
By setting the MIRROR switch on the rear panel 
of the viewfinder to L/R, you can reverse the 
picture and other information displayed in the 
viewfinder horizontally.

To adjust the viewfinder focus
Turn the diopter adjustment ring until the 
viewfinder image is sharpest.

You can also attach a commercially available 
protection filter, close-up lens, etc. that is 52 mm 
in diameter.

To adjust the viewfinder screen
Adjust the brightness, contrast, and peaking of the 
viewfinder screen with the controls shown below.
Outlines: Adjust using the PEAKING control.
Contrast: Adjust using the CONTRAST control.
Brightness: Adjust using the BRIGHT control.

Adjusting the Viewfinder Focus 
and Screen

Diopter adjustment ring

1PEAKING control
2CONTRAST control
3BRIGHT control
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By fitting an optional BKW-401 Viewfinder 
Rotation Bracket, you can rotate the viewfinder 
out of the way so that your right leg does not hit 
the viewfinder while you are carrying the 
camcorder.

1 Loosen the front-to-back viewfinder 
positioning levers and the front-to-back 
viewfinder positioning knobs, and then 
pull the viewfinder slide assembly 
forward.

2 Using a 2.5 mm diameter hexagonal 
wrench, detach the viewfinder slide 
assembly.

3 Attach the BKW-401 with the supplied 
bolts.

4 Adjust the front-to-back position so 
that the arm of the BKW-401 does not 
touch the handle when it is raised.

Using the BKW-401 Viewfinder 
Rotation Bracket

Bolts with 
hexagonal 
hole

Viewfinder slide assembly

Bolts supplied with the BKW-401

Adjust position so that arm 
does not touch handle
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You can attach an optional DXF-C50WA (5-inch) Electronic Viewfinder. To attach it, an Accessory Shoe 
Kit (service part number: A-8274-968-B) is required.

For details, contact a Sony sales or service representative.

Note

It is not possible to use the supplied viewfinder and a 5-inch viewfinder at the same time.

Remove the cover of the grip, and attach the shoe and stopper screw of the Accessory Shoe Kit.

Attaching a 5-inch Electronic Viewfinder

VF cable Guide plate

Fixing ring

Shoe a)

Stopper screw a)

a) Supplied with the Accessory Shoe Kit
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When the camcorder is used for the first 
time
You cannot use the camcorder without setting the 
area of use.

To set the area of use

1 Set the POWER switch to the ON 
position.
The screen for setting the area of use appears 
in the viewfinder.

2 Press the MENU knob.
The settings for selectable areas of use are 
displayed.

3 Turn the MENU knob to select the 
desired area of use.

a) The composite signal output from this 
camcorder is an NTSC signal with a black setup 
(7.5 IRE). The system frequency is 59.94i.

b) The composite signal output from this 
camcorder is an NTSC signal with no black 
setup. The system frequency is 59.94i.

c) The composite signal output from this 
camcorder is a PAL signal. The system 
frequency is 50i.

4 Set the following items.
• Time Zone
• Date/Time

For details, see “Basic Setup Menu 
Operations” (page 115).

5 Turn the MENU knob to select 
“Finish”, then press the MENU knob.
The camcorder is now ready for use.

You can set or change the date and time of the 
internal clock. The date and time set are reflected 
in the timecode.

For menu operations, see “Basic Setup Menu 
Operations” (page 115).

1 Select “MAINTENANCE” > “Clock 
Set” > “Date/Time” in the setup menu.

2 Press the MENU knob.
The Date/Time setting window appears.

3 Turn the MENU knob to display the 
desired value, and press the knob.
The selection shifts to the next item on the 
right.

4 To continue the remaining settings, 
repeat step 3.

5 Making sure that “SET” is selected, 
press the MENU knob.
The internal clock is set with the date and 
time set in steps 3 and 4.

To cancel the setting
Before executing step 5, push the MENU 
CANCEL/PRST/ESCAPE switch up to the 
CANCEL/PRST side.

Setting the Area of Use

Setting Area of use
NTSC Area NTSC area 

(for areas other than 
Japan) a)

NTSC(J) Area NTSC area 
(Japan) b)

PAL Area PAL area c)

Setting the Date/Time of 
the Internal Clock
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Note

Always power the camcorder off before mounting or 
removing a lens.

For information about using a lens other than the 
supplied lens, refer to the operation manual for the 
lens.

1 Push the lens locking lever up and 
remove the lens mount cap from the 
lens mount.

2 Align the center pin on the lens with the 
center slot in the lens mount, and insert 
the lens into the mount.

3 Holding the lens in place, push the lens 
locking lever down to lock the lens.

Caution

If the lens is not firmly locked, it may come 
off while the camcorder is being used. This 
could cause a serious accident. Make sure the 
lens is firmly locked. It is recommended that 
the lens mount securing rubber be put on the 
lens locking lever as illustrated in the 
following diagram.

If you have attached an aberration correction 
lens
The aberration correction function is activated 
automatically. Starting the camcorder with an 
aberration correction lens may require more time 
than normally because of data loading at start-up.
The lens supplied with the camcorder is an 
aberration correction lens. Contact a Sony service 
representative for information about other 
aberration correction lenses.

If the lens does not stay in focus properly as you 
zoom from telephoto to wide angle, adjust the 
flange focal length (the distance from the plane of 
the lens mounting flange to the imaging plane).
Make this adjustment just one time after 
mounting or changing the lens.
When carrying out the adjustment, use the 
supplied flange focal length adjustment chart as 
the subject.

Mounting and Adjusting 
the Supplied Lens

Adjusting the Flange Focal Length

Lens mount 
securing rubber

About 3 m (10 ft)
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Notes

• If you use a subject with insufficient contrast, or move 
the camcorder or subject during adjustment, this will 
cause an adjustment error.

• Place the subject (the flange focal length adjustment 
chart) so that it appears at the center of the screen at the 
telephoto end. Arrange so that no nearby object (no 
object closer to the camera than the chart) enters the 
screen at the wide-angle end.

Carrying out the adjustment

When using the auto focus lens
With the lens supplied with the camcorder, zoom 
and focus operations automatically adjust the 
flange focal length.

1 Open the iris, position the supplied 
flange focal length adjustment chart 
approximately 3 meters (10 ft) away 
from the camcorder, and arrange the 
lighting to obtain a satisfactory video 
output.

2 Set the ZOOM switch to SERVO 
(power zoom mode).

3 Hold down the flange focal length 
adjustment button for 3 seconds.
The flange focal length adjustment starts.

During adjustment
The message “AUTO FB Adjust 
EXECUTING” appears on the viewfinder 
screen.

If the adjustment completes correctly
The message on the viewfinder screen 
changes to “Auto FB Adjust: OK.” 

If the flange focal length adjustment does 
not complete correctly
Check the subject and lighting conditions, and 
repeat the adjustment.

When using a non-auto focus lens

1 Set the iris to manual.

2 Open the iris, position the supplied 
flange focal length adjustment chart 
approximately 3 meters (10 ft) away 
from the camcorder, and arrange the 
lighting to obtain a satisfactory video 
output.

3 Loosen the fixing screws on the F.f or 
F.B ring (flange focal length adjustment 
ring).

4 Use manual or power zoom to set the 
lens to telephoto.

5 Point the camcorder at the chart by 
turning the focus ring and focus on it.

6 Set the zoom ring to wide angle.

7 Turn the F.f or F.B ring until the chart 
is in focus, being careful not to disturb 
the focus ring.

8 Repeat steps 4 to 7 until the chart stays 
in focus all the way from wide angle to 
telephoto.

9 Tighten the F.f or F.B ring fixing 
screws.
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Attach the supplied microphone to the 
microphone holder of the supplied viewfinder.

1 Loosen the screw and open the 
microphone holder clamp.

2 Place the microphone in the 
microphone holder.

1 Place the microphone in the holder so 
that “UP” is at the top.

2 Close the microphone holder.
3 Tighten the screw.

On how to perform this operation, refer to the 
operation manual for the microphone.

3 Plug the microphone cable into the MIC 
IN connector, then set the AUDIO IN 
switch for the channel on which you 
want to record the audio from this 
microphone to FRONT.

4 Secure the microphone cable with the 
cable clamp.

Preparing the Audio 
Input System

Connecting a Microphone to the 
MIC IN Connector

Microphone holder clamp
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You can connect up to two monaural 
microphones to the AUDIO IN CH-1/CH-2 
connectors, using an optional CAC-12 
Microphone Holder.
The following is the procedure for attaching an 
electret condenser microphone such as the 
ECM-674/678.

On how to attach the CAC-12, refer to the operation 
manual for the CAC-12.

1 Attach the electret condenser 
microphone.

1 Loosen the ball joint lock lever.
2 Place the microphone in the holder so 

that “UP” is at the top.
3 Close the microphone holder.
4 Tighten the screw.
5 Position so that the microphone does 

not interfere with the viewfinder and 
tighten the ball joint lock lever.

2 Connect the microphone cable to the 
AUDIO IN CH-1 or CH-2 connector.

3 Set the switches as follows.
• Set the AUDIO IN selectors indicated 

below, depending on the power supply type 
of the microphone.
Internal power supply: MIC
External power supply: +48V

• Set the AUDIO IN CH1/CH2 switch for the 
channel to which the microphone is 
connected to REAR.

4 Switch the input level to match the 
sensitivity of the microphone used.

Switch the input level by changing the setting of 
“MAINTENANCE” > “Audio” > “Rear MIC 
CH1/CH2 Ref” in the setup menu (factory 
default setting is “–60 dB”). For details, see 
page 146.

Notes

• If the input level on the camcorder is not at an 
appropriate setting for the microphone sensitivity, loud 
sounds may be distorted, and the signal-to-noise ratio 
may be affected.

• In order for the AUDIO IN CH-1 and CH-2 connectors 
on the camcorder to be able to provide a phantom 48 V 
power supply, female XLR connectors (3-pin) are 
fitted. If the microphone cable has a female connector, 
use an adaptor.

• When you detach a CAC-12 Microphone Holder, be 
sure to put the two screws back into their original 
places.

Connecting Microphones to the 
AUDIO IN Connectors

Microphone

1AUDIO IN selector switches
2Monaural microphone
3AUDIO IN CH1/CH2 switches
4To AUDIO IN CH-1 or CH-2 connector
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To use a Sony UHF wireless microphone system, 
power the camcorder off and then fit one of the 
following UHF portable tuners.
• DWR-S02D Digital Wireless Receiver
• WRR-855S UHF Synthesized Tuner Unit
• WRR-860C/861/862 UHF Synthesized 

Diversity Tuner

For details of these units, refer to the operation 
manuals for them.

Note

The optional WRR Mount Bracket (service part number: 
A-1999-908-B) is required to fit the WRR-862.
For details, contact a Sony sales or service 
representative.

To fit the DWR-S02D or WRR-855S

1 Remove the four fixing screws holding 
the cover of the portable tuner/receiver 
housing slot located in the rear of the 
camcorder, to remove the cover.

2 Insert the DWR-S02D or WRR-855S 
into the housing slot, and fasten the four 
fixing screws.

3 Set the AUDIO IN selector for the 
channel to which you want to input 
audio signal to WIRELESS (see 
page 17).

Attaching a UHF Portable Tuner 
(for a UHF Wireless Microphone 
System) DWR-S02D or WRR-855S
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1 Attach the optional VCT-14/U14 
Tripod Adaptor to the tripod.

2 Mount the camcorder on the tripod 
adaptor.

3 Make sure that the camcorder is 
securely attached by moving it back and 
forth.

To remove the camcorder from the tripod 
adaptor
Hold down the red button and pull the lever in the 
direction of the arrow.

Note

The tripod adaptor pin may remain in the engaged 
position even after the camcorder is removed. If this 
happens, press the red button and move the lever as 
shown above until the pin returns to the stowed position. 
If the pin remains in the engaged position, you will not 
be able to mount the camcorder on the tripod adaptor.

Tripod Mounting

Slide the camcorder forward along the 
groove in the adaptor until it clicks.

Lever

Red button
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With this camcorder, you can use the Anton 
Bauer Ultralight 2 or equivalent video light 
(powered by 12 V with maximum power 
consumption of 50 W).
• If you connect the video light to the LIGHT 

connector on the camcorder and set the LIGHT 
switch to AUTO, you can turn the light on and 
off automatically as you start and stop recording 
on this camcorder.

• The output of the LIGHT connector on the 
camcorder is controlled to 12 V even when the 
camcorder is supplied with over 12 V power 
(through the DC IN connector or battery pack). 
The brightness or color temperature of the light 
will not change according to voltage increase.

Notes

• Do not use a video light with power consumption of 
over 50 W.

• The brightness or color temperature of the light will 
change when the voltage (supplied through the DC IN 
connector or from the battery pack) is under 12 V.

To attach the video light
Fit the video light to the accessory fitting shoe on 
the camcorder grip, and connect the video light 
cable to the LIGHT connector.

Note

The accessory fitting shoe on the camcorder is of the 1/4-
inch tapped hole type. If you want to replace this with a 
slide-type shoe, use the supplied cold shoe kit.

To attach the shoulder strap

1 Fit one of the clips to a shoulder strap 
fitting.

2 Fit the other clip to the shoulder strap 
fitting on the other side of the grip in the 
same way as in step 1.

To remove the shoulder strap

Connecting a Video 
Light

Using the Shoulder 
Strap

Pull up the strap to lock the fitting.

Clip

Press here and pull in the direction 
shown by the arrow to release.
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You can slide the shoulder pad back and forth 
within a 40 mm range. This adjustment helps you 
get the best balance for shooting with the 
camcorder on your shoulder.

1 Raise the lever in the center of the 
shoulder pad to unlock the shoulder 
pad.

2 Slide the shoulder pad backward or 
forward until it is in the most 
convenient position.

3 Bring down the lever to lock the 
shoulder pad in the selected position.

Adjusting the Shoulder 
Pad Position

Shoulder pad
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For menu operations, see “Basic Setup Menu Operations” (page 115).

The following recording formats can be selected for different combinations of video resolution and system 
frequency.

In UDF mode 

Chapter3 Adjustments and Settings

Setting the Video Format

Setting items of “OPERATION” > “Format” Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec 
Format

System Frequency a)

HD 1080 HD422 50 59.94i HD422 50 1920/59.94i 1920×1080

50i HD422 50 1920/50i

29.97P HD422 50 1920/29.97P

25P HD422 50 1920/25P

23.98P HD422 50 1920/23.98P

HD420 
HQ1920

59.94i HD420 HQ 1920/59.94i 1920×1080

50i HD420 HQ 1920/50i

29.97P HD420 HQ 1920/29.97P

25P HD420 HQ 1920/25P

23.98P HD420 HQ 1920/23.98P

HD420 
HQ1440

59.94i HD420 HQ 1440/59.94i 1440×1080

50i HD420 HQ 1440/50i

29.97P HD420 HQ 1440/29.97P

25P HD420 HQ 1440/25P

23.98P HD420 HQ 1440/23.98P

720 HD422 50 59.94P HD422 50 1280/59.94P 1280×720

50P HD422 50 1280/50P

29.97P HD422 50 1280/29.97P

25P HD422 50 1280/25P

23.98P HD422 50 1280/23.98P

HD420 
HQ1280

59.94P HD420 HQ 1280/59.94P 1280×720

50P HD420 HQ 1280/50P

23.98P HD420 HQ 1280/23.98P b)
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a) 59.94i/29.97P/59.94P/23.98P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “NTSC 
Area” or “NTSC(J) Area”
50i/25P/50P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “PAL Area”

b) Converted to 59.94P by 2-3 pulldown processing and recorded

In exFAT mode

SD – IMX50 59.94i IMX50/59.94i 720×486 

50i IMX50/50i 720×576

29.97P IMX50/29.97PsF 720×486

25P IMX50/25PsF 720×576

DVCAM 59.94i DVCAM/59.94i 720×480 

50i DVCAM/50i 720×576

29.97P DVCAM/29.97PsF 720×480

25P DVCAM/25PsF 720×576

Setting items of “OPERATION” > “Format” Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec 
Format

System Frequency a)

HD 1080 XAVC-I 59.94i XAVC-I 1920/59.94i 1920×1080

50i XAVC-I 1920/50i

29.97P XAVC-I 1920/29.97P

25P XAVC-I 1920/25P

23.98P XAVC-I 1920/23.98P

XAVC-L50 59.94i XAVC-L50 1920/59.94i 1920×1080

50i XAVC-L50 1920/50i

29.97P XAVC-L50 1920/29.97P

25P XAVC-L50 1920/25P

23.98P XAVC-L50 1920/23.98P

XVAC-L35 59.94i XAVC-L35 1920/59.94i 1920×1080

50i XAVC-L35 1920/50i

29.97P XAVC-L35 1920/29.97P

25P XAVC-L35 1920/25P

23.98P XAVC-L35 1920/23.98P

XAVC-L25 59.94i XAVC-L25 1920/59.94i 1920×1080

50i XAVC-L25 1920/50i

HD422 50 59.94i HD422 50 1920/59.94i 1920×1080

50i HD422 50 1920/50i

29.97P HD422 50 1920/29.97P

25P HD422 50 1920/25P

23.98P HD422 50 1920/23.98P

Setting items of “OPERATION” > “Format” Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec 
Format

System Frequency a)
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a) 59.94i/29.97P/59.94P/23.98P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “NTSC 
Area” or “NTSC(J) Area”
50i/25P/50P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “PAL Area”

b) Converted to 59.94P by 2-3 pulldown processing and recorded

HD 1080 HD420 
HQ1920

59.94i HD420 HQ 1920/59.94i 1920×1080

50i HD420 HQ 1920/50i

29.97P HD420 HQ 1920/29.97P

25P HD420 HQ 1920/25P

23.98P HD420 HQ 1920/23.98P

HD420 
HQ1440

59.94i HD420 HQ 1440/59.94i 1440×1080

50i HD420 HQ 1440/50i

29.97P HD420 HQ 1440/29.97P

25P HD420 HQ 1440/25P

23.98P HD420 HQ 1440/23.98P

720 XAVC-I 59.94P XAVC-I 1280/59.94P 1280×720

50P XAVC-I 1280/50P

XAVC-L50 59.94P XAVC-L50 1280/59.94P 1280×720

50P XAVC-L50 1280/50P

HD422 50 59.94P HD422 50 1280/59.94P 1280×720

50P HD422 50 1280/50P

29.97P HD422 50 1280/29.97P

25P HD422 50 1280/25P

23.98P HD422 50 1280/23.98P

HD420 
HQ1280

59.94P HD420 HQ 1280/59.94P 1280×720

50P HD420 HQ 1280/50P

23.98P HD420 HQ 1280/23.98P b)

SD — IMX50 59.94i IMX50/59.94i 720×486 

50i IMX50/50i 720×576

29.97P IMX50/29.97PsF 720×486

25P IMX50/25PsF 720×576

DVCAM 59.94i DVCAM/59.94i 720×480 

50i DVCAM/50i 720×576

29.97P DVCAM/29.97PsF 720×480

25P DVCAM/25PsF 720×576

Setting items of “OPERATION” > “Format” Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec 
Format

System Frequency a)
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In FAT mode

a) 59.94i/29.97P/59.94P/23.98P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “NTSC 
Area” or “NTSC(J) Area”
50i/25P/50P: When “OPERATION” > “Format” > “Country” in the setup menu is set to “PAL Area”

b) Converted to 59.94i by 2-3 pulldown processing and recorded

Select the recording mode between UDF, exFAT, 
and FAT.

1 Select “OPERATION” > “Format” > 
“File System” in the setup menu (see 
page 121).

2 Turn the MENU knob to select “UDF,” 
“exFAT,” or “FAT,” and press the 
knob.

3 A confirmation message appears.

4 Select “Execute” to execute, or select 
“Cancel” to cancel, and then press the 
MENU knob.

5 Power the camcorder off and on again.

1 Select “OPERATION” > “Format” in 
the setup menu (see page 121).

2 Turn the MENU knob to select the item 
to change, and press the knob.

3 Turn the MENU knob to change the 
setting, and press the knob.
A confirmation message appears.

4 Select “Execute” to execute, or select 
“Cancel” to cancel, and then press the 
MENU knob.

Setting items of “OPERATION” > “Format” Video format (recording 
format/system frequency)

Frame size
HD/SD HD System 

Line
Rec 
Format

System Frequency a)

HD 1080 HQ 1920 59.94i HQ 1920/59.94i 1920×1080

50i HQ 1920/50i

29.97P HQ 1920/29.97P

25P HQ 1920/25P

23.98P HQ 1920/23.98P

HQ 1440 59.94i HQ 1440/59.94i 1440×1080

50i HQ 1440/50i

29.97P HQ 1440/29.97P

25P HQ 1440/25P

23.98P HQ 1440/23.98P

SP 1440 59.94i SP 1440/59.94i 1440×1080

50i SP 1440/50i

23.98P SP 1440/23.98P b)

720 HQ 1280 59.94P HQ 1280/59.94P 1280×720

50P HQ 1280/50P

29.97P HQ 1280/29.97P

25P HQ 1280/25P

23.98P HQ 1280/23.98P

SD — DVCAM
(fixed)

59.94i DVCAM/59.94i 720×480

50i DVCAM/50i 720×576

29.97P DVCAM/29.97PsF 720×480

25P DVCAM/25PsF 720×576

Selecting the Recording Mode

Changing the Video Format
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5 When the setting of HD/SD or Country 
was changed, power the camcorder off 
and on again.

Black balance and white balance adjustment 
values that are automatically set by the camcorder 
and the various settings are stored in the 
camcorder memory and retained even when the 
power is turned off.

Black balance adjustment
The black balance will require adjustment in the 
following cases.
• When the camcorder is used for the first time
• When the camcorder has not been used for a 

long time
• When the camcorder is used under conditions in 

which the surrounding temperature has changed 
greatly

• When the GAIN selector (L/M/H/Turbo) values 
have been changed with “OPERATION” > 
“Gain Switch” in the setup menu.

White balance adjustment
Always readjust the white balance when the 
lighting conditions change.

In automatic black balance mode, adjustments are 
performed in the following order: black set and 
black balance. Manual black balance adjustment 
can be selected from the setup menu.

Note

Automatic black balance adjustment is disabled in the 
following cases.
• During recording
• In a special recording modes (Picture Cache 

Rec, Interval Rec, Frame Rec, Slow & Quick)
• When the shutter mode is SLS

1 Set the OUTPUT/DCC switch to CAM.

2 Push the AUTO W/B BAL switch to 
BLACK and release the switch.

Adjusting the Black 
Balance and the White 
Balance

Adjusting the Black Balance
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The message “Executing…” appears during 
execution, and changes to “Done” when the 
adjustment finishes.
Adjustment values are saved to memory 
automatically.

Notes

• During the black balance adjustment, the iris is 
automatically closed.

• During the black balance adjustment, the gain 
selection circuit is automatically activated so you may 
see flickering on the viewfinder screen, but this is not 
a fault.

• Output from the i.LINK connector stops temporarily if 
you execute black balance adjustment during i.LINK 
output. Output from the connector resumes when black 
balance adjustment finishes.

If automatic black balance adjustment 
cannot be made

If any of the above error messages is displayed, 
retry the black balance adjustment.
If the error message occurs again, an internal 
check is necessary.

For information about this internal check, contact your 
vendor or a Sony service representative.

Note

If the lens cable is not firmly connected to the LENS 
connector, it may not be possible to adjust the lens iris. If 
this happens, the black balance will be incorrect.

1 Set the switches and selectors as shown 
below.
• GAIN switch: L (set to a gain value that is 

as small as possible)
• OUTPUT/DCC switch: CAM
• WHITE BAL switch: A or B 1)

1) Adjustment values are saved to memory B only 
when “OPERATION” > “White Setting” > 
“White Switch<B>” in the setup menu is set to 
“Memory.”

2 Set the FILTER selector to suit the 
lighting conditions as follows.

3 Place a white test card under the same 
lighting conditions as for the subject to 
be shot and zoom up to it.
Alternatively, any white object such as a 
cloth or a wall can be used.
The absolute minimum white area is as 
follows.

Note

Make sure there are not bright spots in the 
rectangle.

4 Adjust the lens iris.
Manually adjusted lens: set the iris to an 

appropriate setting.
Lens with automatic iris: set the automatic/

manual switch on the lens to automatic.

5 Push the AUTO W/B BAL switch to 
WHITE and then release the switch.
The message “Executing…” appears during 
execution, and changes to “Done” when the 
adjustment finishes.
The adjustment values are saved 
automatically in the memory selected in 
step 1 (A or B).

Note

If the camcorder has a zoom lens with an automatic 
iris, the iris may hunt 1) during the adjustment. To 
prevent this, adjust the iris gain knob (indicated as 
IG, IS, or S) on the lens.

For details, refer to the lens operation manual.
1) Hunting: Repeated brightening and darkening of 

the image, resulting from repeated response to 
automatic iris control.

Error message Meaning
NG: Iris Not Closed The lens iris did not close; 

adjustment was impossible.

NG: Timeout Adjustment could not be 
completed within the 
standard number of 
attempts.

NG: Out of Range The difference between the 
reference value and the 
current value is so great that 
it exceeds the range, making 
adjustment impossible.

Adjusting the White Balance

Rectangle centered on the screen.
The lengths of the sides are 70% of the 
length and width of the screen.
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If the automatic white balance adjustment 
cannot be made

If any of the above error messages is displayed, 
retry the white balance adjustment. If the error 
message occurs again, an internal check is 
necessary.

For information about this internal check, contact 
your vendor or a Sony service representative.

If you have no time to adjust the white 
balance
Set the WHITE BAL switch to PRST.
This makes it possible to automatically set the 
white balance to 5600K (factory default value) by 
pressing the COLOR TEMP. button.
The color temperature to which the white balance 
is set when the COLOR TEMP. button is pressed 
can be selected from among 3200K, 4300K, 
5600K, and 6300K on OPERATION > 
Assignable SW in the setup menu. You can also 
assign color temperatures to the ASSIGN. 1/3 
switches or ASSIGNABLE 4/5 switches.

To set the white balance using the Direct 
menu
You can set the white balance using the Direct 
menu, when the Direct menu function is enabled.

For details about basic operation and settings of 
Direct menu, see “Changing settings using the 
Direct menu” (page 29).

Note

If the white balance display in the viewfinder is turned 
off (by setting “OPERATION” >“Display On/Off” > 
“Color Temp” to “Off” in the setup menu), then it cannot 
be controlled using the Direct menu.

1 Set “MAINTENANCE” > “Direct 
Menu” to “On” in the setup menu.

2 Check the position of the WHITE BAL 
switch (A or B).

Note

If the WHITE BAL switch is set to position B, 
“OPERATION” >“White Setting” >“White 
Switch<B>” must be set to “Memory” in the setup 
menu.

3 When the camcorder’s status or settings 
are displayed on the viewfinder screen, 
turn the MENU knob.

4 Turn the MENU knob to select the color 
temperature setting (page 26) in the 
viewfinder screen.

5 Press the MENU knob.
The setting can now be changed.

6 Turn the MENU knob to select the 
desired color temperature.

7 Press the MENU knob again to apply 
the setting.

To change the color temperature when 
the ND filter is switched
You can assign electrical CC (color correction) 
filters to ND filters (see page 12). This allows you 
to change the color temperature automatically 
when the ND filter is switched.

1 Set “MAINTENANCE” > “White 
Filter” > “ND Filter C.Temp” in the 
setup menu (see page 153) to “On.”

2 To assign an electrical CC filter to 
FILTER selector position number 1, 
select “ND FLT C.Temp<1>.” To assign 
it to positions 2 to 4, select “ND FLT 
C.Temp<2-4>.”

3 Turn the MENU knob to select the 
desired color temperature.
As you turn the MENU knob, the color 
temperature changes as follows: 3200K y 
4300K y 5600K y 6300K.

4 Repeat steps 2 and 3 as required.

Error message Meaning
NG: Low Light The white video level is too 

low. Either open the lens iris 
or increase the gain.

NG: Timeout Adjustment could not be 
completed within the 
standard number of 
attempts.

NG: High Light The white video level is too 
high. Either stop down the 
lens iris or change the ND 
filter.
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To switch between electrical CC filters 
with an assignable switch
You can assign the function that switches 
between electrical CC filters to an assignable 
switch. This allows you to switch between color 
temperatures (3200K/4300K/5600K/6300K) that 
have been assigned to up to four positions (A to 
D) with each press of the assignable switch.
Regardless of assignments to assignable 
switches, you can also switch between the color 
temperatures assigned to each position from a 
RM-B170/B750 Remote Control Unit.

1 Select “MAINTENANCE” > “White 
Filter” in the setup menu (see page 153).

2 Select the position to which to assign a 
CC filter by selecting one of “Electrical 
CC<A>” to “Electrical CC <D>,” and 
then turn the MENU knob to select the 
desired color temperature.
As you turn the MENU knob, the color 
temperature changes as follows: 3200K y 
4300K y 5600K y 6300K.

To set no color temperature
Select “-----” with “Electrical CC<C>” or 
“Electrical CC<D>” selected.
When the assignable switch is pressed, the 
setting for that position is not displayed. For 
example, if “-----” is set for one position, then 
switching between the remaining three 
positions is carried out.

3 Repeat step 2 as required.

4 Assign the electrical CC filter switching 
function (ELECTRICAL CC) to an 
assignable switch (see page 164).

White balance memory
Values stored in memory are held until the white 
balance is next adjusted even when the camcorder 
power is turned off.
The camcorder has two white balance memories, 
A and B. You can automatically save adjustment 
values for each ND filter in the memory that 
corresponds to the WHITE BAL switch setting 
(A or B). The camcorder has four built-in ND 
filters, allowing you to save a total of eight 
adjustment values (4 × 2). However, the contents 

of the memories are not linked to ND filter 
settings in the following cases.
• When the number of memories allocated to 

each of A and B is limited to one by setting 
“OPERATION” > “White Setting” > “Filter 
White Memory” in the setup menu to “Off.”

• When the electrical CC filter switching function 
has been assigned to an assignable switch, or 
when a remote control unit has been connected. 
(In these cases, the contents of white balance 
memory are linked to electrical CC filter 
positions (A to D).)

Also, when “OPERATION” > “White Setting” > 
“White Switch<B>” in the setup menu is set to 
“ATW (Auto Tracing White Balance),” and the 
WHITE BAL switch is set to B, the ATW 
function is activated to automatically adjust the 
white balance of the picture being shot for 
varying lighting conditions.

Note

While the ATW function is activated, the color 
temperature of the subject may differ from the color 
temperature that is displayed on the viewfinder screen.
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Standard mode
Select this mode for shooting fast-moving 
subjects with little blurring.
You can set the shutter speed in one of two shutter 
modes: Speed mode, in which the speed is set in 
seconds, and Angle mode, in which the speed is 
set in degrees.

Speed mode

a) This speed cannot be selected when the camcorder is 
in Slow & Quick Motion mode and “OPERATION” 
> “Rec Function” > “Frame Rate” in the setup menu 
is set to a value that is greater than the system 
frequency.

Angle mode
180°, 90°, 45°, 22.5°, 11.25°

ECS (Extended Clear Scan) mode
Select this mode for obtaining images with no 
horizontal bands of noise when shooting subjects 
such as monitor screens.
As shown in the following tables, the range of 
shutter speeds that can be set varies depending on 
whether the Slow & Quick Motion (S&Q) 
function is on or off.

System lines: 1080

System lines: 720

SLS (slow speed shutter) mode
Select this mode for shooting subjects in low level 
lighting conditions.

Notes

• SLS mode cannot be used when the video format is SP 
1440/23.98P or when the camcorder is in Slow & 
Quick Motion mode.

• It is not possible to output the color bar signal, turn the 
SLS mode on or off, or change the number of 
accumulated frames when the number of accumulated 
frames is set to 16, 32 or 64.

Notes

• When the automatic iris is used, the iris opens wider as 
the shutter speed increases, thus reducing the depth of 
field.

• The selectable shutter speeds vary depending on the 
current system frequency.

To switch between Speed mode and 
Angle mode

1 Select “OPERATION” > “Shutter” > 
“Shutter Select” in the setup menu (see 
page 133).

Setting the Electronic 
Shutter

Shutter Modes

System 
frequency

Shutter speed (unit: seconds)

59.94i
59.94P
50i
50P

1/60, 1/100, 1/120, 1/125, 1/250, 
1/500, 1/1000, 1/2000

29.97P 1/40
 a), 1/50

 a), 1/60, 1/100, 1/120,
1/125, 1/250, 1/500, 1/1000, 1/2000

25P 1/33
 a), 1/50

 a), 1/60, 1/100, 1/120, 
1/125, 1/250, 1/500, 1/1000, 1/2000

23.98P 1/32
 a), 1/48

 a), 1/50
 a), 1/60, 1/96, 

1/100, 1/120, 1/125, 1/250, 1/500, 
1/1000, 1/2000

System 
frequency

Shutter speed (unit: Hz)
S&Q: Off S&Q: On

59.94i 60.00 to 3800 —

50i 50.00 to 3500 —

29.97P 29.99 to 4100 32.01 to 4100

23.98P 23.99 to 3700 32.02 to 3700

25P 25.00 to 3900 32.03 to 3900

System 
frequency

Shutter speed (unit: Hz)
S&Q: Off S&Q: On

59.94P 60.07 to 4100 32.01 to 4100

50P 50.03 to 3900 32.03 to 3900

29.97P 29.99 to 4100 32.01 to 4100

23.98P 23.99 to 3700 32.02 to 3700

25P 25.00 to 3900 32.03 to 3900

Number of accumulated frames
2, 3, 4, 5, 6, 7, 8, 16, 32, 64

Selecting the Shutter Mode and 
Shutter Speed
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2 Turn the MENU knob to select 
“Second” or “Degree,” and then press 
the knob.

To set the shutter mode and standard-
mode shutter speed
Once the shutter speed is selected, it is retained 
even when the camcorder power is turned off.

1 Push the SHUTTER selector from ON 
to SELECT.
The current shutter setting indication appears 
for about three seconds.

2 Before the shutter setting indication 
disappears in step 1, push the 
SHUTTER selector down to SELECT 
again. Repeat this until the desired 
mode or speed appears.
When all modes and speeds are displayed, 
the display changes in the following order.

Note

Depending on the frame rate setting (see page 125), 
some shutter speeds cannot be selected in Slow & Quick 
Motion mode. These speeds are replaced by the slowest 
selectable shutter speed.

Example: If you perform Slow & Quick Motion 
shooting when setting the frame rate to 60 and the video 
format to HQ1280/29.97P:
The shutter speed is indicated as follows.
When Slow & Quick Motion mode is off
1/40t1/50t1/60t1/100t…

When Slow & Quick Motion mode is on
1/60t1/60t1/60t1/100t…

To set the shutter speed in ECS mode

1 Set the shutter mode to ECS (see the 
previous item).

2 Turn the MENU knob to select the 
desired frequency or number of frames.

To set the shutter speed in SLS mode

1 Set “OPERATION” > “Shutter” > 
“Slow Shutter” in the setup menu to 
“On” (see page 133).

2 Select the desired number of 
accumulated frames with 
“OPERATION” > “Shutter” > “SLS 
Frames” in the setup menu.

To set the shutter speed using the Direct 
menu
You can set the shutter speed using the Direct 
menu, when the Direct menu is enabled.

For details about basic operation and settings of 
Direct menu, see “Changing settings using the 
Direct menu” (page 29).

Note

If the electronic shutter display in the viewfinder is 
turned off (by setting “OPERATION” >“Display On/
Off” > “Shutter Setting” to “Off” in the setup menu), 
then it cannot be controlled using the Direct menu.

In Speed mode, Angle mode, ECS mode

Note

In Speed mode or Angle mode, “OPERATION” > 
“Shutter” > “Shutter Select” must be set to “Second” or 
“Degree,” respectively, in the setup menu.

1 Set “MAINTENANCE” > “Direct 
Menu” to “On” in the setup menu.

2 Check that the SHUTTER switch is in 
the ON position.

3 When the camcorder’s status or settings 
are displayed on the viewfinder screen, 
turn the MENU knob.

4 Turn the MENU knob to select the 
shutter display (page 28) in the 
viewfinder screen.

5 Press the MENU knob.
In Speed mode and Angle mode, the shutter 
speed is displayed in the menu.

6 Turn the MENU knob to select the 
desired shutter speed.

7 Press the MENU knob again to apply 
the setting.

In slow shutter mode (SLS mode)

1 Set “MAINTENANCE” > “Direct 
Menu” to “On” in the setup menu.
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2 Set “OPERATION” > “Shutter” > 
“Slow Shutter” to “On” in the setup 
menu.

3 When the camcorder’s status or settings 
are displayed on the viewfinder screen, 
turn the MENU knob.

4 Turn the MENU knob to select the 
shutter display (page 28) in the 
viewfinder screen.

5 Press the MENU knob.
The number of accumulated frames in slow 
shutter (SLS) mode is displayed.

6 Turn the MENU knob to select the 
number of accumulated frames.

7 Press the MENU knob again to apply 
the setting.

The reference value for automatic iris adjustment 
can be changed to aid the shooting of clear 
pictures of back-lit subjects, or to prevent blown-
out highlights. The reference value for the lens 
iris can be set within the following range with 
respect to the standard value.
• 0.25 to 1 (increments of 0.25): About 0.25 to 1 

stop further open
• –0.25 to –1 (increments of 0.25): About 0.25 to 

1 stop further close
Also you can set the area where light detection 
occurs.

To change the reference value

1 Set “OPERATION” > “Auto Iris” > 
“Iris Override” in the setup menu to 
“On” (see page 131).

2 Set the MENU ON/OFF switch to OFF.

3 Turn the MENU knob to change the 
reference value.

Note

Be sure to confirm that the current shutter mode is 
not ECS.

An indicator of the current reference value is 
shown at the iris position indication (see 
page 28) on the viewfinder screen.

To make the iris more open
Turn the MENU knob counterclockwise as 
seen from the front of the camcorder.
Select one of 0.25, 0.5, 0.75, or 1.

To stop down the iris
Turn the MENU knob clockwise as seen 
from the front of the camcorder.
Select one of –0.25, –0.5, –0.75, or –1.

The changed reference value is retained until 
the power of the camcorder is turned off. 
Even if the reference value is changed, it 
reverts to the standard value every time the 
power is turned on.

Setting Auto Iris
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To set the automatic iris window

1 Set “OPERATION” > “Auto Iris” > 
“Iris Window Indication” in the setup 
menu to “On.”
The current automatic iris window appears 
on the viewfinder screen.
If it is not necessary to display the auto iris 
window on the screen, set to “Off.”

2 Turn the MENU knob to select “Iris 
Window,” and then press the knob.

3 Turn the MENU knob until the desired 
auto iris window appears, and then 
press the knob.

If you select “Var,” the following items 
become effective and you can set the window 
of the desired size. Set the following items 
with “MAINTENANCE” > “Auto Iris2.”

When you exit the menu, the auto iris window 
selected in step 3 appears.
Unless you need to keep this window displayed, 
set “OPERATION” > “Auto Iris” > “Iris Window 
Indication” in the setup menu to “Off.”

To counter problems with very bright 
highlights
If the subject is too bright, the iris may close too 
much, leaving the overall image dark, or the 
highlights may be blown out. In such cases, 
setting the highlight clip function on reduces the 
luminance range, avoiding problems from the 
automatic iris correction.
Set “OPERATION” > “Auto Iris” > “Clip High 
Light” in the setup menu to “On.”

Set the ZOOM switch to SERVO (servo zoom) or 
MANU (manual zoom).

Turn the zoom ring.

Operate the power zoom lever. The current lens 
zoom position appears in the viewfinder, over the 
range 0 (wide-angle) to 99 (telephoto) (see 
page 25).
Push to the W (wide) side when you want wide-
angle, and push to the T (telephoto) side when 
you want telephoto. Press the lever harder for a 
faster zoom action, or softer for slower zoom 
action.

Item Setting
Iris Var Width The width of the window

Iris Var Height The height of the window

Iris Var H 
Position

The position of the window 
in the horizontal direction

Iris Var V 
Position

The position of the window 
in the vertical direction.

Shaded parts indicate areas of light 
detection

Zooming

Switching between Zoom Modes

Using Manual Zoom

Using Servo Zoom
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Note

The lens is designed with an extra margin at the infinity 
position (∞), to compensate for focus drifting due to 
variations in temperature. When shooting a subject at 
infinity in MF or Full MF mode, check the picture in the 
viewfinder as you focus.

When you slide the focus ring back (toward the 
camcorder), the focus mode becomes Full MF 
mode, in which all focus adjustments are manual.

Note

When you slide the focus ring back, the focus instantly 
moves to the mark position.

Focus by turning the focus ring while viewing the 
viewfinder.
The distance indications on the ring are valid in 
Full MF mode. The distances where the picture is 
in focus correspond to absolute positions of the 
focus ring.

Peaking
You can turn the PEAKING knob on the 
viewfinder to use the peaking function. Edges are 
emphasized in the monitor picture, which 
facilitates manual focusing.
The recorded video signals are not affected.

When you slide the focus ring forward (toward 
the lens hood), and set the FOCUS switch to M 
(manual), the focus mode becomes MF mode, in 
which focus adjustments are manual but auto 
focus is available only when necessary.

Using the focus ring
Focus by turning the focus ring while viewing the 
viewfinder.

The distance indications on the ring are invalid in 
MF mode.

One-push auto focus
Press the PUSH AF button. Auto focus is enabled 
temporarily.
One-push auto focus ends when the subject is 
brought into focus.

MF assist function
When the MF assist function is on (see page 166), 
auto focus starts when you stop adjusting with the 
focus ring, enabling fine adjustments with the 
subject at the center of the screen.
Auto focusing by the MF assist function ends 
when the fine adjustments end.

When you slide the focus ring forward, and set the 
FOCUS switch to A (auto), the focus mode 
becomes AF mode, in which auto focus is always 
active.
The distance indications on the ring are invalid in 
AF mode.

When the focus mode is MF or AF, you can set 
the MACRO switch to the ON side to enable 
macro mode. Macro mode allows you to focus 
over the range that includes the macro area.
Macro mode is disabled in Full MF mode.

Adjusting the Focus

Adjusting in Full MF Mode

Adjusting in MF Mode

Adjusting in AF Mode

Using Macro Mode
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When you set the AUDIO SELECT switch to 
AUTO, the input levels of analog audio signals 
recorded on each channel are adjusted 
automatically. You can also make manual 
adjustments.

Note

Even if you set the AUDIO SELECT switch to AUTO, 
the input levels of digital audio signals are not adjusted 
automatically.

Target audio level for manual audio level 
adjustment
Make adjustment using –20 dB as the target level.
If the audio level meter shows a maximum level 
of 0 dB, then it indicates that the input audio level 
is excessive.

1 To adjust the signal input to the AUDIO 
IN CH-1 or CH-2 connector, set the 
AUDIO IN CH-1 or CH-2 switch to 
REAR.
To adjust both input signals, set both 
switches to REAR.

2 Set the AUDIO SELECT switch(es) 
corresponding to the channel(s) selected 
in step 1 to MANUAL.

3 With the LEVEL control(s) for the 
channel(s) selected in step 1, adjust so 
that the audio level meter shows up to 
–20 dB for a normal input volume.

Correspondence between recording level 
adjustments and audio level controls
You can select which audio level control controls 
the audio recording level of the input to each of 
the AUDIO IN CH-1/CH-2 connectors on 

“MAINTENANCE” > “Audio” in the setup 
menu.
Rear1/WRR Level: Channel 1 recording level 

(see page 147)
Rear2/WRR Level: Channel 2 recording level 

(see page 148)

Note

When you have operation of the LEVEL (CH1/CH2) 
knobs and MIC LEVEL control linked together, if the 
MIC LEVEL control is set to 0, the audio signals on 
channels 1 and 2 cannot be recorded. Check the position 
of the MIC LEVEL control before adjusting the LEVEL 
(CH1/CH2) knobs.

1 Set either or both of the AUDIO IN 
switch(es) to FRONT.

2 Set the AUDIO SELECT switch(es) for 
the desired channel(s) selected in step 1 
to MANUAL.

3 Turn the MIC LEVEL control, and 
adjust so that the audio level meter 
shows up to –20 dB for a normal input 
volume.

Correspondence between recording level 
adjustments and audio level controls
You can select which audio level control controls 
the audio recording level of the front microphone 
input on “MAINTENANCE” > “Audio” in the 
setup menu.
MIC CH1 Level: Channel 1 recording level (see 

page 147)
MIC CH2 Level: Channel 2 recording level (see 

page 147)

Note

When you have operation of the MIC LEVEL control 
and LEVEL (CH1/CH2) knobs linked together, if the 
LEVEL (CH1/CH2) controls are set to 0, the audio 
signals on channels 1 and 2 cannot be recorded. Check 
the position of the LEVEL (CH1/CH2) knobs before 
adjusting the MIC LEVEL control.

Adjusting the Audio 
Level

Manually Adjusting the Audio 
Levels of the Audio Inputs from 
the AUDIO IN CH-1/CH-2 
Connectors

Manually Adjusting the Audio 
Level of the MIC IN Connector
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Selecting the recorded audio
You can select the audio recorded on audio 
channels 3 and 4 with the AUDIO IN CH3/CH4 
switches.

You can have the selection made automatically, 
as follows.

To automatically select the same audio as on 
channels 1 and 2
Set “MAINTENANCE” > “Audio” > “Audio 
CH3/4 Mode” of the setup menu to “Ch 1/2.”

Adjusting the audio recording levels

To adjust automatically
Set the AUDIO SELECT CH 3-4 switch to 
AUTO.

To adjust manually

1 Set the AUDIO SELECT CH 3-4 switch 
to MANUAL.

2 Select the knobs that adjust the audio 
levels with the Audio CH3 Level and 
Audio CH4 Level items under 
“MAINTENANCE” > “Audio” in the 
setup menu.

Audio CH3 Level: Channel 3 recording 
level (see page 148)

Audio CH4 Level: Channel 4 recording 
level (see page 148)

You can now adjust the levels of audio 
channels 3 and 4 with the knobs selected 
here.

Note

When picture cache mode is enabled, it is not possible to 
set time data, even if you set the F-RUN/SET/R-RUN 
switch to SET. If you want to set time data, first exit 
picture cache mode.

The timecode setting range is from 00 : 00 : 00 : 
00 to 23 : 59 : 59 : 29 (hours : minutes : seconds : 
frames).

1 Set the DISPLAY switch to TC.

2 Set the PRESET/REGEN/CLOCK 
switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to 
SET.
The first (leftmost) digit of timecode flashes.

4 Use the up and down arrow buttons to 
change values, and use the left and right 
arrow buttons to move the flashing 
digit. Repeat until all digits are set.

To reset the timecode value to 00:00:00:00
Press the RESET/RETURN button.

5 Set the F-RUN/SET/R-RUN switch to 
F-RUN or R-RUN.
F-RUN: Free run. The timecode generator 

keeps running.
R-RUN: Recording run. The timecode 

generator runs only while recording.

To set the drop frame mode/non-drop frame 
mode
You can select the drop frame (DF) mode or non-
drop frame (NDF) mode on MAINTENANCE 
>Timecode in the setup menu.

To make the timecode consecutive
When the F-RUN/SET/R-RUN switch is set to R-
RUN, recording a number of scenes on the media 
normally produces consecutive timecode. 
However, once you remove the media and record 

Recording Audio on Channels 3 
and 4

CH3 switch Channel 3 recording target
FRONT Front microphone audio

REAR Audio signal input to AUDIO 
IN CH-1 connector

WIRELESS Wireless microphone audio

CH4 switch Channel 4 recording target
FRONT Front microphone audio

REAR Audio signal input to AUDIO 
IN CH-2 connector

WIRELESS Wireless microphone audio

Setting Time Data

Setting the Timecode
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on another media, the timecode will no longer be 
consecutive when you use the original media 
again for recording.
In this case, to make the timecode consecutive, set 
the PRESET/REGEN/CLOCK switch to 
REGEN.

Saving the real time in the timecode
Setting the PRESET/REGEN/CLOCK switch to 
CLOCK saves the real time in the timecode. 
When it is necessary to set the actual time, use 
MAINTENANCE > Clock Set > Date/Time in 
the setup menu.

For details, see “Setting the Date/Time of the 
Internal Clock” (page 36).

By setting the user bits (up to 8 hexadecimal 
digits), you can record user information such as 
the date, time, or scene number on the timecode 
track.

1 Set the DISPLAY switch to U-BIT.

2 Set the F-RUN/SET/R-RUN switch to 
SET.
The first (leftmost) digit flashes.

3 Use the up and down arrow buttons to 
change values, and use the left and right 
arrow buttons to move the flashing 
digit. Repeat until all digits are set.

To reset the user bit data to 00 00 00 00
Press the RESET/RETURN button.

4 Set the F-RUN/SET/R-RUN switch to 
F-RUN or R-RUN, corresponding to the 
desired operating mode for the 
timecode generator.

To store the user bit setting in memory
The user bit setting (apart from the real time) is 
automatically retained in memory even when the 
power is turned off.

Connections for timecode 
synchronization
Connect both the reference video signal and the 
external timecode as illustrated below.

Example 1: Synchronizing with an external 
timecode

Setting the User Bits

Synchronizing the Timecode

External timecode

1GENLOCK IN connector
2TC IN connector

Reference video signal
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Example 2: Interconnecting a number of 
camcorders (including one reference 
camcorder)

To lock the timecode to an external 
source

1 Set the POWER switch to the ON 
position.

2 Set the PRESET/REGEN/CLOCK 
switch to PRESET.

3 Set the F-RUN/SET/R-RUN switch to 
F-RUN.

4 Set the DISPLAY switch to TC.

5 Supply a timecode signal and a 
reference video signal complying with 
the SMPTE standard and in proper 
phase relationship, to the TC IN 

connector and to the GENLOCK IN 
connector, respectively.
This operation synchronizes the internal 
timecode generator with the external 
timecode. After about 10 seconds, you can 
disconnect the external timecode without 
losing the synchronization.

Notes

• When you finish the above procedure, the internal 
timecode is immediately synchronized with the 
external timecode and the counter display will show 
the value of the external timecode. However, wait for 
a few seconds until the sync generator stabilizes before 
recording.

• If the frequency of the reference video signal is not the 
same as the system frequency of the camcorder, the 
camcorder cannot be correctly genlocked. In such a 
case, the internal timecode is not correctly 
synchronized with the external timecode.

User bit settings during timecode 
synchronization
When the timecode is synchronized, only the time 
data is synchronized with the external timecode 
value.

To release the timecode synchronization
First disconnect the external timecode, then set 
the F-RUN/SET/R-RUN switch to R-RUN.

To change the power supply from the battery 
pack to an external power supply during 
timecode synchronization
To maintain a continuous power supply, connect 
the external power supply to the DC IN connector 
before removing the battery pack.

Camcorder synchronization during timecode 
synchronization
During timecode synchronization, the camcorder 
is genlocked to the reference video signal input 
from the GENLOCK IN connector.

1VIDEO OUT connector
2TC OUT connector
3TC IN connector
4GENLOCK IN connector

To next camcorder
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To display status screens
With no menu is displayed, push the STATUS 
ON/SEL/OFF switch up to the ON/SEL side. 
Each push selects the next status screen, in the 
order given in the table above.

CAMERA status screen
White Bal: White balance status
Gain: GAIN switch status
Zoom Speed: Zoom speed set with the lens 

ZOOM button
Zebra: Zebra status
Skin Detail: Skin detail status

AUDIO status screen
CH-1/CH-2/CH-3/CH-4: Audio level meters 

and input sources
Wind Filter: Wind filter settings

VIDEO status screen
Video Format: Video format
Rec Mode: REC Format
Output&i.LINK: Output&i.LINK setting and 

i.LINK usage status

SDI Output: HD/SD SDI OUT connector output 
setting

HDMI Output: HDMI connector output setting
Down Converter: SD output down converter 

setting (HD mode only)

ASSIGN SWITCH/REMOTE status screen
This screen displays the names of functions 
assigned to assignable switches and the Wi-Fi 
remote control status.

BATTERY/MEDIA status screen
Battery: The remaining battery capacity
Charge Count: The number of times the battery 

has been charged
Media A/Media B:

• Remaining capacity of media
• Remaining recording time
• Approximate writable lifetime (Life)

“Life 100%” is shown for unused media.

Checking Camcorder 
Settings and Status 
Information (Status 
Screens)

Status screen Information displayed
CAMERA Settings and status 

information related to 
shooting

AUDIO Settings and status 
information related to 
audio input and output

VIDEO Settings and status 
information related to 
recording and playback

ASSIGN SWITCH/
REMOTE

Names of functions 
assigned to assignable 
switches and Wi-Fi remote 
control status

BATTERY/MEDIA Status of the battery 
mounted on the camcorder 
and the media status
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This camcorder records video and audio on SxS 
memory cards (not supplied) loaded into one or 
both of its memory card slots.
You can use the camcorder with the following 
media for recording.

For details about other media supported by the 
camcorder, see “Using a Media Adaptor” (page 66).

SxS memory cards that can be used with 
this camcorder
Use the following Sony-made SxS memory cards.
Operations are not guaranteed with memory cards 
other than the following cards.

SxS PRO+ series

SxS PRO series

SxS-1 series

The memory cards listed above comply with the 
ExpressCard memory card standard.

To load SxS memory cards

1 Slide the cover to the left to open.

2 Insert an SxS memory card into a card 
slot.

3 Close the cover.

ACCESS lamp status indications
Card slots A and B each have an ACCESS lamp 
to indicate the slot status.

To eject SxS memory cards

1 Open the cover, and then press the 
EJECT button to release the lock and 
pull the button out.

2 Press the EJECT button again to eject 
the card.

Note

Data integrity cannot be guaranteed if you power the 
camcorder off or remove a memory card while the card 
is being accessed. Doing so may corrupt all data recorded 
on the card. Always make sure that the ACCESS lamp is 
lit green or not lit before you power the camcorder off or 
remove a memory card.

When SxS memory cards are loaded in both slot 
A and slot B, you can press the SLOT SELECT 
button to select the SxS memory card to use.
The camcorder switches automatically to the 
other card if the selected card becomes full during 
recording.

Note

The SLOT SELECT button is disabled during playback. 
Even when pressed, it does not change the selected slot. 
Button operations are enabled when a thumbnail screen 
(see page 101) is displayed.

Chapter4 Shooting

Handling SxS Memory 
Cards

About SxS Memory Cards

Loading and Ejecting SxS Memory 
Cards

Lamp Slot status
Lights 
orange

Accessing the SxS memory card 
(lights during data reading and 
writing)

Lights 
green

Standby (the loaded SxS memory 
card is ready for recording or 
playback)

Not lit • No SxS memory card is loaded.
• An unusable card is loaded.
• An SxS memory card is loaded, but 

the other slot is selected.

Selecting the SxS Memory Card to 
Use
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When you load an unformatted SxS memory card, 
or load an SxS memory card that has been 
formatted to other specifications, a message 
“Cannot Use Media(A)/Unsupported File 
System” appears in the viewfinder. In this case, 
format the memory card in the following way.

Note

SxS memory cards not formatted on an XDCAM EX 
device cannot be used.

To format (initialize) a memory card

1 Select “OPERATION” > “Format 
Media” in the setup menu (see 
page 123).

2 Select “Media(A)” (slot A) or 
“Media(B)” (slot B).

3 Turn the MENU knob to select 
“Execute,” and then press the knob.
The confirmation message for formatting is 
displayed on the viewfinder screen.

4 Turn the MENU knob to select 
“Execute” and press the knob.

Execution of the format starts.
During execution, a progress indication appears 
(%), and the ACCESS lamp lights in orange.

Recording and playback during format execution
Even during execution of a format, recording and 
playback are possible using an SxS memory card 
loaded into the other card slot.

If the format operation fails
A format operation may fail because the SxS 
memory card is write protected, or because it is 
not the type of card specified for use with this 
camcorder.
In this case, an error message appears. Follow the 
instructions in the error message and exchange 
the card for an SxS memory card that can be used 
with this camcorder.

Notes

• All data is erased when you format a memory card, 
including setup files and all of the recorded video data. 

• Use the format function of this camcorder to format 
SxS memory cards for use on this camcorder. The 
formats of cards formatted on other devices are not 
recognized as valid formats, making it necessary to 
format them again on this camcorder.

You can check the remaining capacity of the SxS 
memory cards loaded in the two slots by checking 
the recording media remaining capacity display 
in the viewfinder.
The camcorder calculates the remaining 
recording time for the media in each slot on the 
basis of the current video format (recording bit 
rate), and displays it in units of minutes.
You can also check the remaining time in the 
BATTERY/MEDIA status screen (page 62).

Notes

• A  mark appears when a memory card is write 
protected.

• The remaining capacity indication for memory cards is 
an approximation. When recording to a memory card, 
in addition to the video data, some space is reserved for 
media management. Accordingly, the actual remaining 
capacity may be slightly smaller than indicated.

When to exchange SxS memory cards
• The warning message “Media Near Full” 

appears, the WARNING indicator and the REC 
indication on the viewfinder screen flash, and 
the buzzer sounds when the total remaining 
recording time of the two memory cards falls to 
five minutes during recording.
Exchange one of the cards for media with 
available recording capacity.

• If you continue recording, the message “Media 
Full” appears and recording stops when the total 
remaining recording time falls to 0.

Note

About up to 600 clips can be recorded on one SxS 
memory card.
The display of remaining recording time changes to “0” 
and the message “Media Full” appears when the clip 
limit is reached.

Formatting (Initializing) SxS 
Memory Cards

Checking the Remaining 
Recording Time
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When you load an SxS memory card that needs to 
be restored, a message appears in the viewfinder 
to ask whether you want to restore it.

To restore a card
Turn the MENU knob to select “Execute,” and 
then press the knob.
The restoration starts.
During the restoration, a execution message 
appears, the progress is displayed (%), and the 
ACCESS lamp lights in orange.
When the restoration finishes, a completion 
message is displayed for three seconds.

If restoration fails
• Write protected SxS memory cards and cards on 

which memory errors have occurred cannot be 
restored. A warning message appears for such 
cards. Follow the instructions in the message 
and unprotect the card or replace it with another 
card.

• SxS memory cards on which memory errors 
have occurred may become usable if they are 
reformatted.

• In some cases, some clips can be restored while 
others cannot. The restored clips can be played 
normally.

• If the message “Could not Restore Some Clips” 
keeps appearing after repeated attempts at 
restoration, it may be possible to restore the SxS 
memory card with the following procedure.

1 Use the camcorder’s copy function (see 
page 108) or the supplied application 
software (see page 180) to copy the 
required clips to another SxS memory 
card.

2 Format the unusable SxS memory card on 
the camcorder.

3 Copy the required clips back to the newly 
formatted SxS memory card.

Recording and playback during restoration
Even while restoration is in progress, you can 
record and play an SxS memory card in the other 
card slot.

Note

For restoration of media recorded with this camcorder, 
be sure to use this camcorder.
Media recorded with a device other than this camcorder 
or with another camcorder of different version (even of 
the same model) may not be restored using this 
camcorder.

Restoring SxS Memory Cards
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Notes

• A media adaptor cannot obtain the high reliability and 
durability equivalent to an SxS memory card for 
professional use.

• Not all memory cards have been tested and are not 
guaranteed to work with this camcorder. For 
compatible memory cards, contact your Sony dealer.

• Format media for use with this camcorder using the 
format function of this camcorder.

By using an optional QDA-EX1 XQD 
ExpressCard Adaptor, you can insert an XQD 
memory card into the SxS memory card slot and 
use it instead of an SxS memory card.

For details on using a QDA-EX1 XQD ExpressCard 
Adaptor, refer to the instruction manual supplied 
with it.

Notes

• High-speed playback may not be properly achieved 
with an XQD memory card.

• Recording in XAVC-I or normal recording when 
shooting using Slow & Quick Motion may not be 
supported, depending on the XQD memory cards used. 
The use of SxS memory cards is recommended.

Formatting
When you use an XQD memory card with this 
camcorder for the first time, formatting is 
required.
An XQD memory card to be used with this 
camcorder must be formatted using the format 
function of this camcorder. It is also necessary to 
format an XQD memory card for use if a caution 
message is displayed when you mount the XQD 
memory card.
For an XQD memory card that was formatted 
with another system unsupported by this 
camcorder, the message “Unsupported File 
System” is displayed on the viewfinder screen.
Format the XQD memory card as instructed 
below.

To format (initialize) a memory card
Specify the slot on “OPERATION” > “Format 
Media” in the setup menu, then select “Execute.” 
On a confirmation message, select “Execute” 
again.

An in-progress message and status bar (%) are 
displayed, and the access lamp lights in orange.
When formatting is completed, a completion 
message is displayed for three seconds.

Note

When formatting, all data in an XQD memory card-
including protected images-are erased and cannot be 
restored.

Connection between the camcorder and a 
computer
To use an XQD memory card in which data have 
been recorded with an XDCAM/XDCAM EX-
series product, insert it into the slot of the 
camcorder and connect between the computer and 
this camcorder using a USB cable.

To use media formatted with this camcorder in 
the slots of other devices
Make a backup of the media, then format it using 
the other device.

When FAT mode is selected, use of the optional 
MEAD-SD02 Media Adaptor permits you to 
insert an SD card into the SxS memory card slot 
of the camcorder and use it for recording and 
playback in the same way as with an SxS memory 
card.

For details on use of the MEAD-SD02 Media 
Adaptor, refer to the Operating Instructions of the 
adaptor.

Note

High-speed playback may not be properly achieved with 
an SD card.

SDHC cards (FAT mode only)
SDHC cards (SD speed Class 10)

Note

Cannot be used in UDF and exFAT modes.

SDXC cards (exFAT only)
SDXC cards (SD speed Class 10)

Using a Media Adaptor

XQD Memory Cards

SD Cards
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Notes

• Cannot be used in other than exFAT mode.
• Do not use SDXC cards with other memory cards at 

the same time. If different types of media are used, the 
camcorder cannot switch between media during 
recording when one media becomes full.

• Recording in XAVC-I or normal recording when 
shooting using Slow & Quick Motion may not be 
supported, depending on the SDXC cards used. The 
use of SxS memory cards is recommended.

• SDXC cards recorded using PMW-series or PXW-
series camcorders may not be supported for recording 
or playback with the camcorder, depending on the 
device.
For details, contact a Sony sales or service 
representative.

Formatting
When you use an SD card with this camcorder for 
the first time, formatting is required.
An SD card to be used with this camcorder must 
be formatted using the format function of this 
camcorder.
It is also necessary to format an SD card for use if 
a caution message is displayed when you mount 
the SD card.
For an SD card that was formatted with another 
system unsupported by this camcorder, the 
message “Unsupported File System” is displayed 
on the viewfinder screen.
Format the SD card as instructed below.

To format (initialize) a memory card
Select “Media(A)” (slot A) or “Media(B)” (slot 
B) on “OPERATION” > “Format Media” in the 
setup menu, and select “Execute.”

During execution, a progress indication appears 
(%), and the ACCESS lamp lights in orange.
When formatting is completed, a completion 
message is displayed for three seconds.

Note

In formatting, all data in an SD card, including protected 
images, are erased and cannot be restored.

Connection between the camcorder and a 
computer
To use an SD card in which data have been 
recorded with an XDCAM/XDCAM EX-series 
product, establish USB connection between the 
computer and this camcorder and insert it into the 
slot of the camcorder, or use a specified USB card 
reader SBAC-US20.

To use media formatted with this camcorder in 
the slots of other devices
Make a backup of the media, then format it using 
the other device.
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In UDF/exFAT mode, you can connect a USB 
flash drive connected to the external device to 
record, save and load the following data.
• Planning metadata (see page 97)
• Setting data file (see page 170)

Notes

• Use USB flash drives with capacity of 4 GB to 32 GB. 
The use of Sony USB flash drives is recommended.

• USB flash drives other than the recommended flash 
drives listed above may not be recognized when 
connected to the USB connector.

USB flash drives must be formatted with the 
FAT32 file system.

Note

Before using a drive, format it on this camcorder or a PC. 
If a drive formatted on a PC cannot be used, format it on 
the camcorder.

1 Connect a USB flash drive to the 
external device connector.
When the drive is unformatted or has been 
formatted in an unsupported format, a 
message appears stating that the drive cannot 
be used.

2 Select “MAINTENANCE” > “USB Set” 
> “Format USB” > “FAT32” in the 
setup menu.
A confirmation message prompting you to 
execute formatting appears on the viewfinder 
screen.

3 Turn the MENU knob to select 
“Execute” and press the knob.
During execution, a progress indication 
appears (%). When formatting is completed, 
the message “Format USB Memory Done” is 
displayed. The 
\MSSONY\PRO\XDCAM\MEMDISC 

folder and the \General\Sony\Planning folder 
are automatically created in the drive.

If the format operation fails
A format operation may fail because the USB 
flash drive is write protected, or because it is not 
the type of drive specified for use with this 
camcorder.
In this case, an error message appears. Follow the 
instructions in the error message and exchange 
the drive for one that can be used with this 
camcorder.

When you load a USB flash drive that cannot be 
mounted normally because the file system is 
destroyed, a message appears on the viewfinder 
screen to ask whether you want to restore it.
Pressing the MENU knob after turning the 
MENU knob to select “Execute” starts execution 
of the format and a progress indication appears 
(%).
When restoring is completed, the message 
“Restore USB Memory Done” is displayed.

Handling USB Flash 
Drives

Formatting (Initializing) USB 
Flash Drives

Restoring USB Flash Drives
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When the RM-B170/B750 Remote Control Unit, 
the RCP-1001/1501 Remote Control Panel, or 
other control unit is connected, some camcorder 
functions can be controlled from these units.
You can use the RM-B750’s display or a video 
monitor connected to the MONITOR connector 
of the remote control unit to control the 
camcorder by menu operations and monitor the 
camcorder picture.

To connect
Using the remote cable (10 m (33 ft)) supplied 
with the remote control unit, connect between the 
REMOTE connector (8-pin) of the camcorder and 
the camera connector of the remote control unit.
When you turn on the camcorder after the 
connection, the camcorder enters Remote Control 
mode.

You can control menu and recording operations.

For the functions that can be controlled from the 
remote control unit, see “Functions That Can Be 
Controlled from the RM-B170/B750” on page 72 or 
“Functions That Can Be Controlled from the RCP-
1001/1501” on page 79.

Notes

• Remote Control operations cannot be made if USB 
connection to the camcorder is enabled.

• Do not connect or disconnect the remote control unit 
when the camcorder is on.

The following switches of the camcorder become 
inoperative when the remote control unit is 
connected.
• GAIN selector
• WHITE BAL switch
• AUTO W/B BAL switch
• SHUTTER switch
• OUTPUT/DCC switch
• Buttons and switches to which the Turbo Gain 

function has been assigned, including the 

ASSIGN. 1/3 switches, the ASSIGNABLE 4 
switch, the COLOR TEMP. button, and the 
ASSIGNABLE 5 switch.

• REC START button: the VTR button on the 
lens, and buttons and switches to which the 
function has been assigned using 
“OPERATION” > “Assignable SW” in the 
setup menu, including the ASSIGN. 1/3 
switches, the ASSIGNABLE 4 switch, the 
COLOR TEMP. button, and the ASSIGNABLE 
5 switch (when “MAINTENANCE” > “Camera 
Config” > “RM Rec Start” in the setup menu is 
set to “RM”).

To release remote control mode
Turn off the camcorder and disconnect the remote 
control unit.
The settings on the controls on the camcorder 
become valid.

To connect the monitor to the RM-B170/
B750
The MONITOR connector (BNC type) of the 
RM-B170/B750 outputs a composite signal.
To connect a monitor to the MONITOR 
connector on the RM-B170/B750, use the black 
cable supplied with the RM-B170/B750.

Camera image quality adjustment items 
when the RM-B170/B750 is connected
When the RM-B170/B750 is connected, the 
parameters for camera image quality adjustment 
items (paint data) are reset to the parameters that 
were specified the last time that RM-B170/B750 
was connected.

Function of the recording start/stop 
buttons when the RM-B170/B750 is 
connected
This setting is made using “MAINTENANCE” > 
“Camera Config” > “RM Rec Start” in the setup 
menu.

Operating via the 
REMOTE Connector

Adjusting the Camcorder from the 
Remote Control Unit
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Relationship between the setting of the RM Rec 
Start item and the function of recording start/stop 
buttons

Structure of the paint adjustment data
The non-volatile memory of the camcorder used 
for storing paint adjustment data consists of two 
regions as shown below: one is the “main data 
block” that is used when a remote control unit is 
not connected, and the other is the “remote 
control data block” that is used when a remote 
control unit is connected. Paint adjustment data is 
automatically selected and output to the camera 
section depending on whether or not a remote 
control unit such as the RM-B170 is connected.

When a remote control unit is connected to the 
camcorder, the “remote control data block” is 
selected as the current paint data block, and the 
paint adjustment parameters that were in effect 
the last time the remote control unit was used are 
recalled.
The settings of the absolute value rotational 
controls 1) and absolute value switches 2) are 
overwritten by those on the remote control unit 
after the remote control unit is connected.
When the remote control unit is disconnected 
from the camcorder, the “main data block” 
becomes effective. Thus the camcorder will 
return to the settings that were in effect before the 
remote control unit was connected.
1) Absolute value rotational controls: The data 

corresponding to the angular position of controls is 
output. Rotational controls for which the data 
corresponding to the amount of their rotation is 
output are called relative value controls.

2) Absolute value switches: Like toggle switches or 
slide switches (except most momentary switches), the 
switches (or knobs) whose positions must coincide 
with their functions are called absolute value 
switches.

When “MAINTENANCE” > “Camera Config” > 
“RM Common Memory” is set to “On” in the 
setup menu, you can use settings of the paint 
adjustment data stored in the main data block 
even if you connect the remote control unit. In 
this case, the settings stored in the main data 

Button
Settings of RM Rec Start
RM CAM PARA

Camcorder’s REC 
START button

Disabled Enabled Enabled

Lens’ VTR button Disabled Enabled Enabled

Buttons and switches 
to which the 
recording start/stop 
function has been 
assigned (ASSIGN. 
1/3 switches, 
ASSIGNABLE 4 
switch, COLOR 
TEMP. button, and 
ASSIGNABLE 5 
switch)

Disabled Enabled Enabled

Remote control 
unit’s VTR button

Enabled Disabled Enabled

Main data block Remote control data 
block

Hardware of the 
camera section

RM-B170 connected

RM-B170 not connected

Setup menu of 
the camcorder

Non-volatile memory
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block will be renewed when you change the 
settings on the remote control unit. Thus, the 
settings of the paint data made with the remote 
control unit can be retained even if the remote 
control unit is removed. However, if the switch 
position on the remote control unit differs from 
the one on the camcorder, the switch position on 
the camcorder takes precedence over that on the 
remote control unit.
Also, it is possible to keep the settings that are in 
effect before you connect the remote control unit. 
In this case, you should set the control knob to the 
relative value mode on the remote control unit.

For details, refer to the Operation Manual supplied 
with the remote control unit.

1 Set the DISPLAY switch to MENU.
The camcorder menus can be displayed on a 
video monitor connected to the MONITOR 
connector of the RM-B170.

2 Select and set the menu items, using the 
MENU SELECT knob and the 
CANCEL/ENTER switch.

3 When the settings are completed, set the 
DISPLAY switch to ON or OFF to exit 
the menu.

For details on operations of the RM-B170, refer to 
the Operation Manual of the RM-B170.

1 Press and light the MONITOR button 
then press the VF MENU button.
The camcorder menus can be displayed on 
the RM-B750’s display or a video monitor 
connected to the MONITOR connector of the 
RM-B750.

2 Select and set the menu items, using the 
MENU SELECT knob, ENTER button, 
and CANCEL button.

3 When the settings are completed, press 
the VF MENU button to exit the menu.

For details on operations of the RM-B750, refer to 
the Operation Manual of the RM-B750.

Operating the Menu from the 
RM-B170

Operating the Menu from the 
RM-B750
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You can adjust the functions in the following table by using menu operations, adjustment knobs, switches, 
and the touch panel (RM-B750 only).

For details on operations, refer to the operation manual of the RM-B170/B750.

How to read the table
In the RM-B170 and RM-B750 columns of the table below, “Yes” and “No” mean the following.
Yes: The operation can be performed from the unit.
No: The operation cannot be performed from the unit.

Functions That Can Be Controlled from the RM-B170/
B750

Item Sub-item Setting Description RM-B170 RM-B750
Gain Step Gain — Sets the master gain. No No

L/M/H Low/Mid/High Switches between three gain levels, 
when the master gain has been set 
from a menu.

No No

Step –3/0/3/6/9/12/18/
24dB

Sets the master gain. Yes Yes

Bars Bars On/Off Turns color bar output on or off. Yes Yes

Shutter Step Shutter 
Setting

On/Off Turns the step shutter function on or 
off.

Yes Yes

Step Shutter 
Speed

— Sets the step shutter speed. Yes Yes

ECS Setting On/Off Turns ECS on or off. Yes Yes

ECS Frequency — Selects the ECS frequency. Yes Yes

SLS Setting On/Off Turns SLS on or off. Yes Yes/No a)

SLS Speed — Sets the SLS speed (number of 
frames).

Yes Yes a)

DCC DCC On/Off Turns DCC on or off. Yes Yes

White 
Balance

AWB Start/Stop Starts execution of auto white 
balance adjustment.
Stops execution if in progress.

Yes Yes

White Memory A/B/C/Preset Switches the auto white balance 
memory.

Yes Yes

ATW On/Off Turns ATW on or off. Yes Yes

5600K On/Off Turns color temperature conversion 
on or off.

Yes Yes

Black ABB Start/Stop Starts execution of auto black 
balance adjustment.
Stops execution if in progress.

Yes Yes
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Iris Iris Mode Auto/Manual Selects the iris mode. Yes Yes

Iris Speed –99 to ±0 to +99 Specifies the control speed (speed of 
reaction to changes in the video). 
(Larger values specify quicker 
reaction times.)

Yes b) Yes b)

Iris Level –99 to ±0 to +99 Adjusts the level of the auto iris 
target value.

Yes b) Yes b)

Iris APL Ratio –99 to ±0 to +99 Adjusts the mix ratio of auto iris 
detection peak value and average 
value.

Yes b) Yes b)

Iris Window Ind On/Off Turns on or off the function that 
displays a frame marker for the auto 
iris detection window.

Yes b) Yes b)

Close On/Off Turns forcible iris closing on or off. No Yes

Rec 
Function

Slow & Quick On/Off Turns the Slow & Quick Motion 
function on or off.

Yes Yes a) b)

Frame Rate The available 
settings vary 
depending on the 
Format >HD 
System Line 
setting.

When “Slow & Quick” is set to 
“On,” sets the frame rate for Slow & 
Quick Motion shooting.

Yes Yes a) b)

Camcorder 
Menu

Menu On/Off Operates the camcorder menu. Yes Yes

Cancel/Preset Cancel/Preset Yes Yes

Select/Set Select (Up/
Down)/Set

Yes Yes

Panel 
Active

Panel Active On/Off Enables (On) or disables (Off) panel 
operations.

Yes Yes

Standard Standard On/Off Selects standard mode. Yes Yes

ND Filter ND Filter Display only Turns the display of ND filter 
settings on or off. (The settings 
cannot be changed, only displayed.)

No No

CC Filter CC Filter A/B/C/D Selects a CC filter. Yes Yes

Extender 
IND

Extender On/Off Turns the lens extender indication 
on or off. (The settings cannot be 
changed, only displayed.)

No No

Call Call On/Off Enables (On) or disables (Off) calls 
from externally connected 
equipment.

Yes Yes

Media Rec Start/Stop Starts or stops recording. Yes Yes

Play Play/Pause Starts playback. Yes Yes

FREV — Starts high-speed reverse playback. Yes Yes

FFWD — Starts high-speed playback. Yes Yes

Stop — Stops playback. Yes Yes

Rec Review — Starts a recording review. Yes Yes

PREV — Jumps to the first frame of the 
current clip.

Yes Yes

NEXT — Jumps to the first frame of the next 
clip.

Yes Yes

Freeze Mix — Execute the freeze mix function. Yes Yes

Item Sub-item Setting Description RM-B170 RM-B750
73



Switch 
Status

Gamma On/Off Turns gamma correction on or off. Yes b) Yes b)

Black Gamma On/Off Turns black gamma correction on or 
off.

Yes Yes b)

Matrix On/Off Turns linear matrix correction and 
user matrix correction on or off.

Yes b) Yes b)

Knee On/Off Turns knee correction on or off. Yes Yes b)

White Clip On/Off Turns white clipping adjustment on 
or off.

Yes b) Yes b)

Detail On/Off Turns detail adjustment on or off. Yes Yes b)

Flare On/Off Turns flare correction on or off. Yes Yes b)

Test Saw On/Off Turns the test saw signal on or off. Yes Yes

White R Gain<A> –99 to ±0 to +99 Specifies the white balance R gain 
value saved in memory A.

Yes Yes

B Gain<A> –99 to ±0 to +99 Specifies the white balance B gain 
value saved in memory A.

Yes Yes

R Gain<B> –99 to ±0 to +99 Specifies the white balance R gain 
value saved in memory B.

Yes Yes

B Gain<B> –99 to ±0 to +99 Specifies the white balance B gain 
value saved in memory B.

Yes Yes

Black Master Black –99 to ±0 to +99 Specifies the master black level. Yes Yes

R Black –99 to ±0 to +99 Specifies the R black level. Yes Yes

B Black –99 to ±0 to +99 Specifies the B black level. Yes Yes

Flare Flare On/Off Turns flare correction on/off. Yes Yes b)

R Flare –99 to ±0 to +99 Sets the R flare correction level. Yes Yes

G Flare –99 to ±0 to +99 Sets the G flare correction level. Yes b) Yes b)

B Flare –99 to ±0 to +99 Sets the B flare correction level. Yes Yes

Gamma Gamma On/Off Turns gamma correction on or off. Yes Yes b)

Step Gamma 0.35 to 0.45 to 
0.90 (0.05 steps)

Specifies a gamma correction value 
in steps of 0.05.

Yes b) Yes b)

Master Gamma –99 to ±0 to +99 Specifies the master gamma level. Yes Yes

R Gamma –99 to ±0 to +99 Specifies the R gamma level. Yes b) Yes

G Gamma –99 to ±0 to +99 Specifies the G gamma level. Yes b) Yes b)

B Gamma –99 to ±0 to +99 Specifies the B gamma level. Yes b) Yes

Gamma Select When Gamma 
Category is STD: 
1 DVW
2 ×4.5
3 ×3.5
4 240M
5 R709
6 ×5.0

Select the gamma table to use in 
gamma correction.

Yes b) Yes b)

When Gamma 
Category is HG: 
1 3250
2 4600
3 3259
4 4609

Yes b) Yes a) b)

Gamma 
Category

STD/HG Selects use of standard gamma 
(STD) or HyperGamma (HG).

Yes b) Yes a) b)

Item Sub-item Setting Description RM-B170 RM-B750
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Black 
Gamma

Black Gamma On/Off Turns black gamma correction on or 
off.

Yes Yes

Gamma Level –99 to ±0 to +99 Specifies the master black gamma 
level.

Yes b) Yes

Range Low/L.Mid/
H.Mid/High

Selects the black gamma correction 
effective range.

Yes b) Yes b)

Knee Knee On/Off Turns knee correction on or off. Yes Yes b)

Knee Point 50% to 90.0% to 
109% (1% steps)

Specifies the knee point. Yes Yes b)

Knee Slope –99 to ±0 to +99 Specifies the knee slope. Yes b) Yes b)

Knee Saturation On/Off Turns the knee saturation function 
on or off.

Yes b) Yes b)

Knee Saturation 
Level

–99 to ±0 to +99 Specifies the knee saturation level. Yes b) Yes b)

White Clip White Clip On/Off Turns white clipping adjustment on 
or off (Off = fixed as 109%).

Yes b) Yes b)

White Clip 
Level

Country is set to 
other than PAL 
Area
90.0% to 
108.0% to 
109.0%

Specifies the white clip level. Yes b) Yes b)

Country is set to 
PAL Area
90.0% to 
105.0% to 
109.0%

Detail(HD 
mode)/
Detail(SD 
mode)

Detail On/Off Turns detail adjustment on or off. Yes Yes b)

Level –99 to ±0 to +99 Specifies the detail level. Yes Yes

H/V Ratio –99 to ±0 to +99 Specifies the mix ratio between the 
H detail level and the V detail level.

Yes b) Yes b)

Crispening –99 to ±0 to +99 Specifies the crispening level. Yes b) Yes b)

Level Depend On/Off Turns the level dependence 
adjustment function on/off.

Yes b) Yes b)

Level Depend 
Level

–99 to ±0 to +99 Specifies the level dependence level. Yes b) Yes b)

Frequency –99 to ±0 to +99 Specifies the central frequency for H 
detail signal. Larger values give 
finer details.

Yes b) Yes b)

Knee Aperture On/Off Turns the linear knee aperture 
function on or off.

Yes b) Yes b)

Knee Aperture 
Level

–99 to ±0 to +99 Specifies the knee aperture level. Yes b) Yes b)

Limit –99 to ±0 to +99 Specifies the detail limiter values for 
both the white-side and black-side 
direction.

Yes b) Yes b)

White Limit –99 to ±0 to +99 Specifies the white-side detail 
limiter value.

Yes b) Yes b)

Black Limit –99 to ±0 to +99 Specifies the black-side detail 
limiter value.

Yes b) Yes b)

Item Sub-item Setting Description RM-B170 RM-B750
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Skin Detail Skin Detail On/Off Turns skin detail correction on or 
off.

Yes b) Yes

Area Detection Color detection 
screen

Detects the color to be targeted by 
skin detail correction.

Yes b) Yes b)

Area Indication On/Off Turns on or off the function that 
displays a zebra pattern in the area 
targeted by skin detail correction.

Yes b) Yes b)

Level –99 to ±0 to +99 Specifies the skin detail level. Yes b) Yes

Saturation –99 to ±0 to +99 Specifies the saturation of the color 
targeted by skin detail correction.

Yes b) Yes b)

Hue 0 to 359 Specifies the hue of the color 
targeted by skin detail correction.

Yes b) Yes b)

Width 0 to 40 to 90 Specifies a range for the hue of the 
color targeted by skin detail 
correction.

Yes b) Yes b)

Matrix Matrix On/Off Turns the matrix correction function 
on or off.

Yes b) Yes b)

Preset Matrix On/Off Turns the preset matrix function on 
or off.

Yes b) Yes b)

Preset Select 1/2/3/4/5/6 Selects a preset matrix.
1: SMPTE-240M equivalent
2: ITU-709 equivalent
3: SMPTE WIDE equivalent
4: NTSC equivalent
5: EBU equivalent
6: ITU-601 equivalent

Yes b) Yes b)

User Matrix On/Off Turns the user matrix function on or 
off.

Yes b) Yes b)

User Matrix 
R-G

–99 to ±0 to +99 Specifies a freely defined R-G user 
matrix.

Yes b) Yes b)

User Matrix 
R-B

–99 to ±0 to +99 Specifies a freely defined R-B user 
matrix.

Yes b) Yes b)

User Matrix 
G-R

–99 to ±0 to +99 Specifies a freely defined G-R user 
matrix.

Yes b) Yes b)

User Matrix 
G-B

–99 to ±0 to +99 Specifies a freely defined G-B user 
matrix.

Yes b) Yes b)

User Matrix 
B-R

–99 to ±0 to +99 Specifies a freely defined B-R user 
matrix.

Yes b) Yes b)

User Matrix 
B-G

–99 to ±0 to +99 Specifies a freely defined B-G user 
matrix.

Yes b) Yes b)

Item Sub-item Setting Description RM-B170 RM-B750
76



Multi 
Matrix

Multi Matrix On/Off Turns the multi matrix correction 
function on or off.

Yes b) Yes b)

Area Indication On/Off Turns on or off the function that 
displays a zebra pattern in the color 
area targeted by multi matrix 
correction.

Yes b) Yes b)

Axis B/B+/MG–/MG/
MG+/R/R+/YL–/
YL/YL+/G–/G/
G+/CY/CY+/B–

Specifies a color targeted by multi 
matrix correction (16-axis mode).

Yes b) Yes b)

Hue –99 to ±0 to +99 Specifies the hue of the color 
targeted by multi matrix correction 
for each 16-axis mode.

Yes b) Yes b)

Saturation –99 to ±0 to +99 Specifies the saturation of the color 
targeted by multi matrix correction 
for each 16-axis mode.

Yes b) Yes b)

V 
Modulation

V Modulation On/Off Turns V modulation shading on or 
off.

Yes b) Yes b)

Master V 
Modulation

–99 to ±0 to +99 Specifies the master V modulation 
level.

Yes b) Yes

R V Modulation –99 to ±0 to +99 Specifies the V modulation level of 
R signal.

Yes b) Yes b)

G V Modulation –99 to ±0 to +99 Specifies the V modulation level of 
G signal.

Yes b) Yes b)

B V Modulation –99 to ±0 to +99 Specifies the V modulation level of 
B signal.

Yes b) Yes b)

Low Key 
Sat.

Low Key Sat. On/Off Turns low key saturation correction 
on or off.

Yes b) Yes b)

Level –99 to ±0 to +99 Specifies the saturation of colors in 
low luminance areas.

Yes b) Yes b)

Noise 
Suppress

Noise Suppress On/Off Turns noise suppression on or off. Yes b) Yes a) b)

White 
Shading

R/G/B White H 
Saw

–99 to ±0 to +99 Specifies a SAW white shading 
correction value for the horizontal 
direction.

Yes b) Yes b)

R/G/B White H 
Para

–99 to ±0 to +99 Specifies a parabola white shading 
correction value for the horizontal 
direction.

Yes b) Yes b)

R/G/B White V 
Saw

–99 to ±0 to +99 Specifies a SAW white shading 
correction value for the vertical 
direction.

Yes b) Yes b)

R/G/B White V 
Para

–99 to ±0 to +99 Specifies a parabola white shading 
correction value for the vertical 
direction.

Yes b) Yes b)

Item Sub-item Setting Description RM-B170 RM-B750
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a) Depending on RM-B750 version
b) The camcorder’s built-in menu can be operated from the RM-B170/B750.

Adjustments of the lens functions
The following functions can also be controlled from the RM-B170/B750.

Scene s1 Standard File number and file ID Yes b) Yes b)

s2 Standard File number and file ID Yes b) Yes b)

s3 Standard File number and file ID Yes b) Yes b)

s4 Standard File number and file ID Yes b) Yes b)

s5 Standard File number and file ID Yes b) Yes b)

Scene Recall Execute/Cancel Loads a scene file (execute using 
Execute).

Yes b) Yes b)

Scene Store Execute/Cancel Saves a scene file (execute using 
Execute).

Yes b) Yes b)

Reference Reference Store Execute/Cancel Stores the current settings of 
reference file items in the reference 
file that is maintained in internal 
memory (execute using Execute).

Yes b) Yes b)

Shot Mark Shot Mark1 — Set a Shot Mark1. Yes No

Shot Mark2 — Set a Shot Mark2. Yes No

Description Operation on the lens BM-B170 RM-B750
Iris adjustment Iris ring Yes Yes

Iris close — No Yes

Switching between auto iris and manual iris IRIS switch Yes Yes

Zooming Zoom ring Yes No

Focus adjustment Focus ring Yes No

Item Sub-item Setting Description RM-B170 RM-B750
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You can adjust the functions in the following table by using menu operations, adjustment knobs, switches, 
and the touch panel on the RCP-1001/1501.

For details on operations, refer to the operation manual of the RCP-1001/1501.

How to read the table
In the RCP-1001, and RCP-1501 columns of the table below, “Yes” and “No” mean the following.
Yes: The operation can be performed from the unit.
No: The operation cannot be performed from the unit.

Functions That Can Be Controlled from the RCP-1001/
1501

Item Sub-item Setting Description RCP-1001/1501
Gain Step Gain — Sets the master gain. Yes

L/M/H Low/Mid/High Switches between three gain levels, when 
the master gain has been set from a menu.

No

Step –3/0/3/6/9/12/18/
24/30/36/42dB

Sets the master gain. Yes

Bars Bars On/Off Turns color bar output on or off. Yes

White 
Balance

AWB Start/Stop Starts execution of auto white balance 
adjustment.
Stops execution if in progress.

Yes

ATW On/Off Turns ATW on or off. Yes

5600K On/Off Turns color temperature conversion on or 
off.

Yes

Black ABB Start/Stop Starts execution of auto black balance 
adjustment.
Stops execution if in progress.

Yes

Iris Iris Mode Auto/Manual Selects the iris mode. Yes

Iris Level –99 to ±0 to +99 Adjusts the level of the auto iris target 
value.

Yes

Close On/Off Turns forcible iris closing on or off. Yes

Camcorder 
Menu

Menu On/Off Operates the camcorder menu. Yes

Cancel/Preset Cancel/Preset Yes

Select/Set Select (Up/
Down)/Set

Yes

Panel 
Active

Panel Active On/Off Enables (On) or disables (Off) panel 
operations.

Yes

Standard Standard On/Off Selects standard mode. Yes

ND Filter ND Filter Display only Turns the display of ND filter settings on 
or off (settings cannot be changed, only 
displayed.)

Yes

CC Filter CC Filter A/B/C/D Selects a CC filter. Yes

Call Call On/Off Enables (On) or disables (Off) calls from 
externally connected equipment.

Yes
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Switch 
Status

Gamma On/Off Turns gamma correction on or off. Yes

Black Gamma On/Off Turns black gamma correction on or off. Yes

Matrix On/Off Turns linear matrix correction and user 
matrix correction on or off.

Yes

Knee On/Off Turns knee correction on or off. Yes

White Clip On/Off Turns white clipping adjustment on or 
off.

Yes

Detail On/Off Turns detail adjustment on or off. Yes

Flare On/Off Turns flare correction on or off. Yes

Test Saw On/Off Turns the test saw signal on or off. Yes

White R Gain<A> –99 to ±0 to +99 Specifies the white balance R gain value 
saved in memory A.

Yes

B Gain<A> –99 to ±0 to +99 Specifies the white balance B gain value 
saved in memory A.

Yes

R Gain<B> –99 to ±0 to +99 Specifies the white balance R gain value 
saved in memory B.

Yes

B Gain<B> –99 to ±0 to +99 Specifies the white balance B gain value 
saved in memory B.

Yes

Black Master Black –99 to ±0 to +99 Specifies the master black level. Yes

R Black –99 to ±0 to +99 Specifies the R black level. Yes

B Black –99 to ±0 to +99 Specifies the B black level. Yes

Detail(HD 
mode)/
Detail(SD 
mode)

Level –99 to ±0 to +99 Specifies the detail level. Yes

Item Sub-item Setting Description RCP-1001/1501
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You can connect a device (such as a computer, 
smartphone, or tablet, collectively referred to as 
“device”) to the camcorder over a wireless LAN 
connection by attaching an optional IFU-WLM3 
USB Wireless LAN Module.
The following operations are supported between 
the camcorder and devices connected by wireless 
LAN using the IFU-WLM3.
• Using the Web menu (page 83) 
• Transferring planning metadata between the 

camcorder and a device (page 83) 
• Camcorder remote operation using a device 

(page 84) 

Open the cover of the external device connector, 
then connect the IFU-WLM3.

Notes

• The IFU-WLM3 (sold separately) may not be available 
in some countries/regions.

• Attach/remove the IFU-WLM3 after the camcorder is 
turned off.

• The CBK-WA101 Wireless Adapter cannot be used 
when using an IFU-WLM3.

• An i.LINK connection and USB wireless LAN module 
cannot be used at the same time.
When using a wireless connection with an IFU-WLM3 
inserted directly into the external device connector, do 
not connect a device to the i.LINK connector.

• If you use other wireless devices near the camcorder, 
the camcorder may not work correctly. Turn any 
wireless devices off that are near the camcorder.

To connect by wireless LAN using the IFU-
WLM3, two types of wireless LAN connections 
are available. In “ad-hoc mode”, you can make a 

peer-to-peer Wi-Fi connection between a device 
and a camcorder. In “infrastructure mode”, you 
can make Wi-Fi connections between a device 
and multiple camcorders via a wireless LAN 
access point (building a LAN). 

To configure network settings
Change settings under “MAINTENANCE” > 
“Network Setting” in the setup menu as required.

a) The IP address determined by DHCP server is 
displayed here.

When you have changed a setting
Set the “Set” item to “Execute.” When a 
confirmation message appears, turn the MENU 
knob to select “Execute” and press the knob.

To make a connection in ad hoc mode

1 Configure network connection settings 
on the device to be connected to the 
camcorder.

2 Start a connection on the device.

3 Set “MAINTENANCE” > “Wi-Fi 
Setting” > “Wi-Fi” to “Enable” in the 
setup menu.

Connecting the 
Camcorder to Devices 
using the IFU-WLM3 
USB Wireless LAN 
Module

Connecting the IFU-WLM3

Connecting by Wireless LAN 
using the IFU-WLM3

Item Setting
DHCP Setting that specifies whether to 

acquire the IP address 
automatically from a DHCP 
server.
Enabled: Acquire 

automatically.
Disabled: Do not acquire 

automatically (factory 
default setting).

IP Address IP address a) (factory default 
setting: 192.168.1.10)

Subnet Mask Subnet mask (factory default 
setting: 255.255.255.0)

Default Gateway Default gateway (factory 
default setting: 0.0.0.0)

User Name User name for log-in (factory 
default setting: admin)

Password Password for log-in (factory 
default setting: model name 
“pxw-x320”)
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4 Set “MAINTENANCE” > “Wi-Fi 
Setting” > “Scan Networks” to 
“Execute” and press the MENU knob.
The camcorder starts scanning for a network 
connection.
When networks are detected, the 
NETWORK SCAN list appears.

5 Turn the MENU knob to select a 
network and press the knob.
The “MAINTENANCE” menu appears 
again.

6 Confirm that the settings for the Wi-Fi 
Setting item conform to the network 
setting on the computer.
SSID (network name): Selected network 

name
Network Type (connection mode): 

“Adhoc”
CH (channel): “1”
Authentication (network authentication): 

Depending on the settings of the device, 
“Open,” “Shared,” or “WPA”

Encryption (data encryption): Depending 
on the settings on the device, “Disable,” 
“WEP,” “TKIP,” or “AES”

WEP Key Index (key index): “1” when 
“Encryption” is set to “WEP”

Input Select (key input format): Depending 
on the network key (or security key), 
“ASCII5,” “ASCII13,” “HEX10,” or 
“HEX26” when “Encryption” is set to 
“WEP,” “ASCII8-63” or “HEX64” 
when “Encryption” is set to “TKIP” or 
“AES”

7 Set the Key item to the network key (or 
security key) set on the device and press 
the MENU knob.

8 Set the Set item to “Execute” and press 
the MENU knob.
The message “Wi-Fi Setting Executing…” 
appears and the camcorder starts connection.
If the connection to the device is successful, 
then the message changes to “Wi-Fi Setting 
OK”.
Black squares (x) appear in the Wi-Fi Status 
column to show the connection status. (The 
number of x squares shows the level of 
connection status.) In the Wireless Mode 
column, the IEEE802.11 standard of the 

established connection appears (802.11b, 
802.11g or 802.11n).

It is also possible to access the camcorder from a device 
by first starting a wireless LAN connection on the 
camcorder.

To terminate the connection
Terminate the connection on the device.

To revert to the default settings (reset)
If you have trouble making a connection, or you 
want to start over, you can reset your wireless 
LAN connection settings to their defaults.

Set “MAINTENANCE” > “Network Setting” > 
“Net Config Reset” in the setup menu to 
“Execute” and press the MENU knob.
If the reset is executed, the message “Done” 
appears.
The camcorder attempts to connect to the network 
using a MAC address as the SSID.

To make a connection in infrastructure 
mode

Setting up the wireless LAN access point
The following settings are required.
• Network ID (SSID)
• Encryption method
• Network key (Key)

For details about setting up the wireless LAN access 
point, refer to the Operation Manual of the wireless 
LAN access point.

To find and connect to a wireless LAN from the 
camcorder
Perform the same procedure in “To make a 
connection in ad hoc mode” (page 81).
Note the following variations.
• Do not perform steps 1 and 2.
• The settings made in step 6 change as follows.

SSID (network name): Selected network name
Network Type (connection mode): “Infra”
Ch (channel): “Auto”
Authentication (network authentication): 

Depending on the settings on the computer, 
“Open,” “Shared,” “WPA,” or “WPA2”

Encryption (data encryption): Depending on 
the settings on the computer, “Disable,” 
“WEP,” “TKIP,” or “AES”

WEP Key Index (key index): “1” when 
“Encryption” is set to “WEP”

Tip
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Input Select (key input format): Depending 
on the network key (or security key), 
“ASCII5,” “ASCII13,” “HEX10,” or 
“HEX26” when “Encryption” is set to 
“WEP,” “ASCII8-63” or “HEX64” when 
“Encryption” is set to “TKIP” or “AES”

You can operate the Web menu built in the 
camcorder from a device when it is connected to 
the camcorder via a wireless LAN connection.
You can check the information and setting status 
of the camcorder, and upload a planning metadata 
file, using the Web menu.

Note

You cannot access the Web menu during recording/
playback. (You cannot send/receive files via a wireless 
LAN connection.)

Example Web menu

Product Information
• Model name
• Serial No.

Network
• MAC Address
• IP Address
• Subnet Mask

Wi-Fi Status (Wireless LAN setting)
• Wireless Mode
• SSID
• Type
• Channel
• Authentication (network authentication)
• Data Encryption (data encryption)

Planning Metadata
Clicking “Upload” displays the Planning 
Metadata screen which allows upload of a 
planning metadata file (see page 83).

Wi-Fi Remote
Clicking “Control Panel” displays the Wi-Fi 
Remote screen, allowing you to operate the 
camcorder remotely (see page 84).

Note

The configuration of items displayed in the Web menu 
varies depending on the browser you are using.

To display the Web menu

1 Launch a web browser on the device, 
and navigate to “http://<camcorder’s 
IP address> (setting of 
“MAINTENANCE” > “Network 
Setting” > “IP Address” in the setup 
menu).
Example (when the IP address is 
“192.168.1.10”): Type “http://
192.168.1.10/” in the address bar.
If the connection is complete, a dialog 
appears asking you to enter the user name 
and password.

2 Enter the user name and password, and 
click “OK.”
User name: admin
Password: pxw-x320 (model name in lower 

case)

You can transfer planning metadata created 
beforehand to the camcorder to specify clip 
names, shot marks, and other items.

To upload a planning metadata file

1 Insert a media such as an SxS memory 
card.

2 Click “Upload” in the Web menu.
The Planning Metadata screen appears.

3 Click “Select” to show Choose File 
dialog.

4 Select the planning metadata file you 
want to upload, and then click “Open.”
The path of the selected file appears.

5 Click “Execute.”
The planning metadata file is loaded into the 
camcorder’s memory and stored in the 
media.
“OK” appears in the Status field when the 
transfer is complete.

Using the Web Menu

Transferring Planning Metadata
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To upload a planning metadata file 
automatically
In the planning metadata file you want to load 
automatically, add a “load” property to the 
PlanningMetadata tag and set the value of the 
property to “True.” When you display the Web 
menu and insert a media, the planning metadata 
file is immediately loaded into the camcorder’s 
memory.
Example: <PlanningMetadata 
…sp spversion="1.00">

For details on the planning metadata, refer to the 
Operating Instructions supplied with the camcorder.

You can control the camcorder remotely from a 
device using Wi-Fi remote control. You can start/
stop recording, adjust iris/focus/zoom, etc., with a 
Wi-Fi connected device. This function is useful 
for setting the camcorder in a remote place, such 
as the top of a crane, etc.

Wi-Fi Remote screen (smartphone)

Wi-Fi Remote screen (tablet)

Notes

• Some serial lenses cannot be controlled from the Wi-Fi 
remote control. With any of such lenses mounted on 
the camcorder, even when you try to perform focus/
zoom control from the Wi-Fi remote control, the focus/
zoom setting value displayed on the Wi-Fi remote 
control continues to be [0].

• Even when a lens controllable from the Wi-Fi remote 
control is mounted on the camcorder, zoom control 
from the remote control is not possible if the servo 
function for the zoom operation is disabled on the lens.

• When a remote control unit is connected to the 
camcorder’s REMOTE connector and the white 
balance memory setting on the camcorder is other than 
“A (memory A),” turning the Wi-Fi remote control on 
or off may cause the color to change.

• When a remote control unit is connected to the 
camcorder’s REMOTE connector, that unit has control 
priority and therefore the Wi-Fi remote control cannot 
work.

To display the Wi-Fi remote control
To display the Wi-Fi remote control on a device 
screen, settings are required on both the device 
and camcorder.

Camcorder settings

1 Set “MAINTENANCE” > “Wi-Fi 
Setting” > “Wi-Fi” to “Enable” in the 
setup menu.

2 Set “MAINTENANCE” > “Wi-Fi 
Setting” > “Wi-Fi Remote” to “On” in 
the setup menu.

Device settings
Set the smartphone, tablet, PC, etc., to be used as 
the Wi-Fi remote control.

1 Make a wireless LAN connection 
between the device and camcorder (see 
page 81 and page 86).

Operating the Camcorder 
Remotely

load="true"
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2 Launch the browser and input http://
<camcorder’s IP address> (setting of 
MAINTENANCE > Network Setting > 
IP Address in the setup menu)/rm.html 
in the address bar.
Example: When the IP address is 
192.168.1.10, input http://192.168.1.10/
rm.html in the address bar.
The Wi-Fi Remote screen will appear on the 
device screen when the connection is 
established.
Thereafter operate the camcorder as shown 
on the screen of the Wi-Fi connected device.
The REC button becomes unavailable when 
the Lock switch is dragged to the right.

Notes

• To display the page for a smartphone, change the page 
to “rms.html.” To display the page for a tablet device, 
change the page to “rmt.html.” Normally, when 
“rm.html” is entered, the page displayed switches 
automatically for the device. However, in some cases, 
a different page may be displayed, depending on the 
device.

• The camcorder status may not match the Wi-Fi 
Remote screen in the following cases. If this happens, 
reload the browser display.
- when the camcorder is restarted while the connection 

is established.
- when the camcorder is controlled directly while the 

connection is established.
- when the device is reconnected.
- when you operate forward/backward on the device’s 

browser.
• If the Wi-Fi signal is poor, the Wi-Fi remote control 

may not work properly.
• Your smartphone/tablet may not be compatible with 

the ad hoc mode. For details, refer to the operating 
instructions supplied with the smartphone/tablet.

You can connect a device (such as a computer, 
smartphone, or tablet, collectively referred to as 
“device”) to the camcorder over a wireless LAN 
connection by attaching an optional CBK-
WA101 Wireless Adapter.
The following operations are supported between 
the camcorder and devices connected by wireless 
LAN using the CBK-WA101.
• Using the Web menu (page 83) 
• Transferring planning metadata between the 

camcorder and a device (page 83) 
• Camcorder remote operation using a device 

(page 84) 
• Proxy file (low resolution) recording (page 86) 
• File transfer (page 86) 
• Monitoring (page 86) 
• High-quality streaming using Sony QoS 

technology (page 86)
• Using the “Content Browser Mobile” 

application (page 86) 
In addition to the operations above, the 
following operations are also supported using 
the “Content Browser Mobile” application.
- Partial transfer of proxy files and original 

files.
- Live logging function

For details about attaching the optional 
CBK-WA101 Wireless Adapter, refer to the 
Operating Instructions or Installation Manual of 
the CBK-WA101.

Notes

• Turn the camcorder off before attaching or removing 
the optional CBK-WA101 Wireless Adapter.

• The IFU-WLM3 cannot be used when using an 
CBK-WA101.

• If you use another wireless device near the camcorder, 
the camcorder may not work correctly. Turn any 
wireless devices off that are near the camcorder.

Connecting the 
Camcorder to Devices 
using the CBK-WA101 
Wireless Adapter

Attaching the CBK-WA101
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You can use a device, such as a smartphone, 
tablet, or computer, to configure and control a 
wireless LAN connection. For details, refer to the 
Operating Instructions or Installation Manual of 
the optional CBK-WA101 Wireless Adapter.

You can record proxy files to an SD card in the 
optional CBK-WA101 Wireless Adapter.
To record proxy files, use the following settings 
in the setup menu.
• Set “MAINTENANCE” > “Camera Config” > 

“SDI Rec Control” to “Para Rec.”
• Set “MAINTENANCE” > “Camera Config” > 

“Match Clip Name” to “On.”

You can transfer proxy files (low resolution) 
recorded on the SD card of an optional 
CBK-WA101 Wireless Adapter, and original 
files (high resolution) recorded on the camcorder, 
to a server.

You can create a stream (H.264) of the camera 
picture or playback picture of the camcorder for 
monitoring and live logging from a device using 
the “Content Browser Mobile” application.

You can stream high-quality video using an 
optional Sony PWS-100RX1 Network RX 
Station as a Connection Control Manager (CCM) 
connected with an optional CBK-WA101 
Wireless Adapter used in network client mode.

This application allows you to configure the 
camcorder and remotely control the camcorder 
while viewing a stream on the screen of the 
device.
Check the version of the “Content Browser 
Mobile” application and use the latest version.

For details about the “Content Browser Mobile” 
application, contact a Sony service representative.

Also, refer to the Operating Instructions of the 
optional CBK-WA101 Wireless Adapter.

Partial transfer of a proxy file
You can transfer a cutout part of a file by 
specifying In and Out points in the proxy file. 
You can also transfer the cutout parts of multiple 
files using the Storyboard.

Notes

• The created clip has margins of up to 15 frames added 
to both ends of the trimmed clip.

• If a proxy file recorded using CBK-WA101 (sold 
separately) software (V1.3) or earlier is trimmed, it 
may not be able to be imported into a non-linear editor.

Partial transfer of an original file 
recorded on this unit
You can transfer a cutout part of a file by 
specifying In and Out points in the original file 
recorded by this unit. You can also transfer the 
cutout parts of multiple files using the 
Storyboard.
The following original file formats are supported.
• exFAT mode: XAVC-I/XAVC-L50, 35, 25/

MPEG2 HD422/MPEG2 HD420HQ
• UDF mode: MPEG2 HD422/MPEG2 

HD420HQ

Notes

• For partial transfer of an original file, first record the 
original file and proxy file with the same name using 
the following settings.
- Set “MAINTENANCE” > “Camera Config” > “SDI 

Rec Control” to “Para Rec.”
- Set “MAINTENANCE” > “Camera Config” > 

“Match Clip Name” to “On.”
• The following operations are not supported during 

partial transfer of an original file.
- Clip operations
- Media formatting

Connecting by Wireless LAN 
using the CBK-WA101

Recording Proxy Files (Low 
Resolution)

Transferring Files

Monitoring

High-Quality Streaming using 
Sony QoS Technology

Using the “Content Browser 
Mobile” Application
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- USB connection with a computer
• During partial transfer of an original file, the picture 

cache recording time for caching pictures in Picture 
Cache Rec mode becomes shorter than the time set 
using “OPERATION” > “Rec Function” > “P.Cache 
Rec Time” in the setup menu.

Live logging function
You can add essence marks while recording on 
the camcorder using the Content Browser Mobile 
application (live logging function). 
These are also applied to the proxy file. You can 
quickly and easily set the cutout points of a clip 
using essence mark information.

Notes

• Supported only if the proxy file has the same duration 
as the original file recorded on the camcorder from 
which information is inherited.

• If the original file is split, marks are not applied to the 
proxy file.

About monitoring in Content Browser 
Mobile
Video monitoring may stop, depending on the RF 
signal strength and mobile device.

The following devices, OS, and browsers (and 
later versions) are supported.

1 Attach a fully charged battery pack (see 
page 30).

2 Load one or two SxS memory cards (see 
page 63).
If you load two cards, the camcorder 
switches automatically to the second card 
when the first card becomes full.

3 Set the camcorder’s POWER switch 
(see page 10) to ON.

4 Make the following settings.
Marker display: On (see page 128)
Iris: Auto (see page 55)
Zoom: Auto (see page 56)
Camera output: Select the picture currently 

being shot (camera picture), and turn the 
DCC function on (see page 14).

Timecode advance mode: F-RUN (Free 
Run) or R-RUN (Rec Run) (see page 59)

Audio input channel selection: Auto (see 
page 17)

5 Push the AUTO W/B BAL switch to the 
BLACK side to adjust the black balance 
(see page 49).

6 Select a filter according to the lighting 
conditions, and adjust the white balance 
(see page 50).

7 Point the camcorder at the subject, and 
adjust the focus (see page 57) and zoom.

8 If you are using the electronic shutter, 
select an appropriate shutter mode and 
speed (see page 53).

9 Do one of the following to start 
recording.
- Press the REC START button (see 

page 12).
- Press the VTR button on the lens (see 

page 23).

Compatible Devices

Device OS Browser
PC Windows 7/

Windows 8/
Windows 10

Chrome

Mac OS10.8/10.9/
10.10

Safari

Smartphone Android 4.1/
4.2/4.3/4.4/5.0/
5.1/6.0

Chrome

iOS 8.0/8.1/8.2/
8.3/8.4/9.0

Safari

Tablet Android 4.1/
4.2/4.3/4.4/5.0/
5.1/6.0

Chrome

iOS 8.0/8.1/8.2/
8.3/8.4/9.0

Safari

Basic Operations
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- Turn on the assignable switch to which the 
Rec function has been assigned (see 
page 165).

During recording, the TALLY indicators, the 
tally indicator on the front panel of the 
viewfinder, and the REC indication on the 
viewfinder screen light. Adjust the zoom and 
focus as required.

Notes

• Never remove the battery pack while the 
camcorder is recording (while the ACCESS lamp 
on the right-side panel is lit in blue and the 
ACCESS lamp in the card slot section is lit in 
orange). Doing so risks the loss of several 
seconds of data before the recording was 
interrupted, because internal processing will not 
end normally.

• The playback control buttons (EJECT, F REV, F 
FWD, NEXT, PREV, PLAY/PAUSE, STOP) do 
not function during recording.

10 To stop recording, perform one of the 
operations listed in step 9.
The TALLY indicators, the tally indicator on 
the front panel of the viewfinder, and the 
REC indication on the viewfinder screen go 
out, and camcorder enters recording standby 
(STBY) mode.
A clip is created from the video and audio 
data and the metadata recorded in steps 9 and 
10.

To check the recording (recording review)
With the camcorder in recording standby 
(STBY) mode, turn on the assignable switch 
to which the Rec Review function or the 
Freeze Mix function has been assigned (see 
page 164).
The camcorder plays the entire last clip, or 
the last few seconds of that clip (3 seconds or 
10 seconds), and then returns to standby 
mode.
When the Rec Review function is assigned to 
the RET button on the lens, you can also 
conduct a review by using the RET button.

11 Repeat steps 9 and 10 to continue 
recording.
With each repetition, another clip is created 
on the memory card.

Notes

• You cannot resume recording for about one second 
after stopping recording.

• The maximum number of clips that can be recorded on 
one memory card is 600. Even if the memory card has 
enough free capacity to record more clips, when 600 
clips have been recorded, no further recording is 
possible.

Clip file sizes
Clip file sizes vary according to file formats.

If you continue recording for an extended period, 
recorded materials may be segmented into 
multiple files, depending on the file size (the 
maximum number of partitions is 99).
The camcorder regards MP4 and AVI files as one 
clip even if it has been segmented into multiple 
files.

Clip names
Eight-character clips names (consisting of a four-
character prefix and a four-digit number) are 
generated automatically for clips recorded by this 
camcorder.
Example: ABCD0001
You can also use “OPERATION” > “Clip” > 
“Title Prefix” (see page 135) in the setup menu to 
set the clip name prefix to a user-specified string 
of characters (four to 46 characters in length). (A 
user-specified prefix cannot be changed after 
recording.)
The four-digit number at the end of clip names is 
generated automatically, counting up in order as 
clips are recorded.

File format File size Clip size
MP4 Less than 4 GB Less than 

30 minutes

AVI Less than 2 GB Less than 
9 minutes and 
30 seconds

MXF Less than 43 GB Less than 
6 hours

Clip 1 Clip 2 Clip 3
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When the camcorder is in standby (STBY) mode, 
you can play all or part of the most recently 
recorded clip (see page 88).

1 Insert the SxS memory card to play (see 
page 63).

2 Press the PREV button (see page 15) or 
the F REV button (see page 15) to cue 
up the clip to play.

3 Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator lights, and the 
playback picture appears in the viewfinder.

To pause the playback
Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator flashes during 
pause.
Press the button again to return to playback mode.

To play at high speed
Press the F FWD button (see page 15) or the F 
REV button (see page 15).
To return to normal playback, press the PLAY/
PAUSE button.

To switch between memory cards
When two memory cards are loaded, press the 
SLOT SELECT button (see page 19) to select the 
active slot.
It is not possible to switch between memory cards 
during playback.

To stop playback
Press the STOP button: Playback stops, and the 

camcorder enters E-E mode.
Press the THUMBNAIL button: Playback 

stops, and a thumbnail screen (see page 101) 
appears in the viewfinder.

Playback also stops and the timecode screen 
appears in the viewfinder when you start 
recording during playback, and when you eject an 
SxS memory card.

You can use the assignable switches to delete the 
last recorded clips (Last Clip DEL function).

You can also use the THUMBNAIL menu to delete all 
recorded clips (All Clips DEL function) or to delete 

selected clips. For details, see “Deleting Clips” 
(page 109).

1 Turn on the assignable switch to which 
the Last Clip DEL function has been 
assigned (see page 165).
A confirmation message appears.

2 Turn the MENU knob to select 
“Execute” and press the knob.

Playing Recorded Clips

Deleting Recorded Clips
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On this camcorder, two types of shot marks are 
available in HD mode. You can record them at 
user-specified positions to make it easier for 
editors to cue up those positions.
You can record up to 127 shot marks per clip.

Note

Shot marks cannot be recorded in SD mode.

You can also use the THUMBNAIL menu to add and 
delete shot marks in clips. For details, see “Adding 
and Deleting Shot Marks (UDF/exFAT/FAT-HD 
Mode Only)” (page 111).

To record shot marks
Do one of the following.
• Turn on an assignable switch to which Shot 

Mark 1 or Shot Mark 2 has been assigned (see 
page 164).

• If Lens RET has been assigned to the RET 
button on the lens, operate as follows.
To record shot mark 1: Press the RET button 

once.
To record shot mark 2: Press the RET button 

twice in quick succession.

When a shot mark is recorded, a “Shot Mark 1” or 
“Shot Mark 2” indication appears in the 
viewfinder for about three seconds near the 
timecode indication.

As a guide for selecting clips during editing, you 
can set OK marks in clips recorded in HD mode.

Notes

• OK marks cannot be set in SD mode.
• OK marks cannot be set or deleted during recording or 

playback.

To add/delete OK marks
You can also use the THUMBNAIL menu to add 
and delete OK marks in previously recorded clips. 

For details, see “Adding/Deleting the OK Mark 
(FAT-HD Mode Only)” (page 108).

The camcorder is equipped with enough internal 
memory to pre-store up to 15 seconds of video 
and audio data in a picture cache. This allows you 
to begin recording a specified number of seconds 
in advance of the time when you press a recording 
start button.

Selecting picture cache mode and setting 
the picture cache time
Before recording in picture cache mode, you need 
to perform the “Picture Cache Rec” and “P. 
Cache Rec Time” settings in the “OPERATION” 
menu (see page 125).
You can also select picture cache mode by using 
an assignable switch to which the Picture Cache 
function has been assigned (see page 164).
The picture cache time determines how far in 
advance you can start recording, counting back in 
seconds from the operation that starts recording. 
Note that it may not be possible to start this far in 
advance in the special cases explained in the 
following notes.

Notes

• Storage of picture data to memory begins when you 
select picture cache mode. Therefore, if you start 
recording immediately after selecting picture cache 
mode, the picture data from before the selection is not 
recorded.

• No data is recorded to picture cache memory during 
playback, recording review, or during thumbnail 
display. It is not possible to record picture data from 
the time you were conducting playback or a recording 
review.

• The Picture Cache Rec function cannot be used at the 
same time as the Interval Rec, Frame Rec, Slow & 
Quick Motion, Clip Continuous Rec, or 2-slot Simul 
Rec function. When you select one of those modes, the 
previously selected function is disabled automatically.

• The data stored in memory is cleared when you change 
the system settings, for example by selecting a 
different video format. Picture data from before the 
change is not recorded even if you start recording 
immediately after the change. The camcorder exits 
picture cache mode automatically.

• It is not possible to set the picture cache time during 
recording.

Advanced Operations

Recording Shot Marks

Setting OK Marks

Recording Cached Video (Picture 
Cache Rec Function)
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• When “OPERATION” > “Format” > “Rec Format” is 
set to “XAVC-l,” the Picture Cache time can be set up 
to 4 seconds.

Camcorder operation when recording in picture 
cache mode
Recording procedures in picture cache mode are 
basically the same as normal recording 
procedures. However, note the following 
differences with respect to how the camcorder 
handles video, time, and output data.
• If you start recording while the media is being 

accessed, the start point of the video that is 
actually recorded may be later than the 
currently specified picture cache time. Because 
the delay increases as the number of recorded 
clips increases, you should avoid rapid start-
and-stop recording operations in picture cache 
mode.

• Regardless of the setting of the F-RUN/SET/R-
RUN switch, the advance mode of the internal 
timecode generator is always F-RUN.

• In picture cache mode, you cannot set time data 
by setting the F-RUN/SET/R-RUN switch to 
SET.
To set time data, first exit picture cache mode.

• If the remaining free capacity of the media in 
the currently selected slot is less than the picture 
cache time, and the media in the other slot has 
enough remaining capacity, then data is 
recorded to the media in the other slot.
However, no data is recorded when there is no 
media in the other slot, and when the media in 
the other slot does not have enough remaining 
capacity. (A message appears in the viewfinder 
to inform you that there is not enough remaining 
capacity.)

• Shot marks are not recorded if they are set 
before the recording start operation.

• When you select a video format that supports 
i.LINK HDV output and play a clip that was 
recorded in picture cache mode, two or more 
frames with the same picture and timecode may 
follow on each other.

• i.LINK output is possible during picture cache 
recording. However, the picture cache time is 
limited.

If power is lost during recording
• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 
automatically after a few seconds, during which 
the media is accessed to record the video and 

audio data stored in the camcorder’s memory up 
to that point.

• If power is lost because the battery was 
removed, the DC cable was disconnected, or the 
power was turned off on the AC adaptor side, 
then the video and audio data stored in memory 
is lost. The data stored in memory is not 
recorded. Be careful to avoid this when 
exchanging the battery.

The camcorder’s Interval Rec function allows 
you to capture time-lapse video to the 
camcorder’s internal memory. This function is an 
effective way to shoot slow-moving subjects.
When you start recording, the camcorder 
automatically records a specified number of 
frames at a specified interval time.

A pre-lighting function is available when Interval 
Rec is enabled. This function automatically turns 
on a video light before recording starts, which 
allows you to record pictures under stable light 
and color temperature conditions.

Interval Rec settings and shooting
Before recording in Interval Rec mode, you need 
to perform the “Interval Rec,” “Number of 
Frames,” “Interval Time,” and “Pre-Lighting” 
settings in the “OPERATION” menu (see 
page 126).
The camcorder exits Interval Rec mode when it is 
powered off, but the “Number of Frames,” 
“Interval Time,” and “Pre-Lighting” settings are 

Recording Time-lapse Video 
(Interval Rec Function)

Interval time

Number of frames in one take
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maintained. You do not need to set them again the 
next time you shoot in Interval Rec mode.

Notes

• The Interval Rec function cannot be used at the same 
time as the Picture Cache Rec, Frame Rec, Slow & 
Quick Motion, Clip Continuous Rec, or 2-slot Simul 
Rec function. When you select one of those modes, the 
previously selected function is disabled automatically.

• The data stored in memory is cleared when you change 
the system settings, for example by selecting a 
different video format. Picture data from before the 
change is not recorded even if you start recording 
immediately after the change. The camcorder exits 
picture cache mode automatically.

• Interval Rec settings cannot be changed during 
recording.

• Interval Rec is disabled when the following formats 
are selected.
- SP 1440/59.94i or SP 1440/50i, when the output 

setting is HD and “OPERATION” > “Input/Output” 
> “i.LINK I/O” in the setup menu is set to “Enable”

- SP 1440/23.98P (pull-down recording)
- Other than HQ 1920/23.98P or HQ 1280/23.98P, 

when the output setting is SD and “OPERATION” > 
“Input/Output” > “i.LINK I/O” in the setup menu is 
set to “Enable”

• If you want to turn the video light on before the start of 
recording, set the camcorder’s LIGHT switch to 
AUTO. The video light’s switch must also be turned 
on. When this is done, the video light turns on and off 
automatically. However, the video light remains lit 
when the time that it is off is five seconds or less.

• If you set the LIGHT switch to MANUAL and turn the 
video light’s switch on, the video light is always lit. (It 
does not go on and off automatically.)

To shoot in Interval Rec mode
Make the settings and preparations described in 
“Basic Operations” (page 87), secure the 
camcorder so that it does not move, and begin 
shooting.

When recording starts, the “Interval” indication 
in the viewfinder changes from flashing to lit, and 
“INT REC” and “INT STBY” appear 
alternatively at the position of the REC 
indication. The TALLY indicators and the tally 
indicator on the front panel of the viewfinder light 
as they do during normal recording.
If you are using the pre-lighting function, the 
video light comes on before recording starts.

Limitations during recording
• The i.LINK (HDV/DV) connector cannot be 

used.

• Regardless of the setting of the F-RUN/SET/
R-RUN switch, the advance mode of the 
internal timecode generator is always R-RUN.

• Audio cannot be recorded.
• Recording review is not possible.
• If you press the SLOT SELECT button, the 

camcorder completes recording of the specified 
number of frames, creates a clip, and switches 
to the other media.

• Genlock is not possible.

If power is lost during recording
• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 
automatically after a few seconds, during which 
the media is accessed to record the video and 
audio data stored in the camcorder’s memory up 
to that point.

• If power is lost because the battery was 
removed, the DC cable was disconnected, or the 
power was turned off on the AC adaptor side, 
then the video and audio data shot up to that 
point may be lost (maximum 15 seconds). Be 
careful to avoid this when exchanging the 
battery.

The Frame Rec function is useful for shooting 
stop motion animations, such as animations with 
puppets or clay figures.
Each time that you press the recording start 
button, the camcorder shoots a specified number 
of frames and then stops.

Frame Rec settings and shooting
Before recording in Frame Rec mode, you need to 
perform the “Frame Rec” and “Number of 
Frames” settings in the “OPERATION” menu 
(see page 126).
The camcorder exits Frame Rec mode when it is 
powered off, but the setting for the number of 
frames setting is maintained. You do not need to 
set it again the next time you shoot in Frame Rec 
mode.

Notes

• The Frame Rec function cannot be used at the same 
time as the Picture Cache Rec, Interval Rec, Slow & 
Quick Motion, Clip Continuous Rec, or 2-slot Simul 

Shooting Stop Motion Animations 
(Frame Rec Function)
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Rec function. When you select one of those modes, the 
previously selected function is disabled automatically.

• The data stored in memory is cleared when you change 
the system settings, for example by selecting a 
different video format. Picture data from before the 
change is not recorded even if you start recording 
immediately after the change. The camcorder exits 
Frame Rec mode automatically.

• Frame Rec settings cannot be changed during 
recording.

• Frame Rec is disabled when the following formats are 
selected.
- SP 1440/59.94i or SP 1440/50i, when the output 

setting is HD and “OPERATION” > “Input/Output” 
> “i.LINK I/O” in the setup menu is set to “Enable”

- SP 1440/23.98P (pull-down recording)
- Other than HQ 1920/23.98P or HQ 1280/23.98P, 

when the output setting is SD and “OPERATION” > 
“Input/Output” > “i.LINK I/O” in the setup menu is 
set to “Enable”

To shoot in Frame Rec mode
Make the settings and preparations described in 
“Basic Operations” (page 87), secure the 
camcorder so that it does not move, and begin 
shooting.

When recording starts, the “Frame Rec” 
indication in the viewfinder changes from 
flashing to lit, and “FRM REC” and “FRM 
STBY” appear alternatively at the position of the 
REC indication. The TALLY indicators and the 
tally indicator on the front panel of the viewfinder 
light as they do during normal recording.

Limitations during recording
• The i.LINK (HDV/DV) connector cannot be 

used.
• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 
internal timecode generator is always R-RUN.

• Audio cannot be recorded.
• Recording review is not possible.
• If you press the SLOT SELECT button, the 

camcorder completes recording of the specified 
number of frames, creates a clip, and switches 
to the other media.

• Genlock is not possible.

If power is lost during recording
• If you set the camcorder’s POWER switch to 

OFF, the camcorder is powered off 
automatically after a few seconds, during which 
the media is accessed to record the video and 

audio data stored in the camcorder’s memory up 
to that point.

• If power is lost because the battery was 
removed, the DC cable was disconnected, or the 
power was turned off on the AC adaptor side, 
then the video and audio data shot up to that 
point may be lost (maximum 15 seconds). Be 
careful to avoid this when exchanging the 
battery.

When the video format (see page 45) is set to one 
of the formats listed below, you can specify a 
recording frame rate that is different from the 
playback frame rate.
When the “Country” setting is “NTSC Area”/
”NTSC(J) Area” 

When the “Country” setting is “PAL Area” 

Shooting with Slow & Quick 
Motion

Recording format System frequency
XAVC-I 1920/29.97P

1920/23.98P
1280/59.94P

XAVC-L50 1920/29.97P
1920/23.98P
1280/59.94P

XAVC-L35 1920/29.97P
1920/23.98P

HD422 50/1920/29.97P
50/1920/23.98P
50/1280/59.94P
50/1280/29.97P
50/1280/23.98P

HQ 1920/29.97P
1920/23.98P
1280/59.94P
1280/29.97P
1280/23.98P

Recording format System frequency
XAVC-I 1920/25P

1280/50P

XAVC-L50 1920/25P
1280/50P

XAVC-L35 1920/25P

HD422 50/1920/25P
50/1280/50P
50/1280/25P
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Slow & Quick Motion settings and 
shooting
Before recording in Slow & Quick Motion mode, 
you need to perform the “Slow & Quick” and 
“Frame Rate” settings in the “OPERATION” 
menu (see page 125).
When you finish making these settings, the 
system frequency and the frame rate appear at the 
top of the viewfinder screen. You can change the 
frame rate while viewing the display in the 
viewfinder by turning the MENU knob.
The Slow & Quick Motion mode setting and the 
frame rate are retained even after the camcorder is 
powered off.

To set the frame rate using the Direct menu
You can set the frame rate using the Direct menu 
if a special recording mode is set for display on 
the viewfinder screen (“OPERATION” 
>“Display On/Off” >“Rec Mode” is set to “On” 
in the setup menu) (page 29)

Notes

• The Direct menu function cannot be used while 
shooting in a special recording mode.

• The Slow & Quick Motion function cannot be used at 
the same time as the Picture Cache Rec, Interval Rec, 
Frame Rec, Clip Continuous Rec, or 2-slot Simul Rec 
function. When you select one of those modes, the 
previously selected function is disabled automatically.

• Slow & Quick Motion is disabled when the slow 
shutter function (viewfinder display “SLS”) function is 
enabled. The slow shutter function is disabled when 
the Slow & Quick Motion function is enabled.

• Slow & Quick Motion is disabled when 
“OPERATION” > “Input/Output” > “i.LINK I/O” in 
the setup menu is set to “Enable.” When Slow & Quick 
Motion is enabled, “i.LINK I/O” is fixed as “Disable.”

• Slow & Quick Motion settings cannot be changed 
during recording.

To shoot in Slow & Quick Motion mode
Shoot as described in “Basic Operations” 
(page 87).

When recording starts, the “S&Q STBY” 
indication in the viewfinder changes to the 
“zS&Q REC” indication. The TALLY 
indicators and the tally indicator on the front 

panel of the viewfinder light as they do during 
normal recording.

Limitations during recording
• The i.LINK (HDV/DV) connector cannot be 

used.
• Regardless of the setting of the F-RUN/SET/

R-RUN switch, the advance mode of the 
internal timecode generator is always R-RUN.

• Audio cannot be recorded when the recording 
and playback frame rates differ.

• Recording review is not possible.
• If you change the recording frame rate to a value 

faster than the current shutter speed, the shutter 
speed is changed to the slowest value for which 
shooting is possible.
Example: If the frame rate is 32 and the shutter 
speed is 1/40, and you change the frame rate to 
55, then the shutter speed is changed to 1/60.
If is not possible to select a shutter speed that is 
slower than the recording frame rate.

• Genlock is not possible.

Normally, a clip is created as an independent file 
each time that you start and stop recording. This 
function allows you to start and stop recording 
while continuously recording to the same clip, for 
as long as the function remains enabled. This is 
convenient when you do not want to generate a 
large number of short clips, and when you want to 
record without worrying about exceeding the clip 
limit. It is still easy to find recording start points, 
because a Rec Start essence mark is recorded at 
the recording start point each time you start 
recording.

Clip Continuous Rec settings and 
shooting

Notes

• The Clip Continuous Rec function cannot be used at 
the same time as the Picture Cache Rec, Interval Rec, 
Frame Rec, Slow & Quick Motion, or 2-slot Simul Rec 
function. When you select one of those modes, the 
previously selected function is disabled automatically.

• The Clip Continuous Rec function is disabled when the 
recording mode is FAT.

HQ 1920/25P
1280/50P
1280/25P

Recording format System frequency

Recording with the Clip 
Continuous Rec Function
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To set Clip Continuous Rec

1 Select “OPERATION” > “Rec 
Function” > “Clip Continuous Rec” in 
the setup menu.

For details about menu operations, see “Basic 
Setup Menu Operations” (page 115).

2 Turn the MENU knob to select “On,” 
and then press the knob.
The “CONT” indication flashes in the 
viewfinder, and the function is enabled.

You can assign the Clip Continuous Rec on/off 
function to one of the ASSIGN. 1/2/3 switches, 
ASSIGNABLE 4/5 switches, and the COLOR 
TEMP button.

For details, see “Assigning Functions to Assignable 
Switches” (page 164).

To shoot in Clip Continuous Rec mode
Shoot as described in “Basic Operations” 
(page 87).
When recording starts, the “CONT” indication in 
the viewfinder changes to “zREC” indication.
The TALLY indicators and the tally indicator on 
the front panel of the viewfinder light as they do 
during normal recording.

Note

During recording or in recording standby mode 
(when the “CONT” indication is lit), if you 
remove the media, the battery, or the power 
source, the media needs to be restored. It is not 
possible to restore media on a device other than 
this camcorder.
Exit Clip Continuous Rec mode (see page 95) and 
then remove the media.
When the “CONT” indication is flashing (at 1 
flash/s), you can remove the media.

To stop shooting
Stop the recording. The camcorder changes to the 
recording standby mode (STBY) and the 
“CONT” indication lights up.

Note

Stop the recording after the recording continues 
for two or more seconds.

To exit Clip Continuous Rec mode
With the camcorder in recording standby mode, 
set “OPERATION” > “Rec Function” > “Clip 
Continuous Rec” in the setup menu to “Off.”

Limitations during recording
A single continuous clip cannot be created if you 
perform one of the following operations while the 
camcorder is in recording or recording standby 
mode (a new clip will be created when you next 
start recording.)
• Operate on a clip (lock, delete, or rename a clip)
• Change the slot
• Change the recording format
• Turn off the POWER switch
• Playback
• Switch to thumbnail mode

You can record to two card slots simultaneously.
This function is used to create a video backup 
while shooting.

Notes

• Use media of the same type and same size when 
recording to two slots simultaneously.

• The use of SxS memory cards is recommended as the 
media.

• It is recommended that the media be formatted 
(initialized) on the camcorder before use.

• SDHC cards are not supported for 2-slot simultaneous 
recording.

Supported media
SxS memory cards
XQD memory cards
SDXC cards (exFAT only)

Supported formats
The following UDF/HD or exFAT/HD formats 
are supported, set using “OPERATION” 
>“Format” in the setup menu.

UDF/HD

Recording to 2 Slots 
Simultaneously (2-Slot Simul Rec 
Function)

OPERATION >Format in setup menu
HD System 
Line

System 
Frequency

Rec Format

1080 59.94i/50i HD422 50

HD420 HQ1920

HD420 HQ1440

29.97P/25P/
23.98P

HD422 50

HD420 HQ1920

HD420 HQ1440
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exFAT/HD

Shooting in 2-slot Simul Rec mode

1 Insert media in both card slot A and 
card slot B.

2 Set “OPERATION” > “Rec Function” 
> “Simul Rec” to “Simul” in the setup 
menu.
The recording mode/operation status 
indicator (page 25) changes to “SML STBY” 
on the viewfinder screen.

3 Start recording as described in step 9 of 
“Basic Operations” (page 87).
When recording starts, the “SML STBY” 
indication on the viewfinder screen changes 
to “zSML REC” indication.

4 Stop recording as described in step 9 of 
“Basic Operations” (page 87).

Notes

• The 2-slot Simul Rec function cannot be used at the 
same time as the Picture Cache Rec, Interval Rec, 
Frame Rec, Slow & Quick Motion, or Clip Continuous 
Rec function.

• The 2-slot Simul Rec function cannot be set during 
recording, playback, or thumbnail display.

• If one of the cards in the slots becomes full during 
recording, normal recording to the other card will 
continue for as long as possible. Even if the card is 
replaced while normal recording is in progress, 
simultaneous or relay recording will not be performed.

• If a card was inserted in only one of the slots or if one 
of the cards was full when simultaneous recording to 
both slots was started, normal recording to the 
available card will be performed.

• The IFU-WLM3 cannot be used when recording 
simultaneously to both slots.

The freeze mix function allows you to 
temporarily overlap a still image (freeze picture) 
from a clip shot in HD mode onto the current 
camera picture. This makes it easier to frame the 
shot.

Note

The freeze mix function is not available in the following 
cases.
• When the recording format is SP 1440/23.98P
• When the video formats of the recorded picture and the 

camera picture differ
• When you are shooting in Slow & Quick Motion mode 

or slow shutter mode
• When there is i.LINK input

To display a freeze mix picture

1 Play a clip or conduct a recording 
review of a clip with the same format as 
the camera picture.

2 Display the picture that you want to use 
as the frame, and then turn on the 
assignable switch to which the Freeze 
Mix function has been assigned.
The recording review picture is frozen and 
overlaps the camera picture.

720 59.94P/50P HD422 50

HD420 HQ1280

29.97P/25P HD422 50

23.98P HD422 50

HD420 HQ1280

OPERATION >Format in setup menu
HD System 
Line

System 
Frequency

Rec Format

1080 59.94i/50i XAVC-I

XAVC-L50

XAVC-L35

XAVC-L25

HD422 50

HD420 HQ1920

HD420 HQ1440

29.97P/25P/
23.98P

XAVC-I

XAVC-L50

XAVC-L35

HD422 50

HD420 HQ1920

HD420 HQ1440

720 59.94P/50P XAVC-I

XAVC-L50

HD422 50

HD420 HQ1280

29.97P/25P HD422 50

23.98P HD422 50

HD420 HQ1280

OPERATION >Format in setup menu
HD System 
Line

System 
Frequency

Rec Format

Framing Shots with the Freeze 
Mix Function
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Note

The following functions are disabled at the freeze mix 
times.
• Menu operations
• During Focus Mag display
• Marker display
• Zebra display
• Peaking display
• Skin detail display

To cancel the freeze mix display
Do one of the following.
• Press an assignable switch again to which the 

Freeze Mix function has been assigned.
The freeze mix display is canceled and the 
display returns to the normal camera picture.

• Start recording (see page 87).
Normal recording starts.

Planning metadata is information about shooting 
and recording plans, recorded in an XML file.

Example of a planning metadata file

You can shoot using clip names and shot mark 
names defined in advance in a planning metadata 
file.
The camcorder can display clip names and shot 
mark names defined in the following languages.
• English
• Chinese
• German
• French 1)

• Italian
• Spanish
• Dutch 1)

• Portuguese
• Swedish
• Norwegian
• Danish
• Finnish 1)

1) Some characters may be displayed in a similar font.

Note

If you define clip name and shot mark names in 
languages other than the above, they may not be 
displayed on the viewfinder screen.

To record planning metadata together with 
recording clips, you need to load a planning 

Planning Metadata 
Operations

Loading a Planning Metadata File 
into Camcorder’s Internal Memory
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metadata file into the camcorder’s memory before 
starting to shoot.
There are two ways to load files.
• Load a file that has been written to the following 

directories on an SxS memory card or a USB 
flash drive.

• When a wireless LAN connection is made 
between the camcorder and a device, operate 
the Web menu built in the camcorder from the 
device to transfer a file.

To load a planning metadata file by menu 
operation
Do the following procedures with 
“OPERATION” > “Planning Metadata” in the 
setup menu.

To load a file in an SxS memory card

1 Insert an SxS memory card into the 
memory card slot A or B, and set 
“Load/Slot(A)” or “Load/Slot(B)” to 
“Execute.”
A file list appears.

Note

The file list displays up to 64 files. Even if the total 
number of planning metadata files is 64 or less, all 
of the planning metadata files may not appear if the 
directory where they are located on the SxS 
memory card (General/Sony/Planning) contains 
512 or more files.

2 Turn the MENU knob to select a file to 
load and press the knob.

To load a file in a USB flash drive (UDF, exFAT 
modes)

1 Connect a USB flash drive formatted 
with the FAT32 file system to the 
external device connector (see page 68).
A file list appears.

Note

The file list displays up to 64 files. Even if the total 
number of planning metadata files is 64 or less, all 
of the planning metadata files may not appear if the 
directory where they are located on the USB flash 
driver (General/Sony/Planning) contains 512 or 
more files.

2 Turn the MENU knob to select a file to 
load and press the knob.

To display detailed information in 
planning metadata
After loading planning metadata into the 
camcorder, you can check the detailed 
information that it contains, such as file names, 
date and time of creation, and titles.
Select “OPERATION” > “Plan.Metadata” > 
“Properties” (see page 136) in the setup menu, 
then select “Execute.”

To clear the planning metadata loaded
Select “OPERATION” > “Plan.Metadata” > 
“Clear” (see page 136) in the setup menu, then 
select “Execute.”

The following two types of clip name strings can 
be written in a planning metadata file.
• The ASCII format name that appears in the 

viewfinder
• The UTF-8 format name that is actually 

registered as the clip name

Select “OPERATION” > “Plan.Metadata” > 
“Clip Name Disp” (see page 136) in the setup 
menu, then select which type of clip name is 
displayed.
When a clip name is set with planning metadata, 
the name is displayed under the depth of field 
indication on the viewfinder screen.

Recording 
mode

Media Directory to 
which files are 
written

FAT SxS memory 
card

BPAV/General/
Sony/Planning

SDHC PRIVATE/SONY/
BPAV/General/
Sony/Planning

exFAT SxS memory 
card

XDROOT/
General/Sony/
Planning 

USB flash drive General/Sony/
Planning

UDF SxS memory 
card

General/Sony/
Planning

USB flash drive

Defining Clip Names in Planning 
Metadata
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Clip name string example
Use a text editor to modify the two fields in the 
<Title> tag that contain the clip name strings.
The shaded fields in the example are clip name 
strings. “Typhoon” is described in ASCII format 
(up to 44 characters). “Typhoon_Strikes_Tokyo” 
is described in UTF-8 format (up to 44 bytes).
“sp” indicates a space and 3 indicates a carriage 
return.

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2011-08-20T17:00:00+09:00"sp
lastUpdate="
2011-09-28T10:30:00+09:00"sp
version="1.00">3

<PropertiessppropertyId="
assignment"spupdate="
2011-09-28T10:30:00+09:00"sp
modifiedBy="Chris">3

<TitlespusAscii=" "sp
xml:lang="en">
</Title>3

</Properties>3

</PlanningMetadata>3

Notes

• When you create a file, enter each statement as a single 
line with a CRLF only after the last character in the 
statement line, and do not enter spaces except where 
specified.

• Up to 44 bytes (or characters) string is available for the 
clip name.
If the UTF-8 format string exceeds 44 bytes, 44 bytes 
string is used as the clip name.
If only ASCII format name is specified, 44 characters 
string is used as the clip name.
When neither an ASCII format name string nor UTF-8 
format name string can be used, the standard format 
clip name is used.

To set clip names
Load a planning metadata file that contains clip 
names into this camcorder, select 
“OPERATION” > “Clip” > “Auto Naming” (see 
page 134) in the setup menu, then select “Plan.”
Each time that you record a clip, the camcorder 
automatically generates a name consisting of the 

clip name defined in the planning metadata file, 
with the addition of an underbar (_) and a four-
digit serial number (0001 to 9999).
Examples: Typhoon_Strikes_Tokyo_0001, 
Typhoon_Strikes_Tokyo_0002, ...

Notes

• When the serial number reaches to 9999, it returns to 
0001 with the next recording operation.

• When you load another planning metadata file, the 
serial number returns to 0001.

When you use planning metadata to set shot 
marks, you can define names for Shot Mark 0 to 
Shot Mark 9.
When you record shot marks, you can add the 
shot mark name strings defined in the planning 
metadata.

Note

Shot Mark 1 and Shot Mark 2 can be recorded on the 
camcorder. Shot Mark 3 to Shot Mark 9 and Shot Mark 
0 can be recorded by operation from a device which is 
connected with the camcorder via wireless LAN.

Shot mark name string example
Use a text editor to modify the fields in the <Meta 
name> tag.
The shaded fields in the example are essence 
mark name strings. Names can be either in ASCII 
format (up to 32 characters) or UTF-8 format (up 
to 16 characters).
“sp” indicates a space and 3 indicates a carriage 
return.

Note

If a name string contains even one non-ASCII character, 
the maximum length of that string is 16 characters.

<?xmlspversion="1.0"spencoding="
UTF-8"?>3

<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
H00123"spcreationDate="
2011-04-15T08:00:00Z"splastUpdate="
2011-04-15T15:00:00Z"spversion=
"1.00">3

<PropertiessppropertyId=
"assignment"spclass="original"sp

Typhoon
Typhoon_Strikes_Tokyo

Defining Shot Mark Names in 
Planning Metadata
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update="2011-04-15T15:00:00Z"sp
modifiedBy="Chris">3

<TitlespusAscii="Football
Game"spxml:lang="en">
Football Game 15/04/2011</
Title>3

<Metaspname="_ShotMark1"sp
content=" "/>3

<Metaspname="_ShotMark2"sp
content=" "/>3

<Metaspname="_ShotMark3"sp
content=" "/>3

<Metaspname="_ShotMark4"sp
content=" "/>3

<Metaspname="_ShotMark5"sp
content=" "/>3

<Metaspname="_ShotMark6"sp
content=" "/>3

<Metaspname="_ShotMark7"sp
content=" "/>3

<Metaspname="_ShotMark8"sp
content=" "/>3

<Metaspname="_ShotMark9"sp
content=" "/>3

<Metaspname="_ShotMark0"sp
content=" "/>3

</Properties>3

</PlanningMetadata>3

Note

When you create a definition file, enter each statement as 
a single line with a CRLF only after the last character in 
the statement line, and do not enter spaces except where 
specified, except within shot mark name strings.

Goal

Shoot

Corner Kick

Free Kick

Goal Kick

Foul

PK

1st Half

2nd Half

Kick Off
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A thumbnail screen appears if you press the THUMBNAIL button in E-E or playback mode. Thumbnail 
screens display lists of the clips stored on SxS memory cards in the form of index pictures. (A message 
appears if you insert a memory card that contains no clips.)
You can select any clip (see page 102) in a thumbnail screen and start playback of that clip (see page 102).
To exit the thumbnail screen, press the THUMBNAIL button again.

In thumbnail screens, the timecode of the index picture appears beneath the thumbnail for each clip. (An 
OK mark also appears when a clip has been marked with an OK mark.)
The clip information on the cursor location is displayed at the bottom of the screen.

a Index picture
UDF, exFAT, FAT-HD mode: When a clip is 
recorded, its first frame is set automatically as the 
index picture. You can change the index picture 
to any frame (see page 111). If the clip is locked 

or the OK mark is on the clip, the lock mark  
appears.
FAT-SD mode: When a clip is recorded, its first 
frame is set automatically as the index picture. If 
the file size is larger than 2 GB, and that the clip 

Chapter5 Clip Operations

Clip Playback

Thumbnail Screen

Clip number/Number of clips

Cursor 
(yellow)

The icon of the currently selected SxS memory card is highlighted.
(If the card is write protected, a lock mark appears on the left.)
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has been split before being saved, the take mark 
 appears. You can check the segment files on 

the expand thumbnail screen (see page 109).

b Date and start time of recording

c Clip name
The number after the clip name (delimited by /) is 
the number of components. This appears only for 
clips larger than 2 GB in size, which have been 
split into smaller files for storage in the FAT-SD 
mode.

d Lock mark (UDF, exFAT, and FAT-HD 
mode only)

Indicates the selected clip is marked with an OK 
mark.

e Independent AV file icon (UDF, exFAT, 
and FAT-HD mode only)

Appears only when a clip is an independent AV 
file. SxS memory cards may contain independent 
files that have been added directly from a 
computer. Because independent files lack the 
associated management files, some operations 
and information displays may not be available.

f Video format of recording

g Special recording information (UDF, 
exFAT, and FAT-HD mode only)

Displays the mode of clips that have been 
recorded in a special mode (Slow & Quick 
Motion, Interval Rec, Frame Rec).
For Slow & Quick Motion clips, the frame rates 
are displayed to the right as “Recording frame 
rate/Playback frame rate” fps.

h OK, NG, KP mark (UDF, exFAT, and 
FAT-HD mode only)

UDF, exFAT: When an OK, NG, or KP flag is 
added to the selected clip, the corresponding mark 
is added to the clip.
FAT-HD mode: When an OK mark is added to 
the selected clip, the OK mark is added to the clip.

i File format
Indicates the file format of the selected clip 
(MXF, MP4, AVI). (File format does not indicate 
when in UDF/HD mode.)

j Clip duration

k Timecode
This is the timecode of the index picture.

Note

Normal thumbnail screens display SD clips only or HD 
clips only, even if the SxS memory card contains clips in 
both formats. You can select the format to display by 
selecting a mode with “OPERATION” > “Format” > 
“HD/SD” (see page 121) in the setup menu.
If you want to display all recorded clips, regardless of the 
HD/SD mode, switch to the all clips thumbnail screen 
(see page 106). However, it is not possible to start 
playback from the all clips thumbnail screen.

To switch between SxS memory cards
When two SxS memory cards are loaded, you can 
switch between them by pressing the SLOT 
SELECT button.

Note

While an expand thumbnail screen (see page 109) or a 
shot mark (essence mark) thumbnail screen (see 
page 110) is displayed, SxS memory cards cannot be 
switched.

To select clip thumbnails
Do one of the following to move the yellow 
cursor to the clip that you want to select.
• Press the arrow buttons (J, j, K, k).
• Turn the MENU knob.
• Press the PREV or NEXT button.

To select the first thumbnail
With the F REV button held down, press the 
PREV button.

To select the last thumbnail
With the F FWD button held down, press the 
NEXT button.

To play clips sequentially starting from a 
selected clip

1 Select the thumbnail of the clip that you 
want to play first.

2 Press the PLAY/PAUSE button.
Play begins from the top of the selected clip.

Playing Clips
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Play continues through all clips after the selected 
clip.
When the last clip has been played to the end, the 
camcorder enters pause (still image) mode at the 
last frame of the last clip.
Press the THUMBNAIL button to return to the 
thumbnail screen.

Playback also stops if you eject the memory card. 
In this case, the camera picture appears in the 
viewfinder.

Notes

• There may be momentary picture breakup or still 
image display at the transition from one clip to another. 
During this time, the playback controls and the 
THUMBNAIL button cannot be operated.

• When you select a clip in the thumbnail screen and 
begin playback, there may be momentary picture 
breakup at the top of the clip. To view the top of the 
clip without breakup, put the camcorder into playback 
mode, pause, use the PREV button to return to the top 
of the clip, and start playback again.

• On SxS memory cards that contain both HD-mode and 
SD-mode clips, you cannot play all clips in sequence. 
For example, while an HD mode thumbnail screen is 
displayed, only HD mode clips are played in sequence.

To cue up clips

To play from the top of the first clip
Simultaneously press the PREV and F REV 
buttons. This jumps to the start of the first clip on 
the SxS memory card.

To play from the start of the last clip
Simultaneously press the NEXT and F FWD 
buttons. This jumps to the start of the last clip on 
the SxS memory card.

To add a shot mark during play (HD mode 
only)
You can add shot marks to clips during play by 
using the same method used during recording (see 
page 90).

Notes

• Shot marks cannot be recorded when the SxS memory 
card is write protected.

• Shot marks cannot be added at the first frame of each 
clip or last frame of the last clip.

• Expand thumbnail screen
• Shot mark thumbnail screen (HD mode only)

Like the normal thumbnail screen and the OK clip 
thumbnail screen, these screens allow you to 
select clip thumbnails (see page 102) and to start 
clip playback (see page 102).

To search clips with the expand 
thumbnail screen
To display the expand thumbnail screen, select a 
clip in the thumbnail screen and press the 
EXPAND button (see page 16) or select 
“THUMBNAIL” > “Thumbnail View” > 
“Forward Expansion” in the setup menu. The 
selected clip is displayed as follows.
HD mode: The clip is divided into 12 equally-

sized blocks, and a thumbnail of the first 
frame in each block is displayed.

SD mode: Only in the case of clips that have been 
split into partial files because the file size was 
larger than 2 GB, a thumbnail of the first 
frame of each partial file is displayed.

For details about the expand thumbnail screen, see 
“Displaying the Expand Thumbnail Screen (UDF/
exFAT/FAT-HD Mode only)” (page 109).

To search for shot marks in clips with the 
shot mark thumbnail screen (HD mode 
only)
When a clip contains one or more shot marks, you 
can easily find them with the shot mark thumbnail 
screen. The shot mark thumbnail screen displays 
a thumbnail of each shot mark frame in the clip. 
To display the shot mark thumbnail screen, press 
the ESSENCE MARK button (see page 17) or 
select “THUMBNAIL” > “Thumbnail View” > 
“Essence Mark Thumbnail” in the setup menu.

For details about the shot mark thumbnail screen, 
see “Displaying the Shot Mark Thumbnail Screen 
(UDF/exFAT/FAT-HD Mode Only)” (page 110).

Using Thumbnails to Search 
Inside Clips
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You can use the THUMBNAIL menu to perform various operations on clips, to check clip properties, and 
to change clip metadata.

Thumbnail Operations

THUMBNAIL Menu Configuration

Menu item Sub-item Description

Clip Properties — Displays detailed properties (see page 107).

Set Index Picture — Changes index pictures in the expand 
thumbnail screen or the essence mark 
thumbnail screen (see page 111).

Thumbnail View Forward Expansion • Displays the expand thumbnail screen (see 
page 109).

• In the expand thumbnail screen, increases the 
number of divisions (see page 110).

Back Expansion In the expand thumbnail screen, decreases the 
number of divisions.

Essence Mark Thumbnail Displays the essence mark thumbnail screen 
(see page 110).

Clip Thumbnail Displays the normal thumbnail screen.

All Clip Thumbnail Displays the all clips thumbnail screen (see 
page 106).

Set Shot Mark Add Shot Mark1 In the expand thumbnail screen or the essence 
mark thumbnail screen, adds a Shot Mark1 
mark (see page 111).

Delete Shot Mark1 In the expand thumbnail screen or the essence 
mark thumbnail screen, deletes a Shot Mark1 
mark (see page 111).

Add Shot Mark2 In the expand thumbnail screen or the essence 
mark thumbnail screen, adds a Shot Mark2 
mark (see page 111).

Delete Shot Mark2 In the expand thumbnail screen or the essence 
mark thumbnail screen, deletes a Shot Mark2 
mark (see page 111).

Set Clip Flag OK Adds an OK mark.

NG Adds an NG mark.

KP(Keep) Adds a KP mark.

None Deletes an OK, NG. or KP mark.

Add OK Mark — Adds an OK mark and protects a clip (see 
page 108).

Delete OK Mark — Deletes an OK mark and unlocks a clip (see 
page 108).

UDF / exFAT / FAT-HD

UDF / exFAT / FAT-HD

UDF / exFAT / FAT-HD

UDF / exFAT

FAT-HD

FAT-HD
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Lock Clip — Protects a clip.

Unlock Clip — Unlocks a clip.

Copy Clip Copy Clip(A)/Copy 
Clip(B)/Copy Clip(USB)

Copies a clip (see page 108).

Delete Clip — Deletes a clip (see page 109).

Divide Clip — Divides a clip (see page 111).

Filter Clips — Displays the OK clip thumbnail screen (see 
page 106).

Filter Clips OK Displays the OK clip thumbnail screen.

NG Displays the NG clip thumbnail screen.

KP(Keep) Displays the KP clip thumbnail screen.

None Displays a None clip (clip which has not been 
marked OK, NG, or KP) thumbnail screen.

Lock All Clips — Protects all clips displayed.

Unlock All Clips — Unlocks all clips displayed.

Copy All All Clips Batch copies groups of clips/files (see 
page 108).General Files

All Clips & General Files

Delete All Clips Execute/Cancel Deletes all unprotected clips (see page 109).

Menu item Sub-item Description

UDF / exFAT

UDF / exFAT

FAT-HD

FAT-HD

UDF / exFAT

UDF / exFAT

UDF / exFAT
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For menu operations, see “Basic Setup Menu 
Operations” (page 115).

To display the THUMBNAIL menu

1 Press the THUMBNAIL button to 
display the thumbnail screen.

2 Set the MENU ON/OFF switch to ON, 
or press the MENU button.

3 Turn the MENU knob to select “TH,” 
and then press the knob. Or press the J 
or j button to select “TH,” and then 
press the SET button.
The THUMBNAIL menu appears.

To hide the THUMBNAIL menu, press the 
MENU button again.

To select menu items and sub-items
Do one of the following.
• Turn the MENU knob to select an item or sub-

item, and then press the knob.
• Press the arrow buttons (J, j, K, k) to 

select an item or sub-item, and then press the 
SET button.

According to the selected item or sub-item, a 
selection list or a clip properties screen appears 
(see page 107).
To return to the previous state, push the MENU 
CANCEL/PRST/ESCAPE switch down to the 
ESCAPE side.

Notes

• Some operations are not supported during partial 
transfer of an original file recorded on the camcorder 
(page 86).

• Some items cannot be operated, when an SxS memory 
card is write protected.

• Some items cannot be selected, depending on the state 
of the camcorder when the menu was displayed.

To hide the clip properties screen
Do one of the following.
Press the RESET/RETURN button: This 

returns to the THUMBNAIL menu.

Press the THUMBNAIL button: The 
camcorder enters E-E mode, and the camera 
picture appears.

Press the PLAY/PAUSE button: Playback from 
the selected clip starts.

To display OK clip thumbnails (HD mode 
only)
When the normal thumbnail screen is displayed, 
you can select “THUMBNAIL” > “Filter Clips” 
to switch to the OK clip thumbnail screen.

For details about adding OK marks, see “Adding/
Deleting the OK Mark (FAT-HD Mode Only)” 
(page 108).

OK/NG/KP/None-Clip thumbnail screen
Only the clips flagged OK/NG/KP, or clips with 
no flag (“None”), among the clips on the current 
SxS memory card are displayed. You can select 
the type of flag to display with “THUMBNAIL” 
> “Filter Clips” (see page 105).

To display the all clip thumbnail screen
When the normal thumbnail screen is displayed, 
you can switch to the all clips thumbnail screen 
by selecting “THUMBNAIL” > “All Clip 
Thumbnail.”

Pressing the RESET/RETURN button returns 
you to the normal thumbnails screen, where you 
can perform playback and other clip operations.

Note

You cannot start playback from the all clip thumbnail 
screen.

Basic THUMBNAIL Menu 
Operations

Changing the Thumbnail Screen 
Type
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Select “Clip Properties” in the THUMBNAIL menu.

a Image of the current clip

b Image of the previous clip
Press the PREV button to display the properties of 
the previous clip.

c Image of the next clip
Press the NEXT button to display the properties 
of the next clip.

d Clip name
When clip names are 12 characters or longer, only 
the first five characters and the last five characters 
are displayed. If you want to check the hidden 
characters, press the MENU knob to display all 
characters of the clip (long display mode).
Press the MENU knob again to exit long display 
mode. Pressing the PREV or NEXT button to 
display the previous or next clip also exists long 
display mode.
In FAT-SD mode, only for clips that have been 
divided because the file size was greater than 2 
GB, the number of component clips appears after 
the clip name.

e Lock mark (UDF, exFAT, and FAT-HD 
mode only)

This appears when the clip is marked with an OK 
mark or protected.

f OK, NG, KP mark (UDF, exFAT, and 
FAT-HD mode only)

UDF/exFAT: When an OK, NG, or KP flag is 
added to the selected clip, the corresponding mark 
is added to the clip.
FAT: When an OK mark is added to the selected 
clip, the OK mark is added to the clip.

g Date and start time of recording

h File format
The file format of the clip (MXF, MP4 or AVI) 
appears.

i Special recording information (UDF, 
exFAT, and FAT-HD mode only)

Displays the mode of clips that have been 
recorded in a special mode (Slow & Quick 
Motion, Interval Rec, Frame Rec).
For Slow & Quick Motion clips, the frame rates 
are displayed to the right as “Recording frame 
rate/Playback frame rate.”

j Timecode of the displayed image

k Timecode of the recording start point

l Timecode of the recording end point

m Duration

n Recorded audio channels

Displaying Clip Properties
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o Video format of recording

You can add an OK/NG/KP flag to clips recorded 
in UDF or exFAT mode. By adding flags, you can 
set the camcorder to display only clips with 
certain flag settings on the thumbnail screen (OK/
NG/KP/None-Clip thumbnail screen) (see 
page 106).
When adding a flag, you can select from “OK,” 
“NG,” “KP” (Keep) in “Set Clip Flag” of the 
THUMBNAIL menu (see page 104) on the 
thumbnail screen. When deleting a flag, select 
“None.”

Note

Flagged clips are not protected. To protect clips from 
deletion, select “Lock Clip” in the THUMBNAIL menu 
(see page 104) on the thumbnail screen. To remove the 
protection, select “Unlock Clip.”

By adding an OK mark to clips recorded in FAT-
HD Mode, you can set the camcorder to display 
only the necessary clips on the thumbnail screen 
(see page 106). Clips with an OK mark added are 
blocked from being deleted or segmented. To 
delete or segment them, remove the OK mark.
From the THUMBNAIL menu (see page 106) on 
the thumbnail screen, you can select “Add OK 
Mark” to add an OK mark, or “Delete OK Mark” 
to delete the OK mark.

You can copy clips to other SxS memory cards.
Clips are copied to destination SxS memory cards 
using the same names as the original clips.

Notes

• If a clip with the same name already exists at the copy 
destination SxS memory card, a one-digit number in 
parentheses is added to the original name.

The number in parentheses is the smallest number that 
does not exist at the copy destination.

Examples:
ABCD0002tABCD0002(1)
ABCD0002(1)tABCD0002(2)
ABCD0005(3)tABCD0005(4)

• If the parenthetical numbers (1) to (9) already exist at 
the copy destination, it is not possible to copy any more 
clips under that name.

• A message appears if there is not enough free capacity 
at the copy destination SxS memory card. Exchange 
the card for one with more free capacity.

• When multiple clips are recorded in a source SxS 
memory card, it may not be possible to copy all clips 
to the end. Depending on memory characteristics and 
usage of the memory cards, this can occur even when 
the source and destination memory cards have the 
same capacity.

Copying a specified clip

You can copy a clip selected on the thumbnail 
screen to another SxS memory card.
Select “THUMBNAIL” > “Copy Clip” > 
“Execute” in the setup menu, then press the 
MENU knob.

To cancel a copy operation
Press the RESET/RETURN button.

To batch copy groups of clips/files
Select “THUMBNAIL” > “Copy All” > “All 
Clips” > “Execute” in the setup menu, then press 
the MENU knob.
When both HD-mode and SD-mode clips exist on 
the source SxS memory card, only clips in the 
currently selected mode are copied. This is a 
convenient way to extract clips in one of the 
modes.
You can also copy of the files in the General 
directory, either together with or separately from 
clips.

To cancel the copy operation
Press the RESET/RETURN button.

To copy all files in the General directory
To copy all files only, without copying clips, 
select “THUMBNAIL” > “Copy All” > “General 
Files.” To copy all files together with all clips, 
select “THUMBNAIL” > “Copy All” > “All 
Clips & General Files.”

Copying to USB media
When USB media is connected, select a clip on a 
thumbnail screen and select “Copy Clip” > “Copy 

Adding/Deleting a Flag (UDF, 
exFAT Modes)

Adding/Deleting the OK Mark 
(FAT-HD Mode Only)

Copying Clips
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Clip(USB)” from the THUMBNAIL menu to 
copy the clip to the USB media.
USB flash drives must be formatted with the 
exFAT file system.
To format the drive in the camcorder, select 
“USB Set” > “Format” > “exFAT” in the 
MAINTENANCE menu.
A confirmation message prompting you to 
execute formatting appears on the viewfinder 
screen. Select “Execute,” then press the MENU 
knob.
You can also copy all SxS memory card clips to 
USB media by selecting “USB Set” > “Copy To 
USB” in the MAINTENANCE menu. This copies 
only clips for the selected mode in the same way 
as selecting “Copy All” in the MAINTENANCE 
menu.

You can delete clips that is selected in the 
thumbnail screen.
Select “THUMBNAIL” > “Delete Clip” > 
“Execute” in the setup menu, then press the 
MENU knob.

Note

HD clips with OK marks cannot be deleted.
If you want to delete such clips, first delete the OK marks 
(see page 108).

To batch delete groups of clips
You can delete clips that are selected in the 
thumbnail screen.
Select “THUMBNAIL” > “Delete All Clips” > 
“Execute” in the setup menu, then press the 
MENU knob.

Notes

• When both HD-mode and SD-mode clips exist on the 
SxS memory card, only clips in the currently selected 
mode are deleted.

• In HD mode, clips with OK marks are not deleted, 
even when a deletion is executed for a group of clips 
that includes them.

To cancel the deletion
Press the RESET/RETURN button.

The expand thumbnail screen allows you to 
search inside clips by using thumbnails (see 
page 103), to change index pictures (see 
page 111), and to add and delete shot marks (see 
page 111).

To display the screen
In the thumbnail screen, select a thumbnail and 
press the EXPAND button (see page 16) or select 
“THUMBNAIL” > “Thumbnail View” > 
“Forward Expansion.”
An expand thumbnail screen for the selected clip 
appears.

Expand thumbnail screen in HD mode
In HD mode, the selected clip is divided into 12 
equally-sized blocks, and a thumbnail of the first 
frame in each block is displayed.

Clip properties are displayed at the bottom of the 
screen.
Except for the items listed below, the information 
displayed here is the same as the information 
displayed in the normal thumbnail screen.

a Frame information
This displays frame information using icons.

Deleting Clips

Displaying the Expand Thumbnail 
Screen (UDF/exFAT/FAT-HD Mode 
only)

Index picture

Frame with Shot Mark1

Frame with Shot Mark2

S1 S2

S2 S1

Number of the selected frame

S1
S2
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The same icons are also displayed beneath the 
thumbnails. However, when several icons could 
be displayed for the same frame, one icon is 
selected for display, in the order of priority Index 
picture t Shot Mark1 t Shot Mark2.

b Timecode display
This displays the timecode of the selected frame 
in the expand thumbnail screen.

Expand thumbnail screen in SD mode
In SD mode, only in the case of clips that have 
been split into partial files because the file size 
was larger than 2 GB, a thumbnail of the first 
frame of each partial file is displayed.

Clip properties are displayed at the bottom of the 
screen.
Except for the items listed below, the information 
displayed here is the same as the information 
displayed in the normal thumbnail screen.

a Timecode display
This is the timecode of the selected partial file.

b Duration
This is the duration of the selected partial file.

To increase the number of divisions
When you press the EXPAND button, or select 
“THUMBNAIL” > “Thumbnail View” > 
“Forward Expansion,” the divided clip or file is 
further divided into 12 equally-sized blocks (a 
clip or file that has been divided into 12 is further 
divided into 12, for 12 × 12 = 144 divisions). You 
can repeat the same operation to increase the 
number of divisions.

To return to the previous division level
Press the EXPAND button with the SHIFT button 
held down, or select “THUMBNAIL” > 
“Thumbnail View” > “Back Expansion.” The 
expand thumbnail screen returns to the previous 
division level.

You can search for shot marks in clips (see 
page 103), change index pictures (see page 111), 
and add and delete shot marks (see page 111).

1 In the thumbnail screen, select the 
thumbnail of a clip, and press the 
ESSENCE MARK button (see page 17) 
or select “THUMBNAIL” > 
“Thumbnail View” > “Essence Mark 
Thumbnail.”
The shot mark thumbnail screen appears, and 
a selection list is displayed.

2 Select the type of the essence mark 
thumbnail screen.
All: Thumbnail display of all frames marked 

with essence marks.
Shot Mark1: Display only frames marked 

with Shot Mark1 marks.
Shot Mark2: Display only frames marked 

with Shot Mark2 marks.
You can also select Shot Mark 0 and Shot 
Mark 3 to Shot Mark 9.
If you have recorded clips by using planning 
metadata that defined names for Shot Mark 0 
to Shot Mark 9, the defined names are 
displayed instead of the above item names in 
the list.

Number of the selected frame

Displaying the Shot Mark 
Thumbnail Screen (UDF/exFAT/
FAT-HD Mode Only)
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Example shot mark thumbnail screen 
(with Shot Mark1 selected)

Clip properties are displayed at the bottom of the 
screen.
Except for the following item, the information 
displayed here is the same as the information 
displayed in the expand thumbnail screen.

a Timecode display
This is the timecode of the selected frame in the 
shot mark thumbnail screen.

To add shot marks

1 Select the frame where you want to add 
a shot mark, and then select 
“THUMBNAIL” > “Set Shot Mark” > 
“Add Shot Mark1” (or “Add Shot 
Mark2”).
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select “Execute,” and press the MENU 
knob.

To delete shot marks

1 Select the frame where you want to 
delete a shot mark, and then select 
“THUMBNAIL” > “Set Shot Mark” > 
“Delete Shot Mark1” (or “Delete Shot 
Mark2”).

The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select “Execute,” and press the MENU 
knob.

1 Select the thumbnail of the frame that 
you want to use as the index picture, 
and then select “THUMBNAIL” > “Set 
Index Picture.”
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select “Execute,” and press the MENU 
knob.

Note

Even if you set the index picture to a frame that is not the 
first frame of a clip, playback of that clip from a 
thumbnail screen always begins at the first frame.

1 Select the thumbnail of the frame where 
you want to divide the clip, and then 
select “THUMBNAIL” > “Divide Clip.”
The properties screen of the selected frame 
appears, and a confirmation message appears 
below the image.

2 Select “Execute,” and press the MENU 
knob.
The clip is divided at the selected frame, and 
two clips with different names are created.

The first four characters of the clip name are 
taken from the name of the original clips, and the 
last four characters are new serial numbers.
Example: When the name of a newly recorded 

clip would be EFGH0100, and a clip named 
ABCD0002 is divided, the names of the two 
newly created clips are ABCD0100 and 
ABCD0101.

Adding and Deleting Shot Marks 
(UDF/exFAT/FAT-HD Mode Only)

S1 S2 S2 S1

S1 S1

Changing Clip Index Pictures 
(UDF/exFAT/FAT-HD Mode Only)

Dividing Clips (FAT-HD Mode 
Only)
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Note

When there is not enough remaining capacity on the SxS 
memory cards to store the divided clips, a message 
appears to inform you that there is not enough capacity.
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On this camcorder, settings for shooting and 
playback are made in the setup menu, which 
appears in the viewfinder.
The setup menu can also be displayed on an 
external video monitor (see page 177).

The setup menu consists of the following menus.

Us: USER menu
Contains arbitrary items from other menus in a 
user-defined order (see page 118).

Cu: USER MENU CUSTOMIZE menu
Used to configure the USER menu (see 
page 118).

Op: OPERATION menu
Settings related to shooting, except settings 
related to picture quality (see page 121).

Pa: PAINT menu
Settings related to picture quality (see page 138).

Th: THUMBNAIL menu
Settings related to clip thumbnails (see 
page 104).

Note

The THUMBNAIL menu is used only when a thumbnail 
screen (see page 101) is displayed. It is disabled when no 
thumbnail screen is displayed.

Ma: MAINTENANCE menu
Settings related to audio and timecode (see 
page 144).

Fi: FILE menu
Settings related to file operations (see page 159).

See page 118 for the organization of the USER 
MENU CUSTOMIZE menu.

See “THUMBNAIL Menu Configuration” 
(page 104) for the organization of the THUMBNAIL 
menu.

USER menu (see page 118)

OPERATION menu (see page 121)

Chapter6 Menu and Detailed Settings

Setup Menu 
Organization and Levels

Setup Menu Organization

Setup Menu Levels

USER

Format Media

Rec Function

Input/Output

Clip

Assignable SW

Camera Config

OPERATION

Format

Format Media

Input/Output

Super Impose

Rec Function

Assignable SW

VF Setting

Marker

Gain Switch

TLCS

Zebra

Display On/Off

Auto Iris

White Setting

Offset White

Shutter

Time Zone

Clip

Plan.Metadata

Flashband Reduce
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PAINT menu (see page 138)

MAINTENANCE menu (see page 144)

FILE menu (see page 159)
PAINT

Switch Status

White

Black

Flare

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Detail(SD Mode)

Aperture

Skin Detail

Matrix

Multi Matrix

V Modulation

Low Key Sat.

Noise Suppress

MAINTENANCE

White Shading

Battery

Audio

WRR Setting

Timecode

Essence Mark

Camera Config

Preset White

White Filter

Auto Iris2

Flicker Reduce

Genlock

ND Comp

Lens

Trigger Mode

Network Setting

Wi-Fi Setting

Clock set

Language

Hours Meter

Direct Menu

Menu Scroll

USB Set

Version

FILE

User

All 

Scene 

Reference 

Lens 

Import
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To display the setup menu
Set the MENU ON/OFF switch to ON, or press 
the MENU button.
The camcorder enters menu mode and the menu 
list appears on the screen.
A cursor appears over the first two characters of 
the most recently used menu, and the 
corresponding menu item selection area appears 
to the right.

Example: When the cursor is positioned at the 
OPERATION menu

Note

The setup menu cannot be used when the camcorder is in 
focus magnification mode. Exit focus magnification 
mode by pressing the assignable switch to which the 
Focus Mag function has been assigned.

To make menu settings

1 Turn the MENU knob, or press the J or 
j button, to move the cursor to the item 
that you want to set.
A list of selectable menu items appears in the 
menu item selection area to the right of the 
icon.

2 Press the MENU knob or the SET 
button.
The cursor moves to the menu item selection 
area.
You can also move the cursor to the menu 

item selection area by pressing the k 
button.
• The menu item selection area displays a 

maximum of seven lines. You can scroll 
through menus with more than seven lines 
by moving the cursor up and down.
Triangles appear at the upper right and 
lower right of the menu item selection area 
to indicate that a menu is scrollable.

3 Turn the MENU knob, or press the J or 
j button, to move the cursor to the item 
that you want to set, and then confirm 
by pressing the MENU knob or the SET 
button.
The sub-items area appears to the right of the 
menu item selection area, and the cursor 
moves to the first sub-item.

4 Turn the MENU knob, or press the J or 
j button, to move the cursor to the sub-
item that you want to set, and then 

Basic Setup Menu 
Operations

Menu item selection area

Menu list Menu item selection area
• B appears to the right when more detailed 

sub-items are available.
• Settings appear to the right when a menu 

item has no sub-items.
• You can select  to return to the 

previous level.

Appears when more menu items 
are available below the last line. 
(v appears when more menu 
items are available above the 
first line.)

• Displays sub-items and their current 
settings

• To return to the previous level, select , 
press the K button, or push the MENU 
CANCEL/PRST/ESCAPE switch down to 
the ESCAPE side.

Sub-items area
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confirm the selection by pressing the 
MENU knob or the SET button.
The settings of the selected sub-item appear, 
and the cursor moves to the currently 
selected value.

• The settings area displays a maximum of 
seven lines. You can scroll through menus 
with more than seven sub-items by moving 
the cursor up and down. Triangles appear at 
the upper right and lower right of the 
settings area to indicate that a sub-item 
menu is scrollable.

• For sub-items with a large settings range 
(for example, –99 to +99), the settings area 
is not displayed. Instead, the sub-item name 
is highlighted to indicate that the sub-item 
can be set.

5 Turn the MENU knob, or press the J or 
j button, to select the value to set, and 
then confirm by pressing the MENU 
knob or the SET button.
The setting is changed, and the display is 
updated to show the new setting.
If you select “Execute” for an executable 
item, the corresponding function is executed.

Items that require confirmation before execution
In step 3, the menu disappears and a confirmation 
message appears if you select an item that 
requires confirmation before execution. Follow 
the instructions in the message to execute or 
cancel the operation.

To enter text
Some items, such as time data or file names, must 
be set by entering text. When you select one of 
these items, the text entry area is highlighted, with 
“SET” displayed to the right.

1 Turn the MENU knob, or press the J or 
j button, to select a character, and then 
confirm by pressing the MENU knob or 
the SET button.

The cursor moves to the next position.
To return to the previous position, push the 
MENU CANCEL/PRST/ESCAPE switch 
down to the ESCAPE side.

2 Select characters for all positions up to 
the last.
The cursor moves to “SET.”

3 Press the MENU knob or the SET 
button.
This confirms the setting.

To cancel the setting change
Push the MENU CANCEL/PRST/ESCAPE 
switch down to the ESCAPE position.

To reset a setting to the initial value

1 Before a setting is changed or after a 
setting change is cancelled, push the 
MENU CANCEL/PRST/ESCAPE 
switch up to the CANCEL/PRST side.

2 When the message to confirm whether 
the current setting is reset to the initial 
value, push the MENU CANCEL/
PRST/ESCAPE switch up to the 
CANCEL/PRST side again.
The current setting is reset to the initial value.

To exit the menu

Set the MENU ON/OFF switch to OFF or press the 
MENU button.
The normal camera picture reappears.

Locking and unlocking the menu
You can lock the setup menu so that only the 
USER menu is displayed.

Locking the menu

1 Press and hold the MENU knob and 
press the MENU ON/OFF switch down 
to display the setup menu.

2 Display “MAINTENANCE” > 
“Camera Config” > “User Menu with 
Lock” in the setup menu.

Settings area
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Notes

• When you press and hold the MENU knob and 
press the MENU ON/OFF switch down, “Camera 
Config” > “User Menu Only” changes to “User 
Menu with Lock.”

• If you press the MENU ON/OFF switch down 
without pressing the MENU knob or you press the 
MENU button to display the menu, “Camera 
Config” > “User Menu with Lock.” is not 
displayed.

3 Select “On,” then press the MENU 
knob.
The viewfinder screen display switches to the 
passcode number input screen.

4 Enter an arbitrary passcode number.
The valid input range is 0000 to 9999. The 
default value is 0000.
Enter a number and press the MENU knob to 
move the cursor to the next digit.
When all digits have been entered, move the 
cursor to “SET.”

5 With “SET” selected, press the MENU 
knob.
The entry is applied.
A confirmation message appears. 
Subsequently, only the USER menu is 
displayed.

Unlocking the menu

1 Press and hold the MENU knob and 
press the MENU ON/OFF switch down 
to display the setup menu.

2 Display “USER” > “Camera Config” > 
“User Menu with Lock” in the setup 
menu.

Notes

• When you press and hold the MENU knob and 
press the MENU ON/OFF switch down, “Camera 
Config” > “User Menu Only” changes to “User 
Menu with Lock.”

• If you press the MENU ON/OFF switch down 
without pressing the MENU knob or you press the 
MENU button to display the menu, “Camera 
Config” > “User Menu with Lock.” is not 
displayed.

3 Select “Off,” then press the MENU 
knob.
The viewfinder screen display switches to the 
passcode number input screen.

4 Enter the passcode number used to lock 
the menu.
The valid input range is 0000 to 9999.
Enter a number and press the MENU knob to 
move the cursor to the next digit.
When all digits have been entered, move the 
cursor to “SET.”

5 With “SET” selected, press the MENU 
knob.
The entry is applied.
If the entered passcode number matches the 
passcode number used to lock the menu, a 
confirmation message appears and the 
display of all menus is enabled.

Notes

• If the entered passcode number does not match 
the passcode number used to lock the menu, the 
menu is not unlocked.

• It is recommended that you leave a record of the 
passcode nearby, just in case it is forgotten. If you 
do forget the passcode number, contact your Sony 
service representative.
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You can register arbitrary menu items from the OPERATION, PAINT, and MAINTENANCE menus in 
the USER menu. You register items using the USER MENU CUSTOMIZE menu.
The USER menu consists of the following items when it is in the factory default state.
• Format Media (see page 123)
• Input/Output (see page 123)
• Rec Function (see page 125)
• Assignable SW (see page 126)
• Clip (see page 134)
• Camera Config 1) (see page 151)

1) Contains only User Menu Only as sub-item

You can edit the USER menu, such as adding items, deleting items, and rearranging items, making the 
USER menu more convenient to use.
You can select any item in the OPERATION menu, PAINT menu, or MAINTENANCE menu and add it 
to the USER menu. Up to 20 items can be registered in the USER menu. There are six items registered in 
the USER menu by factory default, one of which must always be present, allowing you to add up to 19 
new items.

The USER MENU CUSTOMIZE menu has the following organization.

Note

The same item or sub-item cannot be registered twice. 
Also, the name of the item or sub-item cannot be 
changed.

To restore the USER menu to factory default state
Set “USER MENU CUSTOMIZE” > “Customize 
Reset” in the setup menu to “Execute” and press 
the MENU knob.

Menu List

USER Menu 

USER MENU CUSTOMIZE menu

Item Sub-item Setting Description
Registered item or 
blank (no item)

Ins Item R Inserts an item above the selected item.

Ins SubItem R Inserts a sub-item above the selected sub-item.

Ins Item r Inserts an item below the selected item.

Ins SubItem r Inserts a sub-item below the selected sub-item.

Edit Item Del Item/Ins SubItem/
Del SubItem

Edits a registered item or sub-item.

Del Item: Delete item
Ins SubItem: Insert sub-item
Del SubItem: Delete sub-item

Customize Reset Execute/Cancel Restores the USER menu to factory default 
state (execute using Execute)
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Adding an item and all sub-items

1 Display the USER MENU 
CUSTOMIZE menu.
The currently registered menu items are 
displayed.

2 Select the item in the position where you 
want to insert an item, then press the 
MENU knob.

3 Select “Ins Item R” or “Ins Item r,” then 
press the MENU knob.
Ins Item R: Inserts an item above the selected 

item.
Ins Item r: Inserts an item below the selected 

item.
A list of the items that can be added is 
displayed.

4 Select the item you want to add, then 
select “Execute” and press the MENU 
knob.
The selected item and all its sub-items are 
inserted in the position specified in steps 2 
and 3.

Adding an item and selected sub-item

1 Display the USER MENU 
CUSTOMIZE menu.
The currently registered menu items are 
displayed.

2 Select the item in the position where you 
want to insert an item, then press the 
MENU knob.

3 Select “Ins SubItem R” or “Ins SubItem 
r,” then press the MENU knob.
Ins SubItem R: Inserts a sub-item above the 

selected item.
Ins SubItem r: Inserts a sub-item below the 

selected item.
A list of the items that can be added is 
displayed.

4 Select the item you want to add, then 
press the MENU knob.
A list of the sub-items that can be added is 
displayed.

5 Select the sub-item you want to add, 
then select “Execute” and press the 
MENU knob.
The selected item and sub-item are inserted 
in the position specified in steps 2 and 3.

Adding a sub-item to an existing item

Note

A sub-item should always be added below an item that is 
its parent in the source menu. A sub-item cannot be 
inserted below a non-parent item.

1 Display the USER MENU 
CUSTOMIZE menu.
The currently registered menu items are 
displayed.

2 Select the item to which you want to add 
a sub-item, then press the MENU knob.

3 Set “Edit Item” to “Ins SubItem.”
A list of the currently registered sub-items 
for the selected item is displayed.
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4 Select the sub-item in the position 
where you want to insert a sub-item, 
select “Ins SubItem R” or “Ins SubItem 
r,” and press the MENU knob.
Ins SubItem R: Inserts a sub-item above the 

selected sub-item.
Ins SubItem r: Inserts a sub-item below the 

selected sub-item.

A list of the sub-items that can be added is 
displayed.

5 Select the sub-item you want to add, 
then select “Execute” and press the 
MENU knob.
The selected sub-item is inserted in the 
position specified in step 4.

Deleting an item

Note

“Camera Config” is registered by factory default and 
cannot be deleted.

1 Display the USER MENU 
CUSTOMIZE menu.
The currently registered menu items are 
displayed.

2 Select the item you want to delete, then 
press the MENU knob.

3 Set “Edit Item” to “Del Item.”
The selected item is deleted.

Deleting a sub-item

Note

“User Menu Only” in “Camera Config” is registered by 
factory default and cannot be deleted.

1 Display the USER MENU 
CUSTOMIZE menu.

The currently registered menu items are 
displayed.

2 Select the item containing the sub-item 
you want to delete, then press the 
MENU knob.

3 Set “Edit Item” to “Del SubItem.”
A list of the sub-items that can be deleted is 
displayed.

4 Select the sub-item you want to delete, 
then press the MENU knob.
The selected sub-item is deleted.
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Settings in bold are the factory default values.

OPERATION Menu

OPERATION
Item Sub-item Setting Description
Format
Specifies the camcorder’s 
operating mode and 
recording format.

File System UDF/exFAT/FAT Switches between UDF, exFAT, and 
FAT as the recording mode (execute 
using Execute).

HD/SD HD/SD Switches between HD or SD as the 
operating mode (execute using 
Execute).

HD System Line 1080/720 When the operating mode is HD, sets 
the number of system lines to 1080 or 
720 (execute using Execute).

System 
Frequency

The available settings 
vary depending on the 
settings of “HD/SD,” 
“HD System Line,” 
and “Country.”

Selects the system frequency (execute 
using Execute).

59.94i/29.97P/
23.98P

When “HD/SD” is set to “HD,” “HD 
System Line” is set to “1080,” and 
“Country” is set to other than “PAL 
Area.”

59.94P/29.97P/
23.98P

When “HD/SD” is set to “HD,” “HD 
System Line” is set to “720,” and 
“Country” is set to other than “PAL 
Area.”

59.94i/29.97P When “HD/SD” is set to “SD” and 
“Country” is set to other than “PAL 
Area.”

50i/25P • When “HD/SD” is set to “HD,” “HD 
System Line” is set to “1080,” and 
“Country” is set to “PAL Area.”

• When “HD/SD” is set to “SD” and 
“Country” is set to “PAL Area.”

50P/25P When “HD/SD” is set to “HD,” “HD 
System Line” is set to “720,” and 
“Country” is set to “PAL Area.”

Rec Format The available settings 
vary depending on the 
settings in File 
System, HD/SD, HD 
System Line, and 
System Frequency.

Selects the recording format (execute 
using Execute).

XAVC-I/XAVC-L50/
XAVC-L35/
XAVC-L25/
HD422 50/
HD420 HQ1920/
HD420 HQ1440

When the File System setting is 
[exFAT], the HD/SD setting is [HD], 
the HD System Line setting is [1080], 
and the System Frequency setting is 
[59.94i] or [50i].
121



Format
Specifies the camcorder’s 
operating mode and 
recording format.

Rec Format XAVC-I/XAVC-L50/
XAVC-L35/
HD422 50/
HD420 HQ1920/
HD420 HQ1440

When the File System setting is 
[exFAT], the HD/SD setting is [HD], 
the HD System Line setting is [1080], 
and the System Frequency setting is 
[29.97P], [25P], or [23.98P].

XAVC-I/XAVC-L50/
HD422 50/
HD420 HQ1280

When the File System setting is 
[exFAT], the HD/SD setting is [HD], 
the HD System Line setting is [720], 
and the System Frequency setting is 
[59.94P] or [50P].

HD422 50/
HD420 HQ 1280

When the File System setting is 
[exFAT], the HD/SD setting is [HD], 
the HD System Line setting is [720], 
and the System Frequency setting is 
[23.98P].

HD422 50 When the File System setting is 
[exFAT], the HD/SD setting is [HD], 
the HD System Line setting is [720], 
and the System Frequency setting is 
[29.97P] or [25P].

HD422 50/
HD420 HQ1920/
HD420 HQ1440

When the File System setting is [UDF], 
the HD/SD setting is [HD], and the HD 
System Line setting is [1080].

HD422 50/
HD420 HQ1280

When the File System setting is [UDF], 
the HD/SD setting is [HD], the HD 
System Line setting is [720], and the 
System Frequency setting is other than 
[29.97P] or [25P].

HD422 50 When the File System setting is [UDF], 
the HD/SD setting is [HD], the HD 
System Line setting is [720], and the 
System Frequency setting is [29.97P] or 
[25P].

HQ 1920/HQ 1440 When the File System setting is [FAT], 
the HD/SD setting is [HD], the HD 
System Line setting is [1080], and the 
System Frequency setting is [29.97P] or 
[25P].

HQ 1920/HQ 1440/
SP 1440

When the File System setting is [FAT], 
the HD/SD setting is [HD], the HD 
System Line setting is [1080], and the 
System Frequency setting is other than 
[29.97P] or [25P].

HQ 1280 When the File System setting is [FAT], 
the HD/SD setting is [HD], and the HD 
System Line setting is [720].

IMX50/DVCAM When the File System setting is 
[exFAT] or [UDF], and the HD/SD 
setting is [SD]

DVCAM When the File System setting is [FAT] 
and the HD/SD setting is [SD]

OPERATION
Item Sub-item Setting Description
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Format
Specifies the camcorder’s 
operating mode and 
recording format.

Aspect Ratio 
(SD)

16:9/4:3 Selects the SD mode aspect ratio 
(execute using Execute).

Audio 
Length(IMX)

24bit/16bit Selects the audio bit rate for recording 
in IMX format.

Country NTSC Area/NTSC(J) 
Area/PAL Area

Selects the area of use (execute using 
Execute).

Format Media
Executes a media format.

Media(A) Execute/Cancel Initializes the SxS memory card in slot 
A (execute using Execute).

Media(B) Execute/Cancel Initializes the SxS memory card in slot 
B (execute using Execute).

Input/Output
Makes settings related to 
I/O signals.

In FAT mode
Output& i.LINK

HD&HDV/
SD&HDV/SD&DV/
480P/576P

Selects the signals output from the 
video connectors and the i.LINK (HDV/
DV) connector.
When the HD/SD setting is SD, 
“SD&DV” or “SD” is selected.

In UDF/exFAT 
mode
Output

HD/SD/480P/576P

23.98P Output PsF/Pull Down Selects whether to use progressive 
output (PsF) or pulldown output (Pull 
Down) when the video format is in the 
following modes.
UDF/HD mode

HD22 50/1080/23.98P
HD420 HQ1920/1080/23.98P
HD420 HQ1440/1080/23.98P

exFAT/HD mode
XAVC-I/1080/23.98P
XAVC-L50/1080/23.98P
XAVC-L35/1080/23.98P
HD22 50/1080/23.98P
HD420 HQ1920/1080/23.98P
HD420 HQ1440/1080/23.98P

FAT mode
HQ 1920/1080/23.98P
HQ 1440/1080/23.98P

Source Select Camera/i.LINK Selects whether to use the video camera 
picture (Camera) or the signal input 
from the i.LINK (HDV/DV) connector 
(i.LINK) as the video input source.

i.LINK I/O Enable/Disable Selects whether to enable or disable 
input and output of signals via the 
i.LINK (HDV/DV) connector.
When “Enable” is selected, you can 
execute auto black balance adjustment 
during i.LINK output. (When this 
setting is set to “Enable,” The flashband 
reduce function is set to “Off.”)

SDI Output On/Off Turns on/off the output of signals from 
the two HD/SD SDI OUT connectors.
When the camcorder is connected to a 
computer via USB, set to “Off.”

HDMI Output On/Off Turns on/off the output of signals from 
the HDMI connector.

OPERATION
Item Sub-item Setting Description
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Input/Output
Makes settings related to 
I/O signals.

SDI/HDMI Out 
Super

On/Off Turns on/off the superimposition of text 
information on the output of the HD/SD 
SDI OUT and HDMI connectors.

Video Out Super On/Off Turns on/off the superimposition of text 
information on the output of the VIDEO 
OUT connector.

Down Converter Squeeze/Letter/
Crop

Selects the signal conversion mode for 
output of SD signals.
Squeeze: Squeeze the 16:9 picture 

horizontally and output as a 4:3 
picture.

Letter: Mask the top and bottom of the 
4:3 picture and display in the center 
of the screen as a 16:9 picture.

Crop: Crop the edges of the 16:9 
picture and output as a 4:3 picture.

Wide ID Through/Auto Selects whether to add a wide ID signal 
to the SD output signal.
Through: Output without adding a 

wide ID signal.
Auto: Add and output a wide ID signal 

when the Down Converter setting 
is Squeeze.

Super Impose
Makes settings related to 
superimposed text and 
markers.

Super(VF 
Display)

On/Off When “Input/Output” > “SDI/HDMI 
Out Super” or “Video Out Super” is set 
to “On,” superimpose text information 
on the output from the HD/SD SDI 
OUT connector, HDMI connector, and 
VIDEO OUT connector, as specified 
(“On” or “Off”) for each item.

Super(Menu) On/Off

Super(Timecode) On/Off

Super(Marker) On/Off When “Input/Output” > “Video Out 
Super” is set to “On,” specifies whether 
to superimpose markers on the output 
from the VIDEO OUT connector.

Super(Rec Status 
Indicator)

On/Off Selects whether to superimpose (“On”) 
or not impose (“Off”) the recording 
status indication on the following two 
outputs.
• Output from the VIDEO OUT connector 

with “Input/Output” > “Video Out 
Super” set to “On”

• Output from the SDI connector and the 
HDMI connector with “Input/Output” > 
“SDI/HDMI Out Super” set to “On”

OPERATION
Item Sub-item Setting Description
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Rec Function
Makes settings related to 
special recording modes.

Note
When Picture Cache is 
assigned to an assignable 
switch, this item is disabled 
(grayed out).

Slow & Quick On/Off Turns the Slow & Quick Motion 
function on/off.
(When this is set to “On,” “Clip 
Continuous Rec,” “Picture Cache Rec,” 
“Interval Rec,” “Frame Rec,” and 
“Flashband Reduce” are set to Off.)

Frame Rate The available settings 
vary depending on the 
Format >HD System 
Line setting.

When “Slow & Quick” is set to “On,” 
sets the frame rate for Slow & Quick 
Motion shooting.

When “Format” > 
“Country” is set to 
other than “PAL 
Area” in UDF/exFAT 
mode or when in FAT 
mode: 
1 to 30
When “Format” > 
“Country” is set to 
“PAL Area” in UDF/
exFAT mode: 
1 to 25

When “HD System Line” is set to 
“1080.”

When “Format” > 
“Country” is set to 
other than “PAL 
Area” in UDF/exFAT 
mode or in FAT 
mode: 
1 to 30/31 to 60
When “Format” > 
“Country” is set to 
“PAL Area” in UDF/
exFAT mode: 
1 to 25/26 to 50

When “HD System Line” is set to 
“720.”

Clip Continuous 
Rec

On/Off Turns the Clip Continuous Rec function 
on/off. (When this is set to “On,” “Slow 
& Quick,” “Picture Cache Rec,” 
“Interval Rec,” and “Frame Rec” are set 
to “Off.”)

Picture Cache 
Rec

On/Off Turn the picture cache function on/off.
(When this is set to “On,” “Slow & 
Quick,” “Clip Continuous Rec,” 
“Interval Rec,” “Frame Rec,” and 
“Flashband Reduce” are set to “Off.”)

P. Cache Rec 
Time

0-2sec/2-4sec/
4-6sec/6-8sec/
8-10sec/10-12sec/
12-14sec/13-15sec

When “Picture Cache Rec” is set to 
“On,” sets the picture cache time.

Note
When you set “OPERATION” > “Format” 
> “Rec Format” to “XAVC-l,” only “0-
2sec” or “2-4sec” can be selected.

OPERATION
Item Sub-item Setting Description
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Rec Function
Makes settings related to 
special recording modes.

Note
When Picture Cache is 
assigned to an assignable 
switch, this item is disabled 
(grayed out).

Interval Rec On/Off Turns the Interval Rec function on/off.
(When this is set to “On,” “Slow & 
Quick,” “Clip Continuous Rec,” 
“Picture Cache Rec,” and “Frame Rec” 
are set to “Off.”)

Frame Rec On/Off Turns the Frame Rec function on/off.
(When this is set to “On,” “Slow & 
Quick,” “Clip Continuous Rec,” 
“Picture Cache Rec,” and “Interval 
Rec” are set to “Off.”)

Number of 
Frames

The available settings 
vary depending on the 
settings in “Format” > 
“HD System Line and 
Format” > “System 
Frequency.”

When “Interval Rec” or “Frame Rec” is 
set to “On,” specifies the number of 
frames to shoot in one Interval Rec or 
Frame Rec take.

2frame/6frame/
12frame

When “HD System Line” is set to 
“720,” and “System Frequency” is set to 
“59.94P” or “50P.”

1frame/3frame/
6frame/9frame

When “HD System Line” is set to other 
than “720”, or “System Frequency” is 
set to other than “59.94P” or “50P.”

Interval Time 1/2/3/4/5/6/7/8/9/10/
15/20/30/40/50 (sec)
1/2/3/4/5/6/7/8/9/10/
15/20/30/40/50 (min)
1/2/3/4/6/12/24 (hour)

Set the interval for Interval Rec 
shooting, when “Interval Rec” is set to 
“On.”

Pre-Lighting Off/2sec/5sec/10sec If you want the video light to be turned 
on before Interval Rec shooting, select a 
number of seconds before the start of 
shooting. If you do not want it to be 
turned on, select Off.

Simul Rec Simul/Off Sets whether to use the Simul Rec 
function for recording simultaneously to 
slot A and slot B.

Assignable SW
Assigns functions to 
assignable switches.

For details about assigning 
functions, see “Assigning 

Functions to Assignable 
Switches” (page 164).

<0> see page 164 Assigns function to ASSIGN. 0 switch.

<1> Assigns function to ASSIGN. 1 switch.

<2> Assigns function to ASSIGN. 2 switch.

<3> Assigns function to ASSIGN. 3 switch.

<4> Assigns function to ASSIGNABLE 4 
switch.

<5> Assigns function to ASSIGNABLE 5 
switch.

RET Assigns function to RET button on the 
lens.

C. Temp Assigns function to COLOR TEMP. 
button.

OPERATION
Item Sub-item Setting Description
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Assignable SW
Assigns functions to 
assignable switches.

For details about assigning 
functions, see “Assigning 
Functions to Assignable 
Switches” (page 164).

Zoom Speed 0 to 20 to 99 When Zoom has been assigned to the 
ASSIGNABLE 4 or 5 switch, specifies 
the zoom speed.

Note
When the lens supplied with the PXW-
X320 is used, zooming may not operate 
smoothly if the zoom speed is low.

VF Setting
Makes settings related to 
the viewfinder screen.

Color –99 to ±0 to +99 Adjusts the density of the colors 
displayed in the viewfinder screen.

Mode Color/B&W Selects “Color” or “B&W” as the 
display mode of the viewfinder screen. 
(Even when “B&W” is selected, some 
indications are always displayed in 
color. Examples include tally 
indications, thumbnails, and the skin 
gate area.)

Peaking Type Normal/Color/Both Selects the peaking type.
Normal: Normal peaking
Color: Color peaking
Both: Both

Peaking 
Frequency

Normal/High Selects normal or high peaking 
frequency.

Peaking Color White/Red/Yellow/
Blue

When “Peaking Type” is set to “Color,” 
selects the peaking color.

Peaking Level Low/Mid/High When “Peaking Type” is set to “Both,” 
selects the color peaking level.

DXF Rec Tally Upper/Both When a separately sold viewfinder is 
installed, specified whether to light the 
tally indicator on the upper side only 
(“Upper”), or on both the upper and 
lower sides (“Both”).
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Marker
Makes settings related to 
marker display in the 
viewfinder screen.

Setting On/Off Turns the display of all markers on/off.

Note
When Marker is assigned to the ASSIGN. 
2 switch, this setting is disabled.

Center Marker 1/2/3/4/Off When the center marker is displayed, 
selects the type. Select “Off” if you do 
not want to display the marker.

Note
When “Safety Zone,” “User Box,” and 
“Guide Frame” are set to “On,” this setting 
cannot be turned on.

Center H 
Position

–40 to 0 to 40 Specifies the horizontal position of the 
center marker.

Center V 
Position

–40 to 0 to 40 Specifies the vertical position of the 
center marker.

Safety Zone On/Off Turns the safety zone display on/off.

Note
When “Center Marker,” “User Box,” and 
“Guide Frame” are set to “On,” this setting 
cannot be turned on.

Safety Area 80%/90%/92.5%/
95%

Selects the safety zone range.

Aspect Marker Line/Mask/Off When an aspect marker is to be 
displayed, selects the display method. 
Select “Off” if you do not want to 
display the marker.
Line: Show as white lines.
Mask: Display by lowering the video 

signal level of areas outside the 
marker range.

Aspect Select 4:3/13:9/14:9/15:9/
1.66:1/1.85:1/2.35:1/
2.4:1

Selects the aspect ratio of the marker.

Aspect Mask 0% to 30% to 90% 
(10% steps)

When “Aspect Marker” is set to 
“Mask,” specifies the video signal level 
of areas outside the marker range as a 
percentage value relative to the video 
signal level of areas inside the marker 
range.

User Box On/Off Turns the box cursor display on/off.

Note
When “Center Marker,” “Safety Zone,” 
and “Guide Frame” are set to “On,” this 
setting cannot be turned on.

User Box Width 40 to 500 to 999 Specifies the box cursor width (distance 
from the center to the left and right 
edges).

User Box Height 70 to 500 to 999 Specifies the box cursor height 
(distance from the center to the top and 
bottom edges).
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Marker
Makes settings related to 
marker display in the 
viewfinder screen.

User Box H 
Position

–479 to 0 to 479 Specifies the horizontal position of the 
box cursor center.

User Box V 
Position

–464 to 0 to 464 Specifies the vertical position of the box 
cursor center.

Guide Frame On/Off Turns display of the guide frame on/off.

Note
When “Center Marker,” “Safety Zone,” 
and “User Box” are set to “On”, this setting 
cannot be turned on.

Gain Switch
Makes settings related to 
the GAIN switch.

Gain Low –3dB/0dB/3dB/6dB/
9dB/12dB/18dB

Specifies the gain value for the L 
position of the GAIN switch.

Gain Mid –3dB/0dB/3dB/6dB/
9dB/12dB/18dB

Specifies the gain value for the M 
position of the GAIN switch.

Gain High –3dB/0dB/3dB/6dB/
9dB/12dB/18dB

Specifies the gain value for the H 
position of the GAIN switch.

Gain Turbo –3dB/0dB/3dB/6dB/
9dB/12dB/18dB/
24dB

Specifies the gain value for the Turbo 
Gain function, which can be assigned to 
an assignable switch.

Shockless Gain On/Off Turns shockless gain (a function that 
switches smoothly when the gain is 
switched) on/off.

TLCS
Makes settings related to 
total level control.

Mode Backlight/Standard/
Spotlight

Selects the auto iris mode used when the 
TLCS system is activated.
Backlight: Backlight mode (lessens 

the blackout of the main subject 
that occurs under backlit 
conditions)

Standard: Standard mode
Spotlight: Spotlight mode (lessens the 

whiteout of the main subject that 
occurs under a spotlight)

Speed –99 to ±0 to +99 Specifies the control speed (speed of 
reaction to changes in the video) used 
when the TLCS system is activated. 
(Larger values specify quicker reaction 
times.)

AGC On/Off Turns the AGC (auto gain control) 
function on/off.

AGC Limit 18dB/12dB/9dB/
6dB/3dB

Specifies the maximum gain used when 
AGC is on.

AGC Point F2.8/F4/F5.6 Specifies the F value where control by 
auto iris switches to control by AGC, 
used when AGC is on.

Auto Shutter On/Off Turns the auto shutter function on/off.

Auto Shutter 
Limit

1/100 / 1/150 / 1/200 / 
1/250

Selects the maximum shutter speed used 
when auto shutter is on.

Auto Shutter 
Point

F5.6/F8/F11/F16 Specifies the F value where control by 
auto iris switches to control by auto 
shutter, used when auto shutter is on.
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Zebra
Makes settings related to 
zebra displays.

Zebra Select 1/2/BOTH Selects the zebra pattern type (Zebra1, 
Zebra2, Both).

Zebra1 Level 50% to 70% to 107% Specifies the Zebra1 display level.

Zebra1 Aperture 
Level

1 to 10% to 20% Specifies the Zebra1 aperture level.

Zebra2 Level 52% to 100% to 
109%

Specifies the Zebra2 display level.

Display On/Off
Selects the items to 
display in the viewfinder 
screen.

Video Level 
Warnings

On/Off Turns the warnings that appear when 
the video level is too bright or too dark 
on/off.

Sending Clip 
Info

On/Off Turn the uploading status of a clip when 
connecting the CBK-WA101 Wireless 
Adapter (not supplied) on/off.

Brightness 
Display

On/Off Turns the numerical indication of the 
video brightness on/off.

Histogram 
Display

On/Off Turns the histogram display of video 
signal levels on/off (in HD mode only).

Lens Info Meter/Feet/Off Selects whether or not to display the 
depth of field indication and the unit for 
display of the depth of field.
Meter: Displayed in meters
Feet: Displayed in feet
Off: Do not display

Focus Position On/Off Turns the indication of the lens focus 
position on/off.

Zoom Position On/Off Turns the indication of the lens zoom 
position on/off.

Audio Level 
Meter

On/Off Turns the display of the audio level 
meters on/off.

Timecode On/Off Turns the display of time data 
(timecode, user bits, counter, duration) 
on/off.

Battery Remain On/Off Turns the indications of the remaining 
battery time and input voltage on/off.

Media Remain On/Off Turns the indication of the remaining 
media capacity on/off.

TLCS Mode On/Off Turns the indication of the TLCS 
operating mode on/off.

Focus Mode On/Off Turns the indication of the focus 
operating mode on/off.

White Balance 
Mode

On/Off Turns the indication of the white 
balance mode on/off.

Filter Position On/Off Turns the indication of the ND filter 
setting on/off.

Iris Position On/Off Turns the indication of the iris position 
on/off.

Gain Setting On/Off Turns the indication of the gain setting 
on/off.

Shutter Setting On/Off Turns the indications of the shutter 
mode and shutter speed on/off.
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Display On/Off
Selects the items to 
display in the viewfinder 
screen.

Color Temp On/Off Turns the indication of the color 
temperature on/off.

Video Format On/Off Turns the indication of the video format 
on/off.

System Line On/Off Turns the indication of the system lines 
on/off.

Rec Mode On/Off Turns the indication of special 
recording modes (Slow & Quick, 
Interval Rec, Frame Rec) on/off.

Extender On/Off Turns the lens extender indication on/
off.

WRR RF Level On/Off Turns the indication of the digital 
wireless receiver reception level on/off.

Clip 
Number(PB)

On/Off Turns the indication of clip information 
on/off.

Wireless Status On/Off Turn the status of radio wave of the 
CBK-WA101 Wireless Adapter (not 
supplied) on/off.

Streaming&
NCM Status

On/Off Turn the status of streaming and the 
network client mode display of the 
CBK-WA101 Wireless Adapter (not 
supplied) on/off.

Ext Media 
Remain

On/Off Turn the remaining time indication for 
the media of the CBK-WA101 Wireless 
Adapter (not supplied) on/off.

FlashbandReduce On/Off Turn the flashband reduce status 
indication on/off.

ALAC On/Off Turn the ALAC status indication on/off.

Auto Iris
Makes settings related to 
auto iris.

Iris Override On/Off Turns iris override (a setting that opens 
or closes the iris more than normal) on/
off.

Iris Speed –99 to ±0 to +99 Specifies the control speed (speed of 
reaction to changes in the video). 
(Larger values specify quicker reaction 
times.)

Clip High light On/Off Turns on/off the function that disregards 
highlights and forces a flatter reaction to 
high luminance.

Iris Window 1/2/3/4/5/6/Var Selects the auto iris detection window 
type.
Var: Variable

Iris Window 
Indication

On/Off Turns the indication of the auto iris 
detection window frame on/off.
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White Setting
Makes settings related to 
auto white balance 
adjustments.

White 
Switch<B>

Memory/ATW Specifies the operating mode selected 
by the B position of the WHITE BAL 
switch.
Memory: Auto white balance
ATW: Auto tracing white balance

Shockless White Off/1/2/3 Specifies the reaction speed when the 
WHITE BAL switch setting is changed. 
“Off” is an instant reaction, and “1” is 
faster than “2” or “3.”

ATW Speed 1/2/3/4/5 Specifies the reaction speed when 
“White Switch<B>” is set to “ATW.” 
“1” is the fastest reaction.

ATW Mode Natural/Pure Natural: Depending on the brightness 
of scenes, automatically adjusts the 
white balance to natural ambience.

Pure: Not leaving the blue color or red 
color, automatically adjusts the 
white balance closer to original 
colors.

AWB Fixed Area On/Off Specifies whether auto white balance is 
executed at the center of the screen.
On: Execute in an area corresponding 

to 25% of the height and width of 
the screen.

Off: Execute in an area corresponding 
to 70% of the height and width of 
the screen.

Filter White 
Memory

On/Off Specifies whether to allocate a white 
balance memory area for each FILTER 
knob position.
On: Allocation a white balance 

memory area for each FILTER 
knob position.

Off: Use A/B memory regardless of the 
filter position.
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Offset White
Makes settings related to 
white balance offset 
values.

Offset White 
<A>

On/Off Specifies whether to add (“On”) or not 
to add (“Off”) an offset value to the 
white balance value in memory A.

Warm Cool <A> Approximate color 
temperature

When “Offset White<A>” is set to 
“On,” specifies (as a color temperature) 
the offset to add to the white balance 
value in memory A. (Note that the error 
range becomes larger for higher offset 
color temperatures. Adjust while 
viewing the actual video.)

Warm Cool 
Balance<A>

–99 to ±0 to +99 Specifies a more precise color 
temperature, for use when satisfactory 
video cannot be obtained with the 
“Warm Cool <A>” setting.

Offset White 
<B>

On/Off When this is set to “On,” the offset 
adjusted set with this item is added to 
the white balance of channel B.

Warm Cool <B> Approximate color 
temperature

When “Offset White<B>” is set to 
“On,” specifies (as a color temperature) 
the offset to add to the white balance 
value in memory B. (Note that the error 
range becomes larger for higher offset 
color temperatures. Adjust while 
viewing the actual video.)

Warm Cool 
Balance<B>

–99 to ±0 to +99 Specifies a more precise color 
temperature, for use when satisfactory 
video cannot be obtained with the 
“Warm Cool <B>” setting.

Offset White 
<ATW>

On/Off When this item is set to “On,” the offset 
value adjusted here is added to the 
ATW white balance value.

Warm Cool 
<ATW>

Approximate color 
temperature

When “Offset White <ATW>” is set to 
“On,” use color temperature to set an 
offset value to add to the ATW white 
balance value (the higher the offset 
color temperature, the greater the error, 
so make adjustment while observing the 
video).

Shutter
Makes settings related to 
shutter speed selection.

Shutter Select Second/Degree Specifies the unit used to select shutter 
speeds.
Second: Select in units of seconds.
Degree: Select in units of degrees.

Slow Shutter On/Off Turns the SLS mode on/off. (When this 
setting is set to “On,” The flashband 
reduce function is set to “Off.”)

SLS Frames 2Frames/3Frames/
4Frames/5Frames/
6Frames/7Frames/
8Frames/16Frames/
32Frames/64Frames

Selects the number of accumulated 
frames in slow shutter mode.
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Time Zone
Specifies the time zone.

Zone –12:00 to +0:00 to 
+13:30 (in steps of 30 
minutes)

Specifies a difference from UTC 
(Greenwich Mean Time) in units of 30 
minutes.

Clip
Make settings for clip 
name or clip 
management.

Note
Do not assign clip names 
that begin with the “.” 
(period) symbol. Clips with 
names in which the first 
character is “.” cannot be 
viewed on the application 
software for computers.

Auto Naming In Fat mode: Title/
Plan

In UDF/exFAT mode: 
C****/Title/
Plan

Selects the clip naming format.
C****: XDCAM standard name (In 

UDF/exFAT mode)
Title: Name specified by Title Prefix
Plan: Name specified in planning 

metadata (if no name is specified in 
planning metadata, the name 
specified by Title Prefix is 
selected.)
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Clip
Make settings for clip 
name or clip 
management.

Note
Do not assign clip names 
that begin with the “.” 
(period) symbol. Clips with 
names in which the first 
character is “.” cannot be 
viewed on the application 
software for computers.

Title Prefix Text input Specifies the title part (4 to 46 
alphanumeric characters) of clip titles.
When the currently specified title is 
eight characters or fewer in length, the 
entire title appears. When the title is 
longer than eight characters, the first 
seven characters appear and a “…” 
symbol appears in place of the eighth 
character.
Displays the Character Set screen.

Character Set screen configuration
• Character selection area (three lines)
Select the character to insert at the title 
prefix cursor position.
!#$%()+.-.;=@[]^_~0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWX
YZ
• Cursor operation area (one line)
Space: Changes the character at the 

cursor position to a space
INS: Inserts a space at the cursor 

position
DEL: Deletes the character at the cursor 

position
T: Moves the cursor to the left
t: Moves the cursor to the right
ESC: Cancels the change and return to 

the normal menu
END: Executes the change and return to 

the normal menu
• Title prefix area (one line)

An area to enter the title

To set titles
1 Turn the MENU knob or press the 

arrow buttons to select a character, 
highlighting it, in the character 
selection area, and then press the 
MENU knob or the SET button to 
insert it at the cursor position in the 
title prefix area. (The cursor moves 
to the right.)

2 Repeat step 1 to add more characters 
to the title (using Space, INS, and 
DEL as required).

3 When you have finished entering the 
title, select END to close the 
Character Set screen.

Number Set 0001 to 9999 Specifies the initial value of the numeric 
part (four digits) of clip names (unless 
the name specified in planning metadata 
with “Auto Naming” set to “Plan”).
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Clip
Make settings for clip 
name or clip 
management.

Note
Do not assign clip names 
that begin with the “.” 
(period) symbol. Clips with 
names in which the first 
character is “.” cannot be 
viewed on the application 
software for computers.

Name Display Off/On Selects whether to display the name of 
the next clips to be recorded in E-E 
mode (“On”) or not (“Off”).

Update Media<A>/
Media<B>

Updates the management files on the 
media in the selected slot (execute using 
Execute).

Plan.Metadata
Makes settings for 
operating planning 
metadata.

Load/Slot(A) Execute/Cancel Executes load of planning metadata 
from the SxS memory card in slot A.
Select “Execute” to show the list of the 
planning metadata files stored in the slot 
A SxS memory card and select a file to 
execute the load.

Load/Slot(B) Execute/Cancel Executes load of planning metadata 
from the SxS memory card in slot B.
Select “Execute” to show the list of the 
planning metadata files stored in the slot 
B SxS memory card and select a file to 
execute the load.

Load/USB
(UDF/exFAT 
mode)

Execute/Cancel Executes load of planning metadata 
from the USB flash drive connected to 
the external device connector.
Select “Execute” to show the list of the 
planning metadata files stored in the 
USB flash drive and select a file to 
execute the load.

Properties Execute/Cancel Displays the detailed information in the 
planning metadata loaded on the 
camcorder (execute using Execute).

Clear Execute/Cancel Clears the planning metadata loaded on 
the camcorder (execute using Execute).

Clip Name Disp Title1(ASCII)
Title2(UTF-8)

Selects the display mode of the clip 
name specified in planning metadata 
(see page 99).

Note
When you define both of ASCII format 
name and UTF-8 format name with 
planning metadata, the UTF-8 format 
string is used as the clip name string. If you 
define either of ASCII format name and 
UTF-8 format name with planning 
metadata, the defined format name is 
displayed though it is not selected by menu 
setting.
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Flashband Reduce
Reducing flashbanding.

Note
This item is disabled 
(grayed out) when ”Picture 
Cache Rec” is set to “On,” 
“i.LINK I/O” is set to 
“Enable,” and “Slow 
Shutter” is set to “On.”

Setting On/Off Turns the flashband reduce function on/
off.

Note
When the flashband reduce function is set 
to on/off, video and audio may be distorted 
and noise may appear momentarily.
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Settings in bold are the factory default values.

PAINT Menu

PAINT
Item Sub-item Setting Description
Switch Status
Turns various signal 
correction functions and a 
test signal on/off.

Gamma On/Off Turns gamma correction on/off.

Black Gamma On/Off Turns black gamma correction on/off.

Matrix On/Off Turns linear matrix correction and user 
matrix correction on/off.

Knee On/Off Turns knee correction on/off.

White Clip On/Off Turns white clip correction on/off.

Detail On/Off Turns detail correction on/off.

Aperture On/Off Turns aperture correction on/off.

Flare On/Off Turns flare correction on/off.

Test Saw On/Off Turns the test saw signal on/off.

White
Sets the color 
temperature, and 
performs manual white 
balance adjustment.

Color Temp <A> 1500K to 3200K to 
50000K

Displays the white balance color 
temperature saved in memory A.

Color Temp 
BAL <A>

–99 to ±0 to +99 Specifies the white balance gain values 
saved in memory A (linked R gain and 
B gain).

R Gain <A> –99 to ±0 to +99 Specifies the white balance R gain value 
saved in memory A.

B Gain <A> –99 to ±0 to +99 Specifies the white balance B gain value 
saved in memory A.

Color Temp <B> 1500K to 3200K to 
50000K

Displays the white balance color 
temperature saved in memory B.

Color Temp 
BAL <B>

–99 to ±0 to +99 Specifies the white balance gain values 
saved in memory B (linked R gain and 
B gain).

R Gain <B> –99 to ±0 to +99 Specifies the white balance R gain value 
saved in memory B.

B Gain <B> –99 to ±0 to +99 Specifies the white balance B gain value 
saved in memory B.

Black
Specifies the black level 
(level of the 
unilluminated parts of the 
video).
You can achieve a desired 
look by adjusting the 
black level for deeper or 
shallower blacks.

Master Black –99 to ±0 to +99 Specifies the master black level.

R Black –99 to ±0 to +99 Specifies the R black level.

B Black –99 to ±0 to +99 Specifies the B black level.
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Flare
Makes settings related to 
flare.
Flare is light generated 
from a bright image 
region that spreads 
broadly across the image, 
adding light to dark 
regions and reducing 
contrast. It is caused by 
reflection inside the lens 
system.

Flare On/Off Turns flare correction on/off.

Master Flare –99 to ±0 to +99 Sets the master flare correction level.

R Flare –99 to ±0 to +99 Sets the R flare correction level.

G Flare –99 to ±0 to +99 Sets the G flare correction level.

B Flare –99 to ±0 to +99 Sets the B flare correction level.

Gamma 
Makes settings related to 
gamma.
Gamma correction allows 
you to significantly alter 
the impression made by 
the video by adjusting the 
contrast.

Gamma On/Off Turns gamma correction on/off.

Step Gamma 0.35 to 0.45 to 0.90 
(0.05 steps)

Specifies a gamma correction value in 
steps of 0.05.

Master Gamma –99 to ±0 to +99 Specifies the master gamma level.

R Gamma –99 to ±0 to +99 Specifies the R gamma level.

G Gamma –99 to ±0 to +99 Specifies the G gamma level.

B Gamma –99 to ±0 to +99 Specifies the B gamma level.

Gamma Select The available settings 
vary depending on the 
setting in “Gamma 
Category” (see 
“Description”).

Select the gamma table to use in gamma 
correction.

When Gamma Category is STD:
1 DVW: DVW camcorder equivalent
2 ×4.5: ×4.5 gain
3 ×3.5: ×3.5 gain
4 240M: SMPTE-240M equivalent
5 R709: ITU-R709 equivalent (default 

setting)
6 ×5.0: ×5.0 gain

When Gamma Category is HG:
1 3250: Condense 325% video input to 

100% video output
2 4600: Condense 460% video input to 

100% video output
3 3259: Condense 325% video input to 

109% video output
4 4609: Condense 460% video input to 

109% video output (default setting)

Gamma 
Category

STD/HG Selects use of standard gamma (STD) or 
HyperGamma (HG).

Black Gamma
Makes settings related to 
black gamma correction.
Black gamma correction 
allows you to reproduce 
gradations and color 
nuances in black or near-
black (dark) parts of the 
picture.

Black Gamma On/Off Turns black gamma correction on/off.

Gamma Level –99 to ±0 to +99 Specifies the master black gamma level.

Range Low/L.Mid/H.Mid/
High

Selects the black gamma correction 
effective range.
LOW: 0 to 3.6% 
L.MID: 0 to 7.2% 
H.MID: 0 to 14.4% 
HIGH: 0 to 28.8%
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Knee
Makes settings related to 
knee correction.
Knee correction is 
processing that prevents 
washout by compressing 
the bright parts of the 
video according to an 
upper limit for the 
dynamic range of the 
recorded and output 
picture. The signal level 
where knee processing 
begins is called the “knee 
point,” and the slope of 
knee compression is 
called the “knee slope.”

Knee On/Off Turns knee correction on/off.

Knee Point 50.0% to 90.0% to 
109.0%

Specifies the knee point.

Knee Slope –99 to ±0 to +99 Specifies the knee slope.

Knee Saturation On/Off Turns the knee saturation function on/
off.

Knee Saturation 
Level 

–99 to ±0 to +99 Specifies the knee saturation level.

White Clip
Makes settings related to 
white clipping 
adjustments.
White clipping is 
processing that limits the 
maximum level of video 
output signals. The 
maximum video signal 
output value is called the 
“white clip level.”

White Clip On/Off Turns white clipping adjustment on/off.

Level Country is set to 
“NTSC Area” or 
“NTSC(J)Area”
90.0% to 108.0% to 
109.0%

Country is set to 
“PAL Area”
90.0% to 105.0% to 
109.0%

Specifies the white clip level.
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Detail(HD Mode)/
Detail(SD Mode)
Makes settings related to 
details adjustments in HD 
mode and SD mode.
Detail adjustment is 
processing that improves 
the clarity of the video by 
adding detail signals to 
the edges of the subject.

Detail On/Off Turns detail adjustment on/off.

Level –99 to ±0 to +99 Specifies the detail level.

H/V Ratio –99 to ±0 to +99 Specifies the mix ratio between the H 
detail level and the V detail level.

Crispening –99 to ±0 to +99 Specifies the crispening level.

Level Depend On/Off Turns the level dependence adjustment 
function on/off.

Level Depend 
Level

–99 to ±0 to +99 Specifies the level dependence level.

Frequency –99 to ±0 to +99 Specifies the central frequency for H 
detail signals. Larger values give finer 
details.

Knee Aperture On/Off Turns the knee aperture function on/off.

Knee Aperture 
Level

–99 to ±0 to +99 Specifies the knee aperture level.

Limit –99 to ±0 to +99 Specifies the detail limiter values for 
both the white-side and black-side 
direction.

White Limit –99 to ±0 to +99 Specifies the white-side detail limiter 
value.

Black Limit –99 to ±0 to +99 Specifies the black-side detail limiter 
value.

V-BLK Limit –99 to ±0 to +99 Specifies the black-side V detail limiter 
value.

V Detail 
Creation

NAM/G/R+G/Y Selects the source signal used to 
generate the V detail signal.
NAM: A V detail signal created from 

the R signal, or a V detail signal 
created from the G signal, or a V 
detail signal created from the B 
signal, whichever is the signal with 
the highest level

G: G signal
G+R: Composite signal comprising the 

G signal and R signal in a 1:1 ratio
Y: Y signal

Aperture
Makes settings related to 
aperture correction.
Aperture correction is 
processing to improve 
resolution by adding 
high-frequency aperture 
signals to the video 
signal, which corrects 
degeneration due to high-
frequency characteristics.

Aperture On/Off Turns aperture correction on/off.

Level –99 to ±0 to +99 Sets the aperture level.
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Skin Detail
Makes settings related to 
skin detail correction.
Skin detail correction is 
processing that increases 
or decreases the detail 
level of a specified color 
range (skin tone range), 
for the purpose of 
obtaining attractive 
reproduction of skin 
tones.

Skin Detail On/Off Turns skin detail correction on/off.

Area Detection Color detection 
screen

Detects the color to be targeted by skin 
detail correction.

Area Indication On/Off Turns on/off the function that displays a 
zebra pattern in the area targeted by skin 
detail correction.

Level –99 to ±0 to +99 Specifies the skin detail level.

Saturation –99 to ±0 to +99 Specifies the saturation of the color 
targeted by skin detail correction.

Hue 0 to 359 Specifies the hue of the color targeted 
by skin detail correction.

Width 0 to 40 to 90 Specifies a range for the hue of the color 
targeted by skin detail correction.

Matrix
Makes settings related to 
matrix correction.
Matrix correction allows 
you to adjust the color 
and vividness of the 
video. Depending on the 
effect you want, you can 
select one from among a 
number of preset 
matrixes, which define 
different parameter sets. 
Or you can select a user 
matrix with your own 
parameters.

Matrix On/Off Turns the matrix correction function on/
off.

Preset Matrix On/Off Turns the preset matrix function on/off.

Preset Select 1/2/3/4/5/6 Selects a preset matrix.
1: SMPTE-240M equivalent
2: ITU-709 equivalent
3: SMPTE WIDE equivalent
4: NTSC equivalent
5: EBU equivalent
6: ITU-601 equivalent

User Matrix On/Off Turns the user matrix function on/off.

User Matrix 
R-G

–99 to ±0 to +99 Specifies a freely defined R-G user 
matrix.

User Matrix 
R-B

–99 to ±0 to +99 Specifies a freely defined R-B user 
matrix.

User Matrix 
G-R

–99 to ±0 to +99 Specifies a freely defined G-R user 
matrix.

User Matrix 
G-B

–99 to ±0 to +99 Specifies a freely defined G-B user 
matrix.

User Matrix 
B-R

–99 to ±0 to +99 Specifies a freely defined B-R user 
matrix.

User Matrix 
B-G

–99 to ±0 to +99 Specifies a freely defined B-G user 
matrix.
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Multi Matrix
Makes settings related to 
multi matrix correction.
Multi-matrix correction 
allows specific colors to 
be selected for saturation 
correction in a 16-axis 
hue space.

Multi Matrix On/Off Turns the multi matrix correction 
function on/off.

Area Indication On/Off Turns on/off the function that displays a 
zebra pattern in the color area targeted 
by multi matrix correction.

Color Detection Color detection 
screen

Detects colors targeted by multi matrix 
correction.

Preset Execute/Cancel Sets the Hue and Saturation presets.

Axis B/B+/MG–/MG/
MG+/R/R+/YL–/YL/
YL+/G–/G/G+/CY/
CY+/B–

Specifies a color targeted by multi 
matrix correction (16-axis mode)

Hue –99 to ±0 to +99 Specifies the hue of the color targeted 
by multi matrix correction for each 16-
axis mode.

Saturation –99 to ±0 to +99 Specifies the saturation of the color 
targeted by multi matrix correction for 
each 16-axis mode.

V Modulation
Makes settings related to 
V modulation shading.
V modulation shading 
corrects vertical 
imbalances in sensitivity 
arising from the 
relationship between a 
lens and prism.

V Modulation On/Off Turns V modulation shading on/off.

Master V 
Modulation

–99 to ±0 to +99 Specifies the master V modulation 
level.

R V Modulation –99 to ±0 to +99 Specifies the V modulation level of R 
signals.

G V Modulation –99 to ±0 to +99 Specifies the V modulation level of G 
signals.

B V Modulation –99 to ±0 to +99 Specifies the V modulation level of B 
signals.

Low Key Sat.
Makes settings related to 
low key saturation 
correction.
You can correct the 
saturation of colors in 
dark parts of the video 
only.

Low Key Sat. On/Off Turns low key saturation correction on/
off.

Level –99 to ±0 to +99 Specifies the saturation of colors in low 
luminance areas.

Range Low/L.Mid/H.Mid/
High

Specifies the luminance level for which 
low key saturation is enabled.

Noise Suppress
Makes settings related to 
noise suppression (noise 
compression).
You can effectively 
suppress noise 
components while 
preserving fine edge 
components in the 
subject.

Noise Suppress On/Off Turns noise suppression on/off.
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Settings in bold are the factory default values.

MAINTENANCE Menu

MAINTENANCE
Item Sub-item Setting Description
White Shading
Makes settings related to 
white shading.
White shading is required 
for each different lens to 
correct irregularities 
arising from lens 
characteristics. It corrects 
luminance and color 
irregularities in bright 
areas.

Channel Select Red/Green/Blue Selects the target of white shading 
correction.

R/G/B White H 
Saw

–99 to ±0 to +99 Specifies a SAW white shading 
correction value for the horizontal 
direction.

R/G/B White H 
Para

–99 to ±0 to +99 Specifies a parabola white shading 
correction value for the horizontal 
direction.

R/G/B White V 
Saw

–99 to ±0 to +99 Specifies a SAW white shading 
correction value for the vertical 
direction.

R/G/B White V 
Para 

–99 to ±0 to +99 Specifies a parabola white shading 
correction value for the vertical 
direction.

White Saw/Para On/Off Turns the white shading SAW and 
parabola correction functions on/off.
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Battery
Makes settings related to 
batteries.

Info Before End 5%/10%/15%…95%/
100%

Specifies a threshold value that triggers 
a “Battery Near End” warning when a 
BP-GL95A battery pack is used.

Info End 0%/1%/2%/3%/4%/
5%

Specifies a threshold value that triggers 
a “Battery End” warning when a 
BP-GL95A battery pack is used.

Sony Before End 11.5V to 17V (0.1V 
steps)

Specifies a threshold value that triggers 
a “Battery Near End” warning when a 
BP-L60S/L80S battery pack is used.

Sony End 11.0V to 11.5V (0.1V 
steps)

Specifies a threshold value that triggers 
a “Battery End” warning when a 
BP-L60S/L80S battery pack is used.

Other Before 
End

11.5V to 11.8V to 
17.0V (0.1V steps)

Specifies a threshold value that triggers 
a “Battery Near End” warning when a 
non-Sony battery pack is used.

Other End 11.0V to 14.0V (0.1V 
steps)

Specifies a threshold value that triggers 
a “Battery End” warning when a non-
Sony battery pack is used.

DC In Before 
End

11.5V to 11.8V to 
17.0V (0.1V steps)

Specifies a threshold value that triggers 
a “Battery Near End” warning when an 
external power source is connected to 
the DC IN connector.

DC In End 11.0V to 14.0V (0.1V 
steps)

Specifies a threshold value that triggers 
a “Battery End” warning when an 
external power source is connected to 
the DC IN connector.

Detected Battery Info/Sony/Other/
DC IN

Displays the results of automatic battery 
pack type detection.

Type Detection Auto/Other Auto: Detect the battery type 
automatically.

Other: Fix battery type detection as 
“Other.”

Segment No.10 11.0V to 17.0V (0.1V 
steps)

Specifies voltage threshold values that 
cause remaining capacity segments to 
go off in the display of remaining 
battery capacity (see page 26). (The 
segments go off below the specified 
value.) These values are used when the 
battery type has been found to be 
“Other.”

Segment No.9 11.0V to 16.0V to 
17.0V (0.1V steps)

Segment No.8 11.0V to 15.0V to 
17.0V (0.1V steps)

Segment No.7 11.0V to 14.0V to 
17.0V (0.1V steps)

Segment No.6 11.0V to 13.5V to 
17.0V (0.1V steps)

Segment No.5 11.0V to 13.0V to 
17.0V (0.1V steps)

Segment No.4 11.0V to 12.5V to 
17.0V (0.1V steps)

Segment No.3 11.0V to 12.0V to 
17.0V (0.1V steps)

Segment No.2 11.0V to 11.5V to 
17.0V (0.1V steps)

Segment No.1 11.0V to 17.0V (0.1V 
steps)
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Audio
Makes settings related to 
audio.

Front MIC Select Mono/Stereo Selects whether the front microphone is 
monaural (“Mono”) or stereo 
(“Stereo”).

Audio CH3/4 
Mode

Ch1/2 / Switch Selects the input signals for the AUDIO 
IN CH-3/CH-4 connectors.
Ch1/2: The same signals as the AUDIO 

IN CH-1/ CH-2 connectors.
Switch: The signals selected with the 

AUDIO IN CH-3/CH-4 switches.
Front MIC CH1 
Ref

–70dB/–60dB/
–50dB/–40dB/
–30dB/–20dB

Selects the reference level for channel 1 
of the front microphone.

Front MIC CH2 
Ref

–70dB/–60dB/
–50dB/–40dB/
–30dB/–20dB

Selects the reference level for channel 2 
of the front microphone.

Rear MIC CH1 
Ref

–70dB/–60dB/
–50dB/–40dB/
–30dB/–20dB

Selects the reference input level when 
the setting of the AUDIO IN CH1 
switch is MIC.

Rear MIC CH2 
Ref

–70dB/–60dB/
–50dB/–40dB/
–30dB/–20dB

Selects the reference input level when 
the setting of the AUDIO IN CH2 
switch is MIC.

Line Input Ref +4dB/0dB/–3dB/
EBUL

Selects the reference input level when 
the AUDIO IN CH1 and AUDIO IN 
CH2 switches are set to LINE.

Min Alarm 
Volume

Off/Set Selects the volume when the ALARM 
knob is turned all the way down.
Off: Almost inaudible
Set: Fairly audible

Speaker 
Attenuate

Off/3dB/6dB/9dB/
12dB

Selects the volume from the monitor 
speaker (does not affect earphone 
volume).

Headphone Out Mono/Stereo Selects whether the earphones are 
monaural (“Mono”) or stereo 
(“Stereo”).

Reference Level –20dB/–18dB/
–16dB/–12dB/EBUL

Selects the output level of the 1 kHz test 
signal.

Reference Out 0dB/+4dB/–3dB/
EBUL

Specifies the output level with respect 
to the reference input level.

CH1&2 AGC 
Mode

Mono/Stereo For automatic adjustment of the input 
level of analog audio signals recorded 
on channels 1 and 2, specifies whether 
to make the adjustments separately for 
each channel (“Mono”) or in stereo 
mode (“Stereo”).

CH3&4 AGC 
Mode

Mono/Stereo For automatic adjustment of the input 
level of analog audio signals recorded 
on channels 3 and 4, specifies whether 
to make the adjustments separately for 
each channel (“Mono”) or in stereo 
mode (“Stereo”).

AGC Spec –6dB/–9dB/–12dB/
–15dB/–17dB

Selects the AGC saturation level.
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Audio
Makes settings related to 
audio.

Limiter Mode Off/–6dB/–9dB/
–12dB/–15dB/–17dB

For manual audio level adjustments, 
selects the saturation level for the 
limiter applied to loud input signals.
Select “Off” if you do not wish to use 
the limiter.

Output Limiter On/Off Turns the audio output limiter on/off.
CH1 Wind Filter On/Off Turns the channel 1 wind filter on/off.
CH2 Wind Filter On/Off Turns the channel 2 wind filter on/off.
CH3 Wind Filter On/Off Turns the channel 3 wind filter on/off.
CH4 Wind Filter On/Off Turns the channel 4 wind filter on/off.
Audio SG 
(1KHz)

On/Off/Auto Selects whether to output (“On”) or not 
output (“Off”) a 1 kHz test signal in 
color bar mode.
Auto: Output a test signal only when 

the AUDIO SELECT CH1 switch 
is set to AUTO.

MIC CH1 Level Side1/Front/
Front+Side1

For recording input audio from the front 
microphone on channel 1, selects the 
knob that adjusts the audio level.
Side1: The LEVEL knob (left) on the 

side panel
Front: The MIC LEVEL control on the 

front panel
Front+Side1: Adjust with both the 

LEVEL knob (left) and the MIC 
LEVEL control.

MIC CH2 Level Side2/Front/
Front+Side2

For recording input audio from the front 
microphone on channel 2, selects the 
knob that adjusts the audio level.
Side2: The LEVEL knob (right) on the 

side panel
Front: The MIC LEVEL control on the 

front panel
Front+Side2: Adjust with both the 

LEVEL knob (right) and the MIC 
LEVEL control.

Rear1/WRR 
Level

Side1/Front/
Front+Side1

Selects the knob that adjusts the audio 
levels of a wireless microphone and a 
device connected to the AUDIO IN 
CH-1 connector on the rear panel.
Side1: The LEVEL knob (left) on the 

side panel
Front: The MIC LEVEL control on the 

front panel
Front+Side1: Adjust with both the 

LEVEL knob (left) and the MIC 
LEVEL control.
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Audio
Makes settings related to 
audio.

Rear2/WRR 
Level

Side2/Front/
Front+Side2

Selects the knob that adjusts the audio 
levels of a wireless microphone and a 
device connected to the AUDIO IN CH-
2 connector on the rear panel.
Side2: The LEVEL knob (right) on the 

side panel
Front: The MIC LEVEL control on the 

front panel
Front+Side2: Adjust with both the 

LEVEL knob (right) and the MIC 
LEVEL control.

Audio CH3 
Level

Side3/Front/
Front+Side3

Selects the knob that adjusts the level of 
audio recorded on channel 3.
Side3: The LEVEL knob on the side 

panel
Front: The MIC LEVEL control on the 

front panel
Front+Side3: Adjust with both the 

LEVEL knob and the MIC LEVEL 
control.

Audio CH4 
Level

Side4/Front/
Front+Side4

Selects the knob that adjusts the level of 
audio recorded on channel 4.
Side4: The LEVEL knob on the side 

panel
Front: The MIC LEVEL control on the 

front panel
Front+Side4: Adjust with both the 

LEVEL knob and the MIC LEVEL 
control.
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WRR Setting
Makes settings related to 
the wireless tuner.

WRR Valid CH 
Sel

All/CH1 Selects whether to enable channels 1 
and 2 of the wireless receiver (“All”) or 
channel 1 only (“CH1”).

WRR CH Select TX1/TX2 Specifies the target channel for other 
sub-items.
TX1: Channel 1
TX2: Channel 2

WRR Delay 
Comp

On/Off Enables (“On”) or disables (“Off”) 
delay compensation for wireless audio 
input. (When “On” is selected, the audio 
in all E-E output is delayed by about 8 
ms.)

TX --- Displays the name of the transmitter 
whose signals are being received on the 
channel selected by “WRR CH Select.”

TX Audio Peak ---/Peak Displays whether the AF level of the 
transmitter whose signals are being 
received on the channel selected by 
“WRR CH Select” are over peak.

TX Input Level ---/Mic/Line Displays whether the input level of the 
transmitter whose signals are being 
received on the channel selected by 
“WRR CH Select” is set to microphone 
(“Mic”) or line (“Line”).

TX ATT Level --- Sets the ATT level of the transmitter 
whose signals are being received on the 
channel selected by “WRR CH Select.” 
(The setting range varies depending on 
the transmitter.)

TX LCF Freq --- Sets the low cut filter frequency of the 
transmitter whose signals are being 
received on the channel selected by 
“WRR CH Select.” (The setting range 
varies depending on the transmitter.)

TX System 
Delay

Auto/0.0ms to 8.0ms Specifies the amount of audio delay.
Auto: Automatically adjusts the 

amount of delay so that the delay in 
the audio received from the 
wireless transmitter is zero.

0.0ms to 8.0ms: Sets the amount of 
anticipated wireless system delay, 
for cases in which several wireless 
systems are being used over a 
devices such as an audio mixer.
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Timecode
Makes settings related to 
timecode.

TC Out Auto/Generator Selects the source for timecode output.
Auto: During recording, output values 

generated by the timecode 
generator, and during playback 
output values obtained by the 
timecode reader.

Generator: Output values generated 
by the timecode generator during 
both recording and playback.

DF/NDF DF/NDF When “Country” is set to other than 
“PAL Area,” selects drop-frame mode 
(“DF”) or non-drop-frame mode 
(“NDF”).

LTC UBIT Fix/Time Specifies the data recorded in LTC user 
bits.
Fix: Record user-specified data.
Time: Record the current time.

Counter Display Counter/Duration Select the method used to reset the 
counter value displayed on the 
viewfinder screen.
Counter: Continue to increment until 

the RESET button is pressed.
Duration: Reset each time that 

recording is started.
Essence Mark
Makes settings related to 
shot marks and clip index 
picture thumbnails.

Ret Shot Mark 1 On/Off Specify whether to input Shot Mark1 
marks using the RET button on the lens.

Ret Shot Mark 2 On/Off Specify whether to input Shot Mark2 
marks using the RET button on the lens.

Index Picture Pos 0sec to 10sec 
(in 1 sec steps)

Specifies which frame to use as the clip 
thumbnail image

Find Mode Clip/Rec Start Specify the frame to be cued up when 
the PREV or NEXT button is pressed.
Rec Start: The next frame or the 

previous frame where a Rec Start 
essence mark is set.

Clip: Pressing the NEXT button moves 
to the start frame of the next clip. 
Pressing the PREV button moves 
to the start frame of the current 
clip. (Pressing the PREV button at 
the start frame of the current clip 
moves to the start frame of the 
previous clip.)
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Camera Config
Makes settings related to 
various camcorder 
operations.

Rec Tally Blink On/Off Turns warning flashes by the TALLY 
indicator on/off. The warnings alert you 
an almost exhausted battery pack or low 
remaining media capacity.

Rec Review 3sec/10sec/Clip Selects the recording review time.
Clip: Review all of the most recently 

recorded clip.
SDI Rec Control Off / Remote I/F / 

Para Rec
Sets the function that enables 
synchronized recording with this 
camcorder.
Remote I/F: To feed a REC trigger 

signal to a recorder connected to 
the SDI OUT connector.

Para Rec: Performs the recording 
controls by interlocking to the 
camcorder’s recording operation.

HD SDI Remote 
I/F

Chara/G-Tally/
R-Tally

Selects the indication that shows 
whether the external device is recording 
when “SDI Rec Control” is set to 
“Remote I/F.”
Chara: Indicate by the external device 

control indication on the 
viewfinder screen.

G-Tally: Indicate by the green tally 
indicator on the viewfinder screen.

R-Tally: Indicates by the recording 
mode/operation status indication 
on the viewfinder screen.

Note
When “SDI Rec Control” is set to “Para 
Rec,” “Chara” is set automatically and this 
item is grayed out.

Match Clip 
Name

On/Off Sets whether to add the clip name 
information to the SDI output.

ALAC AUTO/OFF Sets the ALAC (automatic lens 
aberration correction) function.
AUTO: The ALAC function is set to on 

when a compatible lens is attached.
OFF: Does not use the ALAC function.

CCU Operation Normal/Local Enables switch operations for the inside 
panel when the camera adaptor is 
mounted.

Notes
• If you change the switch operation 

setting of the camcorder, the camcorder 
will restart automatically.

• When main unit switch operation is 
enabled, display of the CCU remote 
controller and display of return videos 
and tally and call operations from the 
CCU are enabled, but remote control via 
the CCU or via the REMOTE connector 
is disabled.
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Camera Config
Makes settings related to 
various camcorder 
operations.

Color Bars Select ARIB/100%/75%/
SMPTE

Selects the color bar type.

User Menu Only On/Off Selects whether to display the USER 
menu only (“On”) or display the menu 
list (“Off”) when the camcorder is 
displaying the menu.

User Menu with 
Lock

On/Off Selects whether to lock the menu 
display, showing the USER menu only.
On: Enter an arbitrary passcode number 

to lock the menu display. (Only the 
USER menu is displayed.)

Off: Enter the passcode number entered 
when “On” was selected to unlock 
the menu display. (When unlocked, 
the normal menu list is displayed.)

Note

In normal menu display operation, this 
item is not displayed.
For details about menu display operation, 
see page 116.

RM Common 
Memory

On/Off Selects whether to share (“On”) or not 
share (“Off”) settings between times 
when a remote control unit is connected 
and times when the camcorder is used 
locally.

RM Rec Start RM/CAM/PARA For times when a remote control unit is 
connected, selects whether recording 
start/stop buttons are enabled on the 
camcorder or the remote control unit.
RM: Remote control unit
CAM: Camcorder
PARA: Both

Image Invert On/Off Turns the function that inverts images 
vertically on/off.

Rec Start/Stop 
Beep

On/Off Specifies whether to generate (“On”) or 
not generate (“Off”) a beep alarm when 
recording starts/stops.
With this item set to “On,” a single beep 
sounds when recording starts and a 
double beep sounds when recording 
stops.

Rec Status 
Indicator

On/Off Specifies whether to display the 
recording status indicator in the 
viewfinder.

Fan Control Auto/Off in Rec Sets the fan control mode.

MAINTENANCE
Item Sub-item Setting Description
152



Preset White
Makes settings related to 
white balance preset 
values.

Color Temp<P> 1500K to 3200K to 
50000K

Specifies the white balance preset value.

Color Temp 
Balance<P>

–99 to ±0 to +99 Specifies finer color temperature 
settings, for use when satisfactory video 
cannot be obtained with “Color 
Temp<P>.”

R Gain <P> –99 to ±0 to +99 Specifies the R gain preset value.
B Gain <P> –99 to ±0 to +99 Specifies the B gain preset value.
AWB Enable 
<P>

On/Off Turns on and off execution of the AWB 
(auto white balance) function when the 
WHITE BAL switch is set to PRST.

White Filter
Makes settings related to 
filters.

ND Filter 
C.Temp

On/Off Turns the function that assigns electrical 
CC filters to ND filters on/off.

ND FLT 
C.Temp<1>

3200K/4300K/
5600K/6300K

Selects the color temperature for when 
electrical CC filters are assigned to ND 
filters.

ND FLT 
C.Temp<2-4>

3200K/4300K/
5600K/6300K

Selects the color temperature for when 
electrical CC filters are assigned to ND 
filters.

Electrical 
CC<A> 

3200K/4300K/
5600K/6300K

Selects the color temperature for when 
the electrical CC filter switching 
function is assigned to an assignable 
switch.

Electrical 
CC<B>

3200K/4300K/
5600K/6300K

Selects the color temperature for when 
the electrical CC filter switching 
function is assigned to an assignable 
switch.

Electrical 
CC<C>

3200K/4300K/
5600K/6300K/-----

Selects the color temperature for when 
the electrical CC filter switching 
function is assigned to an assignable 
switch.
Select “----” if you do not want to use C.

Electrical 
CC<D>

3200K/4300K/
5600K/6300K/-----

Selects the color temperature for when 
the electrical CC filter switching 
function is assigned to an assignable 
switch.
Select “----” if you do not want to use D.
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Auto Iris2
Makes settings related to 
auto iris.

Iris Window 1/2/3/4/5/6/Var Selects the auto iris detection window 
type.
Var: Variable

Iris Window Ind On/Off Turns the indication of the auto iris 
detection window frame on/off.

Iris Level –99 to ±0 to +99 Adjusts the level of the auto iris target 
value.

Iris APL Ratio –99 to ±0 to +99 Adjusts the mix ratio of auto iris 
detection peak value and average value.
(Available when “OPERATION” > 
“TLCS” > “Mode” is set to “Standard”)

Iris Var Width 40 to 500 to 999 Adjusts the width of the detection 
window when “Iris Window” is set to 
“VAR.”

Iris Var Height 70 to 500 to 999 Adjusts the height of the detection 
window when “Iris Window” is set to 
“VAR.”

Iris Var H 
Position

–479 to 0 to +479 Specifies the horizontal position of the 
detection window when “Iris Window” 
is set to “VAR.”

Iris Var V 
Position

–464 to 0 to +464 Specifies the vertical position of the 
detection window when “Iris Window” 
is set to “VAR.”

Iris Speed –99 to ±0 to +99 Specifies the control speed (speed of 
reaction to changes in the video). 
(Larger values specify quicker reaction 
times.)

Clip High Light On/Off Turns on/off the function that disregards 
highlights and forces a flatter reaction to 
high luminance.

Flicker Reduce
Makes settings related to 
flicker reduction.
Reduces the flicker that 
can occur when a subject 
is shot under a light 
source with a periodically 
varying brightness, such 
as fluorescent lights, due 
to the relationship with 
the camcorder’s 
recording frame rate.

Mode Auto/On/Off Enables or disables flicker reduction.
On: Always enabled.
Auto: Enabled when flicker is detected.
Off: Disabled

Frequency 60Hz/50Hz Set to the frequency of the lighting 
fixture that is causing the flicker. (The 
factory default setting is “50 Hz” when 
“Country” is set to “PAL Area,” 
“60 Hz” when “Country” is set to other 
than “PAL Area.”)

Genlock
Makes settings related to 
genlock.

H Phase(HD) –999 to ±0 to +999 Specifies the H phase of HD output 
when genlock is enabled.

H Phase(SD) –99 to ±0 to +99 Specifies the H phase of SD output 
when genlock is enabled.

Reference Internal/Genlock Displays the type of reference signal 
used by the camcorder.
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ND Comp
Makes settings related to 
ND filter color 
compensation.
Although the differences 
are very slight, each of 
the built-in ND filters has 
different color 
characteristics. When you 
switch between ND 
filters, the white balance 
may be disturbed. You 
can correct for these 
slight color differences 
automatically by 
registering compensation 
values for each filter.

ND Offset 
Adjust

On/Off ND filter color compensation function.

Clear ND Offset Execute/Cancel Clears ND filter color compensation 
values (execute using Execute).

Lens
Executes auto flange back 
adjustment.

Auto FB Adjust Execute/Cancel Executes auto flange back adjustment, 
only for supported lenses (execute using 
Execute).

Trigger Mode
Makes settings related to 
triggers for starting and 
stopping recording.

i.LINK Trigger 
Mode

Internal/Both/
External

Select Internal when recording start and 
stop operations target SxS memory 
cards only. Select External when they 
target only devices connected to the 
i.LINK (HDV/DV) or HD/SD SDI OUT 
connectors. Select Both when they 
target both memory cards and external 
devices.

Network Setting a) 
Makes settings for 
network connection.

Notes
• The IFU-WLM3 USB 

Wireless LAN Module is 
required.

• This item is not available 
when using the 
CBK-WA101 Wireless 
Adapter.

• This item is disabled 
(grayed out) during 
recording and play.

For details about wireless 
LAN connection, see 
“Connecting the 
Camcorder to Devices 
using the IFU-WLM3 USB 
Wireless LAN Module” 

(page 81).

DHCP Enable/Disable Selects whether to acquire the IP 
address automatically from a DHCP 
server (“Enable”) or not (“Disable”).

IP Address 0.0.0.0 to 
255.255.255.255 
(192.168.1.10)

When “DHCP” is set to “Disable,” sets 
the IP address.

Subnet Mask 0.0.0.0 to 
255.255.255.255

When “DHCP” is set to “Disable,” sets 
the subnet mask.

Default Gateway 0.0.0.0 to 
255.255.255.255

When “DHCP” is set to “Disable,” sets 
the default gateway.

User Name admin Sets a desired user name in 1 to 31 
alphanumeric characters.

Password pxw-x320 (model 
name)

Sets a password (model name) in 0 to 31 
alphanumeric characters.

Set Execute/Cancel Confirms the settings in “Network 
Settings” (execute using Execute).

MAC Address Displays the MAC address.
Net Config Reset Execute/Cancel Resets the settings in “Network 

Settings” to the preset values (execute 
using Execute).
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Wi-Fi Setting
Makes settings for 
wireless LAN connection.

Notes
• The IFU-WLM3 USB 

Wireless LAN Module is 
required.

• Menus other than “Wi-
Fi” and “Wi-Fi Remote” 
are not used when using 
the CBK-WA101 
Wireless Adapter.

• This item is disabled 
(grayed out) during 
recording and play.

For details about wireless 

LAN connection, see 
“Connecting the 
Camcorder to Devices 
using the IFU-WLM3 USB 
Wireless LAN Module” 

(page 81).

Scan Networks Execute/Cancel When “Wi-Fi” is set to “Enable,” scan 
the available network connection.

SSID Network name Sets the network name of up to 32 
characters.

Network Type Infra/Adhoc Selects the connection mode.
Infra: Infrastructure mode
Adhoc: Ad hoc mode

Ch 1 to 11 When “Network Type” is set to 
“Adhoc,” set the wireless channel.

Authentication Open/Shared/WPA/
WPA2

Selects the network authentication.
Open: Open system authentication
Shared: Shared key authentication
WPA: WPA (Wi-Fi Protected Access) 

authentication
WPA2: WPA2 (Wi-Fi Protected 

Access 2) authentication when 
“Network Type” is set to “Infra”

Encryption Disable/WEP/TKIP/
AES

Selects whether to apply data 
encryption and the type of data 
encryption.
Disable: Do not apply data encryption.
WEP: Apply WEP (Wired Equivalent 

Privacy) when “Authentication” is 
set to “Open” or “Shared”

TKIP: Apply TKIP (Temporal Key 
Integrity Protocol) when 
“Authentication” is set to “WPA” 
or “WPA2”

AES: Apply AES (Advanced 
Encryption Standard) when 
“Authentication” is set to “WPA” 
or “WPA2”

WEP Key Index 1/2/3/4 When “Encryption” is “WEP,” selects 
the key index.

Input Select When “Encryption” is 
set to “WEP”
ASCII5, 
ASCII13, 
HEX10, 
HEX26

When “Encryption” is 
set to “TKIP” or 
“AES”
ASCII8-63, 
HEX64

Selects the input format depending on 
the network key (or security key).
ASCII5: Five characters ASCII format
ASCII13: 13 characters ASCII format
HEX10: 10 hexadecimal digits
HEX26: 26 hexadecimal digits
ASCII8-63: 8 to 63 characters ASCII 

8-bit format
HEX64: 64 hexadecimal digits

Key Sets the network key (or security key).
Set Enables settings for “Wi-Fi Setting” 

when “Wi-Fi” is set to “Enable” 
(execute using Execute).
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Wi-Fi Setting
Makes settings for 
wireless LAN connection.

Notes
• The IFU-WLM3 USB 

Wireless LAN Module is 
required.

• Menus other than “Wi-
Fi” and “Wi-Fi Remote” 
are not used when using 
the CBK-WA101 
Wireless Adapter.

• This item is disabled 
(grayed out) during 
recording and play.

For details about wireless 

LAN connection, see 
“Connecting the 
Camcorder to Devices 
using the IFU-WLM3 USB 
Wireless LAN Module” 

(page 81).

Wi-Fi Status xxxxx 
Connecting

Displays “Connecting” while 
connection is being attempted. Displays 
black squares (x) to show the 
connection status by the number of 
squares when the camcorder is 
connected to a computer or a LAN.

Wireless Mode 802.11b/802.11g/
802.11n

Displays an IEEE802.11 standard.

Wi-Fi Enable/Disable Selects whether to enable or disable 
wireless LAN connection.

Wi-Fi Remote On/Off Select “On” when using Wi-Fi remote 
control.

Note

Unselectable when “Wi-Fi” is set to 
“Disable.”

Clock Set
Sets the internal clock.

Date/Time Sets the current date and time.
12H/24H 12H/24H Selects the 12-hour format (“12H”) or 

the 24-hour format (“24H”) for display 
of times.

Date Mode YYMMDD/
MMDDYY/
DDMMYY

Selects the display format for dates.
YYMMDD: Year, Month, Day
MMDDYY: Month, Day, Year
DDMMYY: Day, Month Year

Language
Selects the language for 
menus and messages.

Language English/Japanese/
Chinese/Spanish/
Portuguese/Russian/
Indonesian

Selects the language for menus and 
messages.
English: To display in English
Japanese: To display in Japanese
Chinese: To display in Chinese
Spanish: To display in Spanish
Portuguese: To display in Portuguese
Russian: To display in Russian
Indonesian: To display in Indonesian

Notes

• The language of the menus and messages 
differs depending on the area.

• When set to “Japanese,” the menus are 
displayed in English, and messages are 
displayed in Japanese.

Hours Meter
Makes settings related to 
the digital hours meter.

Hours(Sys) Displays the cumulative hours of use 
(cannot be reset).

Hours(Reset) Displays the hours of use (can be reset).
Reset Execute/Cancel Resets “Hours(Reset)” to “0” (execute 

using Execute.)
Direct Menu 
Makes settings related to 
the Direct menu.

Direct Menu On/Off Selects whether to enable (On) or 
disable (Off) the Direct menu functions.
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Menu Scroll
Selects the scroll method 
for the menu.

Menu Scroll Normal/Loop Selects the scroll method for the menu.
Normal: The cursor stops when it 

reaches to the top or bottom while 
scrolling.

Loop: The cursor continues scrolling 
from the bottom when it reaches to 
the top, or from the top when it 
reaches to the bottom.

USB Set USB Thumbnail Execute/Cancel Displays the USB media thumbnail 
screen.

Select Folder Selects a folder on USB media as the 
destination when copying clips and for 
display on the thumbnail screen.
Select “<New>” to create a new folder.

Rename Folder Renames the current folder.
Error Check On/Off Selects whether to perform error 

checking when copying clips.
Format USB exFAT/FAT32 Formats USB media.

exFAT: Format USB media for copying 
clips.

FAT32: Format USB flash drive for 
writing planning metadata (UDF/
exFAT mode).

Copy To USB A to USB/B to USB/
A&B to USB

Copies SxS memory card clips to USB 
media.

Note

Available only when the thumbnail screen 
is displayed.

Copy From USB USB to A/USB to B Copies USB media clips to SxS 
memory card.

Note

Available only when the thumbnail screen 
is displayed.

With General Enable/Disable Enables/disables copying of files in the 
General folder when copying clips.

Version
Displays the version of 
the camcorder, and 
updates the camcorder.

Version Displays the software version of the 
camcorder (Vx.xx).

CBK-CE01 Displays the software version of the 
optional CBK-CE01 (Vx.xx).

Version Up Execute/Cancel Updates the camcorder (execute using 
Execute).

Note
This cannot be selected unless an SxS 
memory card is inserted.
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Settings in bold are the factory default values.

FILE Menu

FILE
Item Sub-item Setting Description
User
Makes settings relating to 
user file operations.

User Load SxS Execute/Cancel Loads a user file saved on an SxS 
memory card (execute using Execute).
When “Load Customize Data” is 

“Off”: USER menu settings are 
replaced by settings saved in a user 
file (menu organization does not 
change).

When “Load Customize Data” is 
“On”: USER menu settings and 
organization are replaced by 
settings and organization saved in a 
user file.

When “Load White Data” is “Off”: 
Do not load white balance data 
when loading a user file.

When “Load White Data” is “On”: 
Load white balance data.

User Save SxS Execute/Cancel Saves current USER menu organization, 
settings, and white balance data to a 
user file on an SxS memory card 
(execute using Execute).

User Load USB (UDF/exFAT mode) Loads a user file saved on a USB flash 
drive (execute using Execute).

User Save USB (UDF/exFAT mode) Saves current USER menu organization, 
settings, and white balance data to a 
user file on a USB flash drive (execute 
using Execute).

File ID Assigns a name to a user file. Names 
can be up to 16 characters in length.

Recall User 
Preset

Execute/Cancel Returns the settings of menu items 
registered in the USER menu to the 
preset values (execute using Execute).

Store User Preset Execute/Cancel Stores the settings of menu items 
registered in the USER menu items as 
the preset values (execute using 
Execute).

Clear User Preset Execute/Cancel Returns the settings of menu items 
registered in the USER menu to the 
factory default values (execute using 
Execute).

Load Customize 
Data

Off/On Selects whether to load menu 
organization and settings (“On”) or 
menu settings only (“Off”) when 
loading a user file.

Load White Data Off/On Selects whether to load (“On”) or not 
load (“Off”) white balance data when 
loading a user file.
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All
Makes settings related to 
ALL file operations.

Display Mode Date&Time/
Model Name

Selects the items to be displayed in the 
list box that appears when a file is saved 
or loaded.

All Load SxS Execute/Cancel Loads a file from an SxS memory card 
(execute using Execute).

All Save SxS Execute/Cancel Stores a file to an SxS memory card 
(execute using Execute).

All Load USB
(UDF/exFAT 
mode)

Execute/Cancel Loads a file from a USB flash drive 
(execute using Execute).

All Save USB
(UDF/exFAT 
mode)

Execute/Cancel Stores a file to a USB flash drive 
(execute using Execute).

File ID Assigns a name to a file. Names can be 
up to 16 characters in length.

All Preset Execute/Cancel Return all items to their preset values 
(execute using Execute).

Store All Preset Execute/Cancel Store the current settings of all items as 
the preset values (execute using 
Execute).

Clear All Preset Execute/Cancel Clear the preset values of all items 
(execute using Execute).

3Sec Clr Preset On/Off Turns on/off the function that clears 
each preset value when the MENU 
CANCEL/PRST/ESCAPE switch is 
pushed up and held for three seconds on 
the CANCEL/PRST side.

Network Data Off/On Selects whether to load (“On”) or not 
load (“Off”) network settings when 
loading an ALL file.
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Scene
Makes settings related to 
scene file operations.

s1 Standard File number and file ID

s2 Standard File number and file ID

s3 Standard File number and file ID

s4 Standard File number and file ID

s5 Standard File number and file ID

sStandard Standard settings

Display Mode Date&Time/
Model Name

Selects the items to be displayed in the 
list box that appears when a file is saved 
or loaded.

Scene Recall 
Mem

Execute/Cancel Loads a file from internal memory 
(execute using Execute).

Scene Store 
Mem

Execute/Cancel Stores a file in internal memory 
(execute using Execute).

Scene Recall SxS Execute/Cancel Loads a file from an SxS memory card 
(execute using Execute).

Scene Store SxS Execute/Cancel Stores a file to an SxS memory card 
(execute using Execute).

Scene Recall 
USB
(UDF/exFAT 
mode)

Execute/Cancel Loads a file from a USB flash drive 
(execute using Execute).

Scene Store USB
(UDF/exFAT 
mode)

Execute/Cancel Stores a file to a USB flash drive 
(execute using Execute).

File ID Assigns a name to a file. Names can be 
up to 16 characters in length.

Reference
Makes settings related to 
reference file operations.

Reference Store Execute/Cancel Stores the current settings of reference 
file items in the reference file that is 
maintained in internal memory (execute 
using Execute).

Reference Clear Execute/Cancel Clears the reference file (execute using 
Execute).

Reference Load 
SxS

Execute/Cancel Loads a file from an SxS memory card 
(execute using Execute).

Reference Save 
SxS

Execute/Cancel Stores a file to an SxS memory card 
(execute using Execute).

Reference Load 
USB
(UDF/exFAT 
mode)

Execute/Cancel Loads a file from a USB flash drive 
(execute using Execute).

Reference Save 
USB
(UDF/exFAT 
mode)

Execute/Cancel Stores a file to a USB flash drive 
(execute using Execute).

File ID Assigns a name to a file. Names can be 
up to 16 characters in length.

Scene White 
Data

On/Off Selects whether to load (“On”) or not 
load (“Off”) white balance data when 
“Scene” > “Scene Recall” or “Scene” > 
“Standard” is executed.
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Lens
Makes settings related to 
lens file operations.

Display Mode Date&Time/
Model Name

Selects the items to be displayed in the 
list box that appears when a file is saved 
or loaded.

Lens Recall 
Mem

Execute/Cancel Loads a file from internal memory 
(execute using Execute).

Lens Store Mem Execute/Cancel Stores a file in internal memory 
(execute using Execute).

Lens Recall SxS Execute/Cancel Loads a file from an SxS memory card 
(execute using Execute).

Lens Store SxS Execute/Cancel Stores a file to an SxS memory card 
(execute using Execute).

Lens Recall USB
(UDF/exFAT 
mode)

Execute/Cancel Loads a file from a USB flash drive 
(execute using Execute).

Lens Store USB
(UDF/exFAT 
mode)

Execute/Cancel Stores a file to a USB flash drive 
(execute using Execute).

File ID Assigns a name to the most recently 
loaded file. Names can be up to 16 
characters in length.

Source Displays the number of the selected file.

Lens No Offset Execute/Cancel Clears a file (execute using Execute).

Lens Auto Recall Off/On/Serial 
Number

When the installed lens supports serial 
communication, specifies whether to 
automatically load that reference file.
Off: Do not use this function.
On: Load the reference for the model 

name and reflect the contents of the 
file.

Serial Number: For lenses that 
support serial number 
communication, load the lens file 
that corresponds to the serial 
number and model name, and 
reflect the contents of that file. For 
lenses that do not support serial 
number communication, load the 
reference for the model name (in 
the same way as when On is 
selected).

Serial Number Displays the serial number of the 
installed lens (only for lenses that 
support serial communication).

Lens ID Displays the model name of the 
installed lens (only for lenses that 
support serial communication).

L Manufacturer Displays the name of the manufacturer 
of the installed lens (only for lenses that 
support serial communication).

M V Modulation –99 to ±0 to +99 Sets a vertical SAW shading 
compensation value in the lens file.
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Lens
Makes settings related to 
lens file operations.

Lens Center H –40 to 0 to 40 Sets a center marker horizontal position 
in the lens file.

Lens Center V –40 to 0 to 40 Sets a center marker vertical position in 
the lens file.

Lens R Flare –99 to ±0 to +99 Sets a R flare level in the lens file.

Lens G Flare –99 to ±0 to +99 Sets a G flare level in the lens file.

Lens B Flare –99 to ±0 to +99 Sets a B flare level in the lens file.

Lens W-R Offset –99 to ±0 to +99 Sets a R white balance compensation 
value in the lens file.

Lens W-B Offset –99 to ±0 to +99 Sets a B white balance compensation 
value in the lens file.

Shading Ch Sel Red/Green/Blue Selects the white shading compensation 
target.

L R/G/B H Saw –99 to ±0 to +99 Sets a horizontal SAW white shading 
compensation value in the lens file.

L R/G/B H Para –99 to ±0 to +99 Sets a horizontal parabola white shading 
compensation value in the lens file.

L R/G/B V Saw –99 to ±0 to +99 Sets a vertical SAW white shading 
compensation value in the lens file.

L R/G/B V Para –99 to ±0 to +99 Sets a vertical parabola white shading 
compensation value in the lens file.

Import File Import Execute/Cancel Loads a PMW-320 scene file.

Note

Before performing import, select the card 
slot for the SxS memory card to which the 
scene file is stored.
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Using the Assignable SW item of the OPERATION menu, you can assign user-specified functions to the 
ASSIGN. 0 to 3 switches, the ASSIGNABLE 4 and 5 switches, the COLOR TEMP. button, and the RET 
button on the lens.
The following tables lists the functions that are assigned when the camcorder is shipped from the factory.

Assigning Functions to Assignable Switches

Switch or button Function Assignable SW setting

ASSIGN. 0 switch No assignment Off

ASSIGN. 1 switch Execute EZ mode, according to the setting of 
“OPERATION” > “TLCS.”

EZ Mode

ASSIGN. 2 switch No assignment Off

ASSIGN. 3 switch No assignment Off

ASSIGNABLE 4 switch No assignment Off

ASSIGNABLE 5 switch No assignment Off

RET button During recording or playback: Write a shot mark.
In the other states: Conduct a recording review (if 

playback is allowed).

Lens RET

COLOR TEMP. button Adjust the white balance with a 5600K preset value. Color Temp SW 5600K

Functions That Can Be Assigned to the ASSIGN. 0 Switch

Assignable SW setting Function State when camcorder 
is next powered on

Off No assignment —

Marker Turns the display of all markers on/off. Setting retained

ATW Hold Hold the white balance setting in the ATW (auto-tracking 
white balance) mode

—

Picture Cache Turn the picture cache function on/off. Setting retained

Freeze Mix Execute the freeze mix function. —

Focus Mag Turn the focus magnification function on/off. Setting not retained

Zebra Turn zebra display on/off. Setting not retained

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Clip Flag OK Add/clear an OK flag to/from the clip being recorded or 
played.

Setting not retained

Clip Flag NG Add/clear an NG flag to/from the clip being recorded or 
played.

Setting not retained

Clip Flag Keep Add/Clear a KP flag to/from the clip being recorded or 
played.

Setting not retained

Flashband Reduce Turn the flashband reduce function on/off. Setting not retained

Quick Backup Back up all the clips in the selected SxS card to a USB 
media.

Setting not retained

USB Thumbnail Display the thumbnail screen of a USB media. Setting not retained
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Note

Immediately after you assign a function to the ASSIGN. 2 switch or you switch the recording format, the setting of the 
switch at that point may not match the camcorder’s internal state. After assigning a function, switch the ASSIGN. 2 
switch or power the camcorder off and on again.

a) When Picture Cache is assigned, “OPERATION” > “Rec Function” in the setup menu is disabled (grayed out) to 
keep the setting unchanged.

b) When the digital extender function is turned on, it is not possible to show the return video.

Functions That Can Be Assigned to the ASSIGN. 2 Switch

Assignable SW setting Function

Off No assignment

Front Mic Switch between stereo and monaural when a stereo microphone is connected.

Marker Turns the display of all markers on/off.

Picture Cache a) Turn the picture cache function on/off.

Zebra Turn zebra display on/off.

Clip Continuous Rec Turn the Clip Continuous Rec mode on/off.

Digital Extender b) Turn the screen magnification function on/off when the optional CBK-CE01 50 
Pin Interface and Digital Extender is installed.

Functions That Can Be Assigned to the ASSIGN. 1 and 3 Switches, the 
ASSIGNABLE 4 and 5 Switches, and the COLOR TEMP. Button

Assignable SW setting Function State when 
camcorder is next 
powered on

Off No assignment —

Front Mic Switch between stereo (On) and monaural (Off) when a 
stereo microphone is connected.

Setting retained

Marker Turns the display of all markers on/off. Setting retained

Last Clip Delete Delete the most recently recorded clip. —

ATW Turn ATW (auto tracing white balance) mode on/off. Setting not retained

ATW Hold Hold the white balance setting in the ATW mode. —

EZ Mode Execute EZ mode, according to the setting of 
“OPERATION” > “TLCS.”

Setting retained

Turbo Gain Execute Turbo Gain according to the setting of 
“OPERATION” > “Gain Switch” > “Gain Turbo.”

Setting not retained

Rec Review Execute recording review. —

Rec Start or stop recording. —

Picture Cache Turn the picture cache function on/off. Setting retained

Freeze Mix Execute the freeze mix function. Setting not retained

Spotlight Turn the spotlight function in auto iris mode on/off. Setting retained

Backlight Turn the backlight function in auto iris mode on/off. Setting retained

EVF Mode Switch the viewfinder screen between B&W (On) and color 
(Off).

Setting retained

BRT Disp Turn the display of the brightness level on/off. Setting retained

Histogram Turn the histogram display on/off. Setting retained
165



Lens Info Switch the depth of field indication between off, displayed in 
meters, and displayed in feet.

Setting retained

Zoom Tele/Wide When a lens that supports serial communication is installed, 
assign the Zoom Tele function to ASSIGNABLE 4, and 
assign the Zoom Wide function to ASSIGNABLE 5 
(displayed only when <4> and <5> are set).

—

Zoom Wide/Tele When a lens that supports serial communication is installed, 
assign the Zoom Wide function to ASSIGNABLE 4, and 
assign the Zoom Tele function to ASSIGNABLE 5 
(displayed only when <4> and <5> are set).

—

Manual Focus Assist Turn the manual focus assist function on/off. Setting retained

Focus Mag Turn the focus magnification function on/off. Setting not retained

Zebra Turn zebra display on/off. Setting not retained

Lens RET Display return video signals when the optional CBK-CE01 is 
installed and a camera control unit is connected.
When a camera control unit is not connected, function as 
follows.
During recording or playback: Write a shot mark.
In the other states: Conduct a recording review (if playback 

is allowed).

—

Return Video a) Display return video signals during operating the system, 
when the optional CBK-CE01 is installed and a camera 
adaptor and camera control unit are connected.

—

Return Video2 Display return video signals during operating the system, 
when the optional CBK-CE01 is installed and a camera 
adaptor is connected.

—

Return Video3 Display return video signals during operating the system, 
when the optional CBK-CE01 is installed and a camera 
adaptor is connected.

—

Return Video4 Display return video signals during operating the system, 
when the optional CBK-CE01 is installed and a camera 
adaptor is connected.

—

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

OK Mark Add or delete an OK mark. —

Clip Flag OK Add/clear an OK flag to/from the clip being recorded or 
played.

Setting not retained

Clip Flag NG Add/clear an NG flag to/from the clip being recorded or 
played.

Setting not retained

Clip Flag Keep Add/Clear a KP flag to/from the clip being recorded or 
played.

Setting not retained

Color Temp SW 3200K Adjust the white balance with a 3200K preset value. Setting retained

Color Temp SW 4300K Adjust the white balance with a 4300K preset value. Setting retained

Color Temp SW 5600K Adjust the white balance with a 5600K preset value. Setting retained

Color Temp SW 6300K Adjust the white balance with a 6300K preset value. Setting retained

Assignable SW setting Function State when 
camcorder is next 
powered on
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a) When the digital extender function is turned on, it is not possible to show the return video.

Electrical CC Function that switches the electrical CC filter (3200K/
4300K/5600K/6300K) applied to white balance adjustment 
values.
Each press of the switch or button switches in the order 
3200Kt4300Kt5600Kt6300K.
These can also be applied from a menu (apply with Electrical 
CC<A><B><C><D>).

Note
This function is not available when “MAINTENANCE” > 
“White Filter” >ND Filter C.Temp” in the setup menu is set to 
“On.”
If you set “ND Filter C.Temp” to “On” after assigning the 
function, the assignable switch ceases to function.

Setting retained

CC5600K Apply a 5600K electrical CC filter to white balance 
adjustment values.

Setting retained

Clip Continuous Rec Turn the Clip Continuous Rec mode on/off. Setting retained

Slot Select When both slots A and B have recording media inserted in 
them, select the media to use.

—

Digital Extender a) Turn the screen magnification function on/off when the 
optional CBK-CE01 50 Pin Interface and Digital Extender is 
installed.

Setting not retained

Flashband Reduce Turn the flashband reduce function on/off. Setting not retained

Quick Backup Back up all the clips in the selected SxS card to a USB 
media.

Setting not retained

USB Thumbnail Display the thumbnail screen of a USB media. Setting not retained

Functions That Can Be Assigned to the RET Button on the Lens

Assignable SW setting Function State when 
camcorder is next 
powered on

Off No assignment —

Lens RET Display return video signals when the optional CBK-CE01 
is installed and a camera control unit is connected.
When a camera control unit is not connected, function as 
follows.
During recording or playback: Write a shot mark.
In the other states: Conduct a recording review (if 

playback is allowed).

—

Return Video a) Display return video signals when the optional CBK-CE01 
is installed and a camera control unit is connected.

—

Rec Review Execute recording review. —

Shot Mark1 Write Shot Mark1. —

Shot Mark2 Write Shot Mark2. —

Clip Flag OK Add/clear an OK flag to/from the clip being recorded or 
played.

Setting not retained

Assignable SW setting Function State when 
camcorder is next 
powered on
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a) When the digital extender function is turned on, it is not possible to show the return video.

Clip Flag NG Add/clear an NG flag to/from the clip being recorded or 
played.

Setting not retained

Clip Flag Keep Add/Clear a KP flag to/from the clip being recorded or 
played.

Setting not retained

OK Mark Add or delete an OK mark. —

Focus Mag Turn the focus magnification function on/off. Setting not retained

Flashband Reduce Turn the flashband reduce function on/off. Setting not retained

Quick Backup Back up all the clips in the selected SxS card to a USB 
media.

Setting not retained

USB Thumbnail Display the thumbnail screen of a USB media. Setting not retained

Assignable SW setting Function State when 
camcorder is next 
powered on
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You can adjust the PMW-320 image quality to match the camcorder using the following menu settings.

Adjusting PMW-320 Image Quality

Menu item Sub-item Setting

HD SD

PAINT >Matrix User Matrix R-G +65 +65

User Matrix R-B –24 –24

User Matrix G-R –20 –20

User Matrix G-B –25 –25

User Matrix B-R –11 –11

User Matrix B-G +28 +28

PAINT >Detail(HD Mode)/Detail(SD Mode) Level –10 ±0
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You can save setup menu settings in the 
camcorder’s internal memory, on an SxS memory 
card, or USB flash drive (in UDF/exFAT mode). 
This allows you to quickly recall an appropriate 
set of menu settings for the current situation.

When using a USB flash drive (UDF, exFAT 
modes)
Before starting, connect a formatted USB flash 
drive (see page 68) to the external device 
connector.

Setting data is saved in the following categories.
User files: User files save the setting items and 

data of the customizable USER menu. You 
can save up to 64 user files on an SxS 
memory card or USB flash drive (in UDF, 
exFAT modes). By loading this file into the 
camcorder memory, you can customize the 
setup of the USER menu.

ALL files: ALL files save the setting data of all 
menus. You can save up to 64 ALL files on 
an SxS memory card or USB flash drive (in 
UDF/exFAT mode).

Note

Device specific data (shading, output levels, and 
other data that requires adjustment for the specific 
device) is not saved.

Scene files: Scene file save adjustments to 
PAINT menu items for the purpose of 
shooting a particular scene. You can save up 
to five scene files in the camcorder’s internal 
memory and up to 64 scene files on an SxS 
memory card or USB flash drive (in UDF/
exFAT mode).

Reference files: Reference files save the 
reference values that are set when you 
execute “FILE” > “Scene” > “Standard” in 
the setup menu. You can save one reference 
file in the camcorder’s internal memory and 

one on an SxS memory card or USB flash 
drive (in UDF/exFAT mode).

Lens files: Lens files save the setting data used to 
compensate for lens characteristics, such as 
flare, white shading, white balance and 
center markers. You can save up to 32 lens 
files in the camcorder’s internal memory and 
up to 64 lens files on an SxS memory card or 
USB flash drive (in UDF/exFAT mode).

The first settings stored in a file are called “preset 
values.”
Even after loading files to set up the camcorder, 
and overwriting original files with new settings, 
you can still recover preset values and reset files 
to their initial states (see page 172).

Before starting, insert a writable SxS memory 
card into a memory card slot.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “All” in the setup 
menu.

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 171).

2 Select “All Save SxS” > “Execute.”
When saving to a USB flash drive (UDF, 
exFAT modes), select “All Save USB” > 
“Execute.”

3 Press the MENU knob.
An All file list box appears.
File numbers where “No File” is displayed 
are empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

Chapter7 Saving and Loading User Setting Data

Saving and Loading 
Settings

Saving Settings Data
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4 Select the file number under which you 
want to save the data, and then press the 
MENU knob.
A confirmation message appears.

5 To execute the save, select “Execute,” 
and then press the MENU knob.
To cancel the save, select “Cancel,” and 
then press the MENU knob.
If you choose to execute the save, the 
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot 
section). A completion message appears and 
the ACCESS lamp goes out when the data 
has been saved to the SxS memory card.
If saving to a USB flash drive, the ACCESS 
lamp does not light up.

If an error message appears
One of the following error messages may appear 
during execution of the save, or as soon as you 
select “Execute.” In this case, the file is not saved 
to the SxS memory card.

To assign names to files
Assigning a name before you save data in an ALL 
file can make it easier to distinguish your files.
The following characters can be used in file 
names.
Alphanumeric characters (a–z, A–Z, 0–9) and 
special characters ( ! # $ % & ' ( ) * + , - . / : ; < = 
> ? @ [ \ ] ~)

1 Select “FILE” > “All” > “File ID” in the 
setup menu.

2 Turn the MENU knob to select a 
character, and then press the MENU 
knob.

3 Repeat step 3.

4 When you have finished entering 
characters, press the MENU knob to 

move the cursor to “SET,” and then 
press the MENU knob.
The specified name is displayed.
When you save the file (see page 170), the 
data will be saved under this name.

Note

When you load a file from an SxS memory card or USB 
flash drive (UDF, exFAT modes), the data saved in the 
camcorder’s internal memory is overwritten.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “All” in the setup 
menu.

2 Select “All Load SxS” > “Execute.”
When loading from a USB flash drive (UDF, 
exFAT modes), select “All Load USB” > 
“Execute.”

3 Press the MENU knob.
An All file list box appears.
File numbers where “No File” is displayed 
are empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the desired file number, and then 
press the MENU knob.
A confirmation message appears.

5 To execute the load, select “Execute,” 
and then press the MENU knob.
To cancel the load, select “Cancel,” and 
then press the MENU knob.
If you choose to execute the load, the 
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot 
section). The ACCESS lamp goes out and a 
completion message appears when the data 
has been loaded from the SxS memory card.
If saving to a USB flash drive, the ACCESS 
lamp does not light up.

If an error message appears
One of the following error messages may appear 
during execution of the load, or as soon as you 
select “Execute.” In this case, the file is not 

Error message Problem Solution
NG:Cannot Save No recordable 

media is 
inserted.

Insert 
recordable 
media.

NG:Media Full The media is 
full.

Use media with 
free capacity 
remaining.

Loading Settings Data
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loaded from the SxS memory card or USB flash 
drive.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “All” in the setup 
menu.

2 Select “All Preset,” and then press the 
MENU knob.

3 To execute the reset, select “Execute,” 
and then press the MENU knob.
To cancel the reset, select “Cancel,” and 
then press the MENU knob.
If you choose to execute the reset, all settings 
in the ALL file are reset to preset values.

Scene files allow you to save the following types 
of data.
• Values set in the PAINT menu
• Shutter speeds set in standard mode or ECS 

mode
• White balance data

The data that is saved and loaded depends on the 
setting of “FILE” > “Reference” > “Scene 
White Data” in the setup menu.

Insert an SxS memory card into a memory card 
slot, then proceed as follows.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “Scene” in the setup 
menu.

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 171).

2 Select “Scene Store SxS” > “Execute.”
When saving to internal memory, select 
“Scene Store Mem” > “Execute.” When 
saving to a USB flash drive (UDF, exFAT 
modes), select “Scene Store USB” > 
“Execute.”

3 Press the MENU knob.
A list box of scene files appears. File 
numbers where “No File” is displayed are 
empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the file number under which you 
want to save the data, and then press the 
MENU knob.
A confirmation message appears.

Error message Problem Solution
NG:No Data • There is no 

readable 
media

• The specified 
file does not 
exist on the 
media

Insert the 
media that 
contains the 
file you want.

Resetting a File after Changing Its 
Contents

Saving and Loading 
Scene Files

Saving Scene Files
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5 To execute the save, select “Execute,” 
and then press the MENU knob.
To cancel the save, select “Cancel,” and 
then press the MENU knob.
If you selected Scene Store SxS in step 2, the 
ACCESS lamp lights when you execute the 
save (in blue on the right-side panel and in 
orange in the card slot section).
When the data has been saved to the SxS 
memory card, a completion message appears 
and the ACCESS lamp goes out.
If saving to internal memory or a USB flash 
drive, the ACCESS lamp does not light up.

Insert an SxS memory card into a memory card 
slot, then proceed as follows.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “Scene” in the setup 
menu.

2 Select “Scene Recall SxS” > “Execute.”
When loading from internal memory, select 
“Scene Recall Mem” > “Execute.” When 
loading from a USB flash drive (UDF, 
exFAT modes), select “Scene Recall USB” > 
“Execute.”

3 Press the MENU knob.
A list box of scene files appears. File 
numbers where “No File” is displayed are 
empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the desired file number, and then 
press the MENU knob.
A confirmation message appears.

5 To execute the load, select “Execute,” 
and then press the MENU knob.
To cancel the load, select “Cancel,” and 
then press the MENU knob.
If you selected “Scene Recall SxS” in step 2, 
the ACCESS lamp lights when you execute 
the load (in blue on the right-side panel and 
in orange in the card slot section).

When the data has been loaded from the SxS 
memory card, a completion message appears 
and the ACCESS lamp goes out.
If saving to internal memory or a USB flash 
drive, the ACCESS lamp does not light up.

Loading Scene Files
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Set the data in lens files on “FILE” (see page 162) 
“Lens” in the setup menu .
You can set the following data and save it as a 
lens file.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

Insert an SxS memory card into a memory card 
slot, then proceed as follows.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “Lens” in the setup 
menu.

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 171).

2 Select “Lens Store SxS” > “Execute,” 
and press the MENU knob.
When saving to internal memory, select 
“Lens Store Mem” > “Execute.” When 

saving to a USB flash drive (UDF, exFAT 
modes), select “Lens Store USB” > 
“Execute.”

3 Press the MENU knob.
A list box of lens file number appears. File 
numbers where “No File” is displayed are 
empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the file number under which you 
want to save the data, and then press the 
MENU knob.
A confirmation message appears.

5 To execute the save, select “Execute,” 
and then press the MENU knob.
To cancel the save, select “Cancel,” and 
then press the MENU knob.
If you selected Lens Store SxS in step 2, the 
ACCESS lamp lights when you execute the 
save (in blue on the right-side panel and in 
orange in the card slot section). When the 
data has been saved to the SxS memory card, 
a completion message appears and the 
ACCESS lamp goes out.
If saving to internal memory or a USB flash 
drive, the ACCESS lamp does not light up.

Insert an SxS memory card into a memory card 
slot, then proceed as follows.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “Lens” in the setup 
menu.

2 Select “Lens Recall SxS” > “Execute.”
When loading from internal memory, select 
“Lens Recall Mem” > “Execute.” When 
loading from a USB flash drive (UDF, 
exFAT modes), select “Lens Recall USB” > 
“Execute.”

3 Press the MENU knob.
A list box of lens file number appears. File 
numbers where “No File” is displayed are 
empty file numbers.

Saving and Loading 
Lens Files

Setting Lens File Data

Settings data Sub-item
V modulation shading 
compensation values

M V Modulation

Center marker position Lens Center H
Lens Center V

Flare level Lens R Flare
Lens G Flare
Lens B Flare

White balance 
compensation value

Lens W-R Offset
Lens W-B Offset

White shading 
compensation value

L R/G/B H Saw
L R/G/B H Para
L R/G/B V Saw
L R/G/B V Para

Saving Lens Files Loading Lens Files
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File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the desired file number, and then 
press the MENU knob.
A confirmation message appears.

5 To execute the load, select “Execute,” 
and then press the MENU knob.
To cancel the load, select “Cancel,” and 
then press the MENU knob.
If you selected “Lens Recall SxS” in step 2, 
the ACCESS lamp lights when you execute 
the load (in blue on the right-side panel and 
in orange in the card slot section). When the 
specified lens file has been loaded from the 
SxS memory card, a completion message 
appears and the ACCESS lamp goes out.
If saving to internal memory or a USB flash 
drive, the ACCESS lamp does not light up.

When you are using a lens that support serial 
communication, you can set up the camcorder by 
automatically loading the lens file that 
corresponds to the lens settings (Lens Auto Recall 
function).
To use the Lens Auto Recall function, set “FILE” 
> “Lens” > “Lens Auto Recall” in the setup menu 
to one of the following.
On: Load the lens file that corresponds to the 

model name.
Off: Do not use the Lens Auto Recall function.
Serial Number: Load the lens file that 

corresponds to the model name and serial 
number (when the lens supports 
communication of the serial number).

If the lens does not support communication of the 
serial number, both settings load the lens file that 
corresponds to the model name.

You can save the USER menu setup status (menu 
organization and settings) and current white 
balance data as a user file.

Insert an SxS memory card into a memory card 
slot, then proceed as follows.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “User” in the setup 
menu.

To assign a name to the data before saving 
it
Assign a name before proceeding to step 2.

For details, see “To assign names to files” 
(page 171).

2 Select “User Save SxS” > “Execute.”
When saving to a USB flash drive (UDF, 
exFAT modes), select “User Save USB” > 
“Execute.”

3 Press the MENU knob.
A user file list box appears.
File numbers where “No File” is displayed 
are empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the file number under which you 
want to save the data, and then press the 
MENU knob.
A confirmation message appears.

5 To execute the save, select “Execute,” 
and then press the MENU knob. To 
cancel the save, select “Cancel,” and 
then press the MENU knob.
If you choose to execute the save, the 
ACCESS lamp lights (in blue on the right-

Loading Lens Files Automatically

Saving and Loading 
User Files

Saving User Files
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side panel and in orange in the card slot 
section).
When the data has been saved, a completion 
message appears and the ACCESS lamp goes 
out.
If saving to a USB flash drive, the ACCESS 
lamp does not light up.

To save USER menu settings as preset values
Select “Store User Preset” > “Execute” in step 2.

Note

When you load a file from an SxS memory card or USB 
flash drive (UDF, exFAT modes), the data saved in the 
camcorder’s internal memory is overwritten.

The data that is loaded varies depending on the 
FILE > “User” > “Load Customize Data” and 
“Load White Data” settings in the setup menu.
When “Load Customize Data” is “Off”: USER 

menu settings only are loaded.
When “Load Customize Data” is “On”: USER 

menu organization and settings are loaded.
When “Load White Data” is “Off”: White 

balance data is not loaded.
When “Load White Data” is “On”: White 

balance data is loaded.

For details about menu operations, see “Basic Setup 
Menu Operations” (page 115).

1 Select “FILE” > “User” in the setup 
menu.

2 Select “User Load SxS” > “Execute.”
When loading from a USB flash drive (UDF, 
exFAT modes), select “User Load USB” > 
“Execute.”

3 Press the MENU knob.
A user file list box appears.
File numbers where “No File” is displayed 
are empty file numbers.
File numbers with a file name or a date and 
time are the number of files that already 
contain data.

4 Select the desired file number, and then 
press the MENU knob.
A confirmation message appears.

5 To execute the load, select “Execute,” 
and then press the MENU knob. To 
cancel the load, select “Cancel,” and 
then press the MENU knob.
If you choose to execute the load, the 
ACCESS lamp lights (in blue on the right-
side panel and in orange in the card slot 
section).
When the data has been loaded, a completion 
message appears and the ACCESS lamp goes 
out.
If saving to a USB flash drive, the ACCESS 
lamp does not light up.

To load USER menu settings as preset values
Select “Load User Preset” > “Execute” in step 2.

Loading User Files
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You can connect a control device such as an RM-B170/B750 Remote Control Unit or RCP-1001/1501 
Remote Control Panel and operate this camcorder. For details about connection and operation of the 
control device, see “Operating via the REMOTE Connector” (page 69).

Select the output signal and use an appropriate cable for the monitor to be connected.

Regardless of whether the signal is HD or SD, the 
same status information and menus can be 
displayed on the external monitor as those on the 
viewfinder screen.

Note

SD signals down-converted for output have the 
following restrictions.
Images of 50P/50i/25P are output as PAL signals, those 
of 59.94P/59.94i/29.97P are output as NTSC signals, and 
those of 23.98P are output as 2-3 pulled-down NTSC 
signals.

Chapter8 Connecting External Devices

Connecting External Monitors

HDMI cable (not supplied)

BNC cable (not supplied)

BNC cable
(not supplied)
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HD/SD SDI OUT connectors (BNC type)
The camcorder has two HD/SD SDI OUT 
connectors.
You can connect a monitor or switcher, or 
recording device such as a VTR, etc., that 
supports SDI.
The output from these connectors can be turned 
on and off with “OPERATION” > “Input/
Output” > “SDI Output” in the setup menu (see 
page 123).
For connection, use a BNC cable (not supplied).

HDMI connector
You can connect a monitor or recording device 
such as a VTR, etc., that supports HDMI.
The output from this connector can be turned on 
and off with “OPERATION” > “Input/Output” > 
“HDMI Output” in the setup menu (see 
page 123).
For connection, use an HDMI cable (not 
supplied).

VIDEO OUT connector
You can connect a monitor or recording device 
such as a VTR, etc., that supports analog 
composite signals.
The analog composite signal output from this 
connector is the same as the NTSC or PAL 
encoded signal that is output from the HD/SD 
SDI OUT connector when the setting of output is 
SD signal (you can switch between NTSC and 
PAL with “OPERATION” > “Format” > 
“Country” in the setup menu (see page 121)).
To input the VIDEO OUT connector output 
signal to an external analog composite device, it 
may be necessary to change the input signal 
setting of that external device to be matched with 
the analog composite signal setting for the 
VIDEO OUT connector.
To input camcorder output audio to an external 
device such as a monitor or VTR or other 
recording device, connect the audio output of the 
AUDIO OUT connector to the audio input of that 
external device.
For connection, use a BNC cable (not supplied).

i.LINK (HDV/DV) connector
The i.LINK (HDV/DV) connector supports HDV 
and DV input/output. However, DV streams 
cannot be recorded on this camcorder.

This connector can be used to connect a device 
that supports i.LINK (HDV). The device type can 
be a monitor, read/write device such as VTR or 
HDD, or computer.

To input/output HDV signals
HDV input/output is supported when the video 
format is an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.98P), 
“OPERATION” > “Input/Output” > 
“Output&i.LINK” in the setup menu is set to 
“HD&HDV” or “SD&HDV,” and “Input/
Output” > “i.LINK I/O” is set to “Enable.”
When the video format is SP 1440/23.98P, a 
59.94i HDV signal subjected to 2-3 pulldown 
processing is output.

To input/output DV signals
DV input/output is supported under either of the 
following conditions.
• “OPERATION” > “Input/Output” > “i.LINK I/

O” in the setup menu is set to “Enable” on SD 
mode.

• In HD mode, the video format is other than DV 
incompatible formats (HQ 1920/23.98P, HQ 
1440/23.98P, and HQ 1280/23.98P), 
“OPERATION” > “Input/Output” > 
“Output&i.LINK” in the setup menu is set to 
“SD&DV,” and “Input/Output” > “i.LINK I/O” 
is set to “Enable.”
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If the computer is equipped with an ExpressCard/
34 or ExpressCard/54 slot, you can directly insert 
the SxS memory card containing clips recorded 
with this camcorder and access to the files.

Notes

• Before operating clips, set the SxS memory card to the 
read-only mode and make a backup copy to a computer 
to protect data. Do the same when using a reader/
writer.

• The SxS Device Driver Software and the UDF Driver 
Software must be downloaded and installed on your 
computer. For details about application software, see 
“Software Downloads” (page 204).

• Operation is not guaranteed with all computers.

For support information for the driver, visit the 
following URL:
http://www.sony.net/SxS-Support/

On Windows
Check that a Removable Disk appears in My 
Computer. This indicates normal status.

On Macintosh
An icon is displayed on the menu bar.

Preparations
When you connect the camcorder to a computer 
using a USB cable (not supplied), the memory 
card in the slot is acknowledged as an extended 
drive by the computer.

When two memory cards are mounted in this 
camcorder, they are acknowledged as two 
independent extended drives by the computer.

Notes

• When connecting the USB cable to the computer, be 
careful to check the form and direction of the PC 
connector.

• The camcorder does not work on the bus power from a 
computer. Use a separate power supply.

• Connection is not possible when transferring part of an 
original file (page 86) using the function of the 
optional CBK-WA101 Wireless Adapter.

To start USB connection
When you connect a computer to the PC 
connector with a USB cable (not supplied), the 
message “Connect USB Now?” is displayed to 
prompt you to confirm that you wish to enable the 
USB connection.
If you select “Cancel” or push the MENU 
CANCEL/PRST/ESCAPE switch down to the 
ESCAPE side or if you disconnect the USB cable, 
the message “Connect USB Now?” disappears.
If you select “Execute” and press the MENU 
knob, the USB connection is enabled and this 
camcorder is recognized as an extension drive. 
You can carry out the same operations by using 
the arrow buttons (J, j, K, k) (see page 16).

Managing/Editing Clips 
with a Computer

Using the ExpressCard Slot of a 
Computer

USB Connection with a Computer

To the 
ExpressCard slot

SxS memory 
card Computer with SxS Device 

Driver Software installed

USB cable 
(not supplied)
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If the USB connection is enabled during 
recording/playback operation, the operation is 
stopped and the message “USB Connecting” 
appears on the viewfinder screen.
At this time, the output signal from the VIDEO 
OUT connector, HDMI connector, and HD/SD 
SDI OUT connector changes to a black signal.

Notes

• The camcorder cannot be operated for recording, 
playback, and so on while connected via USB.

• When the computer accesses the media loaded in the 
camcorder, do not try to carry out the following 
operations.
- Operating the camcorder (turning the power on/off, 

switching the operation mode, etc.)
- Removing or loading a media from an active slot 

(being accessed from the computer)
- Removing or connecting the USB cable

Disabling the USB connection
To disable the USB connection, follow the same 
procedure as that for removing a device from the 
computer.
To enable the USB connection again, first 
disconnect the USB cable and then reconnect it. 
The message “Connect USB Now?” appears 
again.

Note

If you connect the camcorder to the computer using an 
i.LINK cable, you cannot use the computer to operate 
files stored in a recording media loaded in the memory 
card slot of this camcorder.

To remove an SxS memory card

On Windows

1 Click on the icon of “Safely Remove 
Hardware” on the task bar of the 
computer.

2 Select “Safely remove SxS Memory 
Card - Drive(X:)” from the displayed 
menu.

3 Check that the Safe To Remove 
Hardware message appears then 
remove the card.

On Macintosh
Drag the SxS memory card icon on the desktop to 
Trash.

If the SxS memory card icon is located in the 
Finder, click on the eject icon on its side.

To use the application software
To copy clips to the local disk of your computer, 
the dedicated application software must be 
downloaded and installed on your computer. For 
details about application software, see “Software 
Downloads” (page 204).
Although the data regarding recorded materials 
are stored over multiple files and folders, you can 
easily handle the clips without considering such 
data and directory structure by using the 
dedicated application software.

Note

If you operate, e.g. copy the clips on the SxS memory 
card by using Explorer (Windows) or Finder 
(Macintosh), the subsidiary data contained by the clips 
may not be maintained.

To use a nonlinear editing system
For a nonlinear editing system, optional editing 
software that corresponds to the recording 
formats used with this camcorder is required.
Store the clips to be edited on the HDD of your 
computer in advance, using the supplied 
application Software.
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You can record the same images as those 
recorded on the memory card in this camcorder 
on an external device connected to the i.LINK 
(HDV/DV) connector, or record the playback 
picture of the external device on the memory card 
in the camcorder.
When you connect the camcorder to a non-linear 
editing system that supports HDV format, you 
can edit the images recorded on the memory card 
in the camcorder.

Notes

• When you set “OPERATION” > “Input/Output” > 
“Output&i.LINK” in the setup menu to “480P (570P),” 
no signal is output from the HD/SD SDI OUT 
connector.

• Use the i.LINK (HDV/DV) connector only for one-to-
one i.LINK connection.

• When you change a setting which affects output 
signals from the i.LINK (HDV/DV) connector, such as 
“HD/SD,” “HD System Line,” “System Frequency,” 
and “Rec Format” under “OPERATION” > “Format” 
in the setup menu or “i.LINK I/O” and “Down 
Converter” under “OPERATION” > “Input/Output” in 
the setup menu, disconnect the i.LINK cable and 
change the setting.
Changing such a setting with the i.LINK cable 
connected may cause improper operation of the 
connected i.LINK device.

• The external signal input via the i.LINK connection 
that can be recorded on the camcorder is HDV streams 
only. You cannot record DV streams via the i.LINK 
connection.

• An i.LINK connection and USB wireless LAN module 
cannot be used at the same time.
Do not connect an IFU-WLM3 to the external device 
connector during i.LINK connections.

The picture being shot with this camcorder is 
output as an HDV or DV stream via the i.LINK 
(HDV/DV) connector. It can be recorded on a 
connected HDV or DVCAM recorder in 

synchronization with a recording start/stop 
operation on this camcorder.

1 Perform the preparatory settings of the 
camcorder.
• Set “OPERATION” > “Input/Output” > 

“Output & i.LINK” in the setup menu (see 
page 123) to “HD & HDV” or “SD & 
HDV.”
HD & HDV or SD & HDV: To output an 

HDV stream in HD mode when the 
video format is set to an HDV 
compatible format (SP 1440/59.94i, 
SP 1440/50i, or SP 1440/23.94P)

SD & DV: To output a DV stream
• Set “OPERATION” > “Input/Output” > 

“i.LINK I/O” in the setup menu to 
“Enable.”

• Set “MAINTENANCE” > “Trigger Mode” 
> “i.LINK Trigger Mode” in the setup 
menu (see page 155) to “Both” or 
“External.”
Both: To perform recording both on the 

memory card in this camcorder and on 
the external device

External: To perform recording only on 
the external device

2 Set the external device to recording 
standby status.

For operations of the external device, refer to 
the operation manual of that device.

3 Start recording.
The external device starts recording in 
synchronization.

The status of the external device is displayed in 
the i.LINK status indication area (see page 27) on 
the viewfinder screen.

Notes

• Operation may be different depending on the type of 
external device.

Connecting an External 
Device (i.LINK 
Connection)

Recording the Camera Picture on 
an External Device

Indicator Status of the external 
device

STBY In HDV recording standby

zREC In HDV recording

STBY In DV recording standby

zREC In DV recording
181



• When you execute the operation to make a recording 
on the recording media loaded in the camcorder while 
HDV signals are output from the i.LINK (HDV/DV) 
connector, HDV signal output stops for about one 
second before the recording starts, and then it resumes.

• While you can record shot marks on the memory card 
during recording, they are not added to the pictures 
recorded on the external device.

You can transfer an HDV stream to a nonlinear 
editing system connected via the i.LINK (HDV/
DV) connector.

Notes

• The i.LINK (HDV/DV) connector of this camcorder is 
a 6-pin connector. Check the number of pins of the 
i.LINK connector on your computer and use an 
appropriate i.LINK cable.

• When searching pictures of this camcorder on the 
computer, it may take some time until the display is 
reflected on the computer.

• If the playback clip is short or the playback starting 
point is near the end of the clip, the i.LINK signal may 
be interrupted between the clip and the next clip. When 
you try to capture such a signal using the nonlinear 
editing system, a malfunction may occur, depending 
on the nonlinear editing software in use.

• If you specify a search speed other than 4, 15, or 24 
times normal with the nonlinear editing system, no 
i.LINK signal is fed out. In such a case, the picture on 
the viewfinder monitor may stay frozen.

• High-speed playback picture may not be displayed on 
the computer screen, depending on the nonlinear 
editing software in use.

Setting on this camcorder
Set “OPERATION” > “Input/Output” > “i.LINK 
I/O” in the setup menu to “Enable.”

For operations of the nonlinear editing software, 
refer to the operation manual of the software.

The HDV stream input from a device connected 
via the i.LINK (HDV/DV) connector can be 
recorded on an SxS memory card in this 
camcorder. The timecodes superimposed on the 
i.LINK input are recorded regardless of the 
settings of the camcorder.

Note

DV streams cannot be recorded.

1 Set the external signal to a format that 
can be recorded on the camcorder.
Select an HDV compatible format (SP 1440/
59.94i, SP 1440/50i, or SP 1440/23.94P) for 
the video format.

2 Make the following settings with 
“OPERATION” > “Input/Output” in 
the setup menu (see page 123).
• Set “Output&i.LINK” to “HD&HDV” 

or “SD&HDV.”
• Set “i.LINK I/O” to “Enable.”
• Set “Source Select” to “i.LINK.”
The input video is displayed on the 
viewfinder screen or the monitor connected 
to the VIDEO OUT connector.
Audio signals are output through the built-in 
speaker, the headphones connected to the 
EARPHONE connector, and the speakers of 
the monitor connected to the VIDEO OUT 
connector.

3 Start the recording.

Notes

• An error is generated in the following cases. In such a 
case, cancel Recording mode.
- The video format of input signal does not match that 

specified on the camcorder.
- A copy-protected stream is being fed in.

• If the input to the camcorder becomes no signal during 
recording, the TALLY indicators, the tally indicator on 
the front of the viewfinder, and the REC indication 
(zREC) on the viewfinder screen flash, indicating that 
no signal is being recorded on the SxS memory card.
When an input signal is resumed, recording is 
restarted, incrementing the clip number on the memory 
card.

• The operation of all devices is not guaranteed when 
recording simultaneously using the camcorder and 
i.LINK.

Nonlinear Editing

Recording External Input Signals
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You can connect USB storage media (such as a 
HDD or flash memory) to the OPTION connector 
of the unit to copy clips between SxS memory 
cards and USB media.

USB media that can be used with this unit must 
satisfy the following criteria.

Capacity: 3 GB to 2 TB
Media with capacity less than 3 GB is not 
recognized. Media with capacity exceeding 2 TB 
is recognized as 2 TB media.

Format: exFAT
Only media formatted on the PMW-1000, 
PMW-400, PMW-RX50, PMW-50, or this unit 
can be used. Media formatted using other devices 
may not operate correctly.

The recommended USB media are as follows.
• Sony PSZ-HA1T (1 TB)
• Sony PSZ-HA50 (500 GB)
• Sony PSZ-SA25 (256 GB)
• Sony HD-E1 (1 TB)
• Sony HD-EG5 (500 GB)
The operation of the following USB media has 
been verified.
• Lacie LCH-RG005T3 (500 GB)
• Buffalo HD-PNT2.0U3-GBC (2 TB)

When valid USB media is connected, the USB 
icon (see page 28) is displayed on the viewfinder 
screen.

Notes

• The correct operation of HDD or USB flash drives that 
meet the above criteria is not guaranteed.

• This unit is compatible with USB media that operates 
from a 5.0 V / 0.5 A power source. The unit may not 
recognize the USB media, depending on the media 
used. In such cases, supply a separate power source.

• Shooting of images cannot be recorded directly to USB 
media.

• Do not disconnect USB media while copying or 
playing back clips on the media.

• Do not connect/disconnect USB media while the 
camcorder is turned on. It may cause of a malfunction 
of the camcorder or USB media.

To copy from SxS memory cards to USB media
Copy clips recorded on SxS memory cards to 
USB media by selecting “USB Set” > “Copy To 
USB” in the MAINTENANCE menu when the 
thumbnail screen is displayed.
The copy destination folder is specified using 
“USB Set” > “Select Folder” in the 
MAINTENANCE menu. If no folder is selected, 
a new folder is created and files are copied to it. 
The name of the new folder uses the recording 
date of the first clip on the source SxS memory 
card. If “A&BtUSB” is selected, clips on the 
selected SxS memory card are saved in the folder 
specified using “Select Folder,” and clips on the 
unselected SxS memory card are saved in a new 
folder.
You can also copy clips by selecting them on the 
thumbnail screen. Select the clips and then select 
“Copy Clip” > “Copy Clip(A)” or “Copy 
Clip(B)” from the THUMBNAIL menu.

To copy all clips using an assignable switch
Assign the Quick Backup function to an 
assignable switch, then press the assignable 
switch to copy all clips on the selected SxS 
memory card to USB media.
A new folder is created and files are copied to it.

To copy from USB media to SxS memory cards
Copy clips recorded on USB media to the selected 
SxS memory card by selecting “USB Set” > 
“Copy From USB” in the MAINTENANCE 
menu, when selecting the folder by using “USB 
Set” > “Select Folder” in the MAINTENANCE 
menu.

Error checking
You can turn on error checking when copying 
clips between USB media and SxS memory cards 
by setting “USB Set” > “Error Check” to “On” in 
the MAINTENANCE menu. If an error message 
appears, try copying the clip again.
Copying with error checking enabled takes 
approximately twice the time as when error 
checking is disabled.

Connecting USB Media

Supported USB Media

Copying Clips
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Select “USB Set” > “USB Thumbnail” in the 
MAINTENANCE menu to display the thumbnail 
screen for clips recorded on USB media. When 
selecting the folder by using “USB Set” > “Select 
Folder” in the MAINTENANCE menu, you can 
also assign the USB Thumbnail function to an 
assignable switch, then press the switch to display 
the USB media thumbnail screen.
The operations that can be performed on the USB 
media thumbnail screen are basically the same as 
those for the SxS memory card thumbnail screen, 
although with the following differences.
• Functions that are not available

- Adding and deleting shot marks
- Adding and deleting OK/NG/KP flags and 

OK marks
- Setting index pictures
- Splitting clips

• Dropped frames and other issues may occur 
when playing back clips recorded on USB 
media.

THUMBNAIL menu

Displaying the USB Media 
Thumbnail Screen

Item Function
Clip Properties Displays the clip detailed 

information screen (see 
page 104).

Copy Clip (A) Copies the selected clips to the 
SxS memory card in slot A or 
slot B (see page 108).

Copy Clip (B)

Copy Clip (USB) Copies the selected clips to a 
USB media (see page 108).

Delete Clip Deletes the clip (see page 109).
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If you install the optional CBK-CE01 on this camcorder, you can attach the CA-FB70/TX70 Camera 
Adaptor and connect a camera control unit. This allows you to configure a shooting and recording system 
by connecting multiple camcorders, camera control units, and remote control units.

For more information about the CA-FB70 and CA-TX70, refer to their respective operation manuals.

Note

When using the camcorder in this system, do not connect a video light to the camcorder.

The following table shows the tally or call indication when configuring system.

Note

While the CA-FB70/TX70 Camera Adaptor is connected, alarm indication by the tally lamp that is listed in “Warning
Indication” is not performed.

Configuring a Shooting and Recording System

Tally and Call indication

Recording 
status

Receiving data via 
communication

LED indicator of 
DXF

Character display in the viewfinder

– Tally Green 
Tally

Call 
from 
CA

Call from 
other than 
CA

REC/
TALLY 
LED

GREEN 
& TAKE
TALLY 
LED

“z” (red) 
indicator

“z” (green) 
indicator

“CALL” 
indicator

OFF OFF OFF OFF OFF OFF No display No display No display

OFF OFF OFF ON ON OFF “z” (red) No display “CALL” (red)

OFF OFF ON OFF OFF OFF No display No display “CALL” (red)

OFF OFF ON ON ON OFF “z” (red) No display “CALL” (red)

OFF ON OFF OFF OFF ON No display “z” (green) No display

OFF ON OFF ON ON ON “z” (red) “z” (green) “CALL” (red)

OFF ON ON OFF OFF ON No display “z” (green) “CALL” (red)

OFF ON ON ON ON ON “z” (red) “z” (green) “CALL” (red)

ON OFF OFF OFF ON OFF “z” (red) No display No display

ON OFF OFF ON OFF OFF No display No display “CALL” (red)

ON OFF ON OFF ON OFF “z” (red) No display “CALL” (red)

ON OFF ON ON OFF OFF No display No display “CALL” (red)

ON ON OFF OFF ON ON “z” (red) “z” (green) No display

ON ON OFF ON OFF ON No display “z” (green) “CALL” (red)

ON ON ON OFF ON ON “z” (red) “z” (green) “CALL” (red)

ON ON ON ON OFF ON No display “z” (green) “CALL” (red)
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Check the functions of the camcorder before 
setting out for a shooting session, preferably by 
recording and playing back video and audio 
signals.

The fan and battery are consumable parts that will 
need periodic replacement.
When operating at room temperature, a normal 
replacement cycle will be about 5 years.
However, this replacement cycle represents only 
a general guideline and does not imply that the 
life expectancy of these parts is guaranteed. For 
details on parts replacement, contact your dealer.

Use a dust blower to clean the lens, the LCD 
screen, and mirror inside the viewfinder barrel.

Note

Never use organic solvents such as thinners.

The battery terminal of this unit (the connector for 
battery packs and AC adaptors) is a consumable 
part.
Power may not be supplied to the unit properly if 
the pins of the battery terminal are bent or 
deformed by shock or vibrations, or if they 
become corroded due to prolonged outdoor use.
Periodic inspections are recommended to keep 
the unit working properly and to prolong its 
usable lifetime.
Contact a Sony service or sales representative for 
more information about inspections.

Chapter9 Maintenance

Testing the Camcorder Maintenance

Cleaning the Viewfinder

Note about the Battery Terminal
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If a problem occurs when the camcorder is powered or is being operated, a warning is issued by various 
visible and audible indicators.
• Error/warning message (“A” in the “Layout of the table of warning messages” below)
• WARNING indicator (“B”), warning sound from the speaker and earphones (“C”), tally/REC indication 

(“D”), and battery remaining indicator (“E”).
A warning message, and the REC indication appear on the viewfinder screen.
The volume of the warning sound can be adjusted with the ALARM knob. Set the ALARM knob to the 
minimum position to suppress the sound.

How to read the table

• The operation of the WARNING indicator, the tally/REC indication, and the battery indicator is 
represented by graphic symbols as follows.

: Continuous
: 1 flash/s
: 4 flash/s

• The warning sounds are represented by graphic symbols as follows.
: Continuous beep

: 1 beep/s

Error/Warning System
A

WARNING indicator Warning sound Tally/REC Battery remaining

B C D E

Problem Operation in the 
recorder module

Solution

Error Indication

E
-*

**
**

WARNING indicator Warning sound Tally/REC Battery remaining

—  —

Problem Operation in the 
recorder module

Solution

The camcorder is 
abnormal.

Recording stops. Turn off the power and confirm whether an error 
occurs on the connected devices, the cables, and 
the media or not.
(If power cannot be turned off by setting the 
POWER switch to OFF, remove the battery pack 
or the AC power source.)
If the problem continues after the camcorder is 
restarted, contact your Sony service 
representative.
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Warning Indication
M

ed
ia

 N
ea

r 
F

ul
l

M
ed

ia
(A

)1)
 N

ea
r 

F
ul

l
WARNING indicator Warning sound Tally/REC Battery remaining

 —

Problem Operation in the 
recorder module

Solution

Free space on the SxS 
memory card has become 
insufficient.
In 2-slot Simul Rec 
mode, “Media(A)1) Near 
Full” is displayed.

Recording continues. Replace it with another at the earliest 
opportunity.

M
ed

ia
 F

ul
l

M
ed

ia
(A

) 1
)  F

ul
l

WARNING indicator Warning sound Tally/REC Battery remaining

  —

Problem Operation in the 
recorder module

Solution

No space is left on the 
SxS memory card. 
Recording, clip copying 
and clip division cannot 
be performed.
In 2-slot Simul Rec 
mode, “Media(A)1) Full” 
is displayed.

Recording stops. Replace it with another.

B
at

te
ry

 N
ea

r 
E

nd

WARNING indicator Warning sound Tally/REC Battery remaining

 

Problem Operation in the 
recorder module

Solution

The battery power will be 
exhausted soon.

Recording continues. Charge the battery pack at the earliest 
opportunity.

B
at

te
ry

 E
nd

WARNING indicator Warning sound Tally/REC Battery remaining

 

Problem Operation in the 
recorder module

Solution

The battery pack is 
exhausted. Recording 
cannot be performed.

Recording stops. Connect a power source via the DC IN connector 
or stop operation to charge the battery pack.

T
em

pe
ra

tu
re

 H
ig

h

WARNING indicator Warning sound Tally/REC Battery remaining

 —

Problem Operation in the 
recorder module

Solution

The internal temperature 
has risen above a safe 
operation limit.

Recording continues. Suspend operation, turn off the power, and wait 
until the temperature falls.
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V
ol

ta
ge

 L
ow

WARNING indicator Warning sound Tally/REC Battery remaining

 

Problem Operation in the 
recorder module

Solution

The DC IN voltage has 
become low (stage 1).

Recording continues. Check the power supply.

In
su

ff
ic

ie
nt

 V
ol

ta
ge

WARNING indicator Warning sound Tally/REC Battery remaining

 

Problem Operation in the 
recorder module

Solution

The DC IN voltage is too 
low (stage 2).
Recording cannot be 
performed.

Recording stops. Connect other power source.

P
le

as
e 

di
sc

on
ne

ct
 i.

L
IN

K
N

ee
d 

to
 R

eb
oo

t

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

You cannot use both an 
i.LINK connection and 
an IFU-WLM3 
connection at the same 
time.

Recording continues. Turn off the power, and disconnect either the 
i.LINK or IFU-WLM3.

R
ec

or
d 

O
nl

y 
M

ed
ia

(A
)1)

 WARNING indicator Warning sound Tally/REC Battery remaining

— —

Problem Operation in the 
recorder module

Solution

Recording to media(A)1) 
only.
(2-slot Simul Rec mode)

Recording continues. Recording to one media only in 2-slot Simul Rec 
mode.
To record in 2-slot Simul Rec mode, pause 
recording and insert recordable media in both 
slots.

B
at

te
ry

 E
rr

or
P

le
as

e 
C

ha
ng

e 
B

at
te

ry
. WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

An error was detected 
with the battery pack.

Recording stops. Replace the battery pack with a normal one.
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B
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B
at

te
ry

 E
nd

P
le

as
e 

C
ha

ng
e.

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The remaining power of 
the backup battery is 
insufficient.

Recording continues. Refer to a Sony service representative to replace 
the battery with a new one.

U
nk

no
w

n 
M

ed
ia

(A
)1)

P
le

as
e 

C
ha

ng
e.

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

A partitioned memory 
card or one that contains 
recorded clips exceeding 
the number permitted 
with this camcorder is 
loaded.

Recording continues. It cannot be used with this camcorder. Replace it 
with another card.

R
ea

ch
ed

 C
lip

 N
um

be
r 

L
im

it
C

op
y 

C
om

pl
et

ed
 t

o 
xx

/x
x

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The maximum number of 
clips for 1 memory card 
is reached, so copying 
cannot continue. (xx/xx 
indicates the completed 
copy operations.)

— Replace it with another card.

M
ed

ia
 E

rr
or

M
ed

ia
(A

)1)
 N

ee
ds

 t
o 

be
 R

es
to

re
d WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

An error occurred with 
the memory card. The 
card requires restoration.

Recording stops. Remove the card, load it again, and restore it.

M
ed

ia
 E

rr
or

C
an

no
t 

R
ec

or
d 

to
 M

ed
ia

(A
)1) WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

Recording cannot be 
done, as the memory card 
is defective.

Recording stops. As playback may be possible, it is recommended 
to replace it with another card after copying the 
clips, as required.
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C
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U
se

 M
ed

ia
(A

)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

Neither recording nor 
playback can be done, as 
the memory card is 
defective.

Recording stops. It cannot be operated with this camcorder. 
Replace it with another card.

C
an

no
t 

U
se

 M
ed

ia
(A

)1)

U
ns

up
po

rt
ed

 F
ile

 S
ys

te
m WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

A card of a different file 
system was inserted.

Recording stops. It cannot be used with this camcorder. Replace it 
with another card.

V
id

eo
 F

or
m

at
 M

is
m

at
ch

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The external signal input 
via the i.LINK 
connection cannot be 
recorded, as the Video 
Format setting is 
different from the signal 
format of the external 
input signal.

Recording stops. Change settings of “OPERATION” > “Format” 
in the setup menu to match it to that of the 
external signal.

C
op

y 
P

ro
te

ct
ed

 I
np

ut
C

an
no

t 
R

ec
or

d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The external signal input 
via the i.LINK 
connection cannot be 
recorded, as the stream is 
copy-protected.

Recording stops. Check the input signal.

D
V

C
A

M
 I

np
ut

 S
ig

na
l!

C
an

no
t 

R
ec

or
d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The external signal input 
via the i.LINK 
connection cannot be 
recorded, as it is a DV 
stream.

Recording stops. —
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H
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d

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

An error occurred in 
reading data from the 
memory card, and 
playback cannot be 
continued.

Recording stops. If this frequently occurs, change the memory 
card after copying the clips, as required.

M
ed

ia
(A

)1)
 E

rr
or

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

Recording cannot be 
done, as an error 
occurred with the 
memory card.

Recording stops. If this frequently occurs, change the memory 
card.

H
D

D
 A

2)
 B

at
te

ry
 N

ea
r 

E
nd WARNING indicator Warning sound Tally/REC Battery remaining

 —

Problem Operation in the 
recorder module

Solution

The battery power of the 
connected HDD will be 
exhausted soon.

Recording continues. Replace it with another at the earliest 
opportunity.

H
D

D
 A

2)
 B

at
te

ry
 E

nd

WARNING indicator Warning sound Tally/REC Battery remaining

—

Problem Operation in the 
recorder module

Solution

The battery of the 
connected HDD is 
exhausted. Recording 
cannot be performed.

Recording stops. Stop operation to change the battery.
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ug
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C
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y

C
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M
ed

ia
 (

A
)1) WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

There is not enough 
capacity for copying.

Recording continues 
(copying not supported).

Replace the card in slot A with another one.
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M
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A
)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The card has already ten 
clips having the same 
name as that you tried to 
duplicate.

Recording continues 
(copying not supported).

Replace the card in slot A with another one.

N
ot

 E
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ug
h 

C
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ac
it

y
C
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no

t 
D

iv
id

e

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

There is not enough 
capacity for dividing a 
clip.

Recording continues 
(division not supported).

—

W
ill

 S
w

it
ch

 S
lo

ts
 S

oo
n WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

Will switch to other slot 
soon.

Recording continues. Make sure that a memory card is loaded in the 
other slot.

N
o 

C
lip

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

There is no clip to be 
displayed.

Recording continues. —

N
o 

O
K

 C
lip

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

There is no clip with the 
OK mark.

Recording continues. —
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C
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M
ed

ia
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)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The card has already 
clips having the same 
name as that you tried to 
duplicate.

Recording continues 
(copying not supported).

Replace the card in slot A with another one.
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1) (B) for the card in slot B
2) B for a HDD connected to slot B
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M
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A
)1)

WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The memory card comes 
to the end of its service 
life.

Recording stops. Make a backup copy and replace the card with 
another one as soon as possible.
Recording/playback may not be performed 
properly if you continue to use the card.
For details, refer to the operating instructions of 
the memory card.
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WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

The inserted memory 
card contains clips 
recorded in a format that 
is not supported by this 
camcorder.

— The card in slot A cannot be used with this 
camcorder.
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 WARNING indicator Warning sound Tally/REC Battery remaining

— — — —

Problem Operation in the 
recorder module

Solution

Different types of cards 
have been inserted in 
slots A and B.

Recording continues. Replace the last-inserted card with the same type 
of card as the first-inserted card.
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To use the camcorder safely, please read the 
attached “Before Using this Unit.”

Use and storage

Do not subject the camcorder to severe shocks
• The internal mechanism may be damaged or the 

body warped.
• If an accessory mounted on the accessory shoe 

is subjected to severe shock, the accessory shoe 
may be damaged. In such a case, stop using it 
and contact your dealer or a Sony service 
representative.

Do not cover the camcorder while operating
Putting a cloth, for example, over the camcorder 
can cause excessive internal heat build-up.

After use
Always turn off the POWER switch.

Before storing the camcorder for a long period
Remove the battery pack.

Shipping
• Remove the media before transporting the 

camcorder.
• If sending the camcorder by truck, ship, air or 

other transportation service, pack it in the 
shipping carton of the camcorder.

Care of the camcorder
Remove dust and dirt from the surfaces of the 
lenses or optical filters using a blower.
If the body of the camcorder is dirty, clean it with 
a soft, dry cloth. In extreme cases, use a cloth 
steeped in a little neutral detergent, then wipe dry. 
Do not use organic solvents such as alcohol or 
thinners, as these may cause discoloration or 
other damage to the finish of the camcorder.

In the event of operating problems
If you should experience problems with the 
camcorder, contact a Sony service representative.

Use and storage locations
Store in a level, ventilated place.
Avoid using or storing the camcorder in the 
following places.
• In excessive heat or cold (operating temperature 

range of 0 °C to 40 °C (32 °F to 104 °F)
Remember that in summer in warm climates the 
temperature inside a car with the windows 
closed can easily exceed 50 °C (122 °F).

• In damp or dusty locations
• Locations where the camcorder may be exposed 

to rain
• Locations subject to violent vibration
• Near strong magnetic fields
• Close to radio or TV transmitters producing 

strong electromagnetic fields.
• In direct sunlight or close to heaters for 

extended periods

To prevent electromagnetic interference from 
portable communications devices
The use of portable telephones and other 
communications devices near this camcorder can 
result in malfunctions and interference with audio 
and video signals.
It is recommended that the portable 
communications devices near this camcorder be 
powered off.

Note on laser beams
Laser beams may damage the CMOS image 
sensors.
If you shoot a scene that includes a laser beam, be 
careful not to let the laser beam be directed into 
the lens of the camcorder.

Fitting the zoom lens
It is important to fit the lens correctly, as 
otherwise damage may result. Be sure to refer to 
the section “Mounting and Adjusting the 
Supplied Lens” (page 37).

Viewfinder
Do not leave the camcorder with the eyepiece 
pointing directly at the sun.

Appendix

Important Notes on 
Operation
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The eyepiece lens can concentrate the sun’s rays 
and melt the interior of the viewfinder.

About the LCD panels
The LCD panel fitted to this unit is manufactured 
with high precision technology, giving a 
functioning pixel ratio of at least 99.99%. Thus a 
very small proportion of pixels may be “stuck”, 
either always off (black), always on (red, green, 
or blue), or flashing. In addition, over a long 
period of use, because of the physical 
characteristics of the liquid crystal display, such 
“stuck” pixels may appear spontaneously. These 
problems are not a malfunction. Note that any 
such problems have no effect on recorded data.

Condensation
If the unit is suddenly taken from a cold to a warm 
location, or if ambient temperature suddenly 
rises, moisture may form on the outer surface of 
the unit and/or inside of the unit. This is known as 
condensation. If condensation occurs, turn off the 
unit and wait until the condensation clears before 
operating the unit. Operating the unit while 
condensation is present may damage the unit.

Phenomena specific to CMOS image 
sensors
The following phenomena that may appear in 
images are specific to CMOS (Complementary 
Metal Oxide Semiconductor) image sensors. 
They do not indicate malfunctions.

White flecks
Although the CMOS image sensors are produced 
with high-precision technologies, fine white 
flecks may be generated on the screen in rare 
cases, caused by cosmic rays, etc. This is related 
to the principle of CMOS image sensors and is 
not a malfunction.
The white flecks especially tend to be seen in the 
following cases:
• when operating at a high environmental 

temperature
• when you have raised the master gain 

(sensitivity)
• when operating in Slow-Shutter mode
The problem may be alleviated by executing 
automatic black balance adjustment.

Aliasing
When fine patterns, stripes, or lines are shot, they 
may appear jagged or flicker.

Flicker
If recording is made under lighting produced by 
discharge tubes, such as fluorescent, sodium, or 
mercury-vapor lamps, the screen may flicker, 
colors may vary, or horizontal stripes may appear 
distorted.

In such cases, set the flicker-reduction function to 
auto mode (see page 154).
If the frame rate selected for recording is close to 
the power-supply frequency, flicker may not be 
reduced sufficiently even if you activate the 
Flicker-Reduction function. In such cases, use the 
electronic shutter.

Focal plane
Owing to the characteristics of the pickup 
elements (CMOS image sensors) for reading 
video signals, subjects that quickly move across 
the screen may appear slightly skewed.

Flashband
The luminance at the top and bottom of the screen 
may change when shooting a flashlight beam or a 
light source that quickly flashes.
You can use the supplied application software to 
correct clips that contain frames with flash bands.

Note on data compatibility with other 
XDCAM EX-series products
When you use a PMW-EX1/EX3/EX30 to play 
materials recorded on the camcorder, any media 
in which clips of formats not supported by the 
PMW-EX1/EX3/EX30 have been recorded 
cannot be used.
The PMW-EX1/EX3/EX30 cannot divide a clip 
recorded on this camcorder, even if the clip is in a 
video format supported by the PMW-EX1/EX3/
EX30.
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Fragmentation
If pictures cannot be recorded/reproduced 
properly, try formatting the recording medium.
While repeating picture recording/playback with 
a certain recording medium for an extended 
period, files in the medium may be fragmented, 
disabling proper recording/storage. In such a 
case, make a backup of clips in the medium then 
perform formatting of the medium using 
“OPERATION” > “Format Media” (see 
page 123) in the setup menu.

The camcorder’s internal clock is powered by a 
lithium battery. If the message “BackUp Battery 
End” appears in the viewfinder, this battery must 
be exchanged. Contact a Sony service 
representative.

Exchanging the Battery 
of the Internal Clock
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Output formats of the HD/SD SDI OUT connector and HDMI output connector
Output signal that is output from the SDI OUT connector or HDMI output connector corresponds to the 
setup menu setting or format of played clip.

Output Formats and Limitations

Video Formats and Output Signals

When recording: Format of the 
OPERATION menu 
When playing back: Video format of 
the played video clip

Output format

Input/Output setting of the OPERATION menu

HD
HD&HDV

SD
SD&HDV
SD&DV

XAVC-I 1920/59.94i
XAVC-L50 1920/59.94i
XAVC-L35 1920/59.94i
XAVC-L25 1920/59.94i
HD422 1920/59.94i
HD420 HQ1920/59.94i
HD420 HQ1440/59.94i
HQ1920/59.94i
HQ1440/59.94i
SP1440/59.94i

1920×1080/59.94i 720×480/59.94i

XAVC-I 1920/29.97P
XAVC-L50 1920/29.97P
XAVC-L35 1920/29.97P
HD422 1920/29.97P
HD420 HQ1920/29.97P
HD420 HQ1440/29.97P
HQ1920/29.97P
HQ1440/29.97P

1920×1080/29.97PsF 720×480/29.97PsF

XAVC-I 1920/23.98P
XAVC-L50 1920/23.98P
XAVC-L35 1920/23.98P
HD422 1920/23.98P
HD420 HQ1920/23.98P
HD420 HQ1440/23.98P
HQ1920/23.98P
HQ1440/23.98P
(23.98P Output: 2-3 Pull Down)

1920×1080/23.98PsF 6)

1920×1080/59.94i 1)
720×480/59.94i 1)

SP1440/23.98P
(23.98P Output: 2-3 Pull Down)

1920×1080/59.94i 1) 720×480/59.94i 1)

XAVC-I 1280/59.94P
XAVC-L50 1280/59.94P
HD422 1280/59.94P
HD420 HQ1280/59.94P

1280×720/59.94P 720×480/59.94i 2)
198



HD422 1280/29.97P
HD420 HQ1280/29.97P

1280×720/59.94P 3) 720×480/29.97PsF

HD422 1280/23.98P
HD420 HQ1280/23.98P
(23.98P Output: 2-3 Pull Down)

1280×720/59.94P 4) 720×480/59.94i 1)

HQ1280/59.94P 720×480/59.94P 720×480/59.94i 2)

HQ1280/29.97P 720×480/29.97PsF

HQ1280/23.98P 720×480/59.94i 1)

IMX 512/59.94i
DVCAM 480/59.94i
DVCAM 59.94i

720×480/59.94i

IMX 512/29.97P
DVCAM 480/29.97P
DVCAM 29.97P

720×480/29.97PsF

XAVC-I 1920/50i
XAVC-L50 1920/50i
XAVC-L35 1920/50i
XAVC-L25 1920/50i
HD422 1920/50i
HD420 HQ1920/50i
HD420 HQ1440/50i
HQ1920/50i
HQ1440/50i
SP1440/50i

1920×1080/50i 720×576/50i

XAVC-I 1920/25P
XAVC-L50 1920/25P
XAVC-L35 1920/25P
HD422 1920/25P
HD420 HQ1920/25P
HD420 HQ1440/25P
HQ1920/25P
HQ 1440/25P

1920×1080/25PsF 720×576/25PsF

XAVC-I 1280/50P
XAVC-L50 1280/50P
HD422 1280/50P
HD420 HQ1280/50P

1280×720/50P 720×576/50i

HD422 1280/25P
HD420 HQ1280/25P

720×576/25PsF

HQ1280/50P 720×576/50P 720×576/50i 5)

HQ1280/25P 720×576/25PsF

IMX 608/50i
DVCAM 480/50i
DVCAM 50i

720×576/50i

When recording: Format of the 
OPERATION menu 
When playing back: Video format of 
the played video clip

Output format

Input/Output setting of the OPERATION menu

HD
HD&HDV

SD
SD&HDV
SD&DV
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1) Converted from 23.98P by 2-3 pull-down processing.
2) Converted from 59.94P.
3) Converted from 29.97P by displaying each 2 same pictures of 29.97P.
4) Converted from 23.98P by displaying each 2 or 3 same pictures of 23.98P.
5) Converted from 50P.
6) No signal is output from the HDMI OUT connector when 1920×1080/23.98PsF is output from the SDI OUT 

connector.

Output formats of the VIDEO OUT connector
When the output signal from the SDI OUT or HDMI OUT connector is HD, the Y signal whose format is 
the same as the output signal from the SDI OUT or HDMI OUT connector, is output from the VIDEO 
OUT connector. When the output signal from the SDI OUT or HDMI OUT connector is SD, an analog 
composite signal is output from the VIDEO OUT connector.

Output formats of the i.LINK (HDV/DV) connector
The output signal from the i.LINK (HDV/DV) connector corresponds to the setup menu setting or format 
of the played clip, and output in the following format.

Note

When you set “OPERATION” > “Format” > “File System” to “UDF” and “exFAT” in the setup menu, 
no signal is output from the i.LINK (HDV/DV) connector.

IMX 608/25P
DVCAM 480/25P
DVCAM 25P

720×576/25PsF

When recording: Format of the 
OPERATION menu
When playing back: Video format 
of the played video clip

Output format

Input/Output setting of the OPERATION menu

HD&HDV SD&HDV SD&DV

HQ1920/59.94i
HQ1440/59.94i

Input/output is not possible. DV (720×480/59.94i)

SP1440/59.94i HDV (1440×1080/59.94i) DV (720×480/59.94i)

HQ1920/29.97P
HQ1440/29.97P

Input/output is not possible. DV (720×480/29.97PsF)

HQ1920/23.98P
HQ1440/23.98P

Input/output is not possible.

SP1440/23.98P HDV 
(1440×1080/
59.94i 2-3 pull-
down)

HDV 
(1440×1080/
59.94i 2-3 pull-
down)

DV (720×480/59.94i 2-3 pull-
down)

HQ1280/59.94P Input/output is not possible. DV (720×480/59.94i Converted 
from P to i)

HQ1280/29.97P Input/output is not possible. DV (720×480/29.97PsF)

HQ1280/23.98P Input/output is not possible.

DVCAM 59.94i – – DV (720×480/59.94i)

When recording: Format of the 
OPERATION menu 
When playing back: Video format of 
the played video clip

Output format

Input/Output setting of the OPERATION menu

HD
HD&HDV

SD
SD&HDV
SD&DV
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DVCAM 29.97P – – DV (720×480/29.97PsF)

HQ1920/50i
HQ1440/50i

Input/output is not possible. DV (720×576/50i)

SP1440/50i HDV (1440×1080/50i) DV (720×576/50i)

HQ1920/25P
HQ 1440/25P

Input/output is not possible. DV (720×576/25PsF)

HQ1280/50P Input/output is not possible. DV (720×576/50i Converted from 
P to i)

HQ1280/25P Input/output is not possible. DV (720×576/25PsF)

DVCAM 50i – – DV (720×576/50i)

DVCAM 25P – – DV (720×576/50i)

When recording: Format of the 
OPERATION menu
When playing back: Video format 
of the played video clip

Output format

Input/Output setting of the OPERATION menu

HD&HDV SD&HDV SD&DV
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The table below shows output signals from the camcorder and operation restrictions to the camcorder 
when it is connected with a camera adaptor and camera control unit to configure a shooting and recording 
system.
When the camcorder is equipped with the CA-FB70/CA-TX70 HD Camera Adaptor, full HD signals 
complying with the HD-SDI standard are transferred to the camera adaptor.

Note

When configuring a camcorder system with a camera adaptor and camera control unit, install the optional CBK-CE01 50 
Pin Interface and Digital Extender. Set “OPERATION” > “Format” > “HD/SD” to “HD” in the setup menu.

Output Signals and Operation Restrictions When a 
Camcorder System is Configured (in HD Mode Only)

Settings of Rec Format and 

System Frequency under 

OPERATION >Format in 

the setup menu

SDI outputs to the 

camera adaptor

System format of the 

camera adaptor and 

camera control unit

Operation restrictions to the 

camcorder
Genlock Return video 

display

XAVC-I 1920/59.94i
XAVC-L50 1920/59.94i
XAVC-L35 1920/59.94i
XAVC-L25 1920/59.94i
HD422 1920/59.94i
HQ1920/59.94i

1920×1080/59.94i 1920×1080/59.94i Available Available

HQ1440/59.94i

SP1440/59.94i

XAVC-I 1920/29.97P
XAVC-L50 1920/29.97P
XAVC-L35 1920/29.97P
HD422 1920/29.97P
HQ1920/29.97P

1920×1080/29.97PsF

HQ1440/29.97P

SP1440/23.98P 1920×1080/59.94i (2-
3PD)

XAVC-I 1920/23.98P
XAVC-L50 1920/23.98P
XAVC-L35 1920/23.98P
HD422 1920/23.98P
HQ1920/23.98P a)

Output disabled Not supported Unavailable Unavailable

HQ1920/23.98P b) 1920×1080/59.94i (2-
3PD)

1920×1080/59.94i Available Unavailable

HQ1440/23.98P a) Output disabled Not supported Unavailable Unavailable

HQ1440/23.98P b) 1920×1080/59.94i (2-
3PD)

1920×1080/59.94i Available Unavailable
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a) PsF output
b) PD output

XAVC-I 1920/50i
XAVC-L50 1920/50i
XAVC-L35 1920/50i
XAVC-L25 1920/50i
HD422 1920/50i
HQ1920/50i

1920×1080/50i 1920×1080/50i Available Available

HQ1440/50i

SP1440/50i

XAVC-I 1920/25P
XAVC-L50 1920/25P
XAVC-L35 1920/25P
HD422 1920/25P
HQ1920/25P

1920×1080/25PsF

HQ1440/25P

XAVC-I 1280/59.94P
XAVC-L50 1280/59.94P
HD422 1280/59.94P
HQ1280/59.94P

1280×720/59.94P 1280×720/59.94P Available Available

XAVC-I 1280/50P
XAVC-L50 1280/50P
HD422 1280/50P
HQ1280/50P

1280×720/50P 1280×720/50P Available Available

Settings of Rec Format and 

System Frequency under 

OPERATION >Format in 

the setup menu

SDI outputs to the 

camera adaptor

System format of the 

camera adaptor and 

camera control unit

Operation restrictions to the 

camcorder
Genlock Return video 

display
203



When the unit is used with a PC connection, 
download any device drivers, plug-ins, and 
application software you require from the 
following websites.

Sony Professional products website:
U.S.A. http://pro.sony.com
Canada http://www.sonybiz.ca
Latin America http://sonypro-latin.com
Europe http://www.pro.sony.eu/pro
Middle East, Africa

http://sony-psmea.com
Russia http://sony.ru/pro/
Brazil http://sonypro.com.br
Australia http://pro.sony.com.au
New Zealand http://pro.sony.co.nz
Japan http://www.sonybsc.com
Asia Pacific http://pro.sony-asia.com
Korea http://bp.sony.co.kr
China http://pro.sony.com.cn
India http://pro.sony.co.in

Sony Creative Software, software download 
page:
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

Software Downloads Specifications

General

Power requirements

12 V DC

Power consumption

Approx. 25 W

Main unit (camcorder) + LCD viewfinder + auto 

focus lens + microphone

Power source for HD recording: 12 V DC

Approx. 30 W

Main unit (camcorder) + LCD viewfinder + auto 

focus lens + microphone + CBK-WA101 

Wireless Adapter

Power source for recording: 12 V DC

Notes

• Do not use a video light with power 
consumption of over 50 W.

• When connecting a device to the DC OUT 
connector, use one with current consumption 
of 0.5 A or less.

Operating temperature

0 ºC to 40 ºC (32 ºF to 104 ºF)

Storage temperature

–20 ºC to +60 ºC (–4 ºF to +140 ºF)

Recording/playback formats

Video (XAVC)

XAVC-I mode: GBG, 112 Mbps max, 

MPEG-4 AVC/H.264

XAVC-L50 mode: VBR, 50 Mbps max, 

MPEG-4 AVC/H.264

XAVC-L35 mode: VBR, 35 Mbps max, 

MPEG-4 AVC/H.264

XAVC-L25 mode: VBR, 25 Mbps max, 

MPEG-4 AVC/H.264

Video (MPEG-2 Long GOP)

HD 422 mode: CBR, 50 Mbps max, 

MPEG-2 422P@HL

HQ mode: VBR, 35 Mbps max, 

MPEG-2 MP@HL

SP mode: CBR, 25 Mbps MPEG-2 MP@H-14

SD mode: MPEG IMX, DVCAM
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Audio

<exFAT>

XAVC-I mode: LPCM 24-bit, 48 kHz, 

4 channels

XAVC-L mode: LPCM 24-bit, 48 kHz, 

4 channels

HD 422 50 mode: LPCM 24-bit, 48 kHz, 

4 channels

HD 420 HQ mode: LPCM 16-bit, 48 kHz, 

4 channels

SD MPEG IMX mode: LPCM 16/24-bit, 

48 kHz, 4 channels

SD DVCAM mode: LPCM 16-bit, 48 kHz, 

4 channels

<UDF>

HD 422 50 mode: LPCM 24-bit, 48 kHz, 

4 channels

HD 422 HQ mode: LPCM 16-bit, 48 kHz, 

4 channels

SD MPEG IMX mode: LPCM 16/24-bit, 

48 kHz, 4 channels

SD DVCAM mode: LPCM 16-bit, 48 kHz, 

4 channels

<FAT>

HD mode: LPCM 16-bit, 48 kHz, 4 channels

SD DVCAM mode: LPCM 16-bit, 48 kHz, 

2 channels

Maximum recording time

The maximum recording time is equivalent to the 

duration of a single clip recording that fills the media. 

The recording time may become shorter, depending on 

the number of recorded clips.

<exFAT>

XAVC-I mode:

When using SBP-128B (128 GB): 

Approx. 120 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 60 minutes

When using SBS-32G1A (32 GB): 

Approx. 30 minutes

XAVC-L50 mode:

When using SBP-128B (128 GB): 

Approx. 240 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 120 minutes

When using SBS-32G1A (32 GB): 

Approx. 60 minutes

XAVC-L35 mode:

When using SBP-128B (128 GB): 

Approx. 340 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 170 minutes

When using SBS-32G1A (32 GB): 

Approx. 85 minutes

XAVC-L25 mode:

When using SBP-128B (128 GB): 

Approx. 440 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 220 minutes

When using SBS-32G1A (32 GB): 

Approx. 110 minutes

HD 422 50/SD MPEG IMX mode:

When using SBP-128B (128 GB): 

Approx. 240 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 120 minutes

When using G49SBS-32G1A (32 GB): 

Approx. 60 minutes

HD 420 HQ mode:

When using SBP-128B (128 GB): 

Approx. 360 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 180 minutes

When using SBS-32G1A (32 GB): 

Approx. 90 minutes

SD DVCAM mode:

When using SBP-128B (128 GB): 

Approx. 440 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 220 minutes

When using SBS-32G1A (32 GB): 

Approx. 110 minutes

<UDF>

HD 422 50/SD MPEG IMX mode: 

When using SBP-128B (128 GB): 

Approx. 240 minutes

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 120 minutes

When using G49SBS-32G1A (32 GB): 

Approx. 60 minutes

HD 420 HQ mode: 

When using SBP-128B (128 GB): 

Approx. 360 minutes 

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 180 minutes

When using SBS-32G1A (32 GB): 

Approx. 90 minutes
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SD DVCAM mode: 

When using SBP-128B (128 GB): 

Approx. 440 minutes 

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 220 minutes

When using SBS-32G1A (32 GB): 

Approx. 110 minutes

<FAT> 

HD HQ mode 

When using SBP-128B (128 GB): 

Approx. 400 minutes 

When using SBS-64G1A (64 GB): 

Approx. 200 minutes

When using SBS-32G1A (32 GB): 

Approx. 100 minutes

HD SP mode: 

When using SBP-128B (128 GB): 

Approx. 560 minutes 

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 280 minutes

When using SBS-32G1A (32 GB): 

Approx. 140 minutes

SD DVCAM mode: 

When using SBP-128B (128 GB): 

Approx. 520 minutes 

When using SBS-64G1A/SBP-64B 

(64 GB): Approx. 260 minutes

When using SBS-32G1A (32 GB): 

Approx. 130 minutes

Recording frame rate

<exFAT>

XAVC-I mode: CBG, 112 Mbps max, 

MPEG-4 AVC/H.264

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1280×720/59.94p, 50p

XAVC-L50 mode: MPEG-4 AVC/H.264, 

50Mbps/VBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1280×720/59.94p, 50p

XAVC-L35 mode: MPEG-4 AVC/H.264, 

35Mbps/VBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

XAVC-L25 mode: MPEG-4 AVC/H.264, 

25Mbps/VBR

1920×1080/59.94i, 50i

HD 422 50 mode: MPEG-2 422@HL, 

50Mbps/CBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1280×720/59.94p, 50p, 29.97p, 25p, 

23.98p

HD 420 HQ mode: MPEG-2 MP@HL, 

35Mbps/VBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1440×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1280×720/59.94p, 50p, 23.98p

(2-3 pull down)

SD MPEG IMX mode:

720×486/59.94i, 29.97PsF

720×576/50i, 25PsF

SD DVCAM mode:

720×480/59.94i, 29.97PsF

720×576/50i, 25PsF

<UDF>

HD 422 50mode: MPEG-2 422P@HL, 

50 Mbps/CBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1280×720/59.94p, 50p, 29.97p, 25p, 

23.98p
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HD 420 HQ mode: MPEG-2 MP@HL, 

35 Mbps/VBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1440×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

1280×720/59.94p, 50p, 23.98p (2-3 pull 

down)

SD MPEG IMX mode:

720×486/59.94i, 29.97PsF

720×576/50i, 25PsF

SD DVCAM mode:

720×480/59.94i, 29.97PsF

720×576/50i, 25PsF

<FAT>

HD HQ 1920 mode: MPEG-2 MP@HL, 

35 Mbps/VBR

1920×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

HD HQ 1440 mode: MPEG-2 MP@HL, 

35 Mbps/VBR

1440×1080/59.94i, 50i, 29.97p, 25p, 

23.98p

HD HQ 1280 mode: MPEG-2 MP@HL, 

35 Mbps/VBR

1280×720/59.94p, 50p, 29.97p, 25p, 

23.98p

HD SP 1440 mode: MPEG-2 MP@H-14, 

25 Mbps/CBR

1440×1080/59.94i, 50i, 23.98p (2-3 pull 

down)

SD DVCAM mode:

720×480/59.94i, 29.97PsF

720×576/50i, 25PsF

Continuous operation time 

Approx. 194 min. (with the BP-L80S)

Mass

Main body only: 3.4 kg (7 lb 7.9 oz)

Dimensions

See page 210

Supplied accessories

See page 209

Camera

Imaging element
1/2-inch type CMOS

Effective picture elements: 1920 (H) × 1080 (V)

Format

3-chip RGB

Optical system

F1.6 prism system

Built-in filters

1: Clear

2: 1/4ND

3: 1/16ND

4: 1/64ND

Sensitivity

F11 (1920×1080/59.94i)

F12 (1920×1080/50i)

Minimum illumination

0.04 lx

with 1920×1080/59.94i

(F1.6, 64-frame accumulation, +24 dB)

S/N ratio

60 dB (Y)

Horizontal resolution

1000 TV lines or more (1920×1080i mode)

Gain

–3, 0, 3, 6, 9, 12, 18, 24 dB

Shutter speed

1/60 to 1/2000 sec. + ECS (Extended Clear 

Scan)

Shutter speed (Slow shutter (SLS))

2 to 8, 16, 32, 64 frames

Slow & Quick Motion

720: Frame rate is selectable from 1 fps to 60 fps

1080p: Frame rate is selectable from 1 fps to 

30 fps

White balance

Preset (3200K), Memory A, Memory B/ATW
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Input/Output connectors

Audio

Sampling frequency

48 kHz

Quantization

16 bits

Headroom

20 dB (factory default) (20, 18, 16, 12 dB)

Frequency response

MIC: 50 Hz to 20 kHz (within ±3 dB)

LINE: 20 Hz to 20 kHz (within ±3 dB)

WRR Analog: 50 Hz to 20 kHz (within ±3 dB)

WRR Digital: 20 Hz to 20 kHz (within ±3 dB)

Dynamic range

90 dB (typical)

Distortion

0.08% max. (with input level –40 dBu)

Built-in speaker

Monaural

Output: 300 mW

Display

Viewfinder

3.5-inch color LCD monitor: 960 (H) × 540 (V), 

1/4 HD size

LCD screen

Black and white LCD (displays audio level, TC, 

and remaining of the battery and media)

Media

Card slots

Type: ExpressCard/34

Number of slots: 2

Connector: Conforms to PCMCIA ExpressCard 

Standard

Writing rate

200 Mbps or more

Reading rate

200 Mbps or more

Inputs/Outputs

Inputs

Audio input: XLR type, 3-pin, female (2)

Line/Mic/Mic +48 V selectable

–60 dBu/+4 dBu

(0 dBu = 0.775 Vrms)

Microphone input: XLR type, 5-pin, female

–60 dBu

GENLOCK input: BNC type (1)

1.0 Vp-p, 75 ohms, unbalanced

Timecode input: BNC type (1)

0.5 V to 18 Vp-p, 10 kilohms

Outputs

Video output: BNC type (1), HD-Y or analog 

composite

HDMI: Type A, 19-pin (1)

SDI output: BNC type (2), HD-SDI/SD-SDI 

selectable

Audio output: XLR type, 5-pin, male

0 dBu

Timecode output: BNC type (1)

1.0 Vp-p, 75 ohms

Earphone output (stereo minijack) (1)

8 ohms, –∞ to –18 dBs variable

Others

DC input: XLR type, 4-pin, male

11 V to 17 V DC

DC output: 4-pin

11 V to 17 V DC, maximum rated current: 

0.5 A

Lens: 12-pin

Supplies power to lens

11 V to 17 V DC, maximum rated current: 

1.0 A

Remote: 8-pin

LIGHT: 2-pin

USB: 4-pin, Type B (1), Host Type A (1)

i.LINK: 6-pin (1), IEEE1394 compliant

HDV (HDV1080i)/DVCAM stream input/

output, S400

VF: 26-pin, rectangular, 20-pin round

For wireless receiver: D-sub 15-pin
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Power supply and related equipment

Lens, viewfinder and related equipment

Note

The BKW-401 can only be used with the viewfinder 
supplied with the camcorder or the DXF-20W.

Equipment for remote control

Lens

Lens mount

Sony 1/2-inch type bayonet mount

Focal length

5.8 mm to 93 mm

(35 mm equivalent: 31.4 mm to 503 mm)

Zoom

Servo/Manual selectable

Zoom ratio

16×

Maximum relative aperture

1:1.9

Iris

Auto/Manual selectable

F1.9 to F16 and C (close)

Focus range

Auto/Manual selectable

Ranges:

800 mm (31 1/2 inches) to ∞ (Macro OFF, wide 

angle)

50 mm (2 inches) to ∞ (Macro ON, wide angle)

782 mm (30 7/8 inches) to ∞ (Macro ON, 

telephoto)

Filter thread

M82 mm, 0.75 mm pitch

Macro

ON/OFF switchable

Supplied Accessories

Viewfinder (1)

Shoulder strap (1)

Stereo microphone (1)

Windscreen (1)

Cold shoe kit (1 set)

Lens mount cap

Flangeback (focal distance) adjustment chart

Auto focus lens (1)

Before Using this Unit (1)

Operating Instructions (CD-ROM) (1)

Related Equipment

AC adaptor

AC-DN10/DN2B

Battery pack

BP-L80S

Battery charger

BC-L160/L500/L70

Lens
1/2-inch type bayonet mount lenses only

Viewfinder

DXF-20W/C50WA

CBK-VF02

Viewfinder rotation bracket

BKW-401

Remote control unit

RM-B170/B750

RCP-1000/1500/1530

RCP-751/921

RCP-1001/1501

Note

The command network unit (CNU) is not 
supported.

50-pin interface and digital extender

CBK-CE01

HD camera adaptor

CA-FB70/TX70 (when an optional CBK-CE01 

is installed)

Note

When using SDIOUT2 with the CA-FB70 
attached to the camcorder, use an L angle 
bracket.

MPEG TS adaptor

HDCA-702 (when an optional CBK-CE01 is 

installed)

Note

SDIOUT2 cannot be used when the MPEG TS 
adaptor is attached.
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Media adaptor

XQD ExpressCard adaptor

Recording media

Audio equipment

Other peripheral devices

Equipment for maintenance and handling

Dimensions

Design and specifications are subject to change 
without notice.

Wireless adapter

CBK-WA101

USB wireless LAN module

IFU-WLM3

MEAD-SD02 (for SDHC/SDXC card)

QDA-EX1 (for XQD memory card)

SxS memory card

SxS PRO+ series

SxS PRO series

SxS-1 series

Microphone

ECM-678/674/673/680S

Microphone holder

CAC-12

Wireless microphone

DWR-S02D

WRR-855S/860C/861/862

Tripod adaptor

VCT-14/U14

Video light

UC-D200A (PROTECH)

Ultralight (Anton Bauer)

Pad

CBK-SP01 Soft Type Shoulder Pad

Hard carrying case

LC-H300

Soft carrying case

LC-DS300SFT

(Unit: mm (inches))
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• XDCAM, SxS, SxS PRO, SxS-1, XQD, i.LINK, and 
 are registered trademarks of Sony Corporation.

• The terms HDMI and HDMI High-Definition 
Multimedia Interface, and the HDMI Logo are 
trademarks or registered trademarks of HDMI 
Licensing LLC in the United States and other 
countries.

• The ExpressCard word mark and logos are owned by 
the Personal Computer Memory Card International 
Association (PCMCIA) and any use of such marks by 
Sony Corporation is under license. Other trademarks 
and trade names are those of their respective owners.

The products or system names appearing in this 
document are trademarks or registered trademarks of 
their respective owners.

Notes

• Always make a test recording, and verify that it was 
recorded successfully.
SONY WILL NOT BE LIABLE FOR DAMAGES 
OF ANY KIND INCLUDING, BUT NOT 
LIMITED TO, COMPENSATION OR 
REIMBURSEMENT ON ACCOUNT OF 
FAILURE OF THIS UNIT OR ITS RECORDING 
MEDIA, EXTERNAL STORAGE SYSTEMS OR 
ANY OTHER MEDIA OR STORAGE SYSTEMS 
TO RECORD CONTENT OF ANY TYPE.

• Always verify that the unit is operating properly 
before use. SONY WILL NOT BE LIABLE FOR 
DAMAGES OF ANY KIND INCLUDING, BUT 
NOT LIMITED TO, COMPENSATION OR 
REIMBURSEMENT ON ACCOUNT OF THE 
LOSS OF PRESENT OR PROSPECTIVE 
PROFITS DUE TO FAILURE OF THIS UNIT, 
EITHER DURING THE WARRANTY PERIOD 
OR AFTER EXPIRATION OF THE WARRANTY, 
OR FOR ANY OTHER REASON WHATSOEVER.

• SONY WILL NOT BE LIABLE FOR CLAIMS OF 
ANY KIND MADE BY USERS OF THIS UNIT OR 
MADE BY THIRD PARTIES.

• SONY WILL NOT BE LIABLE FOR THE LOSS, 
REPAIR, OR REPRODUCTION OF ANY DATA 
RECORDED ON THE INTERNAL STORAGE 
SYSTEM, RECORDING MEDIA, EXTERNAL 
STORAGE SYSTEMS OR ANY OTHER MEDIA 
OR STORAGE SYSTEMS.

• SONY WILL NOT BE LIABLE FOR THE 
TERMINATION OR DISCONTINUATION OF 
ANY SERVICES RELATED TO THIS UNIT 
THAT MAY RESULT DUE TO 
CIRCUMSTANCES OF ANY KIND.
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Peripheral Devices and Accessories

a) The carrying case is large enough to hold the camcorder with lens and microphone mounted. However, 
remove them if they protrude more than 25 cm (9 7/8 inches) from the front of the main unit.

ECM-680S/678/673 
Microphone

CAC-12 
Microphone Holder

CBK-VF02, DXF-20W 
Viewfinder

HD monitor/SD monitor

PMW-RX50, PDW-HR1 XDCAM 
HD series recorder

HDCAM series recorder

PXW-X320

RM-B170/B750
RCP-1001/1501
RCP-751/921
RCP-1000/1500/1530
Remote Control Unit

VCT-14/U14
Tripod adaptor

AC-DN10/DN2B 
AC Adaptor

WRR-855S/860C/861/862 
UHF Synthesized Tuner Unit
DWR-S02D Digital Wireless Receiver

BC-L160
Battery 
Charger

BC-L160 
Battery 
Charger

BC-L70 
Battery 
Charger

BP-L80S
Battery Pack

SxS memory card

DXF-C50WA 
Viewfinder

MEAD-SD02 Media Adaptor

CBK-CE01 50-Pin Interface and Digital Extender + 
CA-FB70/TX70 HD Camera Adaptor

CCU (Camera Control Unit)

CBK-CE01 50-Pin Interface and Digital 
Extender + HDCA-702 MPEG TS Adaptor

CBK-WA100/101 Wireless Adapter
IFU-WLM3 USB Wireless LAN Module

QDA-EX1 XQD ExpressCard Adaptor

Portable light

CBK-DCB01 
Demand Converter Box
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THIS PRODUCT IS LICENSED UNDER THE 
AVC PATENT PORTFOLIO LICENSE FOR 
THE PERSONAL USE OF A CONSUMER OR 
OTHER USES IN WHICH IT DOES NOT 
RECEIVE REMUNERATION TO

(i) ENCODE VIDEO IN COMPLIANCE WITH 
THE AVC STANDARD (“AVC VIDEO”) AND/
OR
(ii) DECODE AVC VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN 
A PERSONAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER 
LICENSED TO PROVIDE AVC VIDEO.

NO LICENSE IS GRANTED OR SHALL BE 
IMPLIED FOR ANY OTHER USE. 
ADDITIONAL INFORMATION MAY BE 
OBTAINED FROM MPEG LA, L.L.C. SEE
HTTP://WWW.MPEGLA.COM

This product uses RICOH Bitmap Fonts 
produced and sold by Ricoh Company, Ltd.

About License

MPEG-4 AVC Patent Portfolio 
License

About Bitmap Fonts
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Because it uses the OpenSSL Toolkit, this product uses software developed by the OpenSSL Project 
(http://www.openssl.org/).

OpenSSL License
  ---------------

/* ====================================================================
 * Copyright (c) 1998-2008 The OpenSSL Project.  All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 *
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer. 
 *
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the
 *    distribution.
 *
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 *
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please contact
 *    openssl-core@openssl.org.
 *
 * 5. Products derived from this software may not be called "OpenSSL"
 *    nor may "OpenSSL" appear in their names without prior written
 *    permission of the OpenSSL Project.
 *
 * 6. Redistributions of any form whatsoever must retain the following
 *    acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 *
 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;

About OpenSSL
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 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
 * OF THE POSSIBILITY OF SUCH DAMAGE.
 * ====================================================================
 *
 * This product includes cryptographic software written by Eric Young
 * (eay@cryptsoft.com).  This product includes software written by Tim
 * Hudson (tjh@cryptsoft.com).
 *
 */

 Original SSLeay License
 -----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
 * All rights reserved.
 *
 * This package is an SSL implementation written
 * by Eric Young (eay@cryptsoft.com).
 * The implementation was written so as to conform with Netscapes SSL.
 * 
 * This library is free for commercial and non-commercial use as long as
 * the following conditions are aheared to.  The following conditions
 * apply to all code found in this distribution, be it the RC4, RSA,
 * lhash, DES, etc., code; not just the SSL code.  The SSL documentation
 * included with this distribution is covered by the same copyright terms
 * except that the holder is Tim Hudson (tjh@cryptsoft.com).
 * 
 * Copyright remains Eric Young's, and as such any Copyright notices in
 * the code are not to be removed.
 * If this package is used in a product, Eric Young should be given attribution
 * as the author of the parts of the library used.
 * This can be in the form of a textual message at program startup or
 * in documentation (online or textual) provided with the package.
 * 
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the copyright
 *    notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in the
 *    documentation and/or other materials provided with the distribution.
 * 3. All advertising materials mentioning features or use of this software
 *    must display the following acknowledgement:
 *    "This product includes cryptographic software written by
 *     Eric Young (eay@cryptsoft.com)"
 *    The word 'cryptographic' can be left out if the rouines from the library
 *    being used are not cryptographic related :-).
 * 4. If you include any Windows specific code (or a derivative thereof) from 
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 *    the apps directory (application code) you must include an acknowledgement:
 *    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
 * 
 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 * SUCH DAMAGE.
 * 
 * The licence and distribution terms for any publically available version or
 * derivative of this code cannot be changed.  i.e. this code cannot simply be
 * copied and put under another distribution licence
 * [including the GNU Public Licence.]
 */

This product uses the following software, released under MIT License.

jQuery JavaScript Library v1.7.2
http://jquery.com/
Copyright 2011, John Resig

Sizzle.js
http://sizzlejs.com/
Copyright 2011, The Dojo Foundation
Date: Wed Mar 21 12:46:34 2012 -0700

MIT License

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 
associated documentation files (the "Software"), to deal in the Software without restriction, including 
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies 
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following 
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial 
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL 

About JQuery,Sizzle.js
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THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR 
OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, 
ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.
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Numerics

2-Slot Simul Rec function    95

A

AC power    30
ACCESS lamp    15, 18, 63
Accessories    212
Accessory shoe    11
Adaptor connector    10
ALARM knob    13
Area setting    36
Arrow buttons (K, k, J, j)    16
ASSIGN. 0 switch    13
ASSIGN. 1/2/3 switches    13
ASSIGNABLE 4/5 switches    18
Assignable switches    164
ATW (Auto Tracing White Balance)    14
Audio control section    16

protective cover    15
AUDIO IN CH-1/CH-2/CH-3/CH-4 switches

    17
AUDIO IN CH1/CH2 connectors    20
AUDIO IN selector switches    20
Audio input system    39
Audio level

adjusting playback level    13
adjusting recording level    58
meters    21, 28

AUDIO LEVEL CH-1/CH-2/CH-3/CH-4 
knobs    17

AUDIO OUT connector    20
AUDIO SELECT CH-1/CH-2 switches    17
AUDIO SELECT CH 3-4 switches    17
Auto focus lens    21
AUTO W/B BAL switch    12

B

BACKLIGHT button    16
Battery changing    197

Battery pack    30
attachment shoe    10
remaining capacity    21, 26
voltage display    26

BKW-401    34
Black balance, adjusting    49
BRIGHT control    23
Brightness adjustment    23
Brightness level indicator    27

C

Camera adaptor    10
Clip

batch copy    108
batch delete    109
copying    108
cue up    103
defining names    98
deleting    89, 109
dividing    111
managing/editing on a computer    179
operations    101
playback    89, 102
properties    107
searching on expand thumbnail screen    

103
searching on shot mark thumbnail screen    

103
setting index picture    111
thumbnail selection    102

Clock    36
changing battery    197

COLOR TEMP. button    13
Color temperature

indicator    26
switching    51, 52

Computer    179
Connection    177, 179

computer    179
i.LINK (HDV/DV)    181
monitor    177

Connector    23
Contrast adjustment    23
CONTRAST control    23

D

Date, setting    36
DC IN connector    10

Index
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DC OUT 12V connector    10
DCC (Dynamic Contrast Control) function    

14
Depth of field indicator    26
Diopter adjustment ring    23
Direct menu    29
DISPLAY switch    16, 23

E

EARPHONE jack    20
E-E (Electric-to-Electric)    15
Electric color temperature filter indicator    28
Electrical CC filter

switching    52
Electronic shutter    53
ESSENCE MARK button    17
EXPAND button    16
Expand thumbnail screen

displaying    109
increasing number of divisions    110

Extender indicator    25
External device

connection    177
control indicator    27
recording    181

External device connector    18
External input

recording    182
setting indicator    27

External power input    26
Eyecup    23

F

F FWD button/indicator    15
F REV button/indicator    15
F-RUN/SET/R-RUN switch    17
Filter indicator    28
FILTER selector    12
Flange focal length, adjusting    37

button    22
Focus    57

mode indicator    27
position indicator    25
ring    22

FOCUS switch    21
Formatting (initializing)    64
Frame Rec function    92
Framing    96

Freeze mix function    96

G

GAIN selector    13
Gain value indicator    28
GENLOCK IN connector    19
Green tally indicator    25

H

HD/SD SDI OUT connector    20, 178
HDMI output connector    19, 178
Histogram display    28
HOLD button    16

I

i.LINK
connection    181

i.LINK (HDV/DV) connector    20, 178
Independent AV file    102
Index picture    101

changing    111
Initial setting    116, 172
Input source indicator    27
Interval Rec function    91
Iris

auto setting    55
IRIS switch    22
position indicator    28
ring    22

IRIS switch    22

L

LCD Panel    15
Lens    21

cable clamp    11
locking lever    11
mount    11
mount cap    11
mount securing rubber    11
mounting    37

LENS connector    11
Lens files

loading    174
loading automatically    175
saving    174
setting    174
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Level meters    28
LIGHT connector    11
LIGHT switch    10

M

MACRO switch    22
Maintenance    186
Media

protection (lock)    21
remaining capacity    21
remaining capacity indicator    28
status indicator    25

Menu
basic operations    115
FILE menu    159
list    118
locking    116
MAINTENANCE menu    144
OPERATION menu    121
PAINT menu    138
THUMBNAIL menu    104
USER menu    118
USER MENU CUSTOMIZE menu    118

MENU button    16
MENU CANCEL/PRST/ESCAPE switch    14
MENU knob    12
MENU ON/OFF switch    14
MIC IN (+48 V) connector    11
MIC LEVEL control    12
Microphone    39
Microphone holder    24

attachment shoe    11
MIRROR switch    24
Monitor    177
MONITOR knob    13
MONITOR switches    13

N

ND filter    12
NEXT button    15
Nonlinear editing    180, 182
Number of system lines    26

O

OK mark
setting    90

OK/NG/KP marks    107

Operation status indicator    25
i.LINK connection device    27

OUTPUT/DCC switch    14

P

PC connector    18
Peaking adjustment    23
PEAKING control    23
Peripheral devices    212
Picture Cache Rec function    90
Planning metadata    97
PLAY/PAUSE button/indicator    15, 102
Power supply    30
POWER switch    10
PRESET/REGEN/CLOCK switch    17
PREV button    15
PUSH AF button    21
PUSH AUTO button    22

R

REC START button    12
Recording    181

external device    181
external input signals    182

Recording mode    48
indicator    25
special mode indicator    26
special mode setting indicator    26

Recording review    88
REMOTE connector    20
Remote control unit    69
Remote control unit connection    69
Reset    116, 172
RESET/RETURN button    16
RET button    23
RM-B750    69

S

Scene files
loading    173
saving    172

SET button    16
Settings data

loading    171
saving    170

Settings/status monitoring    62
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Setup menu    113
basic operations    115
FILE menu    159
MAINTENANCE menu    144
menu list    118
OPERATION menu    121
PAINT menu    138
THUMBNAIL menu    104

SHIFT button    17
Shooting    63
Shot mark

adding    111
adding during playback    103
defining names    99
deleting    111
recording    90

Shot mark thumbnail screen    110
Shoulder pad    11

adjusting position    44
Shoulder strap

attaching    43
attachment point    11

Shutter    53
Shutter speed    53

indicator    28
SHUTTER switch    12
Slide stopper    23
Slow & Quick    93
Slow & Quick motion shooting    93
Speaker    15
Specifications    204
Standard settings    116
STATUS ON/SEL/OFF switch    14
Status screen    62

assignable switches    62
audio    62
battery and media    62
camera    62
video    62

STOP button    15
Stop motion animation    92
Switch cover    14
SxS device driver software    179
SxS memory card    63

ejecting    63
exchanging    64
formatting    64
loading    63
remaining capacity    64
restoring    65

switching    63
SxS memory card slots    18

EJECT button    18
slot cover    18
SLOT SELECT button    19

T

TALLY indicator    19
Tally indicator    23
TALLY switch    20, 23
TC IN connector    19
TC OUT connector    19
Testing    186
Thumbnail

indicator    16
operations    104

THUMBNAIL button    16
THUMBNAIL menu    104

basic operations    106
Thumbnail screen

all clip thumbnail screen    106
changing screen type    106
control section protective cover    15
OK clip thumbnail screen    106
operations section    16

Time counter display    20
Time data    59
Time-lapse recording    91
Time, setting    36
Timecode

Indicator    27
Setting    59
synchronizing    60

TLCS control mode indicator    27
Tripod

mount    11
mounting    42

U

UHF portable tuner, attaching    41
USB connection    179
User bits setting    60
User files    175

V

VF connector    11
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Video format    45, 108
indicator    26

Video level indicator    27
Video light    43
VIDEO OUT connector    19
Viewfinder    23

5-inch viewfinder    35
adjusting focus    33
adjusting position    31
adjusting screen    33
adjusting the angle    32
attachment shoe    11
cable    24
cleaning    186
front-to-back positioning knob    11
left-to-right positioning ring    11
lifting up the barrel and eyepiece    32
positioning lever    11
rotation bracket    34
screen display    24

Voltage display    26
VTR button    23

W

WARNING indicator    15
Warning system    187
WHITE BAL switch    14
White balance

adjusting    50
memory indicator    28

Wi-Fi remote control    84
Wireless receiver reception level    25

Z

Zebra pattern    23
ZEBRA switch    23
Zoom    56

control connector    22
position indicator    25
power zoom lever    22
ring    22

ZOOM switch    22
222
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